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Dear Reader,

Thank you for choosing Mastering Microsoft Visual Basic 2010. This book is part of a family of
premium-quality Sybex books, all of which are written by outstanding authors who combine
practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we're still committed to producing con-

sistently exceptional books. With each of our titles, we're working hard to set a new standard

for the industry. From the paper we print on to the authors we work with, our goal is to bring
you the best books available.

I hope you see all that reflected in these pages. I'd be very interested to hear your comments
and get your feedback on how we’re doing. Feel free to let me know what you think about
this or any other Sybex book by sending me an email at nedde@wiley.com. If you think you've
found a technical error in this book, please visit http://sybex.custhelp.com. Customer feed-
back is critical to our efforts at Sybex.

Best regards,

Vice President and Publisher
Sybex, an Imprint of Wiley


http://sybex.custhelp.com

To my dearest and most precious ones, Nepheli and
Eleni-Myrsini
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Introduction

Welcome to Microsoft’s Visual Basic 2010, another milestone version of the most popular
programming language for building Windows and web applications. In modern software devel-
opment, however, the language is only one of the components we use to build applications.
The most important component is the .NET Framework, which is an indispensable component
of every application; it’s actually more important than the language itself. You can think of
the Framework as an enormous collection of functions for just about any programming task.
All drawing methods, for example, are part of the System.Drawing class. To draw a rectangle,
you call the DrawRectangle method of the System.Drawing class, passing the appropriate
arguments. To create a new folder, you call the CreateDirectory method of the Directory
class, and to retrieve the files in a folder, you call the GetFiles method of the same class.

The Framework contains all the functionality of the operating system and makes it available
to your application through methods. Methods are very similar to functions, which extend the
basic capabilities of a language. The Framework is a huge collection of such methods, organized
in units according to their role and in a way that makes it fairly easy to locate the methods for
the task at hand. The language and the Framework are the two ““programming’” components
absolutely necessary to build Windows applications. It’s possible to develop applications with
these two components alone, but the process would be awfully slow.

The software development process relies on numerous tools that streamline the coding expe-
rience. The third component is an integrated environment that hosts those tools, enabling you
to perform many common tasks with point-and-click operations. It’s basically an environment
in which you can design your forms with visual tools and write code as well. This environ-
ment, provided by Visual Studio, is known as an integrated development environment, or IDE.
You'll be amazed by the functionality provided by the tools of Visual Studio: you can actu-
ally design a functional data-driven application without writing a single line of code. You can
use similar tools in the same environment to design a fancy data-driven web page without a
single line of code. Visual Studio even provides tools for manipulating databases and allows
you to switch between tasks, all in the same, streamlined environment. You realize, of course,
that Visual Studio isn’t about writing applications without code; it just simplifies certain tasks
through wizards, and more often than not, we step in and provide custom code to write a
functional application. Even so, Visual Studio provides numerous tools, from debugging tools
that help you track and fix all kinds of bugs in your code to database-manipulation tools and
deployment wizards that streamline the process of deploying applications.

This book shows you how to use Visual Studio 2010 and Visual Basic 2010 to design
rich Windows and web applications. We'll start with the visual tools and then we’ll explore
Visual Basic and the Framework. A Windows application consists of a visual interface and
code behind the elements of the interface. (The code handles the user actions on the visual
interface, such as the click of a button, the selection of a menu item, and so on.) You'll use the



XXVl

INTRODUCTION

tools of Visual Studio to build the visual interface, and then you’ll program the elements of
the application with Visual Basic. For any nontrivial processing, such as file and folder manip-
ulation, data storage, and so on, you'll use the appropriate classes of the .NET Framework. A
substantial segment of this book deals with the most useful components of the Framework. We
will also explore databases and data-driven applications, which are the most common type of
business applications. Finally, we’ll go through the basics of web programming. You'll learn
how to build web applications with Visual Basic and how to write web services.

The Mastering Series

The Mastering series from Sybex provides outstanding instruction for readers with intermedi-
ate and advanced skills in the form of top-notch training and development for those already
working in their field and clear, serious education for those aspiring to become pros. Every
Mastering book includes the following:

¢ Real-World Scenarios, ranging from case studies to interviews, that show how the tool,
technique, or knowledge presented is applied in actual practice

¢ Skill-based instruction, with chapters organized around real tasks rather than abstract
concepts or subjects

¢ Self-review test questions, so you can be certain you're equipped to do the job right

Who Should Read This Book?

You don’t need a solid knowledge of Visual Basic to read this book, but you do need a basic
understanding of programming. You need to know the meaning of variables and functions and
how an If..Then structure works. This book is aimed at the typical programmer who wants to
get the most out of Visual Basic. It covers the topics I felt are of use to most VB programmers,
and it does so in depth. Visual Basic 2010 and the .NET Framework 4.0 are two extremely rich
programming tools, and I had to choose between a superficial coverage of many topics and an
in-depth coverage of fewer topics. To make room for more topics, I have avoided including

a lot of reference material and lengthy listings. For example, you won’t find complete project
listings or form descriptions. I assume that you can draw a few controls on a form and set their
properties and that you don’t need long descriptions of the control properties (even if you don’t
know how to design a form, you'll learn how in the first two chapters). I'm also assuming that
you don’t want to read the trivial segments of each application. Instead, the listings concentrate
on the “meaty” part of the code: the procedures that explain the topic at hand.

The topics covered in this book were chosen to provide a solid understanding of the prin-
ciples and techniques for developing applications with Visual Basic. Programming isn’t about
new keywords and functions. I chose the topics I felt every programmer should learn in order
to master the language. I was also motivated by my desire to present useful, practical examples.
You will not find all topics equally interesting or important. My hope is that everyone will find
something interesting and something of value for their daily work — whether it’s an applica-
tion that maps the folders and files of a drive to a TreeView control, an application that prints
tabular data, a data-driven application for editing customers or products, or an application that
saves a collection of objects to a file.

Many books offer their readers long, numbered sequences of steps to accomplish a task. Fol-
lowing instructions simplifies certain tasks, but programming isn’t about following instructions.
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It's about being creative; it’s about understanding principles and being able to apply the same
techniques in several practical situations. And the way to creatively exploit the power of a lan-
guage such as Visual Basic 2010 is to understand its principles and its programming model.

In many cases, I provide a detailed, step-by-step procedure that will help you accomplish
a task, such as designing a menu, for example. But not all tasks are as simple as designing
menus. I explain why things must be done in a certain way, and I present alternatives and try
to connect new topics to those explained earlier in the book. In several chapters, I expand on
applications developed in earlier chapters. Associating new knowledge with something you
have mastered already provides positive feedback and a deeper understanding of the language.

This book isn’t about the hottest features of the language either; it’s about solid program-
ming techniques and practical examples. After you master the basics of programming Windows
applications with Visual Basic 2010 and you feel comfortable with the more advanced examples
of the book, you will find it easy to catch up with the topics not discussed in this book.

How about the Advanced Topics?

Some of the topics discussed in this book are nontrivial, and quite a few topics can be consid-
ered advanced. Creating collections of custom objects and querying them and exposing some
functionality in the form of web services are not trivial topics, but these are the tools that will
allow you to make the most of Visual Studio.

You may also find some examples to be more difficult than you expected. I have tried to
make the text and the examples easy to read and understand, but not unrealistically simple.
Understanding the basic functions for manipulating files and folders isn’t difficult. To make the
most of these functions, however, you need to understand how to scan a folder’s files, includ-
ing the files in its subfolders and the files in their subfolders, with a technique known as recur-
sion. To make each chapter as useful as possible, I've included nontrivial examples, which will
provide a better understanding of the topics. In addition, many of these examples can be easily
incorporated into your applications.

You can do a lot with the TreeView control with very little programming, but to make the
most out of this control, you must be ready for some advanced programming — nothing terri-
bly complicated, but some things just aren’t trivial. Programming most of the operations of the
TreeView control, for instance, is not complicated, but if your application calls for populating
a TreeView control with an arbitrary number of branches (such as mapping a directory
structure to a TreeView control), the code can get complex. The same goes for printing; it’s
fairly straightforward to write a program that prints some text, but printing tabular reports
takes substantial coding effort.

The reason I've included the more advanced examples is that the corresponding chapters
would be incomplete without them. If you find some material to be over your head at first
reading, you can skip it and come back to it after you have mastered other aspects of the lan-
guage. But don’t let a few advanced examples intimidate you. Most of the techniques are well
within the reach of an average VB programmer. The few advanced topics were included for the
readers who are willing to take that extra step and build elaborate interfaces by using the latest
tools and techniques.

There’s another good reason for including advanced topics. Explaining a simple topic, such
as how to populate a collection with items, is very simple. But what good is it to populate a
collection if you don’t know how to save it to disk and read back its items in a later session?
Likewise, what good is it to learn how to print simple text files? In a business environment,
you will most likely be asked to print a tabular report, which is substantially more complicated
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than printing text. One of my goals in writing this book was to exhaust the topics I've chosen
to discuss and present all the information you need to do something practical: not just how to
create collections, but also how to save them in disk files; not just how to write to a file, but
also how to prompt users for a filename with the same dialog box all Windows applications
use; not just how to print something, but also how to create a preview of the printout. In short,
I've tried to include everything you need to know in order to incorporate in your applications
the features everybody has come to expect from a Windows application.

The Structure of the Book

This book isn’t meant to be read from cover to cover, and I know that most people don’t read
computer books this way. Each chapter is independent of the others, although all chapters con-
tain references to other chapters. Each topic is covered in depth; however, I make no assump-
tions about the reader’s knowledge of the topic. As a result, you may find the introductory
sections of a chapter too simple. The topics become progressively more advanced, and even
experienced programmers will find some new information in most chapters. Even if you are
familiar with the topics in a chapter, take a look at the examples. I have tried to simplify many
of the advanced topics and to demonstrate them with clear, practical examples.

This book tries to teach through examples. Isolated topics are demonstrated with short
examples, and at the end of many chapters you'll build a large, practical application (a real-
world application) that “puts together” the topics and techniques discussed throughout the
chapter. You may find some of the more advanced applications a bit more difficult to under-
stand, but you shouldn’t give up. Simpler applications would have made my job easier, but the
book wouldn’t deserve the Mastering title, and your knowledge of Visual Basic wouldn’t be as
complete.

The book starts with the fundamentals of Visual Basic, even though very little of it is specific
to version 2010. You'll learn how to design visual interfaces with point-and-click operations and
how to program a few simple events, such as the click of the mouse on a button. After reading
the first two chapters, you'll understand the structure of a Windows application. Then you’'ll
explore the elements of the visual interface (the basic Windows controls) and how to program
them. You'll also learn about the My object and code snippets, two features that make Visual
Basic so simple and fun to use (again). These two objects will also ease the learning process
and make it much simpler to learn the features of the language.

In Part 2, I discuss in detail the basic components of Windows applications. I explain the
most common controls you'll use in building Windows forms as well as how to work with
forms: how to design forms, how to design menus for your forms, how to create applications
with multiple forms, and so on. You will find detailed discussions of many Windows controls
as well as how to take advantage of the built-in dialog boxes, such as the Font and Color dialog
boxes, in your applications.

Visual Basic 2010 is a truly object-oriented language, and objects are the recurring theme in
every chapter. Part 3 of the book (Chapter 8, Chapter 9, and Chapter 10) contains a formal and
more systematic treatment of objects. You will learn how to build custom classes and controls,
which will help you understand object-oriented programming a little better. You will also learn
about inheritance and will see how easy it is to add custom functionality to existing classes
through inheritance.

Part 4 deals with some of the most common classes of the .NET Framework. The Frame-
work is at the very heart of Windows programming; it's your gateway to the functionality of
the operating system itself. The first chapter in this part of the book is an introduction to the



INTRODUCTION | XXIX

Framework at large, and it shows you how to use the basic classes for manipulating files and
folders, how to manipulate data and time, how to work with time spans, how to create graph-
ics and printouts, and other interesting aspects of the Framework. In the next chapter you'll
learn how to use collections in your code and then you’ll find a chapter on XML and a chapter
on LINQ. You will see how easy it is to create and use XML in your VB code as well as how
to query collections, XML, and databases with a new language that’s embedded into VB: Lan-
guage Integrated Query (LINQ). LINQ is the hottest new technology that allows you to query
data with widely different structures, and data from different sources, in a uniform way.

The first 14 chapters deal with the fundamentals of the language and Windows applications.
Following these chapters, you will find an overview of the data-access tools. I'm assuming that
the majority of you will eventually build a data-driven application. The emphasis in Part 5 is
on the visual tools, and you will learn how to query databases and present data to the user.
You will also find information on programming the basic objects of ADO.NET and write simple
data-driven Windows applications.

In the last few chapters of this book you will learn about web applications, the basics of
ASP.NET 4, how to develop data-bound web applications, and how to write web services. Since
I could not discuss both Windows and web applications in the same detail, I've decided to
focus on Windows applications, and in the last few chapters (Part 6) show you how to apply
your knowledge to the Web. While the interface is totally different, the essential code is the
same.

Don’t Miss the Tutorials

In addition to the printed material, this book is accompanied by a number of tutorials, which
you can download from www.sybex.com/go/masteringvb2010. These tutorials are actual chap-
ters (some of them quite lengthy); we couldn’t include them in the printed version of the book,
so we included them as PDF files. They are as follows:

¢ Accessing Files and Folders

¢ Creating Graphics with VB 2010

¢ Printing with VB 2010

¢ Making the Most of the ListView and TreeView Controls

This book is a revision of Mastering Visual Basic 2008. As the book couldn’t keep growing —
and we had to make room for new topics — we decided to remove some chapters that were
included in the previous edition of the book from the printed version. These chapters have been
revised and edited and you will find them in PDF format at this book’s website. Throughout
this book, I'll be referring to them as tutorials; they’re complete chapters with sample projects
and the same structure as the book’s chapters. You can download the tutorials from the same
site as the book’s projects and read them on your computer screen.

Downloading This Book’s Code

The code for the examples and projects can be downloaded from the Sybex website (www.
sybex.com). At the main page, you can find the book’s page by searching for the author,
the title, or the ISBN (9780470187425) and then clicking the book’s link listed in the search
results. On the book’s page, click the Download link and it will take you to the download
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page. Or, you can go directly to the book’s page at www.sybex.com/go/masteringvb2010. The
downloaded source code is a ZIP file, which you can unzip with the WinZip utility.

HOW TO REACH THE AUTHOR

Despite our best efforts, a book of this size is bound to contain errors. Although a printed
medium isn’t as easy to update as a website, 1 will spare no effort to fix every problem
you report (or I discover). The revised applications, along with any other material 1 think
will be of use to the readers of this book, will be posted on the Sybex website. If you have
any problems with the text or the applications in this book, you can contact me directly at
pevangelos@yahoo.com.

Although I can’t promise a response to every question, 1 will fix any problems in the examples
and provide updated versions. I would also like to hear any comments you may have on
the book, about the topics you liked or did not like and how useful the examples are. Your
comments will be carefully considered for future editions.
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Chapter 1

Getting Started with
Visual Basic 2010

I'm assuming that you have installed one of the several versions of Visual Studio 2010. For this
book, I used the Professional edition of Visual Studio, but just about everything discussed in
this book applies to the Standard edition as well. Some of the Professional edition features that
are not supported by the Standard edition include the database tools, which are discussed in
Chapter 15 through Chapter 18 of this book.

You may have already explored the new environment on your own, but I'm going to start
with an overview of Visual Studio and its basic tools for the benefit of readers who aren’t famil-
iar with them. I will not assume any prior knowledge of Visual Basic 6 or Visual Basic .NET,
just some familiarity with programming at large.

As you already know, Visual Basic 2010 is just one of the languages you can use to build
applications with Visual Studio 2010. I happen to be convinced that it is also the simplest, most
convenient language, but this isn’t really the issue; I'm assuming you have your reasons to code
in VB or you wouldn’t be reading this book. What you should keep in mind is that Visual Stu-
dio 2010 is an integrated environment for building, testing, debugging, and deploying a vari-
ety of applications: Windows applications, web applications, classes and custom controls, and
even console applications. It provides numerous tools for automating the development process,
visual tools for performing many common design and programming tasks, and more features
than any author could hope to cover.

In this chapter, you'll learn how to do the following:

¢ Navigate the integrated development environment of Visual Studio

¢ Understand the basics of a Windows application

Exploring the Integrated Development Environment

Visual Basic 2010 is just one of the languages you can use to program your applications. The
language is only one aspect of a Windows application. The visual interface of the application
isn’t tied to a specific language, and the same tools you'll use to develop your application’s
interface will also be used by all programmers, regardless of the language they’ll use to code
the application.
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CHAPTER 1 GETTING STARTED WITH VISUAL BASIC 2010

To simplify the process of application development, Visual Studio provides an environment
that’s common to all languages, known as an integrated development environment (IDE). The pur-
pose of the IDE is to enable the developer to do as much as possible with visual tools before
writing code. Even as you write code, the IDE will help you in many ways. For example, it
underlines errors, it suggests the keywords that may appear at the current place in your code in
a list, and it even provides tools for locating and fixing errors (a process known as debugging).

The IDE provides tools for designing, executing, and debugging your applications. It will be
a while before you explore all the elements of the IDE, and I will explain the various items as
needed in the course of the book. In the following sections, you’ll look at the basic components
of the IDE you’ll be using to build simple Windows applications. You'll learn how its tools
allow you to quickly design the user interface of your application as well as how to program
the application.

The IDE is your second desktop, and you’ll be spending most of your productive hours in
this environment.

The Start Page

When you run Visual Studio 2010 for the first time, you will be prompted to select the type

of projects you plan to build so that the environment can be optimized for that specific type
of development. I'm assuming that you have initially selected the Visual Basic Development
settings, which will optimize your copy of Visual Studio for building Windows and web appli-
cations with Visual Basic 2010. You can always change these settings, as explained at the end of
this section.

After the initial configuration, you will see a window similar to the one shown in Figure 1.1.
The Recent Projects tab will be empty, of course, unless you have already created some test
projects. Visual Studio 2010 will detect the settings of a previous installation, so if you're
upgrading from an earlier version of Visual Studio, the initial screen will not be identical to the
one shown in Figure 1.1.

FIGURE 1.1

This is what you’ll see
when you start Visual
Studio for the first time.
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EXPLORING THE INTEGRATED DEVELOPMENT ENVIRONMENT

On the Start Page window of Visual Studio, you will see the following panes under the Get
Started heading;:

Welcome Click the Welcome tab to see a series of links that provide developer assistance for
using Visual Studio. These links include What’s New In Visual Studio 2010, Creating Applica-
tions With Visual Studio, and Extending Visual Studio, among others. Other related links may
be added as this book goes to the printer.

Windows Here you'll find a list of topics related to Windows application development. Win-
dows applications, frequently referred to as desktop applications, are the applications you
install on a local computer and execute locally.

Web Here you'll find a list of topics related to web application development. Web applica-
tions are executed on a remote computer, the web server, and you interact with them through
a browser.

Cloud, Office, SharePoint In addition to Windows and web applications, Visual Studio can
be used to develop applications for Office and SharePoint as well as applications that use a new
Microsoft platform for building distributed applications, the Azure platform. These three types
of projects aren’t discussed in this book.

Data Here you'll find a list of topics related to data-driven programming. All applications
that interact with a database are data driven; they can be Windows or web applications. The
principles of interacting with a database (retrieve, display, and update database data) are the
same regardless of whether you use them to build Windows or web applications.

Recent Projects Here you see a list of the projects you opened most recently with Visual Stu-
dio, and you can select the one you want to open again — chances are you will continue work-
ing on the same project as the last time. Each project name is a hyperlink, and you can open a
project by clicking its name. Above the list of recent projects there are two hyperlinks — one for
creating a new project and another one for opening a new solution. You will find more infor-
mation on solutions and projects later in this chapter.

Most developers will skip the Start Page. To do so, open the Tools menu and choose the
Import And Export Settings command to start a configuration wizard. In the first dialog box
of the wizard, select the Reset All Settings check box and then click the Next button. The next
screen of the wizard prompts you for a location in which to save the new settings so that
Visual Studio can read them every time it starts. Leave the default location as is and click
Next again to see the last screen of the wizard, in which you're prompted to select a default
collection of settings. This collection depends on the options you've installed on your system.
I installed Visual Studio 2010 with Visual Basic only on my system, and I was offered the
following options (among others): General Development Settings, Visual Basic Development
Settings, and Web Development. For the default configuration of my copy of Visual Studio,
and for the purpose of this book, I chose Visual Basic Development Settings so that Visual
Studio could optimize the environment for a typical VB developer. Click the Finish button to
see a summary of the process and then close the wizard.

Starting a New Project

At this point, you can create a new project and start working with Visual Studio. To best
explain the various items of the IDE, let’s build a simple form. The form is the window of your
application — it’s what users will see on their Desktop when they run your application.

5
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The basic work item with Visual Studio is the solution, which is a container for one or more
projects. When you create a set of related projects, they should belong to the same solution. (In
this book, you'll learn how to build individual, unrelated projects.) Even when you create an
individual new project, though, Visual Studio automatically creates a solution for it. You can
add a new or existing project to the solution at any time.

Open the File menu and choose New Project, or click the New Project link on the Start
Page. In the New Project dialog box that pops up (see Figure 1.2), you'll see a list of project
types you can create with Visual Studio. The most important ones are Windows Forms Appli-
cations, which are typical Windows applications with one or more forms (windows); Console
Applications, which are simple applications that interact with the user through a text window
(the console); Windows Forms Control Libraries, which are collections of custom controls; and

Class Libraries, which are collections of classes. These are the project types I'll cover in depth
in this book.

FIGURE 1.2
The New Project
dialog box

If you have Visual Basic 2010 Express edition installed, you will see fewer project types in
the New Project dialog box, but all of the projects discussed in this book are included.

Notice the Create Directory For Solution check box in the dialog box shown in Figure 1.2.
If this box is checked, Visual Studio will create a new folder for the solution under the folder
you specify in the Location box. You also have the option to create a new solution or add the
project to the current solution, if you have one open at the time. While following along with the
projects of this book, you should create a new solution for each project and store it in its own
folder.

You may discover at some point that you have created too many projects and you
don’t really need all of them. You can remove unwanted projects from your system by
deleting the corresponding folders — no special action is required. You'll know it’s time
to remove unneeded project folders when Visual Studio suggests project names such as
WindowsApplication9 or WindowsApplication49.

For this project, select the Windows Forms Application template; Visual Studio suggests the
name WindowsApplicationl as the project name. Change it to MyTestApplication, select the
Create Directory For Solution check box, and then click the OK button to create the new project.
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What you see now is the Visual Studio IDE displaying the Form Designer for a new project,
as shown in Figure 1.3. The main window of your copy of Visual Studio may be slightly dif-
ferent, but don’t worry about it. I'll go through all the components you need to access in the
process of designing, coding, and testing a Windows application.

FIGURE 1.3 Click to access Form Designer
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The new project contains a form already: the Forml component in the Solution Explorer. The
main window of the IDE is the Form Designer, and the gray surface on it is the window of
your new application in design mode. Using the Form Designer, you'll be able to design the
visible interface of the application (place various components of the Windows interface on the
form and set their properties) and then program the application.

The default environment is rather crowded, so let’s hide a few of the toolbars that we won’t
use in the projects of the first few chapters. You can always show any of the toolbars at any
time. Open the View menu and choose Toolbars. You'll see a submenu with 28 commands that
are toggles. Each command corresponds to a toolbar, and you can turn the corresponding tool-
bar on or off by clicking one of the commands in the Toolbars submenu. For now, turn off all
the toolbars except the Layout and Standard toolbars. These are the toolbars shown by default
and you shouldn’t hide them; if you do (perhaps to make more room for the designer), this is
the place where you go to make them visible again.

The last item in the Toolbars submenu is the Customize command; Customize leads to a dia-
log box in which you can specify which of the toolbars and which of the commands you want
to see. After you have established a work pattern, use this menu to customize the environment
for the way you work with Visual Studio. You can hide just about any component of the IDE,
except for the main menu — after all, you have to be able to undo the changes!

Using the Windows Form Designer

To design the form, you must place on it all the controls you want to display to the user at
runtime. The controls are the components of the Windows interface (buttons, text boxes, radio
buttons, lists, and so on). Open the Toolbox by moving the pointer over the Toolbox tab at the
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far left; the Toolbox, shown in Figure 1.4, pulls out. This Toolbox contains an icon for each con-
trol you can use on your form.

FIGURE 1.4
Windows Forms Toolbox
of the Visual Studio IDE

Tuwlbax
o &l Windows Forms

d Comeman Conlrob

0
v X

Pmrler

Button

EE>

Checkilex
Chrckradl kB
ComboBox
DrateTimeRicke

Lokl

=l 5 B

A Linidabel
ListBax

== [
==

L st

MashedTeabox

MonthCalendm

Megifylcan

[T

MumencUpDownm
FrclareBox
PrageessBar
RedicDution
FathTexibon
TretBes

ToolTip

TIFEHE® IR

e

'l b

WehBrowser

The controls are organized into groups according to function on the interface. In the first
part of the book, you'll create simple Windows applications and you’ll use the controls on the
Common Controls tab. When you develop web applications, you will see a different set of icons
in the Toolbox.

To place a control on the form, you can double-click the icon for the control. A new instance
with a default size will be placed on the form. Then you can position and resize it with the
mouse. Or you can select the control from the Toolbox with the mouse and then click and drag
the mouse over the form and draw the outline of the control. A new instance of the control
will be placed on the form, and it will fill the rectangle you specified with the mouse. Start by
placing a TextBox control on the form.

The control properties will be displayed in the Properties window. Figure 1.5 shows the
properties of a TextBox control. This window, at the far right edge of the IDE and below the
Solution Explorer, displays the properties of the selected control on the form. If the Properties
window is not visible, open the View menu and choose Properties Window, or press F4. If no
control is selected, the properties of the selected item in the Solution Explorer are
displayed.

In the Properties window, also known as the Properties Browser, you see the properties
that determine the appearance of the control and (in some cases) its function. The properties
are organized in categories according to their role. The properties that determine the appear-
ance of the control are listed alphabetically under the header Appearance, the properties that
determine the control’s behavior are listed alphabetically under the header Behavior, and so on.
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You can click the AZ button on the window’s title bar to display all properties in alphabetical
order. After you familiarize yourself with the basic properties, you will most likely switch to
the alphabetical list.
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REARRANGING THE IDE WINDOWS

As soon as you place a control on the form, the Toolbox retracts to the left edge of the
Designer. You can fix this window on the screen by clicking the pushpin icon on the Toolbox’s
toolbar. (It’s the icon next to the Close icon at the upper-right corner of the Toolbox window,
and it appears when the Toolbox window is docked but not while it’s floating.)

You can easily rearrange the various windows that make up the IDE by moving them around
with the mouse. Move the pointer to a window’s title bar, press the left mouse button, and
drag the window around. If you can’t move a window with the mouse, it’s because the win-
dow’s position is locked. In this case, click the pushpin icon to unlock the window’s position
and then move it around with the mouse.

As you move the window, eight semitransparent buttons with arrows appear on the screen,
indicating the areas where the window can be docked, as shown in the following screen shot.
Keep moving the window until the pointer hovers over one of these buttons and the docking
area appears in semitransparent blue color. Find a position you like and release the mouse
button to dock it. If you release the mouse button while the pointer is not on top of an arrow,
the window is not docked. Instead, it remains where you dropped it as a floating window, and
you can move it around with your mouse at will.
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Most developers would rather work with docked windows, and the default positions of the
IDE windows are quite convenient. If you want to open even more windows and arrange
them differently on the screen, use the docking feature of the IDE to dock the additional
windows.

Locate the TextBox control’s Text property and set it to My TextBox Control by entering
the string into the box next to the property name. The control’s Text property is the string that
appears in the control (the caption), and most controls have a Text property.

Next locate its BackColor property and select it with the mouse. A button with an arrow
appears next to the current setting of the property. Click this button and you’ll see a dialog
box with three tabs (Custom, Web, and System), as shown in Figure 1.6. In this dialog box, you
can select the color that will fill the control’s background. Set the control’s background color to
yellow and notice that the control’s appearance changes on the form.

One of the settings you'll want to change is the font of the various controls. While the
TextBox control is still selected on the form, locate the Font property in the Properties window.
You can click the plus sign in front of the property name and set the individual properties of
the font, or you can click the ellipsis button to invoke the Font dialog box. Here you can set
the control’s font and its attributes and then click OK to close the dialog box. Set the TextBox
control’s Font property to Verdana, 14 points, bold. As soon as you close the Font dialog box,
the control on the form is adjusted to the new setting.

There’s a good chance that the string you assigned to the control’s Text property won't fit
in the control’s width when rendered in the new font. Select the control on the form with the
mouse and you will see eight handles along its perimeter. Rest the pointer over any of these
handles and it will assume a shape indicating the direction in which you can resize the control.
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Make the control long enough to fit the entire string. If you have to, resize the form as well.
Click somewhere on the form, and when the handles appear along its perimeter, resize it with
the mouse.
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Some controls, such as the Label, Button, and CheckBox controls, support the AutoSize
property; AutoSize determines whether the control is resized automatically to accommodate
the caption. The TextBox control, as well as many others, doesn’t support the AutoSize prop-
erty. If you attempt to make the control tall enough to accommodate a few lines of text, you'll
realize that you can’t change the control’s height. By default, the TextBox control accepts a sin-
gle line of text, and you must set its MultiLine property to True before you can resize the
TextBox control vertically.

THE FONT IS A DESIGN ELEMENT

Like documents, forms should be designed carefully and follow the rules of a printed page
design. At the very least, you shouldn’t use multiple fonts on your forms, just as you shouldn’t
mix different fonts on a printed page. You could use two font families on rare occasions, but
you shouldn’t overload your form. You also shouldn’t use the bold style in excess.

To avoid adjusting the Font property for multiple controls on the form, set the font for the
form first because each control you place on a form inherits the form’s font. If you change the
form’s font, the controls will be adjusted accordingly, but this may throw off the alignment
of the controls on the form. Experiment with a few Label controls, select a font that you like
that’s appropriate for your interface (you shouldn’t use a handwritten style with a business
application, for example), and then set the form’s Font property to the desired font. Every

11
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time you add a new form to the application, you should start by setting its Font property to
that same font so that the entire application will have a consistent look.

The font is the most basic design element, whether you’re designing forms or a document.
Various components of the form may have a different font size, even a different style (like
bold or italics), but there must be a dominant font family that determines the look of the
form. The Verdana family was designed for viewing documents on computer monitors and is a
popular choice. Another great choice is Segoe Ul, a new font family introduced with Windows
Vista. The Segoe Print font has a distinguished handwritten style, and you can use it with
graphics applications.

The second most important design element is color, but don’t get too creative with colors
unless you’re a designer. 1 recommend that you stay with the default colors and use similar
shades to differentiate a few elements of the interface.

The design of a modern interface has become a new discipline in application develop-
ment, and there are tools for designing interfaces. One of them is Microsoft’s Expression
Blend, which enables designers to design the interface and developers to write code with-
out breaking each other’s work. You can download a trial version of Expression Blend from
www.microsoft.com/expression.

So far, you've manipulated properties that determine the appearance of the control. Now
you’ll change a property that determines not only the appearance, but also the function of the
control. Locate the MuTltiTline property. Its current setting is False. Expand the list of available
settings and change it to True. (You can also change it by double-clicking the name of the prop-
erty. This action toggles the True/False settings.) Switch to the form, select the TextBox control,
and make it as tall as you wish.

The MuTtiline property determines whether the TextBox control can accept one (if
Multiline = False) or more (if MuTltiline = True) lines of text. Set this property to True, go
back to the Text property, set it to a long string, and press Enter. The control breaks the long
text into multiple lines. If you resize the control, the lines will change, but the entire string will
fit in the control because the control’s WordWrap property is True. Set it to False to see how the
string will be rendered on the control.

Multiline TextBox controls usually have a vertical scroll bar so users can quickly locate the
section of text that they’re interested in. Locate the control’s Scrol1Bars property and expand
the list of possible settings by clicking the button with the arrow. This property’s settings are
None, Vertical, Horizontal, and Both. Set it to Vertical, assign a very long string to its Text
property, and watch how the control handles the text. At design time, you can’t scroll the text
on the control; if you attempt to move the scroll bar, the entire control will be scrolled. The
scroll bar will work as expected at runtime. (It will scroll the text vertically.)

You can also make the control fill the entire form. Start by deleting any other controls you
may have placed on the form and then select the multiline TextBox. Locate the Dock property
in the Properties window and keep double-clicking the name of the property until its setting
changes to FiT11. (You'll learn a lot more about docking controls in Chapter 6, “Working with
Forms.””) The TextBox control fills the form and is resized as you resize the form, both at design
time and runtime.

To examine the control’s behavior at runtime, press F5. The application will be compiled,
and a few moments later, a window filled with a TextBox control (like the one shown in
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Figure 1.7) will appear on the Desktop. This is what the users of your application would see (if
this were an application worth distributing, of course).

FIGURE 1.7
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Enter some text on the control, select part of the text, and copy it to the Clipboard by press-
ing Ctrl4+C. You can also copy text from any other Windows application and paste it on the
TextBox control. Right-click the text on the control and you will see the same context menu you
get with Notepad; you can even change the reading order of the text — not that you’d want
to do that with a Western language. When you're finished, open the Debug menu and choose
Stop Debugging. This will terminate your application’s execution, and you’ll be returned to the
IDE. The Stop Debugging command is also available as a button with a blue square icon on
the toolbar. Finally, you can stop the running application by clicking the Close button in the
application’s window.

The design of a new application starts with the design of the application’s form, which is the
application’s user interface, or Ul The design of the form determines to a large extent the func-
tionality of the application. In effect, the controls on the form determine how the application
will interact with the user. The form itself could serve as a prototype, and you could demon-
strate it to a customer before even adding a single line of code. By placing controls on the
form and setting their properties, you're implementing a lot of functionality before coding the
application. The TextBox control with the settings discussed in this section is a functional text
editor.

Creating Your First VB Application

In this section, I will walk you through the development of a simple application to demon-
strate not only the design of the interface, but also the code behind the interface. You'll build
an application that allows users to enter the name of their favorite programming language, and
the application will evaluate the choice. Objectively, VB is a step ahead of all other languages,
and it will receive the best evaluation. All other languages get the same grade — good — but
not VB.
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The project is called WindowsApplicationl. You can download the project from
www . sybex.com/go/masteringvb2010 and examine it, but I suggest you follow the steps
outlined in this section to build the project from scratch. Start a new project, use the default
name, WindowsApplication1, and place a TextBox and a Button control on the form. Use the
mouse to position and resize the controls on the form, as shown in Figure 1.8.
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Start by setting the form’s Font property to Segoe Ul, 9 pt. Arrange and size the controls
as shown in Figure 1.8. Then, place a Label control on the form and set its Text property to
Enter your favorite programming language. The Label will be resized according to its cap-
tion because the control’s AutoSize property is True by default. To be sure that a Label control
will not grow too long and cover other controls on the form, set its AutoSize property to False
and size it manually. As you move the controls around on the form, you'll see some blue lines
connecting the edges of the controls when they’re aligned. These lines are called snap lines, and
they allow you to align controls on the form.

Now you must insert some code to evaluate the user’s favorite language. Windows applica-
tions are made up of small code segments, called event handlers, which react to specific actions
such as the click of a button, the selection of a menu command, the click of a check box, and
so on. For this example, you want to program the action of clicking the button. When the user
clicks the button, you want to execute some code that will display a message.

The Windows programming model is known as event-driven programming, as it’s based
on programming events. A Windows form contains controls, such as Buttons, CheckBoxes,
TextBoxes, and so on. These controls react to certain events, which are usually initiated by the
user. A button click, checking or clearing a check box, a drag and a drop operation — all are
examples of user-initiated events. You decide the events to which your application should react
and then program the desired actions by inserting some code into the event’s handler. Event
handlers are independent of one another, and you can focus on one event at a time.

To insert some code behind the Button control, double-click the control. You'll see the form’s
code window, which is shown in Figure 1.9. You will see only the definition of the procedure,
not the code that is shown between the two statements in the figure. The statement beginning
with Private.. is too long to fit on the printed page, so I had to break it into two lines. When
a line is too long, you can break it into two (or more) lines by pressing Enter. In previous ver-
sions, you had to insert a space followed by an underscore to indicate that the statement con-
tinues on the following line. Alternatively, you can turn on the word wrap feature of the editor
(you'll see shortly how to adjust the editor’s properties). Notice that I also inserted quite a bit
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of space before the second half of the first code line. It's customary to indent continued lines so
they can be easily distinguished from the other lines.
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The editor opens a subroutine, which is delimited by the following statements:

Private Sub Buttonl_Click(ByVal sender As System.Object,
Byval e As System.EventArgs) Handles Buttonl.Click

End Sub

At the top of the main pane of the Designer, you will see two tabs named after the form: the
Form1.vb [Design] tab and the Form1.vb tab. The first tab is the Windows Form Designer (in
which you build the interface of the application with visual tools), and the second is the code
editor (in which you insert the code behind the interface). At the top of the code editor, which
is what you see in Figure 1.9, are two ComboBoxes. The one on the left contains the names
of the controls on the form. The one on the right contains the names of events each control
recognizes. When you select a control (or an object, in general) in the left list, the other list’s
contents are adjusted accordingly. To program a specific event of a specific control, select the
name of the control in the left list (the Objects list) and the name of the event in the right list
(the Events list). While Buttonl is selected in the Objects list, open the Events list to see the
events to which the button can react.

The Click event happens to be the default event of the Button control. To program the But-
ton’s Click event, double-click the Button on the form and the editor will open a window with
the Buttonl_CT1ick subroutine. This subroutine is an event handler, which is invoked automati-
cally every time an event takes place. The event of interest in our example is the C1ick event of
the Buttonl control. Every time the Buttonl control on the form is clicked, the Buttonl_Click
subroutine is activated. To react to the Click event of the button, you must insert the appropri-
ate code in this subroutine.

There are more than two dozen events for the Button control, and it is among the simpler
controls. (After all, what can you do to a button besides click it?) Most of the controls recognize
a very large number of events, which we rarely code. I've never seen a button that reacts
to a double-click, even though you can program this event, or coding for the KeyPress
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event, which is fired when the user presses a key when the button has the focus. When
programming a TextBox control, however, the KeyPress event is one of the most common
events to code.

The definition of the event handler can’t be modified; this is the event handler’s signature
(the arguments it passes to the application). All event handlers in VB 2010 pass two arguments
to the application: the sender argument, which is an object that represents the control that fired
the event, and the e argument, which provides additional information about the event.

The name of the subroutine is made up of the name of the control, followed by an
underscore and the name of the event (Buttonl_Click). This is just the default name, and
you can change it to anything you like (such as Evaluatelanguage, for this example, or
StartCalculations). What makes this subroutine an event handler is the keyword Handles at
the end of the statement. The HandTes keyword tells the compiler which event this subroutine
is supposed to handle. Buttonl.Click is the Click event of the Buttonl control. If there were
another button on the form, the Button2 control, you’d have to write code for a subroutine
that would handle the Button2.Click event. Each control recognizes many events, and you
can provide a different event handler for each control and event combination. Of course, we
never program every possible event for every control.

The controls have a default behavior and handle the basic events on their own. The TextBox
control knows how to handle keystrokes. The CheckBox control (a small square with a check
mark) changes state by hiding or displaying the check mark every time it’s clicked. The Scroll-
Bar control moves its indicator (the button in the middle of the control) every time you click
one of the arrows at the two ends. Because of this default behavior of the controls, you need
not supply any code for the events of most controls on the form.

If you change the name of the control after you have inserted some code in an event han-
dler, the name of the event handled by the subroutine will be automatically changed. The name
of the subroutine, however, won’t change. If you change the name of the Buttonl control to
bttnEvaluate, the subroutine’s header will become

Private Sub Buttonl_Click(ByVal sender As System.Object,
ByvVal e As System.EventArgs) Handles bttnEvaluate.Click

End Sub

Rename the Buttonl_Click subroutine to EvaluateLanguage. You must edit the code to
change the name of the event handler. I try to name the controls before adding any code to
the application so that their event handlers will be named correctly. Alternatively, you can use
your own name for each event handler. The default names of the controls you place on a form
are quite generic, and you should change them to something more meaningful. I usually prefix
the control names with a few characters that indicate the control’s type (such as txt, 1b1, bttn,
and so on), followed by a name that reflects the function of the control on the form. Names
such as txtLanguage and bttnEvaluate make your code far more readable. It’s a good prac-
tice to change the default names of the controls as soon as you add the controls to the form.
Names such as Buttonl, Button2, Button3, and so on, don’t promote the readability of your
code. With the exception of this first sample project, I'm using descriptive names for the con-
trols used in this book’s projects.

Let’s add some code to the Click event handler of the Buttonl control. When this but-
ton is clicked, I want to examine the text the user entered in the text box. If it’s Visual Basic,



CREATING YOUR FIRST VB APPLICATION 17

I want to display one message; if not, I want to display a different message. Insert the lines of
Listing 1.1 between the Private Sub and End Sub statements. (I'm showing the entire listing
here, but there’s no reason to retype the first and last statements.)

LISTING 1.1: Processing a user-supplied string

Private Sub EvaluatelLanguage(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim language As String
Tanguage = TextBoxl.Text
If Tanguage = "Visual Basic"' Then
MsgBox("We have a winner!")
Else
MsgBox(language & " is not a bad language.")
End If
End Sub

Here’s what this code does. First, it assigns the text of the TextBox control to the variable
Tanguage. A variable is a named location in memory where a value is stored. Variables
are where you store the intermediate results of your calculations when you write code. All
variables are declared with a Dim statement and have a name and a type. The first statement
declares a new variable, the Tanguage variable, with the Dim statement and sets its type to
String (it’s a variable that will store text).

You could also declare and assign a value to the Tanguage variable in a single step:

Dim language = TextBoxl.Text

The compiler will create a String variable, because the statement assigns a string to the vari-
able. We'll come back to the topic of declaring and initializing variables in Chapter 2, “Han-
dling Data.”

Then the program compares the value of the Tanguage variable to the string Visual Basic,
and depending on the outcome of the comparison, it displays one of two messages. The
MsgBox() function displays the message that you passed as an argument by placing it between
the parentheses in a small window with an OK button, as shown in Figure 1.8. The argument
for a MsgBox() function must be a string. Users can view the message and then click the OK
button to close the message box.

Even if you're not familiar with the syntax of the language, you should be able to under-
stand what this code does. Visual Basic is the simplest of the languages supported by Visual
Studio 2010, and I will discuss the various aspects of the language in detail in the following
chapters. In the meantime, focus on understanding the process of developing a Windows appli-
cation: how to build the visible interface of the application and how to program the events to
which you want your application to react.

The code of this first application isn’t very robust. If the user doesn’t enter the string with
the exact spelling shown in the listing, the comparison will fail. You can convert the string to
uppercase and then compare it with VISUAL BASIC to eliminate differences in case. To convert
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a string to uppercase, use the ToUpper method of the String class. The following expression
returns the string stored in the Tanguage variable, converted to uppercase:

Tanguage.ToUpper

You should also take into consideration the fact that the user might enter VB or VB2010, or
something similar. You never know what users may throw at your application, so whenever
possible you should try to limit their responses to the number of available choices. In this case,
you could display the names of certain languages (the ones you're interested in) and force the
user to select one of them.

One way to display a limited number of choices is to use a ComboBox control. In the next
section, you'll revise your sample application so that users won’t have to enter the name of the
language. You'll force them to select their favorite language from a list so that you won’t have
to validate the string supplied by the user.

Making the Application More User Friendly

Start a new project: the WindowsApplication2 project. Do not select the Create Directory For
Solution check box; save the project from within the IDE. As soon as the project is created,
open the File menu and choose Save All to save the project. When the Save Project dialog box
appears, click the Browse button to select the folder where the project will be saved. In the
Project Location dialog box that appears, select an existing folder or create a new folder such
as MyProjects or VB.NET Samples.

Open the Toolbox and double-click the ComboBox tool icon. A ComboBox control will be
placed on your form. Now, place a Button control on the form and position it so that your form
looks like the one shown in Figure 1.10. Then set the Text property for the button to Evaluate
My Choice.

FIGURE 1.10 .
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You must now populate the ComboBox control with the valid choices. Select the ComboBox
control on the form by clicking it with the mouse and locate its Items property in the Proper-
ties window. The setting of this property is Collection, which means that the Items property
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doesn’t have a single value; it’s a collection of items (strings, in this case). Click the ellipsis but-
ton and you’ll see the String Collection Editor dialog box, as shown in Figure 1.11.
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The main pane in the String Collection Editor dialog box is a TextBox, in which you can
enter the items you want to appear in the ComboBox control at runtime. Enter the following
strings, one per row and in the order shown here:

C++

C#

Visual Basic
Java

Cobol

Click the OK button to close the dialog box. The items you just entered will not appear on
the control at design time, but you will see them when you run the project. Before running
the project, set one more property. Locate the ComboBox control’s Text property and set it to
Select your favorite programming language. This is not an item of the list; it’s the string that
will initially appear on the control.

You can run the project now and see how the ComboBox control behaves. Press F5 and
wait a few seconds. The project will be compiled, and you'll see the form displayed on your
Desktop, on top of the Visual Studio window. I'm sure you know how the ComboBox control
behaves in a typical Windows application, and your sample application is no exception. You
can select an item on the control, either with the mouse or with the keyboard. Click the button
with the arrow to expand the list and then select an item with the mouse. Or press the down or
up arrow keys to scroll through the list of items. The control isn’t expanded, but each time you
click an arrow button, the next or previous item in the list appears on the control. Press the Tab
key to move the focus to the Button control and press the spacebar to emulate a CTick event
(or simply click the Button control).

You haven’t told the application what to do when the button is clicked yet, so let’s go back
and add some code to the project. Stop the application by clicking the Stop button on the tool-
bar (the solid black square) or by choosing Debug > Stop Debugging from the main menu.
When the form appears in design mode, double-click the button and the code window will
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open, displaying an empty Click event handler. Insert the statements shown in Listing 1.2
between the Private Sub and End Sub statements.

LISTING 1.2: The revised C11 ck event handler

Private Sub Buttonl_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim language As String
Tanguage = ComboBox1.Text

If language = "Visual Basic" Then
MsgBox("We have a winner!")
Else
MsgBox(language & "is not a bad language.")
End If
End Sub

When the form is first displayed, a string that doesn’t correspond to a language is displayed
in the ComboBox control. This is the string that prompts the user to select a language; it isn’t a
valid selection because it’s not included in the list of items.

You can also preselect one of the items from within your code when the form is first loaded.
When a form is loaded, the Load event of the Form object is raised. Double-click somewhere on
the form and the editor will open the form’s Load event handler:

Private Sub Forml_Load(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles MyBase.Load
End Sub

Enter the following code to select the Visual Basic item when the form is loaded:

Private Sub Forml_Load(ByVal sender As System.Object,
Byval e As System.EventArgs) Handles MyBase.Lload
ComboBox1.SelectedIndex = 2
End Sub

SelectedIndex is a property of the ComboBox control that returns the index of the selected
item in the Items collection. You can set it to an integer value from within your code to select
an item on the control, and you can also use it to retrieve the index of the selected item in the
list. Instead of comparing strings, you can compare the SelectedIndex property to the value
that corresponds to the index of the item Visual Basic, with a statement such as the following:

If ComboBoxl.SelectedIndex = 2 Then

MsgBox("We have a winner!")
Else

MsgBox(ComboBox1.Text & " is not a bad language.")
End If
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The Text property of the ComboBox control returns the text on the control, and it’s used
to print the selected language’s name. The & symbol is an operator, similar to the arithmetic
operators, that concatenates two strings. The first string is the Text property of the ComboBox
control and the second string is a literal enclosed in double quotes. To combine the two, use the
concatenation operator.

Of course, if you insert or remove items from the list, you must edit the code accordingly.
If you run the application and test it thoroughly, you'll realize that there’s a problem with the
ComboBox control. Users can type in the control a new string, which will be interpreted as a
language. By default, the ComboBox control allows users to type in something in addition to
selecting an item from the list. To change the control’s behavior, select it on the form and locate
its DisplayStyle property in the Properties window. Expand the list of possible settings for
the control and change the property’s value from DropDown to DropDownList. Run the applica-
tion again and test it; your sample application has become bulletproof. It’s a simple application,
but you'll see more techniques for building robust applications in Chapter 4, “GUI Design and
Event-Driven Programming.”

The controls on the Toolbox are more than nice pictures you can place on your forms. They
encapsulate a lot of functionality and expose properties that allow you to adjust their appear-
ance and their functionality. Most properties are usually set at design time, but quite frequently
you change the properties of various controls from within your code. And it should be obvious
by now that the changes take place from within the code that resides in the handlers for the
events to which the application should react.

Now that you're somewhat familiar with the process of building Windows applications, and
before you look into any additional examples, I will quickly present the components of the
Visual Studio IDE.

Understanding the IDE Components

The IDE of Visual Studio 2010 contains numerous components, and it will take you a while to
explore them. It’s practically impossible to explain in a single chapter what each tool, window,
and menu command does. I'll discuss specific tools as we go along and as the topics become
more and more advanced. In the following sections, I will go through the basic items of the
IDE — the ones you’ll use in the following few chapters to build simple Windows applications.

The IDE Menus

The IDE menus provide access to a variety of commands; some lead to submenus. Notice that
most menus can be displayed as toolbars. Also, not all options are available at all times. The
options that cannot possibly apply to the current state of the IDE are either invisible or dis-
abled. The Edit menu is a typical example. It's quite short when you're designing the form and
quite lengthy when you edit code. The Data menu disappears altogether when you switch to
the code editor — you can’t use these menu options while editing code. If you open an XML
document in the IDE, the XML item will be added to the menu bar of Visual Studio. Yes, Visual
Studio can handle XML files too. Not only that, but Visual Basic provides built-in support for
XML files, which I'll help you explore in Chapter 13, “XML in Modern Programming.”

FILE MENU

The File menu contains commands for opening and saving projects or project items as well as
commands for adding new or existing items to the current project. For the time being, use the
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New > Project command to create a new project, Open > Project/Solution to open an existing
project or solution, Save All to save all components of the current project, and the Recent
Projects submenu to open one of the recent projects.

EDIT MENU

The Edit menu contains the usual editing commands. Among these commands are the
Advanced command and the IntelliSense command. Both commands lead to submenus, which
are discussed next. Note that these two items are visible only when you're editing your code
and are invisible while you're designing a form.

Edit > Advanced Submenu

The following options are the more-interesting ones available through the Edit > Advanced
submenu:

View White Space Space characters (necessary to indent lines of code and make it easy to
read) are replaced by periods.

Word Wrap When a code line’s length exceeds the length of the code window, the line is
automatically wrapped.

Comment Selection/Uncomment Selection Comments are lines you insert between your
code statements to document your application. Every line that begins with a single quote is

a comment; it is part of the code, but the compiler ignores it. Sometimes, you want to disable a
few lines from your code but not delete them (because you want to be able to restore them later,
should you change your mind). A simple technique to disable a line of code is to comment

it out (insert the comment symbol in front of the line). The Comment Selection/Uncomment
Selection command allows you to comment (or uncomment) large segments of code in a single
move.

Edit > IntelliSense Submenu

Edit > IntelliSense leads to a submenu with five options, which are described next. IntelliSense
is a feature of the editor (and other Microsoft applications) that displays as much informa-
tion as possible, whenever possible. When you type the name of a control and the following
period, IntelliSense displays a list of the control’s properties and methods so that you can select
the desired one — no more guessing at names. When you type the name of a function and an
opening parenthesis, IntelliSense will display the syntax of the function — its arguments. The
IntelliSense submenu includes the following options:

List Members When this option is on, the editor lists all the members (properties, methods,
events, and argument list) in a drop-down list. This list appears when you enter the name

of an object or control followed by a period. Then, you can select the desired member from
the list using either the mouse or the keyboard. Let’s say your form contains a control named
TextBox1 and you're writing code for this form. When you enter the name of the control fol-
lowed by a period (TextBox1.), a list with the members of the TextBox control will appear (as
shown in Figure 1.12).

In addition, a description of the selected member is displayed in a ToolTip box, as you can
see in the same figure. Select the Text property and then enter the equal sign, followed by a
string in quotes, as follows:

TextBox1l.Text = "Your User Name"
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If you select a property that can accept a limited number of settings, you will see the names of
the appropriate constants in a drop-down list. If you enter the following statement, you will
see the constants you can assign to the property (see Figure 1.13):

TextBox1.TextAlign
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Again, you can use your mouse to select the desired value. The drop-down list with the mem-
bers of a control or object (the Members list) remains open until you type a terminator key (the
Esc or End key) or select a member by pressing the spacebar or the Enter key.

Parameter Info While editing code, you can move the pointer over a variable, method, or
property and see its declaration in a pop-up box. You can also jump to the variable’s definition
or the body of a procedure by choosing Go To Definition from the context menu that appears if
you right-click the variable or method name in the code window.

Quick Info Quick Info is another IntelliSense feature that displays information about com-
mands and functions. When you type an opening parenthesis following the name of a function,
for example, the function’s arguments will be displayed in a ToolTip box. The first argument
appears in bold font; after a value for this argument is entered, the next one is shown in bold.
If an argument accepts a fixed number of settings, these values will appear in a drop-down list,
as explained previously.

Complete Word The Complete Word feature enables you to complete the current word by
pressing Ctrl+spacebar. For example, if you type TextB and then press Ctrl+spacebar, you
will see a list of words that you're most likely to type (TextBox, TextBox1, and so on).

Insert Snippet This command opens the Insert Snippet window at the current location in the
code editor window. Code snippets, which are an interesting feature of Visual Studio 2010, are
discussed in the section ““Using Code Snippets’ later in this chapter.
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Edit > Outlining Submenu

A practical application contains a substantial amount of code in a large number of event han-
dlers and custom procedures (subroutines and functions). To simplify the management of the
code window, the Outlining submenu contains commands that collapse and expand the various
procedures.

Let’s say you're finished editing the CTlick event handlers of several buttons on the form.
You can reduce these event handlers to a single line that shows the names of the procedures
with a plus sign in front of them. You can expand a procedure’s listing at any time by clicking
the plus sign. When you do so, a minus sign appears in front of the procedure’s name, and
you can click it to collapse the body of the procedure again. The Outlining submenu contains
commands to handle the outlining of the various procedures or to turn off outlining and view
the complete listings of all procedures. You will use these commands as you write applications
with substantial amounts of code:

Hide Selection This option lets you hide the selected code segment. You can select part of
a routine or multiple routines, which are hidden as a whole with this command. To display
the hidden code, click the plus icon on the left margin, or use the Stop Hiding Selection
command.

Toggle Outlining Expansion This option lets you change the outline mode of the current
procedure. If the procedure’s definition is collapsed, the code is expanded, and vice versa.

Toggle All Outlining This option is similar to the Toggle Outlining Expansion option, but it
toggles the outline mode of the current document. A form is reduced to a single statement. A
file with multiple classes is reduced to one line per class.

Stop Outlining This option turns off outlining and adds a new command to the Outlining
submenu, Start Automatic Outlining, which you can select to turn on automatic outlining
again.

Stop Hiding Current This option stops hiding the currently hidden selection.

Collapse To Definitions This option reduces the listing to a list of procedure headers.

VIEW MENU

This menu contains commands that allow you to display any toolbar or window of the IDE.
The Other Windows command leads to a submenu with the names of some standard windows,
including the Output and Command windows. The Output window is the console of the appli-
cation. The compiler’s messages, for example, are displayed in the Output window. The Com-
mand window allows you to enter and execute statements. When you debug an application,
you can stop it and enter VB statements in the Command window. Another related window is
the Immediate window, which is very similar to the Command window, and it has the advan-
tage of displaying the IntelliSense box as you type. You'll see how to use these windows later
in this book (they’re used mostly for debugging).

PROJECT MENU

This menu contains commands for adding items to the current solution (an item can be a form,
a file, a component, or another project). The last option in this menu is the Project Properties
command, which opens the project’s properties pages. The Add Reference and Add Web
Reference commands allow you to add references to .NET components and web components,
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respectively. These two commands are also available in the project’s shortcut menu (to open
this menu, right-click the name of the project in the Solution Explorer).

BuUILD MENU

The Build menu contains commands for building (compiling) your project. The two basic
commands in this menu are Build and Rebuild All. The Build command compiles (builds

the executable for) the entire solution, but it doesn’t compile any components of the project
that haven’t changed since the last build. The Rebuild All command clears any existing files
and builds the solution from scratch. Every time you start your application, Visual Studio
recompiles it as needed so you don’t usually have to build your application to execute it. There
are situations (when you add custom classes and controls to your application) when you must
build the project. These topics are discussed later in this book.

DEBUG MENU

This menu contains commands to start or end an application as well as the basic debugging
tools. The basic commands of this menu are discussed briefly in Chapter 4.

DATA MENU

This menu contains commands you will use with projects that access data. You'll see how to
use this short menu’s commands in the discussion of the visual database tools in Chapter 16
through Chapter 18.

FORMAT MENU

The Format menu, which is visible only while you design a Windows or web form, contains
commands for aligning the controls on the form. The commands accessible from this menu are
discussed in Chapter 4. The Format menu is invisible when you work in the code editor — the
commands apply to the visible elements of the interface.

TOOLS MENU

This menu contains a list of useful tools, such as the Macros command, which leads to a sub-
menu with commands for creating macros. Just as you can create macros in a Microsoft Office
application to simplify many tasks, you can create macros to automate many of the repetitive
tasks you perform in the IDE. The last command in this menu, the Options command, leads to
the Options dialog box, in which you can fully customize the environment. The Choose Tool-
box Items command opens a dialog box that enables you to add more controls to the Toolbox.
In Chapter 9, “Building Custom Windows Controls,” you'll learn how to design custom con-
trols and add them to the Toolbox.

WINDOW MENU

This is the typical Window menu of any Windows application. In addition to the list of
open windows, it contains the Hide command, which hides all toolboxes, leaving the entire
window of the IDE devoted to the code editor or the Form Designer. The toolboxes don’t
disappear completely; they're all retracted, and you'll be able see the tabs on the left and
right edges of the IDE window. To expand a toolbox, just hover the mouse pointer over the
corresponding tab.



26

CHAPTER 1

GETTING STARTED WITH VISUAL BASIC 2010

HELP MENU

This menu contains the various help options. The Dynamic Help command opens the Dynamic
Help window, which is populated with topics that apply to the current operation. The Index
command opens the Index window, in which you can enter and get help on a specific topic.

The Toolbox Window

The Toolbox window contains all the controls you can use to build your application interface.
This window is usually retracted, and you must move the pointer over it to view the Toolbox.
The controls in the Toolbox are organized in various tabs, so take a look at them to become
familiar with their functions.

In the first few chapters, we’ll work with the controls in the Common Controls and Menus
& Toolbars tabs. The Common Controls tab contains the icons for the most common Windows
controls, while the All Windows Controls tab contains all the controls you can place on
your form. The Data tab contains the icons for the objects you will use to build data-driven
applications (they’re explored later in this book). The Menus & Toolbars tab contains the Menu
and ContextMenu controls (they’re discussed in Chapter 4) among others. On the Printing tab
you will find all the controls you'll need to create printouts, and they’re discussed briefly in
Chapter 11 and in more detail in the tutorial “Printing with Visual Basic.”” The Dialogs tab
contains controls for implementing the common dialog controls, which are so common in
Windows interfaces; they’re discussed in Chapter 7, “More Windows Controls.”

The Solution Explorer Window

The Solution Explorer window contains a list of the items in the current solution. A solution
can contain multiple projects, and each project can contain multiple items. The Solution
Explorer displays a hierarchical list of all the components, organized by project. You can
right-click any component of the project and choose Properties in the context menu to see the
selected component’s properties in the Properties window. If you select a project, you will see
the Project Properties dialog box. You will find more information on project properties in the
following chapter.

If the solution contains multiple projects, you can right-click the project you want to become
the startup form and select Set As StartUp Project. (The Startup project is the one that starts
executing when you press F5 in the IDE.) You can also add items to a project with the Add
Item command from the context menu or remove a component from the project with the
Exclude From Project command. This command removes the selected component from the
project but doesn’t affect the component’s file on the disk. The Delete command removes the
selected component from the project and also deletes the component’s file from the disk.

If a project contains many items, you can organize them into folders. Right-click the project
name and select Add from the context menu. From the shortcut menu that appears, select New
Folder. To move an existing item into a folder, just drag it and drop it on one of the project
folders.

The Properties Window

This window (also known as the Properties Browser) displays all the properties of the selected
component and their settings. Every time you place a control on a form, you switch to this
window to adjust the appearance of the control. You have already seen how to manipulate
the basic properties of a control through the Properties window, and you will find many more
examples in this and the following chapter.
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Many properties are set to a single value, such as a number or a string. If the possible
settings of a property are relatively few, they’re displayed as meaningful constants in a
drop-down list. Other properties are set through a more elaborate interface. Color properties,
for example, are set on a Color dialog box that’s displayed right in the Properties window.
Font properties are set through the usual Font dialog box. Collections are set in a Collection
Editor dialog box, in which you can enter one string for each item of the collection, as you did
for the items of the ComboBox control earlier in this chapter.

If the Properties window is hidden, or if you have closed it, you can choose View > Prop-
erties Window or right-click a control on the form and choose Properties, or you can simply
press F4 to bring up this window. There will be times when one control might totally overlap
another control, and you won't be able to select the hidden control and view its properties. In
this case, you can select the desired control in the ComboBox at the top of the Properties win-
dow. This box contains the names of all the controls on the form, and you can select a control
on the form by selecting its name from this box.

The Output Window

The Output window is where many of the tools, including the compiler, send their output.
Every time you start an application, a series of messages is displayed in the Output window.
These messages are generated by the compiler, and you need not understand them at

this point. If the Output window is not visible, choose View » Other Windows > Output
from the menu.

The Command and Immediate Windows

While testing a program, you can interrupt its execution by inserting a breakpoint. When

the breakpoint is reached, the program’s execution is suspended and you can execute a state-
ment in the Immediate window. Any statement that can appear in your VB code can also

be executed in the Immediate window. To evaluate an expression, enter a question mark
followed by the expression you want to evaluate, as in the following samples, where result is
a variable in the program you interrupted:

? Math.Log(35)
? "The answer is " & result.ToString

You can also send output to this window from within your code with the Debug.Write and
Debug.WritelLine methods. Actually, this is a widely used debugging technique — to print
the values of certain variables before entering a problematic area of the code. There are more
elaborate tools to help you debug your application, but printing a few values to the Immediate
window is a time-honored practice in programming with VB.

In many of the examples of this book, especially in the first few chapters, I use the
Debug.WritelLine statement to print something to the Immediate window. To demonstrate the
use of the DateDiff() function, for example, I'll use a statement like the following:

Debug.WriteLine(DateDiff(DateInterval.Day, #3/9/2007#, #5/15/20084#))

When this statement is executed, the value 433 (which is the number of days between the
two dates) will appear in the Immediate window. This statement demonstrates the syntax of
the DateDiff() function, which returns the difference between the two dates in days. Sending
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some output to the Immediate window to test a function or display the results of intermediate
calculations is a common practice.

To get an idea of the functionality of the Immediate window, switch back to your first
sample application and insert the Stop statement after the End If statement in the button’s
Click event handler. Run the application, select a language, and click the button on the form.
After displaying a message box, the application will reach the Stop statement and its execution
will be suspended. You'll see the Immediate window at the bottom of the IDE. If it’s not
visible, open the Debug menu and choose Windows > Immediate. In the Immediate window,
enter the following statement:

? ComboBox1.Items.Count

Then, press Enter to execute it. Notice that IntelliSense is present while you're typing in
the Immediate window. The expression prints the number of items in the ComboBox control.
(Don’t worry about the numerous properties of the control and the way I present them here;
they’re discussed in detail in Chapter 5, “Basic Windows Controls.””) As soon as you press
Enter, the value 5 will be printed on the following line.

You can also manipulate the controls on the form from within the Immediate window. Enter
the following statement and press Enter to execute it:

ComboBox1.SelectedIndex = 4

The fifth item on the control will be selected (the indexing of the items begins with 0). How-
ever, you can't see the effects of your changes because the application isn’t running. Press F5 to
resume the execution of the application and you will see that the item Cobol is now selected in
the ComboBox control.

The Immediate window is available only while the application’s execution is suspended. To
continue experimenting with it, click the button on the form to evaluate your choice. When the
Stop statement is executed again, you'll be switched to the Immediate window.

Unlike the Immediate window, the Command window is available at design time. The Com-
mand window allows you to access all the commands of Visual Studio by typing their names
in this window. If you enter the string Edit followed by a period, you will see a list of all
commands of the Edit menu, including the ones that are not visible at the time, and you
can invoke any of these commands and pass arguments to them. For example, if you enter
Edit.Find “Margin” in the Command window and then press Enter, the first instance of
the string Margin will be located in the open code window. To start the application, you
can type Debug.Start. You can add a new project to the current solution with the AddProj
command, and so on. Most developers hardly ever use this window in designing or debugging
applications.

The Error List Window

This window is populated by the compiler with error messages if the code can’t be success-
fully compiled. You can double-click an error message in this window and the IDE will take
you to the line with the statement in error — which you should fix. Change the MsgBox() func-
tion name to MssgBox (). As soon as you leave the line with the error, the name of the function
will be underlined with a wiggly red line and the following error description will appear in the
Error List window:

Name 'MssgBox' is not declared
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Correct the function name (it should be MsgBox with one s) and the error number will disap-
pear from the Error List window. The Error List window has two more tabs, the Warnings tab
and the Messages tab, which display various warnings.

Setting Environment Options

The Visual Studio IDE is highly customizable. I will not discuss all the customization options
here, but I will show you how to change the default settings of the IDE. Open the Tools menu
and select Options (the last item in the menu). The Options dialog box appears, in which you
can set all the options regarding the environment. Figure 1.14 shows the options for the fonts of
the various items of the IDE. Here you can set the font for the Text Editor, dialog boxes, tool-
boxes, and so on. Select an item in the tree in the left pane list and then set the font for this
item in the box below.
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Figure 1.15 shows the Projects And Solutions options. The top box indicates the default loca-
tion for new projects. The Save New Projects When Created check box determines whether
the editor will create a new folder for the project when it’s created. If you uncheck this box,
then Visual Studio will create a folder in the Temp folder. Projects in the Temp folder will be
removed when you run the Disk Cleanup utility to claim more space on your hard drives.

By default, Visual Studio saves the changes to the current project every time you press F5.
You can change this behavior by setting the Before Building option in the Build And Run page,
under the Project And Solutions branch. If you change this setting, you must save your project
from time to time with the File > Save All command.

Most of the tabs in the Options dialog box are straightforward, and you should take a look
at them. If you don’t like some of the default aspects of the IDE, this is the place to change
them. If you switch to the Basic item under the Text Editor branch of the tree in the left pane of
the Options dialog box, you will find the Line Numbers option. Select this check box to display
numbers in front of each line in the code window. The Options dialog box contains a lot of
options for customizing your work environment, and it’s worth exploring on your own. Before
you make any changes in the Visual Studio options, make sure you save the current settings
with the Import And Exporting Settings command accessible from the Tools menu.
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Building a Console Application

Apart from Windows applications, you can use Visual Studio 2010 to build applications that
run in a command prompt window. The command prompt window isn’t really a DOS win-
dow, even though it looks like one. It’s a text window, and the only way to interact with an
application is to enter lines of text and read the output generated by the application, which is
displayed in this text window, one line at a time. This type of application is called a console
application, and I'm going to demonstrate console applications with a single example. We will
not return to this type of application later in the book because it’s not what you're supposed to
do as a Windows developer.

The console application you'll build in this section, ConsoleApplicationl, prompts users to
enter the name of their favorite language. It then prints the appropriate message on a new line,
as shown in Figure 1.16.

FIGURE 1.16 ’
A console application m
uses the command
prompt window to inter-
act with the user.
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Start a new project. In the New Project dialog box, select the template Console Application.
You can also change its default name from ConsoleApplication] to a more descriptive name.
For this example, don’t change the application’s name.
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A console application doesn’t have a user interface, so the first thing you'll see is the code
editor’s window with the following statements:

ModuTle Modulel
Sub Main()
End Sub

End Module

Unlike a Windows application, which is a class, a console application is a module. Main()
is the name of a subroutine that’s executed automatically when you run a console application.
The code you want to execute must be placed between the statements Sub Main() and End Sub.
Insert the statements shown in Listing 1.3 in the application’s Main() subroutine.

LISTING 1.3: Console application

Module Modulel
Sub Main()
Console.WriteLine("Enter your favorite Tanguage")
Dim Tanguage As String
Tanguage = Console.ReadLine()
Tanguage = language.ToUpper
If language = "VISUAL BASIC' Or
Tanguage = "VB" Or
Tanguage = "VB.NET" Or

Tanguage = "VISUAL BASIC 2010" Then
Console.WriteLine("We have a winner!")
Else
Console.WriteLine(Tanguage & " is not a bad Tanguage.")
End If

Console.WriteLine()
Console.WriteLine()
Console.WriteLine("PRESS ENTER TO EXIT")
Console.ReadLine()
End Sub
End Module

This code is quite similar to the code of the equivalent Windows applications we developed
earlier, except that it uses the Console.WriteLine statement to send its output to the command
prompt window instead of a message box.

A console application doesn’t react to events because it has no visible interface. However,
it’s easy to add some basic elements of the Windows interface to a console application. If you
change the Console.WriteLine method call into the MsgBox() function, the message will be
displayed in a message box.

One reason to build a console application is to test a specific feature of the language with-
out having to build a user interface. Many of the examples in the documentation are console
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applications; they demonstrate the topic at hand and nothing more. If you want to test the
DateDiff() function, for example, you can create a new console application and enter the lines
from Listing 1.4 in its Main() subroutine.

LISTING 1.4: Testing the DateDi ff() function with a console application

Sub Main()
Console.WriteLine(DateDiff(DateInterval.Day, #3/9/2000#, #5/15/2008#))
Console.WriteLine("PRESS ENTER TO EXIT")
Console.ReadLine()

End Sub

The last two lines will be the same in every console application you write. Without them,
the command prompt window will close as soon as the End Sub statement is reached, and you
won’t have a chance to see the result. The Console.ReadLine method waits until the user
presses the Enter key.

Console applications are convenient for testing short code segments, but Windows program-
ming is synonymous with designing graphical user interfaces, so you won't find any more
console applications in this book.

Using Code Snippets

Visual Basic 2010 comes with a lot of predefined code snippets for selected actions, and you
can insert these snippets into your code as needed. Let’s say you want to insert the statements
for writing some text to a file, but you have no idea how to access files. Create an empty line in
the listing (press the Enter key a couple of times at the end of a code line). Then open the Edit
menu and choose IntelliSense > Insert Snippet (or right-click somewhere in the code window
and choose Insert Snippet from the context menu).

When Insert Snippet opens, you will see a list of the snippets, organized in folders according
to their function, as shown in Figure 1.17. Double-click any folder name to see the subfold-
ers or actual snippets available for that function. Try it out. Double-click the Fundamentals
folder and take a look at the options available to you: Collections, Data Types, File System, and
Math. Double-click the filesystem item to see a list of common file-related tasks, as shown in
Figure 1.18. Scroll down and locate the item Write Text To A File in the list. Now, double-click
it to insert that snippet at the current location in the code window.

The following snippet will be inserted in your code:

My.Computer.FileSystem.WriteAl1Text("C:\test.txt", "Text", True)

To write some text to a file, you need to call the WriteAl1Text method of the
My .Computer.FileSystem object. You can replace the strings shown in the snippet with
actual values. The first string is the filename, the second string is the text to be written to the
file, and the last argument of the method determines whether the text will be appended to the
file (if False) or will overwrite any existing text (if True).

Each snippet shows you the basic statements for performing a common task, and you can
edit the code inserted by Visual Studio as needed. A real-world application would probably
prompt the user for a filename via the File common dialog box and then use the filename spec-
ified by the user in the dialog box instead of a hard-coded filename.
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FIGURE 1.17
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As you program, you should always try to find out whether there’s a snippet for the task at
hand. Sometimes you can use a snippet without even knowing how it works. Although snip-
pets can simplify your life, they won’t help you understand the Framework, which is discussed
in detail throughout this book.

Using the My Component

You have probably noticed that the code snippets available through Visual Studio use an entity
called My — a peculiar object that was introduced with VB 2005 to simplify many program
ming tasks. As you saw in the preceding code snippet, the My component allowed you to write
some text to a file with a single statement, the WriteAl1Text method. If you're familiar with
earlier versions of Visual Basic, you know that to actually write text to a file you must first
open a file, then write some text to it, and finally close the file. The My component allows you
to perform all these operations with a single statement.

Another example is the PTay method, which you can use to play back a WAV file from
within your code:

My .Computer.Audio.PTay ("C:\Sounds\CountDown.wav")

Or you can use it to play back a system sound:

My .Computer.Audio.PTaySystemSound(System.Media.SystemSounds.Exclamation)

33
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The method that plays back the sound is the Play method, and the method that writes text
to a file is the WriteAl1Text method. However, you can’t call them directly through the My
component; they’re not methods of the My component. If they were, you'd have to dig hard to
find out the method you need. The My component exposes six components, which contain their
own components. Here’s a description of the basic components of the My component and the
functionality you should expect to find in each component:

My.Application The Application component provides information about the current appli-
cation. The CommandLineArgs property of My.Application returns a collection of strings, which
are the arguments passed to the application when it was started. Typical Windows applications
aren’t called with command-line arguments, but it’s possible to start an application and pass a
filename as an argument to the application (the document to be opened by the application, for
example). The Info property is an object that exposes properties such as DirectoryPath (the
application’s default folder), ProductName, Version, and so on.

My.Computer This component exposes a lot of functionality via a number of properties,
many of which are objects. The My.Computer.Audio component lets you play back sounds.
The My.Computer.Clipboard component lets you access the Clipboard. To find out whether
the Clipboard contains a specific type of data, use the ContainsText, ContainsImage,
ContainsData, and ContainsAudio methods. To retrieve the contents of the Clipboard, use
the GetText, GetImage, GetData, and GetAudioStream methods. Assuming that you have a
form with a TextBox control and a PictureBox control, you can retrieve text or image data from
the Clipboard and display it on the appropriate control with the following statements:

If My.Computer.Clipboard.ContainsImage Then
PictureBoxl.Image = My.Computer.Clipboard.GetImage

End If

If My.Computer.Clipboard.ContainsText Then
TextBox2.Text = My.Computer.Clipboard.GetText

End If

You may have noticed that using the My component in your code requires that you write long
statements. You can shorten them substantially via the With statement, as shown next:

With My.Computer.Clipboard
If .ContainsImage Then
PictureBox1l.Image = .GetImage
End If
If .ContainsText Then
TextBox2.Text = .GetText
End If
End With

When you're executing multiple statements on the same object, you can specify the object in
a With statement and call its methods in the block of the With statement by specifying the
method name prefixed with a dot. The Wi th statement is followed by the name of the object
to which all following methods apply and is terminated with the End Wi th statement.

Another property of the My.Computer component is the FileSystem object that exposes
all the methods you need to access files and folders. If you enter the expression
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My .Computer.FileSystem followed by a dot, you will see all the methods exposed by
the FileSystem component. Among them, you will find DeleteFile, DeleteDirectory,
RenameFile, RenameDirectory, WriteAl1Text, ReadAT1Text, and many more. Select a
method and then type the opening parenthesis. You will see the syntax of the method in a
ToolTip. The syntax of the CopyFiTe method is as follows:

My .Computer.FileSystem.CopyFile(
sourceFileName As String, destinationFileName As String)

Just specify the path of the file you want to copy and the new file’s name, and you're finished.
This statement will copy the specified file to the specified location.

You will notice that the ToolTip box with the syntax of the CopyFile method has multiple ver-
sions, which are listed at the left side of the box along with arrow up and arrow down icons.
Click these two buttons to see the next and previous versions of the method. The second ver-
sion of the CopyFile method is as follows:

My .Computer.FileSystem.CopyFile(
sourceFileName As String, destinationFileName As String,
overwrite As Boolean)

The overwrite argument specifies whether the method should overwrite the destination file if
it exists.

The third version of the method accepts a different third argument that determines whether
the usual copy animation will be displayed as the file is being copied.

The various versions of the same method differ in the number and/or type of their arguments,
and they’re called overloaded forms of the method. Instead of using multiple method names
for the same basic operation, the overloaded forms of a method allow you to call the same
method name and adjust its behavior by specifying different arguments.

My.Forms This component lets you access the forms of the current application. You can also
access the application’s forms by name, so the Forms component isn’t the most useful one.

My.Settings This component lets you access the application settings. These settings apply to
the entire application and are stored in an XML configuration file. The settings are created from
within Visual Studio, and you use the Settings component to read them.

My.User This component returns information about the current user. The most important
property of the User component is the CurrentPrincipal property, which is an object that
represents the credentials of the current user.

My.WebServices The WebServices component represents the web services referenced by the
current application.

The My component gives beginners unprecedented programming power and allows you to
perform tasks that would require substantial code if implemented with earlier versions of the
language, not to mention the research it would take to locate the appropriate methods in the
Framework. You can explore the My component on your own and use it as needed. My is not a
substitute for learning the language and the Framework. It can help you initially, but you can’t
go far without learning the methods of the Framework for handling files or any other feature.
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Let’s say you want to locate all the files of a specific type in a folder, including its sub-
folders. Scanning a folder and its subfolders to any depth is quite a task (you'll find

the code in the tutorial “Accessing Folders and Files,” which you can download from

www . sybex.com/go/masteringvb2010). You can do the same with a single statement by using
the My component:

Dim files As ReadOnlyCollection(Of String)
files = My.Computer.FileSystem.GetFiles("D:\Data", True, "*.txt")

The GetFiles method populates the f77es collection with the pathnames of the text files in
the folder D:\Data and its subfolders. However, it won’t help you if you want to process each
file in place. Moreover, this GetFiles method is synchronous: If the folder contains many sub-
folders with many files, it will block the interface until it retrieves all the files. In the tutorial
"“Accessing Folders and Files,” you'll see the code that retrieves filenames and adds them to a
control as it goes along.

If you're already familiar with VB, you may think that the My component is an aid for the abso-
lute beginner or the nonprogrammer. This isn’t true. VB is about productivity, and the My com-
ponent can help you be more productive with your daily tasks, regardless of your knowledge
of the language or programming skills. If you can use My to save a few (or a few dozen) state-
ments, do it. There’s no penalty for using the My component because the compiler replaces the
methods of the My component with the equivalent method calls to the Framework.

The Bottom Line

Navigate the integrated development environment of Visual Studio. To simplify the pro-
cess of application development, Visual Studio provides an environment that’s common to all
languages, known as an integrated development environment (IDE). The purpose of the IDE
is to enable the developer to do as much as possible with visual tools before writing code. The
IDE provides tools for designing, executing, and debugging your applications. It’s your second
desktop, and you'll be spending most of your productive hours in this environment.

Master It Describe the basic components of the Visual Studio IDE.

Understand the basics of a Windows application. A Windows application consists of

a visual interface and code. The visual interface is what users see at runtime: a form with
controls with which the user can interact — by entering strings, checking or clearing check
boxes, clicking buttons, and so on. The visual interface of the application is designed with
visual tools. The visual elements incorporate a lot of functionality, but you need to write some
code to react to user actions.

Master It Describe the process of building a simple Windows application.
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Handling Data

This chapter and the next discuss the fundamentals of any programming language: variables
and data types. A variable stores data, which is processed with statements. A program is a list
of statements that manipulate variables. To write even simple applications, you need a basic
understanding of some fundamental topics, such as the data types (the kind of data you can
store in a variable), the scope and lifetime of variables, and how to write procedures and pass
arguments to them. In this chapter, we’ll explore the basic data types of Visual Basic, and in the
following one, you'll learn about procedures and flow-control statements.

If you're new to Visual Basic, you may find some material in this chapter less than exciting.
It covers basic concepts and definitions — in general, tedious, but necessary, material. Think of
this chapter as a prerequisite for the following ones. If you need information on core features
of the language as you go through the examples in the rest of the book, you'll probably find it
here.

In this chapter, you'll learn how to do the following:

¢ Declare and use variables
¢ Use the native data types
¢ Create custom data types
*

Use arrays

Variables

In Visual Basic, as in any other programming language, variables store values during a pro-
gram’s execution. A variable has a name and a value. The variable UserName, for example,
might have the value Joe, and the variable Discount might have the value 0.35. UserName and
Discount are variable names, and Joe and 0.35 are their values. Joe is a string (that is, text),
and 0.35 is a numeric value. When a variable’s value is a string, it must be enclosed in double
quotes. In your code, you can refer to the value of a variable by the variable’s name.

In addition to a name and a value, variables have a data type, which determines what kind
of values you can store to a variable. VB 2010 supports several data types (and they’re dis-
cussed in detail later in this chapter). It's actually the Common Language Runtime (CLR) that
supports the data types, and the data types are common to all languages, not just to Visual
Basic. The data type of a variable is specified when the variable is declared, and you should
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always declare variables before using them. (I'll tell you more about declaring variables in the
next section.)

The various data types are discussed in detail later in this chapter, but let me start with
some simple examples to demonstrate the concepts of using variables in an application. One
of the available numeric data types is the Decimal data type; it can store both integer and
non-integer values. For example, the following statements calculate and display the discount
for the amount of $24,500:

Dim Amount As Decimal

Dim Discount As Decimal

Dim DiscountedAmount As Decimal

Amount = 24500

Discount = 0.35

DiscountedAmount = Amount * (1 - Discount)
MsgBox(“Your price is $” & DiscountedAmount.ToString)

If you enter these statements in a button’s Click event handler to test them, the compiler
may underline the statement that assigns the value 0.35 to the Discount variable and generate
an error message. To view the error message, hover the pointer over the underlined segment
of the statement in error. This will happen if the Strict option is on. (I discuss the Strict option,
along with two more options of the compiler, later in this chapter.) By default, the Strict option
is off and the statement won’t generate an error.

The compiler treats any numeric value with a fractional part as a Double value and detects
that you're attempting to assign a Double value to a Decimal variable. To specify that a
numeric value should be treated as a Decimal type, use the following notation:

Discount = 0.35D

As you will see later, the D character at the end of a numeric value indicates that the value
should be treated as a Decimal value, and there are a few more type characters (see Table 2.2
later in this chapter). I've used the Decimal data type here because it’s commonly used in finan-
cial calculations.

The amount displayed on the message box by the last line of code depends on the values
of the Discount and Amount variables. If you decide to offer a better discount, all you have to
do is change the value of the Discount variable. If you didn’t use the Discount variable, you'd
have to make many changes throughout your code. In other words, if you coded the line that
calculated the discounted amount as follows, you’d have to look for every line in your code
that calculates discounts and change the discount from 0.35 to another value:

DiscountedAmount = 24500 * (1 - 0.35)

When you change the value of the Discount variable in a single place in your code, the
entire program is up-to-date and it will evaluate the proper discount on any amount.

Declaring Variables

In most programming languages, variables must be declared in advance. Historically, the rea-
son for doing this has been to help the compiler generate the most efficient code. If the compiler
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knows all the variables and their types ahead of time, it can produce the most compact and effi-
cient, or optimized, code. For example, when you tell the compiler that the variable Discount
will hold a number, the compiler sets aside a certain number of bytes for the Discount variable
to use.

When programming in VB 2010, you should declare your variables because this is the
default mode, and Microsoft recommends this practice strongly. If you attempt to use an
undeclared variable in your code, VB 2010 will throw an exception. It will actually catch the
error as soon as you type in the line that uses the undeclared variable, underlining it with
a wiggly line. It is possible to change the default behavior and use undeclared variables
the way most people did with earlier versions of VB, but all the examples in this book
use explicitly declared variables. In any case, you're strongly encouraged to declare your
variables.

You already know how to declare variables with the Dim statement and the As keyword,
which introduces their type:

Dim meters As Integer
Dim greetings As String

The first variable, meters, will store integers, such as 3 or 1,002; the second variable,
greetings, will store text. You can declare multiple variables of the same or different type in
the same line, as follows:

Dim Qty As Integer, Amount As Decimal, CardNum As String

If you want to declare multiple variables of the same type, you need not repeat the type.
Just separate all the variables of the same type with commas and set the type of the last
variable:

Dim Length, Width, Height As Integer, Volume, Area As Double

This statement declares three Integer variables and two Double variables. Double variables hold
fractional values (or floating-point values, as they’re usually called) that are similar to the Sin-
gle data type except that they can represent non-integer values with greater accuracy.

An important aspect of variables is their scope, a topic that’s discussed in more detail later in
this chapter. In the meantime, bear in mind that all variables declared with the Dim statement
exist in the module in which they were declared. If the variable Count is declared in a subrou-
tine (an event handler, for example), it exists only in that subroutine. You can’t access it from
outside the subroutine. Actually, you can have a Count variable in multiple procedures. Each
variable is stored locally, and they don’t interfere with one another.

VARIABLE-NAMING CONVENTIONS

When declaring variables, you should be aware of a few naming conventions:

¢ A variable’s name must begin with a letter or an underscore character, followed by more
letters or digits.

¢ It can’t contain embedded periods or other special punctuation symbols. The only special
character that can appear in a variable’s name is the underscore character.
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It mustn’t exceed 1,024 characters.

It must be unique within its scope. This means that you can’t have two identically named
variables in the same subroutine, but you can have a variable named counter in many dif-
ferent subroutines.

Variable names are not case sensitive: myAge, myage, and MYAGE all refer to the same vari-
able in your code. Actually, as you enter variable names in your code, the editor converts their
casing so that they match their declaration.

VARIABLE INITIALIZATION

Visual Basic allows you to initialize variables in the same line that declares them. The following
statement declares an Integer variable and immediately places the value 3,045 in it:

Dim distance As Integer = 3045

This statement is equivalent to the following two:

Dim distance As Integer
distance = 3045

It is also possible to declare and initialize multiple variables (of the same or different type)
on the same line:

Dim quantity As Integer = 1, discount As Single = 0.25

Types of Variables

You've learned how to declare variables and that all variables should have a type. But what
data types are available? Visual Basic recognizes the following five categories of variables:

Numeric
String
Boolean
Date
Object

* & o o

The two major variable categories are numeric and string. Numeric variables store numbers,
and string variables store text. Object variables can store any type of data. Why bother to spec-
ify the type if one type suits all? On the surface, using object variables might seem like a good
idea, but they have their disadvantages. Integer variables are optimized for storing integers,
and date variables are optimized for storing dates. Before VB can use an object variable, it must
determine its type and perform the necessary conversions. If the variable is declared with a
specific type, these conversions are not necessary.

Text is stored in string variables, but numbers can be stored in many formats, depending on
the size of the number and its precision. That’s why there are many types of numeric variables.
The String and Date data types are much richer in terms of the functionality they expose and
are discussed in more detail in Chapter 11, “The Framework at Large.”
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NUMERIC VARIABLES

You’d expect that programming languages would use the same data type for numbers. After
all, a number is a number. But this couldn’t be further from the truth. All programming lan-
guages provide a variety of numeric data types, including the following:

¢ Integer (there are several Integer data types)

¢ Decimal

¢ Single (floating-point numbers with limited precision)
¢ Double (floating-point numbers with extreme precision)

Decimal, Single, and Double are the three basic data types for storing floating-point numbers
(numbers with a fractional part). The Double data type can represent these numbers more accu-
rately than the Single type and is used almost exclusively in scientific calculations. The Integer
data types store whole numbers. The data type of your variable can make a difference in the
results of the calculations. The proper variable types are determined by the nature of the val-
ues they represent, and the choice of data type is frequently a trade-off between precision and
speed of execution (less-precise data types are manipulated faster). Visual Basic supports the
numeric data types shown in Table 2.1. In the Data Type column, I show the name of each data
type and the corresponding keyword in parentheses.

Integer Variables

There are three types of variables for storing integers, and they differ only in the range of
numbers each can represent. As you understand, the more bytes a type takes, the larger
values it can hold. The type of Integer variable you'll use depends on the task at hand. You
should choose the type that can represent the largest values you anticipate will come up
in your calculations. You can go for the Long type, to be safe, but Long variables take up
four times as much space as Short variables and it takes the computer longer to process
them.

Single- and Double-Precision Numbers

The Single and Double data type names come from single-precision and double-precision
numbers. Double-precision numbers are stored internally with greater accuracy than single-
precision numbers. In scientific calculations, you need all the precision you can get; in those
cases, you should use the Double data type.

The Single and Double data types are approximate; you can’t represent any numeric value
accurately and precisely with these two data types. The problem stems from the fact that com-
puters must store values in a fixed number of bytes, so some accuracy will be lost. Instead of
discussing how computers store numeric values, I will demonstrate the side effects of using the
wrong data type with a few examples.

The result of the operation 1 + 3 is 0.333333.. . (an infinite number of the digit 3). You could
fill 256 MB of RAM with 3s, and the result would still be truncated. Here’s a simple example
that demonstrates the effects of truncation.

In a button’s Click event handler, declare two variables as follows:

Dim a As Single, b As Double
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TABLE 2.1:

DATA TYPE

Byte (Byte)

Signed Byte
(SByte)

Short (Int16)

Integer (Int32)

Long (Int64)

Unsigned Short

(UShort)

Unsigned Integer
(UInteger)

Unsigned Long
(ULong)

Single Precision
(Single)

Double Precision
(Double)

Decimal (Decimal)

MEMORY
REPRESENTATION

1 byte

1 byte

2 bytes

4 bytes

8 bytes

2 bytes

4 bytes

8 bytes

4 bytes

8 bytes

16 bytes

Visual Basic numeric data types

STORES

Integers in the range 0 to 255.

Integers in the range —128 to 127.

Integer values in the range —32,768 to 32,767.

Integer values in the range —2,147,483,648 to
2,147,483,647.

Integer values in the range —9,223,372,036,854,755,808 to
9,223,372,036,854,755,807.

Positive integer values in the range 0 to 65,535.

Positive integers in the range 0 to 4,294,967,295.

Positive integers in the range 0 to
18,446,744,073,709,551,615.

Single-precision floating-point numbers. A single precision
variable can represent negative numbers in the range
—3.402823E38 to —1.401298E—45 and positive numbers in
the range 1.401298E—45 to 3.402823E38. The value 0 can’t
be represented precisely (it’s a very, very small number,
but not exactly o).

Double-precision floating-point numbers. A double
precision variable can represent negative numbers in the
range —1.79769313486232E308 to
—4.94065645841247E-324 and positive numbers in the
range 4.94065645841247E-324 to 1.79769313486232E308.

Integer and floating-point numbers scaled by a factor in
the range from 0 to 28. See the description of the Decimal
data type for the range of values you can store in it.

Then enter the following statements:

a=1/3

Debug.WriteLine(a)

Run the application, and you should get the following result in the Output window:

.3333333
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There are seven digits to the right of the decimal point. Break the application by pressing
Ctrl+Break and append the following lines to the end of the previous code segment:

a = a * 100000
Debug.WriteLine(a)

This time, the following value will be printed in the Output window:

33333.34

The result is not as accurate as you might have expected initially — it isn’t even rounded
properly. If you divide a by 100,000, the result will be as follows:

0.3333334

This number is different from the number we started with (0.3333333). The initial value was
rounded when we multiplied it by 100,000 and stored it in a Single variable. This is an impor-
tant point in numeric calculations, and it’s called error propagation. In long sequences of numeric
calculations, errors propagate. Even if you can tolerate the error introduced by the Single data
type in a single operation, the cumulative errors might be significant.

Let’s perform the same operations with double-precision numbers, this time using the vari-
able b. Add these lines to the button’s C1ick event handler:

b=1/3
Debug.WriteLine(b)
b = b * 100000
Debug.WriteLine(b)

This time, the following numbers are displayed in the Output window:

0.333333333333333
33333.3333333333

The results produced by the double-precision variables are more accurate.

Why are such errors introduced in our calculations? The reason is that computers store
numbers internally with two digits: zero and one. This is very convenient for computers
because electronics understand two states: on and off. As a matter of fact, all the statements
are translated into bits (zeros and ones) before the computer can understand and execute
them. The binary numbering system used by computers is not much different from the decimal
system we humans use; computers just use fewer digits. We humans use 10 different digits
to represent any number, whole or fractional, because we have 10 fingers (in effect, computers
count with just two fingers). Just as with the decimal numbering system, in which some
numbers can’t be precisely represented, there are numbers that can’t be represented precisely
in the binary system.

Let me give you a more illuminating example. Create a single-precision variable, a, and a
double-precision variable, b, and assign the same value to them:

Dim a As Single, b As Double
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0.03007
0.03007

a
b

Then print their difference:

Debug.WriteLine(a-b)

If you execute these lines, the result won’t be zero! It will be —6.03199004634014E-10. This is
a very small number that can also be written as 0.000000000603199004634014. Because different
numeric types are stored differently in memory, they don’t quite match. What this means to
you is that all variables in a calculation should be of the same type.

Eventually, computers will understand mathematical notation and will not convert all
numeric expressions into values as they do today. If you multiply the expression 1/3 by 3, the
result should be 1. Computers, however, must convert the expression 1/3 into a value before
they can multiply it by 3. Because 1/3 can’t be represented precisely, the result of the (1/3) x
3 will not be exactly 1. If the variables a and b are declared as Single or Double, the following
statements will print 1:

a=3
b=1/a
Debug.WriteLine(a * b)

If the two variables are declared as Decimal, however, the result will be a number very
close to 1 but not exactly 1 (it will be 0.9999999999999999999999999999 — there will be 28 dig-
its after the decimal point). Fortunately, these errors do not surface with typical business-line
applications, but you should be aware of truncation errors and how they may affect your cal-
culations. In business applications, we always round our results to two decimal digits and the
value 0.999999 of the preceding example will be rounded to 1.00.

The Decimal Data Type

Variables of the Decimal type are stored internally as integers in 16 bytes and are scaled by

a power of 10. The scaling power determines the number of decimal digits to the right of the
floating point, and it’s an integer value from 0 to 28. When the scaling power is 0, the value is
multiplied by 10°, or 1, and it's represented without decimal digits. When the scaling power is
28, the value is divided by 10%(which is 1 followed by 28 zeros — an enormous value), and it’s
represented with 28 decimal digits.

The largest possible value you can represent with a Decimal value is an integer: 79,228,
162,514,264,337,593,543,950,335. The smallest number you can represent with a Decimal variable
is the negative of the same value. These values use a scaling factor of 0. When the scaling fac-
tor is 28, the largest value you can represent with a Decimal variable is quite small, actually. It's
7.9228162514264337593543950335 (and the smallest value is the same with a minus sign). This is
a very small numeric value (not quite 8), but it’s represented with extreme accuracy. The num-
ber zero can’t be represented precisely with a Decimal variable scaled by a factor of 28. The
smallest positive value you can represent with the same scaling factor is 0.00...01 (there are
27 zeros between the decimal period and the digit 1) — an extremely small value, but still not
quite zero. The more accuracy you want to achieve with a Decimal variable, the smaller the
range of available values you have at your disposal — just as with everything else in life.
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When using decimal numbers, the compiler keeps track of the decimal digits (the digits fol-
lowing the decimal point) and treats all values as integers. The value 235.85 is represented as
the integer 23585, but the compiler knows that it must scale down the value by 100 when it
finishes using it. Scaling down by 100 (that is, 10%) corresponds to shifting the decimal point
by two places. First, the compiler multiplies this value by 100 to make it an integer. Then, it
divides it by 100 to restore the original value. Let’s say that you want to multiply the following
values:

328.558 * 12.4051

First, the compiler turns them into integers. The compiler remembers that the first number
has three decimal digits and the second number has four decimal digits. The result of the mul-
tiplication will have seven decimal digits. So the compiler can multiply the following integer
values:

328558 * 124051

It then treats the last seven digits of the result as decimals. The result of the multiplica-
tion is 40,757,948,458. The actual value after taking into consideration the decimal digits is
4,075.7948458. This is how the compiler manipulates the Decimal data type.

TYPE CHARACTERS

As 1 mentioned earlier, the D character at the end of a numeric value specifies that the
number should be converted into a Decimal value. By default, every value with a fractional
part is treated as a Double value because this type can accommodate fractional values with
the greatest possible accuracy. Assigning a Double value to a Decimal variable will produce
an error if the Strict option is on, so you must specify explicitly that the two values should
be converted to the Decimal type. The D character at the end of the value is called a type
character. Table 2.2 lists all of the type characters that are available in Visual Basic.

TABLE 2.2: Type characters
TYPE CHARACTER DESCRIPTION EXAMPLE
C Converts value to a Char type Dim ch As String = "A"c
Dore@ Converts value to a Decimal type Dim price As Decimal = 12.99D
R or # Converts value to a Double type Dim pi As Double = 3.14R
Tor% Converts value to an Integer type Dim count As Integer = 99I
Lor& Converts value to a Long type Dim distance As Long = 1999L
S Converts value to a Short type Dim age As Short = 1S

For! Converts value to a Single type Dim velocity As Single = 74.99F
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If you perform the same calculations with Single variables, the result will be truncated (and
rounded) to three decimal digits: 4,075.795. Notice that the Decimal data type didn’t introduce
any rounding errors. It’s capable of representing the result with the exact number of decimal
digits provided the Decimal type can accommodate both operands and their result. This is the
real advantage of Decimals, which makes them ideal for financial applications. For scientific
calculations, you must still use Doubles. Decimal numbers are the best choice for calculations
that require a specific precision (such as four or eight decimal digits).

INFINITY AND OTHER ODDITIES

The Framework can represent two very special values, which may not be numeric values them-
selves but are produced by numeric calculations: NaN (not a number) and Infinity. If your
calculations produce NaN or Infinity, you should give users a chance to verify their data, or
even recode your routines as necessary. For all practical purposes, neither NaN nor Infinity
can be used in everyday business calculations.

NoOT A NUMBER (NAN)

NaN is not new. Packages such as Wolfram Mathematica and Microsoft Excel have been using
it for years. The value NaN indicates that the result of an operation can’t be defined: It’s not
a regular number, not zero, and not infinity. NaN is more of a mathematical concept rather
than a value you can use in your calculations. The Log() function, for example, calculates
the logarithm of positive values. By definition, you can’t calculate the logarithm of a negative
value. If the argument you pass to the Log() function is a negative value, the function will
return the value NaN to indicate that the calculations produced an invalid result. You may
find it annoying that a numeric function returns a non-numeric value, but it’s better than if
it throws an exception. Even if you don’t detect this condition immediately, your calculations
will continue and they will all produce NaN values.

Some calculations produce undefined results, such as infinity. Mathematically, the result of
dividing any number by zero is infinity. Unfortunately, computers can’t represent infinity, so
they produce an error when you request a division by zero. Visual Basic will report a special
value, which isn’t a number: the Infinity value. If you call the ToString method of this value,
however, it will return the string Infinity. Let’s generate an Infinity value. Start by declar-
ing a Double variable, db1Var:

Dim db1Var As Double = 999
Then divide this value by zero:

Dim infVar as Double
infvar = dblvar / 0

And display the variable’s value:

MsgBox(infVar)
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The string Infinity will appear in a message box. This string is just a description; it tells
you that the result is not a valid number (it’s a very large number that exceeds the range of
numeric values that can be represented with any data type), but it shouldn’t be used in other
calculations. However, you can use the Infinity value in arithmetic operations. Certain opera-
tions with infinity make sense; others don’t. If you add a number to infinity, the result is still
infinity (any number, even an arbitrarily large one, can still be increased). If you divide a value
by infinity, you’ll get the zero value, which also makes sense. If you divide one Infinity value
by another Infinity value, you'll get the second odd value, NaN.

Another calculation that will yield a non-number is the division of a very large number by
a very small number (a value that’s practically zero, but not quite). If the result exceeds the
largest value that can be represented with the Double data type, the result is Infinity. Declare
three variables as follows:

1E299
1E-299

Dim TargeVar As Double
Dim smallVar As Double
Dim result As Double

The notation 1E299 means 10 raised to the power of 299, which is an extremely large num-
ber. Likewise, 1E-299 means 10 raised to the power of —299, which is equivalent to dividing 10
by a number as large as 1E299.

Then divide the large variable by the small variable and display the result:

result = largeVar / smallVar
MsgBox(result)

The result will be Infinity. If you reverse the operands (that is, you divide the very small
by the very large variable), the result will be zero. It’s not exactly zero, but the Double data
type can’t accurately represent numeric values that are very, very close (but not equal) to zero.

You can also produce an Infinity value by multiplying a very large (or very small) number
by itself many times. But clearly, the most absurd method of generating an Infinity value is
to assign the DoubTle.PositiveInfinity or Double.NegativeInfinity value to a variable!

The result of the division 0 / 0, for example, is not a numeric value. If you attempt to enter
the statement 0 / 0 in your code, however, VB will catch it even as you type, and you'll get the
error message Division by zero occurs in evaluating this expression.

To divide zero by zero, set up two variables as follows:

Dim varl, var2 As Double
Dim result As Double
varl = 0

var2 = 0

result = varl / var2
MsgBox(result)

If you execute these statements, the result will be NaN. Any calculations that involve the
result variable will also yield NaN. The following statements will produce a NaN value:

result = result + result
result = 10 / result
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result = result + 1E299
MsgBox(result)

If you make var2 a very small number, such as 1E-299, the result will be zero. If you make
varl a very small number, the result will be Infinity.

For most practical purposes, Infinity is handled just like NaN. They’re both numbers that
shouldn’t occur in business applications (unless you're projecting the national deficit in the
next 50 years), and when they do, it means that you must double-check your code or your data.
They are much more likely to surface in scientific calculations, and they must be handled with
the statements described in the next section.

Testing for Infinity and NaN

To find out whether the result of an operation is a NaN or Infinity, use the IsNaN and
IsInfinity methods of the Single and Double data types. The Integer data type doesn’t
support these methods, even if it’s possible to generate Infinity and NaN results with integers.
If the IsInfinity method returns True, you can further examine the sign of the Infinity value
with the IsNegativeInfinity and IsPositiveInfinity methods.

In most situations, you'll display a warning and terminate the calculations. The statements
of Listing 2.1 do just that. Place these statements in a button’s C1ick event handler and run the
application.

LISTING 2.1: Handling NaN and Infinity values

Dim varl, var2 As Double
Dim result As Double
varl = 0
var2 = 0
result = varl / var2
If Double.IsInfinity(result) Then
If Double.IsPositiveInfinity(result) Then
MsgBox(”Encountered a very large number. Can't continue”)
Else
MsgBox(”"Encountered a very small number. Can't continue”)
End If
Else
If Double.IsNaN(result) Then
MsgBox(“Unexpected error in calculations”)
Else
MsgBox("The result is : ” & result.ToString)
End If
End If

This listing will generate a NaN value. Set the value of the varl variable to 1 to generate
a positive Infinity value or to -1 to generate a negative Infinity value. As you can see, the
IsInfinity, IsPositiveInfinity, IsNegativeInfinity, and IsNaN methods require that the
variable be passed as an argument.
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If you change the values of the varl and var2 variables to the following values and execute
the application, you'll get the message Encountered a very large number:

1E+4299
1E-299

varl
var2

If you reverse the values, you'll get the message Encountered a very small number. In either
case, the program will terminate gracefully and let the user know the type of problem that pre-
vents the completion of the calculations.

BYTE VARIABLES

None of the previous numeric types is stored in a single byte. In some situations, however, data
are stored as bytes, and you must be able to access individual bytes. The Byte data type holds
an integer in the range of 0 to 255. Bytes are frequently used to access binary files, image and
sound files, and so on. To declare a variable as a Byte, use the following statement:

Dim n As Byte

The variable n can be used in numeric calculations too, but you must be careful not to assign
the result to another Byte variable if its value might exceed the range of the Byte type. If the
variables A and B are initialized as:

Dim A As Byte, B As Byte

A = 233

B = 50

the following statement will produce an overflow exception:

Debug.WriteLine(A + B)

The result (283) can’t be stored in a single byte. Visual Basic generates the correct answer, but
it can’t store it into a Byte variable.

BOOLEAN OPERATIONS WITH BYTES

The operators that won’t cause overflows are the Boolean operators And, Or, Not, and Xor,
which are frequently used with Byte variables. These aren’t logical operators that return True
or False; they combine the matching bits in the two operands and return another byte. If you
combine the numbers 199 and 200 with the AND operator, the result is 192. The two values in
binary format are 11000111 and 11001000. If you perform a bitwise AND operation on these two
values, the result is 11000000, which is the decimal value 192.

In addition to the Byte data type, VB 2010 provides a Signed Byte data type, SByte, which
can represent signed values in the range from -128 to 127. The bytes starting with the 1 bit
represent negative values. The range of positive values is less by one than the range of negative
values because the value 0 is considered a positive value (its first bit is 0).
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BOOLEAN VARIABLES

The Boolean data type stores True/False values. Boolean variables are, in essence, integers that
take the value -1 (for True) and 0 (for False). Actually, any nonzero value is considered True.
Boolean variables are declared as

Dim failure As Boolean

and they are initialized to False. Even so, it’s a good practice to initialize your variables explic-
itly, as in the following code segment. Boolean variables are used in testing conditions, such as
the following:

Dim failure As Boolean = False
' other statements ..
If failure Then MsgBox(”Couldn't complete the operation”)

They are also combined with the logical operators And, Or, Not, and Xor. The Not operator
toggles the value of a Boolean variable. The following statement is a toggle:

running = Not running

If the variable running is True, it’s reset to False and vice versa. This statement is a shorter
way of coding the following:

Dim running As Boolean
If running = True Then
running = False

Else
running = True
End If

Boolean operators operate on Boolean variables and return another Boolean as their result.
The following statements will display a message if one (or both) of the variables ReadOnly and
Hidden are True (in the following example, the ReadOnly and Hidden variables might represent
the corresponding attributes of a file):

If ReadOnly Or Hidden Then
MsgBox(“Couldn't open the file”)
Else
' statements to open and process file..
End If

The condition of the If statement combines the two Boolean values with the Or operator. If
one or both of them are True, the final expression is True.

STRING VARIABLES

The String data type stores only text, and string variables are declared as follows:

Dim someText As String
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You can assign any text to the variable someText. You can store nearly 2 GB of text in a
string variable (that’s 2 billion characters, and it’s much more text than you care to read on a
computer screen). The following assignments are all valid:

Dim aString As String
aString = "Now is the time for all good men to come
"to the aid of their country”

"

aString ="
aString = "There are approximately 25,000 words in this chapter”
aString = ”25,000”

The second assignment creates an empty string, and the last one creates a string that just
happens to contain numerals, which are also characters. The difference between these two vari-
ables is that they hold different values:

Dim aNumber As Integer = 25000
Dim aString As String = ”25,000”

The aString variable holds the characters 2, 5, comma, 0, 0, and 0, and aNumber holds a
single numeric value. However, you can use the variable aString in numeric calculations and
the variable aNumber in string operations. VB will perform the necessary conversions as long
as the Strict option is off. In general, you should turn on the Strict option because it will help
you catch possible runtime errors, as discussed in the section “The Strict, Explicit, and Infer
Options.” The recommended practice is to convert strings to numbers and numbers to strings
explicitly as needed using the methods discussed in the section ““Converting Variable Types,”
later in this chapter. Even if you prefer to work with the Strict option off, which is the default
value, it’s recommended that you turn it on temporarily to spot any areas in your code that
might cause runtime errors.

CHARACTER VARIABLES

Character variables store a single Unicode character in two bytes. In effect, characters are
Unsigned Short integers (UInt16), but the Framework provides all the tools you need to work
with characters without having to resort to their numeric values (a very common practice for
the older among us).

To declare a Character variable, use the Char data type:

Dim charl, char2 As Char

You can initialize a Char variable by assigning either a character or a string to it. In the latter
case, only the first character of the string is assigned to the variable. The following statements
will print the characters a and A to the Output window:

Dim charl As Char = ”a”, char2 As Char = "ABC”
Debug.WriteLine(charl)
Debug.WriteLine(char2)
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These statements will work only if the Strict option is off. If it's on, the values assigned to
the charl and char2 variables will be marked in error and the code will not compile. To fix
the error, change the Dim statement as follows:

Dim charl As Char = ”"a’c, char2 As Char = "A’c

(This tells the compiler to treat the values of the variables as characters, not strings.) When the
Strict option is on, you can’t assign a string to a Char variable and expect that only the first
character of the string will be used.

UNICODE OR ANSI

The Integer values that correspond to the English characters are the ANSI (American National
Standards Institute) codes of the equivalent characters. The following statement will print the
value 65:

Debug.WriteLine(Convert.ToInt32("a"))

If you convert the Greek character alpha («) to an integer, its value is 945. The Unicode value
of the famous character 7 is 960. Unicode and ANSI values for English characters are the same,
but all “foreign” characters have a unique Unicode value.

Character variables are used in conjunction with strings. You'll rarely save real data as char-
acters. However, you might have to process the individual characters in a string, one at a time.
Let’s say the string variable password holds a user’s new password, and you require that pass-
words contain at least one special symbol. The code segment of Listing 2.2 scans the password
and rejects it if it contains letters and digits only.

LISTING 2.2: Processing individual characters

Dim password As String, ch As Char
Dim i As Integer
Dim valid As Boolean = False
While Not valid
password = InputBox(”Please enter your password”)
For i = 0 To password.Length - 1
ch = password.Chars(i)
If Not Char.IsLetterOrDigit(ch) Then
valid = True
Exit For
End If
Next
If valid Then
MsgBox(”You new password will be activated immediately! ")
Else
MsgBox(”Your password must contain at Teast one special symbol! ")
End If
End While
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If you are not familiar with the If..Then, For..Next, or While..End WhiTe structures, you can
read their descriptions in the following chapter.

The code prompts the user with an input box to enter a password. The valid variable is
Boolean and it’s initialized to False. (You don’t have to initialize a Boolean variable to False
because this is its default initial value, but it does make the code easier to read.) It’s set to True
from within the body of the loop only if the password contains a character that is not a letter or
a digit. We set it to False initially, so the WhiTe..End While loop will be executed at least once.
This loop will keep prompting the user until a valid password is entered.

The For..Next loop scans the string variable password, one letter at a time. At each iteration,
the next letter is copied into the ch variable. The Chars property of the String data type is an
array that holds the individual characters in the string (another example of the functionality
built into the data types).

Then the program examines the current character. The IsLetterOrDigit method of the
Char data type returns True if a character is either a letter or a digit. If the current character
is a symbol, the program sets the valid variable to True so that the outer loop won't be exe-
cuted again, and it exits the For..Next loop. Finally, it prints the appropriate message and either
prompts for another password or quits.

DATE VARIABLES

Date variables store date values that may include a time part (or not), and they are declared
with the Date data type:

Dim expiration As Date

The following are all valid assignments:

expiration = #01/01/2010#
expiration = #8/27/1998 6:29:11 PM#
expiration = “July 2, 2011”
expiration = Today()

Now AND TODAY

By the way, the Today() function returns the current date and time, while the Now() function
returns the current date. You can also retrieve the current date by calling the Today property
of the Date data type: Date.Today.

The pound sign tells Visual Basic to store a date value to the expiration variable, just as
the quotes tell Visual Basic that the value is a string. You can store a date as a string to a Date
variable, but it will be converted to the appropriate format.

The format of the date inside the pound characters is determined by the regional settings
(found in Control Panel). In the United States, the format is mm/dd/yy. (In other countries, the
format is dd/mm/yy.) If you assign an invalid date to a Date variable, such as 23/04/2012, the
statement will be underlined and an error message will appear in the Task List window. The
description of the error is Date constant is not valid.

You can also perform arithmetic operations with date values. VB recognizes your inten-
tion to subtract dates and it properly evaluates their difference. The result is a TimeSpan
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object, which represents a time interval. If you execute the following statements, the value
638.08:49:51.4970000 will appear in the Output window:

Dim d1, d2 As Date
dl = Now
d2 = #1/1/2004#Debug.WriteLine(dl - d2)

The value of the TimeSpan object represents an interval of 638 days, 8 hours, 49 minutes,

and 51.497 seconds.

CONVERTING BETWEEN LOCALES

In a global environment like ours, handling dates has gotten a bit complicated. If you live in
the United States and you receive a data file that includes dates from a company in the United
Kingdom, you should take into consideration the locale of the computer that generated the
file. To specify the locale of a date value, use the Parse method of the DateTime class, which
accepts two arguments: the date to be parsed and a CultureInfo object that represents the
date’s locale. (If you find this tip too advanced on first reading, please make a note and look it
up when you have to deal with dates in different cultures).

The date 25/12/2011 is a valid UK date, but if you attempt to assign this value to a Date
variable (assuming that your computer’s locale is English-US), the statement will generate an
error. To convert the date to US format, create a CultureInfo that represents the locale of
the original date:

Dim UK As New CultureInfo("en-GB")

Then call the DateTime.Parse method, as follows, to convert the date value to a valid date:

Dim D1 As Date
D1 = DateTime.Parse("25/12/2011", UK)

The following code segment compares two dates with different locales to one another and
prints an appropriate message that indicates whether the two dates are equal (in this example,
they are):

Dim D1, D2 As Date
Dim UK As New CultureInfo("en-GB")
Dim US As New CultureInfo("en-US")
D1 = DateTime.Parse("27/8/2010", UK)
D2 = DateTime.Parse("'8/27/2010", US)
If D1 = D2 Then

MsgBox("Same date")
Else

MsgBox("Different dates")
End If

Dates like 3/4/2025 or 4/3/2025 are valid in any culture, but they may not be correct unless
you interpret them with the proper locale, so be careful when importing dates. You can look
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up the locales of other countries in the documentation. For example, fr-FR is France’s French
locale, fr-BE is Belgium’s French locale, and fr-CH is Switzerland’s French locale. For Switzer-
land, a culturally diverse place, there’s also a German locale, the de-CH locale. The problem of
locales is also addressed by XML, which is the definitive standard for data exchange, and it’s
discussed later in this book in Chapter 13, “XML in Modern Programming,” and Chapter 14,
“Introduction to LINQ.”

You’ll face a similar issue with formatted numeric values because some locales use the period
as the decimal separator while others use it as a separator for thousands. The two formatted
values 19,000.99 and 19.000,99 are valid in different cultures, but they’re not the same at
once. To properly convert these formatted numbers, use the Parse method of the Decimal or
Double class, passing as argument the string to be parsed and the locale of the original value
(the US locale for 19,999.99 and the UK locale for 19,999.99). Again, examine the following
statements that convert these two formatted numeric strings into numeric values, taking into
consideration the proper locale. The statements are equivalent to the ones 1 showed you earlier
for handling dates. For this example, I’ll use the Italian language locale; that locale uses the
period as the thousands separator and the coma as the decimal separator.

Dim vall, val2 As Decimal
Dim IT As New CultureInfo("it-IT")
Dim US As New CultureInfo("en-US")
vall = System.Decimal.Parse("19,999.99", IT)
val2 = System.Decimal.Parse("19,999.99", US)
If vall = val2 Then
MsgBox("Same values")
Else
MsgBox("Different values")
End If

Many developers try to remove the thousands separator(s) from the formatted number and
then replace the period with a coma (or vice versa). Use the technique shown here; it will
work regardless of the current locale and it’s so much easier to read and so much safer.

The Strict, Explicit, and Infer Options

The Visual Basic compiler provides three options that determine how it handles variables:
¢ The Explicit option indicates whether you will declare all variables.
¢ The Strict option indicates whether all variables will be of a specific type.

¢ The Infer option indicates whether the compiler should determine the type of a variable
from its value.

These options have a profound effect on the way you declare and use variables, and you
should understand what they do. By exploring these settings, you will also understand a little
better how the compiler handles variables. It’s recommended that you turn on all three, but old
VB developers may not want to follow this advice.

VB 2010 doesn’t require that you declare your variables, but the default behavior is to
throw an exception if you attempt to use a variable that hasn’t been previously declared. If an
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undeclared variable’s name appears in your code, the editor will underline the variable’s name
with a wiggly line, indicating that it caught an error. The description of the error will appear
in the Task List window below the code window. If you rest the cursor over the segment in
question, you will see the description of the error in a ToolTip box.

To change the default behavior, you must insert the following statement at the beginning of
the file:

Option Explicit Off

The Option Explicit statement must appear at the very beginning of the file. This setting
affects the code in the current module, not in all files of your project or solution. You can turn
on the Strict (as well as the Explicit) option for an entire solution. Open the project’s proper-
ties page (right-click the project’s name in Solution Explorer and select Properties), select the
Compile tab, and set the Strict and Explicit options accordingly, as shown in Figure 2.1.
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You can also set default values for the Explicit option (as well as for Strict and Infer) for all
projects through the Options dialog box of the IDE (Integrated Development Environment). To
open this dialog box, choose the Options command from the Tools menu. When the dialog box
appears, select the VB Defaults tab under Projects And Solutions, as shown in Figure 2.2. Here
you can set the default values for all four options. You can still change the default values for
specific projects through the project’s properties pages.

The way undeclared variables are handled by VB 2010 is determined by the Explicit and
Strict options, which can be either on or off. The Explicit option requires that all variables
used in the code are declared before they're used. The Strict option requires that variables are
declared with a specific type. In other words, the Strict option disallows the use of generic
variables that can store any data type.

The default value of the Explicit statement is On. This is also the recommended value, and
you should not make a habit of changing this setting. By setting the Explicit option to Off,
you're telling VB that you intend to use variables without declaring them. As a consequence,
VB can’t make any assumption about the variable’s type, so it uses a generic type of variable
that can hold any type of information. These variables are called Object variables, and they're
equivalent to the old variants.
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While the option Explicit is set to Off, every time Visual Basic runs into an undeclared vari-
able name, it creates a new variable on the spot and uses it. Visual Basic adjusts the variable’s
type according to the value you assign to it. With Explicit turned off, create two variables, varl
and var2, by referencing them in your code with statements like the following ones:

varl
var2

"Thank you for using Fabulous Software”
49.99

The varl variable is a string variable, and var2 is a numeric one. You can verify this with
the GetType method, which returns a variable’s type. The following statements print the high-
lighted types shown below each statement:

Debug.WriteLine ”"Variable varl is ” & varl.GetType().ToString
Variable varl is System.String
Debug.WriteLine "Variable var2 is ” & var2.GetType().ToString
Variable var2 is System.Double

Later in the same program, you can reverse the assignments:

varl = 49.99
var2 = "Thank you for using Fabulous Software”

If you execute the preceding type-checking statements again, you'll see that the types of the
variables have changed. The varl variable is now a Double, and var?2 is a String. The type of
a generic variable is determined by the variable’s contents, and it can change in the course of
the application. Of course, changing a variable’s type at runtime doesn’t come without a per-
formance penalty (a small one, but nevertheless some additional statements must be executed).
Another related option is the Strict option, which is off by default. The Strict option tells
the compiler whether the variables should be strictly typed. A strictly typed (or strongly typed)
variable must be declared with a specific type and it can accept values of the same type only.
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With the Strict option set to Off, you can use a string variable that holds a number in a numeric
calculation:

Dim a As String = ”25000”
Debug.WriteLine a / 2

The last statement will print the value 12500 in the Immediate window. Likewise, you can use
numeric variables in string calculations:

Dim a As Double = 31.03
a=a+ "1

After the execution of the preceding statements, the a variable will still be a Double and will
have the value 32.03. If you turn the Strict option on by inserting the following statement at the
beginning of the file, you won’t be able to mix and match variable types:

Option Strict On

If you attempt to execute any of the last two code segments while the Strict option is on, the
editor will underline a segment of the statement to indicate an error. If you rest the cursor over
the underlined segment of the code, the following error message will appear in a tip box:

Option strict disallows implicit conversions from String to Double

or any type conversion is implied by your code.

When the Strict option is set to On, the compiler will allow some implicit conversions
between data types, but not always. For example, it will allow you to assign the value of an
integer to a Long, but not the opposite. The Long value might exceed the range of values that
can be represented by an Integer variable.

TYPE INFERENCE

One of the trademark features of BASIC, including earlier versions of Visual Basic, was the abil-
ity to use variables without declaring them. It has never been a recommended practice, yet VB
developers loved it. This feature is coming back to the language, only in a safer manner. VB
2010 allows you to declare variables by assigning values to them. The compiler will infer the
type of the variable from its value and will create a variable of the specific type behind the
scenes. The following statement creates an Integer variable:

Dim count = 2999

Behind the scenes, the compiler will create a typed variable with the following statement:

Dim count As Integer = 2999

To request the variable’s type, use the GetType method. This method returns a Type object,
which represents the variable’s type. The name of the type is given by the ToString property.

The following statement will print the highlighted string in the Immediate window:

Debug.WriteLine(count.GetType.ToString)
System.Int32
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The count variable is of the Integer type (the 32-bit integer variety, to be precise). If you
attempt to assign a value of a different type, such as a date, to this variable later in your code,
the editor will underline the value and generate a warning like this: Value of type ‘Date’ can-
not be converted to Integer. The compiler has inferred the type of the value assigned initially to
the variable and created a variable of the same type. That’s why subsequent statements can’t
change the variable’s type. Behind the scenes, the compiler will actually insert a Dim statement,
as if you had declared the variable explicitly.

If the Infer option is off, the compiler will handle variables declared without a specific type
depending on the Strict option. If the Strict option is off, the compiler will create an Object vari-
able, which can store any value, even values of different types in the course of the application.
If the Strict option is on, the compiler will reject the declaration; it will underline the variable’s
name with a wiggly line and generate the following warning: Option Strict On requires all vari-
able declarations to have an As clause.

Object Variables

Variants — variables without a fixed data type — were the bread and butter of VB programmers
up to version 6. Variants are the opposite of strictly typed variables: They can store all types of
values, such as integers, strings, characters, you name it. If you're starting with VB 2010, you
should use strongly typed variables. However, variants are a major part of the history of VB,
and most applications out there (the ones you may be called to maintain) use them. I will discuss
variants briefly in this section and show you what was so good (and bad) about them.

Variants, or object variables, are the most flexible data type because they can accommodate
all other types. A variable declared as Object (or a variable that hasn’t been declared at all) is
handled by Visual Basic according to the variable’s current contents. If you assign an integer
value to an object variable, Visual Basic treats it as an integer. If you assign a string to an object
variable, Visual Basic treats it as a string. Variants can also hold different data types in the course
of the same program. Visual Basic performs the necessary conversions for you.

To declare a variant, you can turn off the Strict option and use the Dim statement without
specifying a type, as follows:

Dim myVar

You can use object variables in both numeric and string calculations. Suppose that the vari-
able modemSpeed has been declared as Object with one of the following statements:

Dim modemSpeed " with Option Strict = Off
Dim modemSpeed As Object ' with Option Strict = On

Later in your code, you assign the following value to it:

modemSpeed = "28.8"
You can treat the modemSpeed variable as a string and use it in statements such as the
following:

MsgBox “We suggest a ” & modemSpeed & ” modem.”

This statement displays the following message:

"We suggest a 28.8 modem.”
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You can also treat the modemSpeed variable as a numeric value, as in the following
statement:

Debug.WriteLine "A ” & modemSpeed & ” modem can transfer ” &
modemSpeed * 1024 / 8 & ” bytes per second.”

This statement displays the following message:

"A 28.8 modem can transfer 3686.4 bytes per second.”

The first instance of the modemSpeed variable in the preceding statement is treated as a string
because this is the variant’s type according to the assignment statement (we assigned a string
to it). The second instance, however, is treated as a number (a single-precision number). The
compiler sees that it’s used in a numeric calculation and converts it to a double value before
using it.

Another example of this behavior of variants can be seen in the following statements:

Dim I, S
I=10
S = 11"

Debug.WriteLine(I + S)
Debug.WriteLine(I & S)

The first WriteLine statement will display the numeric value 21, whereas the second state-
ment will print the string 1011. The plus operator (+) tells VB to add two values. In doing so,
VB must convert the two strings into numeric values and then add them. The concatenation
operator (&) tells VB to concatenate the two strings.

Visual Basic knows how to handle object variables in a way that makes sense. The
result may not be what you had in mind, but it certainly is dictated by common sense. If
you really want to concatenate the strings 10 and 11, you should use the concatenation
operator (&), which tells Visual Basic exactly what to do. Quite impressive, but for many
programmers, this is a strange behavior that can lead to subtle errors — and they avoid it.
Keep in mind that if the value of the S variable were the string Al, then the code would
compile fine but would crash at runtime. And this is what we want to avoid at all costs: an
application that compiles without warnings but crashes at runtime. Using strongly typed
variables is one of the precautions you can take to avoid runtime errors. Keep in mind that
a program that prompts users for data, or reads it from a file, may work for quite a while,
just because it’s reading valid data, and crash when it encounters invalid data. It’s up to
you to decide whether to use variants and how far you will go with them. Sure, you can
perform tricks with variants, but you shouldn’t overuse them to the point that others can’t read
your code.

Variables as Objects

Variables in Visual Basic are more than just names or placeholders for values. They’re intelli-
gent entities that can not only store but also process their values. I don’t mean to scare you,
but I think you should be told: VB variables are objects. And here’s why: A variable that holds
dates is declared as such with the following statement:

Dim expiration As Date



VARIABLES AS OBJECTS

To assign a date value to the expiration variable, use a statement like this:

expiration = #1/1/2003#

So far, nothing out of the ordinary; this is how we always used variables, in most languages.
In addition to holding a date, however, the expiration variable can manipulate dates. The
following expression will return a new date that’s three years ahead of the date stored in the
expiration variable:

expiration.AddYears(3)

The AddYears method returns a new date, which you can assign to another date variable:

Dim newExpiration As Date
newExpiration = expiration.AddYears(3)

AddYears is a method that knows how to add a number of years to a Date variable. By
adding a number of years (or months, or days) to a date, we get back another date. The method
will take into consideration the number of days in each month and the leap years, which is a
totally nontrivial task if we had to code it ourselves. There are similarly named methods for
adding months, days, and so on. In addition to methods, the Date type exposes properties, such
as the Month and Day properties, which return the date’s month and day number, respectively.
The keywords following the period after the variable’s name are called methods and properties,
just like the properties and methods of the controls you place on a form to create your appli-
cation’s visual interface. The methods and properties (or the members) of a variable expose the
functionality that’s built into the class representing the variable itself. Without this built-in func-
tionality, you'd have to write some serious code to extract the month from a date variable, to
add a number of days to a given date, to figure out whether a character is a letter or a digit or
a punctuation symbol, and so on. Much of the functionality that you’ll need in an application
that manipulates dates, numbers, or text has already been built into the variables themselves.

Don’t let the terminology scare you. Think of variables as placeholders for values and access
their functionality with expressions like the ones shown earlier. Start using variables to store
values, and if you need to process them, enter a variable’s name followed by a period to see
a list of the members it exposes. In most cases, you'll be able to figure out what these mem-
bers do by just reading their names. I'll come back to the concept of variables as objects, but I
wanted to hit it right off the bat. A more detailed discussion of the notion of variables as objects
can be found in Chapter 8, “Working with Objects,” which discusses objects in detail.

BASIC DATA TYPES VERSUS OBJECTS

Programming languages can treat simple variables much more efficiently than they treat objects.
An integer takes two bytes in memory, and the compiler will generate very efficient code to
manipulate an integer variable (add it to another numeric value, compare it to another integer,
and so on). If you declare an integer variable and use it in your code as such, Visual Basic
doesn’t create an object to represent this value. It creates a new variable for storing integers,
like good old BASIC. After you call one of the variable’s methods, the compiler emits code to
create the actual object. This process is called boxing, and it introduces a small delay, which is
truly insignificant compared to the convenience of manipulating a variable through its methods.
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As you've seen by now, variables are objects. This shouldn’t come as a surprise, but it’s an
odd concept for programmers with no experience in object-oriented programming. We haven’t
covered objects and classes formally yet, but you have a good idea of what an object is. It’s
an entity that exposes some functionality by means of properties and methods. The TextBox
control is an object and it exposes the Text property, which allows you to read or set the text
on the control. Any name followed by a period and another name signifies an object. The name

after the period is a property or method of the object.

Converting Variable Types

In many situations, you will need to convert variables from one type into another. Table 2.3
shows the methods of the Convert class that perform data-type conversions.

TABLE 2.3:
METHOD
ToBoolean
ToByte
ToChar
ToDateTime
ToDecimal
ToDoubTe
ToIntl6
ToInt32
ToInt64
ToSByte
CShort
ToSingle
ToString
ToUIntl6
ToUInt32

ToUInt64

The data-type conversion methods of the Convert class

CONVERTS ITS ARGUMENT TO

Boolean

Byte

Unicode character

Date

Decimal

Double

Short Integer (2-byte integer, Int16)
Integer (4-byte integer, Int32)

Long (8-byte integer, Int64)

Signed Byte

Short (2-byte integer, Int16)

Single

String

Unsigned Integer (2-byte integer, Int16)
Unsigned Integer (4-byte integer, Int32)

Unsigned Long (8-byte integer, Int64)
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In addition to the methods of the Convert class, you can still use the data-conversion func-
tions of VB (CInt() to convert a numeric value to an Integer, CDb1() to convert a numeric
value to a Double, CSng() to convert a numeric value to a Single, and so on), which you can
look up in the documentation. If you're writing new applications in VB 2010, use the new Con-
vert class to convert between data types.

To convert the variable initialized as

Dim A As Integer

to a Double, use the ToDouble method of the Convert class:

Dim B As Double
B = Convert.ToDouble(A)

Suppose you have declared two integers, as follows:

Dim A As Integer, B As Integer
A =23
B =7

The result of the operation A / B will be a Double value. The statement

Debug.Write(A / B)

displays the value 3.28571428571429. The result is a Double value, which provides the greatest
possible accuracy. If you attempt to assign the result to a variable that hasn’t been declared as
Double and the Strict option is on, the editor will generate an error message. No other data
type can accept this value without loss of accuracy. To store the result to a Single variable, you
must convert it explicitly with a statement like the following;:

Dim C As Single = Convert.ToSingle(A / B)

You can also use the DirectCast() function to convert a variable or expression from one
type to another. The DirectCast() function is identical to the CType() function. Let’s say the
variable A has been declared as String and holds the value 34.56. The following statement con-
verts the value of the A variable to a Decimal value and uses it in a calculation:

Dim A As String = "34.56"
Dim B As Double
B = DirectCast(A, Double) / 1.14

The conversion is necessary only if the Strict option is on, but it’s a good practice to perform
your conversions explicitly. The following section explains what might happen if your code
relies on implicit conversions.
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WIDENING AND NARROWING CONVERSIONS

In some situations, VB 2010 will convert data types automatically, but not always. Let’s say
you have declared and initialized two variables, an Integer and a Double, with the following
statements:

Dim count As Integer = 99
Dim pi As Double = 3.1415926535897931

If the Strict option is off and you assign the variable p7 to the count variable, the count vari-
able’s new value will be 3. (The Double value will be rounded to an Integer value, according to
the variable’s type.) Although this may be what you want, in most cases it's an oversight that
will lead to incorrect results.

If the Strict option is on and you attempt to perform the same assignment, the compiler will
generate an error message to the effect that you can’t convert a Double to an Integer. The exact
message is Option Strict disallows implicit conversions from Double to Integer.

When the Strict option is on, VB 2010 will allow conversions that do not result in loss of
accuracy (precision) or magnitude. These conversions are called widening conversions. When you
assign an Integer value to a Double variable, no accuracy or magnitude is lost. This is a widen-
ing conversion because it goes from a narrower to a wider type and will therefore be allowed
when Strict is on.

On the other hand, when you assign a Double value to an Integer variable, some accuracy
could be lost (the decimal digits may be truncated). This is a narrowing conversion because we
go from a data type that can represent a wider range of values to a data type that can represent
a narrower range of values. With the Strict option on, such a conversion will not be allowed.

Because you, the programmer, are in control, you might want to give up the
accuracy — presumably, it’s no longer needed. Table 2.4 summarizes the widening conversions
that VB 2010 will perform for you automatically.

TABLE 2.4: VB 2010 widening conversions
ORIGINAL DATA TYPE WIDER DATA TYPE
Any type Object
Byte Short, Integer, Long, Decimal, Single, Double
Short Integer, Long, Decimal, Single, Double
Integer Long, Decimal, Single, Double
Long Decimal, Single, Double
Decimal Single, Double
Single Double
Double None

Char String
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If the Strict option is on, the compiler will point out all the statements that may cause run-
time errors and you can reevaluate your choice of variable types. Even if you're working with
the Strict option off, you can turn it on momentarily to see the compiler’s warnings and then
turn it off again.

Formatting Numbers

So far, you've seen how to use the basic data types. Let me digress here for a moment and
mention that the basic data types are no longer part of the language (Visual Basic or C#).
They're actually part of the Common Language Runtime (CLR), which is a basic component
of Visual Studio (actually, it’s the core of Visual Studio and it’s shared by all languages that
can be used with Visual Studio). You can treat this note as fine print for now, but don’t be
surprised when you read in the documentation that the basic data types are part of the CLR.
All data types expose a ToString method, which returns the variable’s value (a number or
date) as a string so that it can be used with other strings in your code. The ToString method
formats numbers and dates in many ways, and it’s probably one of the most commonly used
methods. You can call the ToString method without any arguments, as we have done so far,
to convert any value to a string. With many types, the ToString method, however, accepts an
optional argument, which determines how the value will be formatted as a string. For example,
you can format a number as currency by prefixing it with the appropriate symbol (such as the
dollar symbol) and displaying it with two decimal digits, and you can display dates in many
formats. Some reports require that negative amounts are enclosed in parentheses. The ToString
method allows you to display numbers and dates, and any other type, in any way you wish.
Notice that ToString is a method, not a property. It returns a value that you can assign to
a string variable or pass as arguments to a function such as MsgBox(), but the original value is
not affected. The ToString method can also format a value if called with an optional argument:

ToString(formatString)

The formatString argument is a format specifier (a string that specifies the exact format to be
applied to the variable). This argument can be a specific character that corresponds to a pre-
determined format (a standard format string, as it’s called) or a string of characters that have
special meaning in formatting numeric values (a picture format string). Use standard format
strings for the most common formatting options, and use picture strings to specify unusual for-
matting requirements. To format the value 9959.95 as a dollar amount, you can use the C format
specifier, which stands for Currency:

Dim Amnt As Single = 9959.95
Dim strAmnt As String
strAmnt = Amnt.ToString("C”)

Or use the following picture numeric format string:
strAmnt = Amnt.ToString(”$#,###.00”)

Both statements will format the value as $9,959.95. If you're using a non-U.S. version of
Windows, the currency symbol will change accordingly. If you're in the United States, use
the Regional And Language Options tool in Control Panel to temporarily change the current
culture to a European one and the amount will be formatted with the Euro sign.
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The picture format string is made up of literals and characters that have special meaning
in formatting. The dollar sign has no special meaning and will appear as is. The # symbol is
a digit placeholder; all # symbols will be replaced by numeric digits, starting from the right.
If the number has fewer digits than specified in the string, the extra symbols to the left will
be ignored. The comma tells the ToString method to insert a comma between thousands. The
period is the decimal point, which is followed by two more digit placeholders. Unlike the #
sign, the 0 is a special placeholder: If there are not enough digits in the number for all the zeros
you've specified, a 0 will appear in the place of the missing decimal digits. If the original value
had been 9959.9, for example, the last statement would have formatted it as $9,959.90. If you
used the # placeholder instead, the string returned by the ToString method would have a sin-
gle decimal digit.

STANDARD NUMERIC FORMAT STRINGS

The ToString method of the numeric data types recognizes the standard numeric format
strings shown in Table 2.5.

The format character can be followed by an integer. If present, the integer value specifies the
number of decimal places that are displayed. The default accuracy is two decimal digits.

TABLE 2.5: Standard numeric format strings

FORMAT DESCRIPTION EXAMPLE

CHARACTER

Corc Currency (12345.67).ToString(”’C") returns $12,345.67.

Dord Decimal (123456789) .ToString(”D”) returns
123456789. It works with integer values only.

Eore Scientific format (12345.67).ToString(”"E”) returns 1.234567E
+ 004.

Forf Fixed-point format (12345.67).ToString("F”) returns 12345.67.

Gorg General format Returns a value either in fixed-point or scientific
format.

Norn Number format (12345.67).ToString(”N”) returns 12,345.67.

Porp Percentage (0.12345).ToString(”N”) returns 12.35%.

Rorr Round-trip (1/ 3).ToString(”R”) returns

0.33333333333333331 (where the G specifier
would return a value with fewer decimal digits:

0.333333333333333)-

X or x Hexadecimal format 250.ToString(”X”) returns FA.
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The C format string causes the ToString method to return a string representing the num-
ber as a currency value. An integer following the C determines the number of decimal digits
that are displayed. If no number is provided, two digits are shown after the decimal sepa-
rator. Assuming that the variable value has been declared as Decimal and its value is 5596,
then the expression value.ToString(”C”) will return the string $5,596.00. If the value of the
variable were 5596.4499, then the expression value.ToString(”C3"”) would return the string
$5,596.450. Also note that the C format string formats negative amounts in a pair of parenthe-
ses, as is customary in business applications.

Notice that not all format strings apply to all data types. For example, only integer values can
be converted to hexadecimal format, and the D format string works with integer values only.

PICTURE NUMERIC FORMAT STRINGS

If the format characters listed in Table 2.5 are not adequate for the control you need over the
appearance of numeric values, you can provide your own picture format strings. Picture for-
mat strings contain special characters that allow you to format your values exactly as you like.
Table 2.6 lists the picture formatting characters.

TABLE 2.6: Picture numeric format strings

FORMAT CHARACTER

0

%

E+0,E-0,e+0,e—-0

nn

DESCRIPTION
Display zero
placeholder
Display digit
placeholder

Decimal point

Group separator

Percent notation

Exponent notation

Literal character

Literal string

Section separator

EFFECT
Results in a nonsignificant zero if a
number has fewer digits than there are

zeros in the format

Replaces the symbol with only
significant digits

Displays a period (.) character

Separates number groups — for
example, 1,000

Displays a % character

Formats the output of exponent
notation

Used with traditional formatting
sequences such as \n (newline)

Displays any string within single or
double quotation marks literally

Specifies different output if the
numeric value to be formatted is
positive, negative, or zero
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The following statements will print the highlighted values:

Dim Amount As Decimal = 42492.45
Debug.WriteLine(Amount.ToString(”$#,###.00”))

$42,492.45

Amount = 0.2678

Debug.WriteLine(Amount.ToString(”0.000"))

0.268

Amount = -24.95
Debug.WriteLine(Amount.ToString(”$#,###.00; ($#,###.00)"))
($24.95)

User-Defined Data Types

In the previous sections, we used variables to store individual values (or scalar values, as
they’re called). As a matter of fact, most programs store sets of data of different types. For
example, a program for balancing your checkbook must store several pieces of information for
each check: the check’s number, amount, date, and so on. All these pieces of information are
necessary to process the checks, and ideally, they should be stored together.

What we need is a variable that can hold multiple related values of the same or different
type. You can create custom data types that are made up of multiple values using Structures.
A Structure allows you to combine multiple values of the basic data types and handle them as
a whole. For example, each check in a checkbook-balancing application is stored in a separate
Structure (or record), as shown in Figure 2.3. When you recall a given check, you need all the
information stored in the Structure.

FIGURE 2.3 Record Structure

Pictorial representation [ Check Number | Check Date | Check Amount | Check Paid To |
of a structure

Array of Records

275 11/04/2010 104.25 Gas Co.
276 11/09/2010 48.76 Books
277 11/12/2010 200.00 VISA
278 11/21/2010 631.50 Rent

To define a Structure in VB 2010, use the Structure statement, which has the following syn-
tax:

Structure structureName
Dim variablel As varType
Dim variable2 As varType

Dim variablen As varType
End Structure

varType can be any of the data types supported by the CLR or the name of another Structure
that has been defined already. The Dim statement can be replaced by the Private or Public
access modifiers. For Structures, Dim is equivalent to PubTic.
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After this declaration, you have in essence created a new data type that you can use in your
application. structureName can be used anywhere you’d use any of the base types (Integers,
Doubles, and so on). You can declare variables of this type and manipulate them as you manip-
ulate all other variables (with a little extra typing). The declaration for the CheckRecord Struc-
ture shown in Figure 2.3 is as follows:

Structure CheckRecord
Dim CheckNumber As Integer
Dim CheckDate As Date
Dim CheckAmount As Single
Dim CheckPaidTo As String
End Structure

This declaration must appear outside any procedure; you can’t declare a Structure in a sub-
routine or function. Once declared, the CheckRecord Structure becomes a new data type for
your application.

To declare variables of this new type, use a statement such as this one:

Dim checkl As CheckRecord, check2 As CheckRecord

To assign a value to one of these variables, you must separately assign a value to each one
of its components (they are called fields), which can be accessed by combining the name of the
variable and the name of a field separated by a period, as follows:

checkl.CheckNumber = 275

Actually, as soon as you type the period following the variable’s name, a list of all members
to the CheckRecord Structure will appear, as shown in Figure 2.4. Notice that the Structure
supports a few members on its own. You didn’t write any code for the Equals, GetType,
and ToString members, but they’re standard members of any Structure object, and you can
use them in your code. Both the GetType and ToString methods will return a string like
ProjectName.FormName + CheckRecord. You can provide your own implementation of the
ToString method, which will return a more meaningful string:

Public Overrides Function ToString() As String
Return "CHECK # ” & CheckNumber & ” FOR ” & CheckAmount.ToString(”C”)
End Function

I haven’t discusses the Overrides keyword yet; it tells the compiler to override the default
implementation of the ToString method. For the time being, use it as shown here to create
your custom ToString method. This, as well as other object-related terms, are discussed in
detail in Chapter 8.

As you understand, Structures are a lot like objects that expose their fields as properties and
then expose a few members of their own. The following statements initialize a variable of the
CheckRecord type:

check2.CheckNumber = 275
check2.CheckDate = #09/12/2010#
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check2.CheckAmount = 104.25
check2.CheckPaidTo = "Gas Co.”

FIGURE 2.4
Variables of custom
types expose their mem- T Structure Checke

b . Dim Checkbumber As Integer
ers as properties. Dim CheckDate As Dale

Uim Checkamount As Single
Uim CheckPaidle As String
Lrnd SEructurs

“Publie €Lass

L |
Private sub Buttonl Click({byval sender As System.Dbject

Byval & As System.Llventargs) Mandles Butto
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cheelkl,

ek
¥ CheckDaze
@ CheckNumber

¥ CheckPaidio

Erd Sub
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¥ Egquals

¥ CetiashCode
% GetType

W Referencelquals
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Examining Variable Types

Besides setting the types of variables and the functions for converting between types, Visual
Basic provides the GetType method. GetType returns a string containing the name of the vari-
able type (Int32, Decimal, and so on). All variables expose this method automatically, and you
can call it like this:

Dim var As Double
Debug.WriteLine "The variable's type is ” & var.GetType.ToString

There’s also a GetType operator, which accepts as an argument a type and returns a Type
object for the specific data type. The GetType method and GetType operator are used mostly in
If structures, like the following one:

If var.GetType() Is GetType(Double) Then
' code to handle a Double value
End If

Notice that the code doesn’t reference data type names directly. Instead, it uses the value
returned by the GetType operator to retrieve the type of the class System.Double and then
compares this value to the variable’s type with the Is (or the IsNot) keyword. If you attempt
to express this comparison with the equals operator (=), the editor will detect the error and
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suggest that you use the Is operator. This syntax is a bit arcane for BASIC developers; just
make a note, and when you need to find out a variable’s type in your application, use it
as is.

Is IT A NUMBER, STRING, OR DATE?

Another set of Visual Basic functions returns variable data types, but not the exact type. They

return a True/False value indicating whether a variable holds a numeric value, a date, or an
array. The following functions are used to validate user input, as well as data stored in files,
before you process them.

IsNumeric() Returns True if its argument is a number (Short, Integer, Long, Single, Double,

Decimal). Use this function to determine whether a variable holds a numeric value before
passing it to a procedure that expects a numeric value or before processing it as a number.
The following statements keep prompting the user with an InputBox for a numeric value.
The user must enter a numeric value or click the Cancel button to exit. As long as the user
enters non-numeric values, the InputBox keeps popping up and prompting for a numeric
value:

Dim strAge as String = ""
Dim Age As Integer
While Not IsNumeric(strAge)
strAge = InputBox("lease enter your age")
End While
Age = Convert.ToIntl6(strAge)

The variable strAge is initialized to a non-numeric value so that the While..End While loop
will be executed at least once.

IsDate() Returns True if its argument is a valid date (or time). The following expressions
return True because they all represent valid dates:

IsDate(#10/12/2010#)
IsDate("10/12/2010")
IsDate("October 12, 2010")

IsArray() Returns True if its argument is an array.

A Variable’s Scope

In addition to a type, a variable has a scope. The scope (or visibility) of a variable is the section

of the application that can see and manipulate the variable. If a variable is declared within
a procedure, only the code in the specific procedure has access to that variable; the variable

doesn’t exist for the rest of the application. When the variable’s scope is limited to a procedure,

it’s called local.

Suppose that you're coding the handler for the C1ick event of a button to calculate the
sum of all even numbers in the range 0 to 100. One possible implementation is shown in
Listing 2.3.
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LISTING 2.3: Summing even numbers

Private Sub Buttonl_Click(ByVal sender As Object, _
ByVal e As System.EventArguments) _
Handles Buttonl.Click
Dim i As Integer
Dim Sum As Integer = 0
For i = 0 to 100 Step 2
Sum = Sum + i
Next
MsgBox ”“The sum is ” & Sum.ToString
End Sub

The variables 7 and Sum are local to the Buttonl_Click() procedure. If you attempt to set
the value of the Sum variable from within another procedure, Visual Basic will complain that
the variable hasn’t been declared. (Or, if you have turned off the Explicit option, it will create
another Sum variable, initialize it to zero, and then use it. But this won't affect the variable Sum
in the Buttonl_Click() subroutine.) The Sum variable is said to have procedure-level scope;
it’s visible within the procedure and invisible outside the procedure.

Sometimes, however, you'll need to use a variable with a broader scope: a variable that’s
available to all procedures within the same file. This variable, which must be declared outside
any procedure, is said to have a module-level scope. In principle, you could declare all vari-
ables outside the procedures that use them, but this would lead to problems. Every procedure
in the file would have access to any variable, and you would need to be extremely careful not
to change the value of a variable without good reason. Variables that are needed by a single
procedure (such as loop counters) should be declared in that procedure.

Another type of scope is the block-level scope. Variables introduced in a block of code,
such as an If statement or a loop, are local to the block but invisible outside the block. Let’s
revise the previous code segment so that it calculates the sum of squares. To carry out the
calculation, we first compute the square of each value and then sum the squares. The square
of each value is stored to a variable that won’t be used outside the loop, so we can define
the sqrValue variable in the loop’s block and make it local to this specific loop, as shown in
Listing 2.4.

LISTING 2.4: A variable scoped in its own block

Private Sub Buttonl_Click(ByVal sender As Object, _
ByVal e As System.EventArguments) _
Handles Buttonl.Click
Dim i, Sum As Integer
For i = 0 to 100 Step 2
Dim sqrValue As Integer
sqrvalue = i * i
Sum = Sum + sqrValue
Next
MsgBox ”“The sum of the squares is ” & Sum
End Sub
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The sqrValue variable is not visible outside the block of the For..Next loop. If you attempt
to use it before the For statement or after the Next statement, the code won’t compile.

The sqrValue variable maintains its value between iterations. The block-level variable is not
initialized at each iteration, even though there’s a Dim statement in the loop.

Finally, in some situations, the entire application must access a certain variable. In this case,
the variable must be declared as PubTic. Public variables have a global scope; they are visible
from any part of the application. To declare a public variable, use a Pub1ic statement in place
of a Dim statement. Moreover, you can’t declare public variables in a procedure. If you have
multiple forms in your application and you want the code in one form to see a certain variable
in another form, you can use the Pub1ic modifier.

So, why do we need so many types of scope? You'll develop a better understanding of scope
and which type of scope to use for each variable as you get involved in larger projects. In gen-
eral, you should try to limit the scope of your variables as much as possible. If all variables
were declared within procedures, you could use the same name for storing a temporary value
in each procedure and be sure that one procedure’s variables wouldn’t interfere with those of
another procedure, even if you use the same name.

A Variable’s Lifetime

In addition to type and scope, variables have a lifetime, which is the period for which they
retain their value. Variables declared as Public exist for the lifetime of the application. Local
variables, declared within procedures with the Dim or Private statement, live as long as the
procedure. When the procedure finishes, the local variables cease to exist, and the allocated
memory is returned to the system. Of course, the same procedure can be called again, and
then the local variables are re-created and initialized again. If a procedure calls another, its local
variables retain their values while the called procedure is running.

You also can force a local variable to preserve its value between procedure calls by using
the Static keyword. Suppose that the user of your application can enter numeric values at
any time. One of the tasks performed by the application is to track the average of the numeric
values. Instead of adding all the values each time the user adds a new value and dividing by
the count, you can keep a running total with the function RunningAvg(), which is shown in
Listing 2.5.

LISTING 2.5: Calculations with global variables

Function RunningAvg(ByVal newValue As Double) As Double
CurrentTotal = CurrentTotal + newValue
TotalItems = TotalItems + 1
RunningAvg = CurrentTotal / TotalItems

End Function

You must declare the variables CurrentTotal and TotalItems outside the function so that
their values are preserved between calls. Alternatively, you can declare them in the function
with the Static keyword, as shown in Listing 2.6.

LISTING 2.6: Calculations with local Static variables

Function RunningAvg(ByVal newValue As Double) As Double
Static CurrentTotal As Double
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Static TotalItems As Integer

CurrentTotal = CurrentTotal + newValue

TotalItems = Totalltems + 1

RunningAvg = CurrentTotal / TotalItems
End Function

The advantage of using static variables is that they help you minimize the number of total
variables in the application. All you need is the running average, which the RunningAvg()
function provides without making its variables visible to the rest of the application. Therefore,
you don'’t risk changing the variable values from within other procedures.

Variables declared in a form module outside any procedure take effect when the form is
loaded and cease to exist when the form is unloaded. If the form is loaded again, its variables
are initialized as if it's being loaded for the first time.

Variables are initialized when they’re declared, according to their type. Numeric variables
are initialized to zero, string variables are initialized to a blank string, and object variables are
initialized to Nothing.

Constants

Some variables don’t change value during the execution of a program. These variables are con-
stants that appear many times in your code. For instance, if your program does math calcula-
tions, the value of pi (3.14159...) might appear many times. Instead of typing the value 3.14159
over and over again, you can define a constant, name it pi, and use the name of the constant in
your code. The statement

%

circumference = 2 * pi * radius

is much easier to understand than the equivalent

circumference = 2 * 3.14159 * radius

The manner in which you declare constants is similar to the manner in which you declare
variables except that you use the Const keyword, and in addition to supplying the constant’s
name, you must also supply a value, as follows:

Const constantname As type = value

Constants also have a scope and can be Public or Private. The constant p7, for instance, is
usually declared in a module as Public so that every procedure can access it:

Public Const pi As Double = 3.14159265358979

The rules for naming variables also apply to naming constants. The constant’s value is a lit-
eral value or a simple expression composed of numeric or string constants and operators. You
can’t use functions in declaring constants. By the way, the specific value I used for this example
need not be stored in a constant. Use the pi member of the Math class instead (Math.p1).
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Arrays

A standard structure for storing data in any programming language is the array. Whereas indi-

vidual variables can hold single entities, such as one number, one date, or one string, arrays can

hold sets of data of the same type (a set of numbers, a series of dates, and so on). An array has

a name, as does a variable, and the values stored in it can be accessed by a number or index.
For example, you could use the variable Salary to store a person’s salary:

Salary = 34000

But what if you wanted to store the salaries of 16 employees? You could either declare 16
variables — Salaryl, Salary2, and so on up to Salarylé — or declare an array with 16 ele-
ments. An array is similar to a variable: It has a name and multiple values. Each value is iden-
tified by an index (an integer value) that follows the array’s name in parentheses. Each different
value is an element of the array. If the array Salaries holds the salaries of 16 employees, the
element Salaries(0) holds the salary of the first employee, the element Salaries(1) holds
the salary of the second employee, and so on up to the element Salaries(15). Yes, the default
indexing of arrays starts at zero, as odd as it may be for traditional BASIC developers.

Declaring Arrays

Arrays must be declared with the Dim (or Public) statement followed by the name of the array
and the index of the last element in the array in parentheses, as in this example:

Dim Salary(15) As Integer

Salary is the name of an array that holds 16 values (the salaries of the 16 employees) with
indices ranging from 0 to 15. Salary(0) is the first person’s salary, Salary(1) the second per-
son’s salary, and so on. All you have to do is remember who corresponds to each salary, but
even this data can be handled by another array. To do this, you'd declare another array of 16
elements:

Dim Names(15) As String

Then assign values to the elements of both arrays:

Names(0) = ”“Joe Doe”
Salary(0) = 34000
Names(1) = "Beth York”
Salary(1l) = 62000

Names(15) = "Peter Smack”
Salary(15) = 10300

This structure is more compact and more convenient than having to hard-code the names of
employees and their salaries in variables.

All elements in an array have the same data type. Of course, when the data type is Object,
the individual elements can contain different kinds of data (objects, strings, numbers, and
SO on).
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Arrays, like variables, are not limited to the basic data types. You can declare arrays that
hold any type of data, including objects. The following array holds colors, which can be used
later in the code as arguments to the various functions that draw shapes:

Dim colors(2) As Color
colors(0) = Color.BurlyWood
colors(1l) = Color.AliceBlue
colors(2) Color.Sienna

The Color class represents colors, and among the properties it exposes are the names of the
colors it recognizes.

A better technique for storing names and salaries is to create a structure and then declare an
array of this type. The following structure holds names and salaries:

Structure Employee
Dim Name As String
Dim Salary As Decimal
End Structure

Insert this declaration in a form’s code file, outside any procedure. Then create an array of the
Employee type:

Dim Emps(15) As Employee

Each element in the Emps array exposes two fields, and you can assign values to them by using
statements such as the following:

Emps(2).Name = "Beth York”
Emps(2).Salary = 62000

The advantage of using an array of structures instead of multiple arrays is that the related
information will always be located under the same index. The code is more compact, and you
need not maintain multiple arrays.

Initializing Arrays
Just as you can initialize variables in the same line in which you declare them, you can initialize
arrays, too, with the following constructor (an array initializer, as it’s called):

Dim nameArray() As type = {entry0O, entryl, .. entryN}
Here’s an example that initializes an array of strings:

Dim Names() As String = {”Joe Doe”, "Peter Smack”}

This statement is equivalent to the following statements, which declare an array with two ele-
ments and then set their values:

Dim Names(1) As String



ARRAYS

"Joe Doe”
"Peter Smack”

Names(0)
Names (1)

The number of elements in the curly brackets following the array’s declaration determines the
dimensions of the array, and you can’t add new elements to the array without resizing it. If
you need to resize the array in your code dynamically, you must use the ReDim statement and
supply the new size of the array in parentheses.

ARRAY LIMITS

The first element of an array has index 0. The number that appears in parentheses in the Dim
statement is one fewer than the array’s total capacity and is the array’s upper limit (or upper
bound). The index of the last element of an array (its upper bound) is given by the method
GetUpperBound, which accepts as an argument the dimension of the array and returns the
upper bound for this dimension. The arrays we have examined so far are one-dimensional, and
the argument to be passed to the GetUpperBound method is the value 0. The total number of
elements in the array is given by the method GetLength, which also accepts a dimension as
an argument. The upper bound of the following array is 19, and the capacity of the array is 20
elements:

Dim Names(19) As Integer

The first element is Names(0), and the last is Names(19). If you execute the following state-
ments, the highlighted values will appear in the Output window:

Debug.WriteLine(Names.GetLowerBound(0))
0
Debug.WriteLine(Names.GetUpperBound(0))
19

To assign a value to the first and last element of the Names array, use the following
statements:

Names(0) = "First entry”
Names(19) = "Last entry”

To iterate through the array elements, use a loop like the following one:

Dim i As Integer, myArray(19) As Integer
For i = 0 To myArray.GetUpperBound(0)
myArray(i) = i * 1000

Next

The number of elements in an array is given by the expression myArray.GetUpper
Bound(0) + 1. You can also use the array’s Length property to retrieve the count of elements.
The following statement will print the number of elements in the array myArray in the Output
window:

Debug.WriteLine(myArray.Length)
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Still confused with the zero-indexing scheme, the count of elements, and the index of the
last element in the array? You can make the array a little larger than it needs to be and ignore
the first element. Just make sure that you never use the zero element in your code — don’t
store a value in the element Array(0), and you can then ignore this element. To get 20 ele-
ments, declare an array with 21 elements as Dim MyArray(20) As type and then ignore the first
element.

Multidimensional Arrays

One-dimensional arrays, such as those presented so far, are good for storing long sequences of
one-dimensional data (such as names or temperatures). But how would you store a list of cities
and their average temperatures in an array? Or names and scores, years and profits, or data
with more than two dimensions, such as products, prices, and units in stock? In some situa-
tions, you will want to store sequences of multidimensional data. You can store the same data
more conveniently in an array of as many dimensions as needed.

Figure 2.5 shows two one-dimensional arrays — one of them with city names, the other
with temperatures. The name of the third city would be City(2), and its temperature would
be Temperature(2).

FIGURE 2.5 Cities (7) Temperatures (7) Temperatures (7, 1)
Two one-dlmenswr}al 0 San Francisco 78] San Francisco 78
arrays and the equiv- 1 Los Angeles 86| Los Angeles 86
alent two-dimensional 2 |
array 3 ]

4 —

5 —

6 —

7 Seattle 165 Seattle 65

Two one-dimensional arrays A two-dimensional array

A two-dimensional array has two indices: The first identifies the row (the order of the city in
the array), and the second identifies the column (city or temperature). To access the name and
temperature of the third city in the two-dimensional array, use the following indices:

Temperatures(2, 0) ' is the third city’s name
Temperatures(2, 1) " is the third city’s average temperature

The benefit of using multidimensional arrays is that they’re conceptually easier to manage.
Suppose you're writing a game and want to track the positions of certain pieces on a board.
Each square on the board is identified by two numbers: its horizontal and vertical coordinates.
The obvious structure for tracking the board’s squares is a two-dimensional array, in which the
first index corresponds to the row number and the second corresponds to the column number.
The array could be declared as follows:

Dim Board(9, 9) As Integer
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When a piece is moved from the square in the first row and first column to the square in the
third row and fifth column, you assign the value 0 to the element that corresponds to the initial
position:

Board(0, 0) = 0
And you assign 1 to the square to which it was moved to indicate the new state of the board:
Board(2, 4) =1

To find out whether a piece is on the top-left square, you'd use the following statement:

If Board(0, 0) = 1 Then
' piece found
Else

End If

empty square
This notation can be extended to more than two dimensions. The following statement creates

an array with 1,000 elements (10 by 10 by 10):

Dim Matrix(9, 9, 9)

You can think of a three-dimensional array as a cube made up of overlaid two-dimensional
arrays, such as the one shown in Figure 2.6.

FIGURE 2.6 [3,0,0[3,0,1]3,0,2]3,0,3
Pictorial representa- I L l 3,13
tions of one-, two-, and 0 !25050!2'0'1 !2'0'2 2,03 3:2:3
three-dimensional arrays 1 (1)8 ?1 ?g ?g |1‘0‘0|1,0,1 |1,0,2 1,0,3 g;g 3,3,3
p) : : : : ' ' ' 11,351 1343
20[21]22]23 0,0,0{0,0,1{0,0,2/0,0,3 123 2,33 353
3 30[31]32](33 0,1,0{0,1,10,1,2/0,1,3 1’3’3 2,43 3‘6‘3
4 40[41 142143 0,2,0{0,2,10,2,2|0,2,3 1’4’3 2,5,3 3’7’3
0 50(51[52[53] [0.3,0]03.1]03.203 3} 221 [2.6.3f—==
6 6,0[61]62]63 0,4,0{0,4,1{0,4,2/0,4,3 1’6’3 2,7,3
i 70[71172]73 0,5,0{0,5,10,5,2/0,5,3 1’7’3
0,6,0{0,6,1]0,6,2(0,6,3 j===
0,7,0{0,7,10,7,2/0,7,3
Data(7) Data(7, 3) Data(7, 3, 3)

It is possible to initialize a multidimensional array with a single statement, just as you
do with a one-dimensional array. You must insert enough commas in the parentheses
following the array name to indicate the array’s rank. The following statements initialize a
two-dimensional array and then print a couple of its elements:

Dim a(,) As Integer = {{10, 20, 30}, {11, 21, 31}, {12, 22, 32}}
Console.WriteLine(a(0, 1)) "will print 20
Console.WriteLine(a(2, 2)) "will print 32
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You should break the line that initializes the dimensions of the array into multiple lines to
make your code easier to read:

Dim a(,) As Integer = {{10, 20, 30},
{11, 21, 31},
{12, 22, 32}}

If the array has more than one dimension, you can find out the number of dimensions with
the Array.Rank property. Let’s say you have declared an array for storing names and salaries
by using the following statements:

Dim Employees(1,99) As Employee

To find out the number of dimensions, use the following statement:

Employees.Rank

When using the Length property to find out the number of elements in a multidimensional
array, you will get back the total number of elements in the array (2 x 100 for our example).
To find out the number of elements in a specific dimension, use the GetLength method, pass-
ing as an argument a specific dimension. The following expressions will return the number of
elements in the two dimensions of the array:

Debug.WriteLine(Employees.GetLength(0))
2
Debug.WriteLine(Employees.GetLength(1))
100

Because the index of the first array element is zero, the index of the last element is the length
of the array minus 1. Let’s say you have declared an array with the following statement to store
player statistics for 15 players and there are five values per player:

Dim Statistics(14, 4) As Integer

The following statements will return the highlighted values shown beneath them:

Debug.WriteLine(Statistics.Rank)

2 ' dimensions in array
Debug.WritelLine(Statistics.Length)

75 ' total elements 1in array
Debug.WriteLine(Statistics.GetLength(0))

15 ' elements in first dimension
Debug.WriteLine(Statistics.GetLength(1))

5 ' elements in second dimension
Debug.WriteLine(Statistics.GetUpperBound(0))

14 ' Tast index in the first dimension

Debug.WritelLine(Statistics.GetUpperBound(1))
4 ' Tast index in the second dimension
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Multidimensional arrays are becoming obsolete because arrays (and other collections) of cus-
tom structures and objects are more flexible and convenient.

Collections

Historically, arrays are the primary structures for storing sets of data, and for years they were
the primary storage mechanism for in-memory data manipulation. In this field, however,
where technologies grow in and out of style overnight, arrays are being replaced by other,
more flexible and more powerful structures, the collections. Collections are discussed in detail
in Chapter 12, but I should mention them briefly in this chapter, not only for completeness, but
also because collections are used a lot in programming and you will find many examples of
collections in this book’s chapters.

A collection is a dynamic data storage structure: You don’t have to declare the size of a
collection ahead of time. Moreover, the position of the items in a collection is not nearly as
important as the position of the items in an array. New items are appended to a collection
with the Add method, while existing items are removed with the Remove method. (Note that
there’s no simple method of removing an array element, short of copying the original array
to a new one and skipping the element to be removed.) The collection I just described is the
List collection, which is very similar to an array. To declare a List collection, use the New
keyword:

Dim names As New List(Of String)

The New keyword is literally new to you; use it to create variables that are true objects (any
variable that’s not of a basic data type or structure). The New keyword tells the compiler to cre-
ate a variable of the specified type and initialize it. The List collection must be declared with a
specific data type, which is specified with the Of keyword in parentheses. All items stored in
the example names list must be strings. A related collection is the ArrayList collection, which is
identical to the List collection but you don’t have to declare the type of variables you intend to
store in it because you can add objects of any type to an ArrayList collection.

To create a collection of color values, use the following declaration:

Dim colors As New List(O0f Color)

The following statements add a few items to the two collections:

names.Add(”Richard”)

names .Add(”Nancy”)
colors.Add(Color.Red)
colors.Add(TextBox1.BackColor)

Another collection is the Dictionary collection, which allows you to identify each element by

a key instead of an index value. The following statement creates a new Dictionary collection for
storing names and birth dates:

Dim BDays As New Dictionary(Of String, Date)
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The first data type following the Of keyword is the data type of the keys, while the following
argument is the data type of the values you want to store to the collection. Here’s how you add
data to a Dictionary collection:

BDays .Add("Manfred”, #3/24/1972#)
BDays.Add("Alfred”, #11/24/1959#)

To retrieve the birth date of Manfred, use the following statement:

BDays(”Manfred”)

Finally, you can use collections to store custom objects too. Let’s say you have three vari-
ables that represent checks (they're of the CheckRecord custom type presented earlier in this
chapter in the section ““User-Defined Data Types”). You can add them to a List collection just
as you would add integers or strings to a collection:

Dim Checks As New List(O0f CheckRecord)
Checks.Add(checkl)
Checks.Add(check2)
Checks.Add(check3)

A seasoned developer would store the same data to a Dictionary collection using the check
number as an index value:

Dim Checks As New Dictionary(Of Integer, CheckRecord)
Checks.Add(checkl.CheckNumber, checkl)

An application that uses this structure can prompt the user for a specific check number,
retrieve it by its index from the Checks collection and display it to the user. As you will see in
Chapter 12, a big advantage of collections over arrays is that collections allow you to remove
elements with the Remove method.

The Bottom Line

Declare and use variables. Programs use variables to store information during their execu-
tion, and different types of information are stored in variables of different types. Dates, for
example, are stored in variables of the Date type, while text is stored in variables of the String
type. The various data types expose a lot of functionality that’s specific to a data type; the meth-
ods provided by each data type are listed in the IntelliSense box.

Master It How would you declare and initialize a few variables?
Master It Explain briefly the Explicit, Strict, and Infer options.
Use the native data types. The CLR recognized the following data types, which you can use

in your code to declare variables: String, numeric data types (Integer, Double, and so on), Date,
Char and Boolean types.



THE BOTTOM LINE 83

All other variables, or variables that are declared without a type, are Object variables and can
store any data type or any object.

Master It How will the compiler treat the following statement?

Dim amount = 32

Create custom data types. Practical applications need to store and manipulate multiple data
items, not just integers and strings. To maintain information about people, we need to store
each person’s name, date of birth, address, and so on. Products have a name, a description, a
price, and other related items. To represent such entities in our code, we use structures, which
hold many pieces of information about a specific entity together.

Master It Create a structure for storing products and populate it with data.

Use arrays. Arrays are structures for storing sets of data as opposed to single-valued
variables.

Master It How would you declare an array for storing 12 names and another one for stor-
ing 100 names and Social Security numbers?






Chapter 3

Visual Basic Programming Essentials

The one thing you should have learned about programming in Visual Basic so far is that an
application is made up of small, self-contained segments. The code you write isn’t a monolithic
listing; it’s made up of small segments called procedures, and you work on one procedure at a
time.

In this chapter we’ll explore the two types of procedures supported by Visual Basic: sub-
routines and functions — the building blocks of your applications. We'll discuss them in detail:
how to call them with arguments and how to retrieve the results returned by the functions.
You'll learn how to use the built-in functions that come with the language as well as how to
write your own subroutines and functions.

The statements that make up the core of the language are actually very few. The flexibil-
ity of any programming language is based on its capacity to alter the sequence in which the
statements are executed through a set of so-called flow-control statements. These are the state-
ments that literally make decisions and react differently depending on the data, user actions, or
external conditions. Among other topics, in this chapter you'll learn how to do the following;:

& Use Visual Basic’s flow-control statements
¢ Write subroutines and functions

¢ Pass arguments to subroutines and functions

Flow-Control Statements

What makes programming languages so flexible and capable of handling every situation and
programming challenge with a relatively small set of commands is their capability to examine
external or internal conditions and act accordingly. Programs aren’t monolithic sets of com-
mands that carry out the same calculations every time they are executed; this is what calcula-
tors (and extremely simple programs) do. Instead, they adjust their behavior depending on the
data supplied; on external conditions, such as a mouse click or the existence of a peripheral;
even on a coding mistake you haven’t caught during your tests.

In effect, the statements discussed in the first half of this chapter are what programming is
all about. Without the capability to control the flow of the program, computers would just be
bulky calculators. You have seen how to use the If statement to alter the flow of execution in
previous chapters, and I assume you're somewhat familiar with these kinds of statements. In
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this section, you'll find a formal discussion of flow-control statements, which are grouped into
two major categories: decision statements and looping statements.

Decision Statements

Applications need a mechanism to test conditions, and they take a different course of action
depending on the outcome of the test. Visual Basic provides three statements that allow you to
alter the course of the application based on the outcome of a condition:

¢ If.Then
& If.Then.Else

¢ Select Case

IF...THEN STATEMENTS

The If.Then statement tests an expression, which is known as a condition. If the condition

is True, the program executes the statement(s) that follow the Then keyword up to the End

If statement, which terminates the conditional statement. The If..Then statement can have a
single-line or a multiple-line syntax. To execute one statement conditionally, use the single-line
syntax as follows:

If condition Then statement

To execute multiple statements conditionally, embed the statements within an If and End If
statement, as follows:

If condition Then
' Statement
' Statement
End If

Conditions are logical expressions that evaluate to a True/False value and they usually con-
tain comparison operators — equals (=), different (<>), less than (<), greater than (>), less than
or equal to (<=), and so on — and logical operators — And, Or, Xor, and Not. Here are a few
examples of valid conditions:

If (agel < age2) And (agel > 12) Then ..
If scorel = score2 Then ..

The parentheses are not really needed in the first sample expression, but they make the
code a little easier to read and understand. Sometimes parentheses are mandatory, to specify
the order in which the expression’s parts will be evaluated, just as math formulae may require
parentheses to indicate the precedence of calculations.

The expressions can get quite complicated. The following expression evaluates to True if the
datel variable represents a date earlier than the year 2005 and either one of the scorel and
score2 variables exceeds 90 (you could use it locate high scores in a specific year):

If (datel < #1/1/2005) And (scorel > 90 Or score2 > 90) Then
' statements
End If
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The parentheses around the last part of the comparison are mandatory because we want the
compiler to perform the following comparison first:

scorel > 90 Or score2 > 90

If either variable exceeds 90, the preceding expression evaluates to True and the initial con-
dition is reduced to the following:

If (datel < #1/1/2008) And (True) Then

The compiler will evaluate the first part of the expression (it will compare two dates) and
finally it will combine two Boolean values with the And operator: If both values are True, the
entire condition is True; otherwise, it’s False. If you didn’t use parentheses, the compiler would
evaluate the three parts of the expression:

expressionl: datel < #1/1/2008#
expression2: scorel < 90
expression3: score2 < 90

Then it would combine expressionl with expression2 using the And operator, and finally
it would combine the result with expression3 using the Or operator. If score2 were greater
than 90, the entire expression would evaluate to True, regardless of the value of the datel and
scorel variables.

IF...THEN...ELSE STATEMENTS

A variation of the If..Then statement is the If..Then..E1se statement, which executes one block
of statements if the condition is True and another block of statements if the condition is False.
The syntax of the If.Then..E1se statement is as follows:

If condition Then
statementblockl
Else
statementblock2
End If

Visual Basic evaluates the condition; if it’s True, VB executes the first block of statements
and then jumps to the statement following the End If statement. If the condition is False,
Visual Basic ignores the first block of statements and executes the block following the Else
keyword.

A third variation of the If.Then..ETse statement uses several conditions, with the ElseIf
keyword:

If conditionl Then
statementblockl
ElseIf condition2 Then
statementblock2
ElseIf condition3 Then
statementblock3

87
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Else
statementblock4
End If

You can have any number of E1seIf clauses. The conditions are evaluated from the top,
and if one of them is True, the corresponding block of statements is executed. The Else clause,
which is optional, will be executed if none of the previous expressions is True. Listing 3.1 is an
example of an If statement with E1seIf clauses.

LISTING 3.1: Multiple ET1seIf statements

score = InputBox("Enter score")
If score < 50 Then
Result = "Failed"
ElseIf score < 75 Then
Result = "Pass'
ElseIf score < 90 Then
Result = "Very Good"
Else
Result = "Excellent"
End If
MsgBox Result

MULTIPLE IF...THEN STRUCTURES VERSUS ELSEIF

Notice that after a True condition is found, Visual Basic executes the associated statements
and skips the remaining clauses. It continues executing the program with the statement
immediately after End If. All following ElseIf clauses are skipped, and the code runs a bit
faster. That’s why you should prefer the complicated structure with the ElseIf statements
used in Listing 3.1 to this equivalent series of simple If statements:

If score < 50 Then
Result = "Failed"

End If

If score < 75 And score >= 50 Then
Result = "Pass"

End If

If score < 90 And score > =75 Then
Result = "Very Good"

End If

If score >= 90 Then
Result = "Excellent"

End If

With the multiple If statements, the compiler will generate code that evaluates all the condi-
tions, even if the score is less than 50.
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The order of the comparisons is vital when you're using multiple E1seIf statements. Had
you written the previous code segment with the first two conditions switched, like the follow-
ing segment, the results would be quite unexpected:

If score < 75 Then
Result = "Pass"
ElseIf score < 50 Then
Result = "Failed"
ElseIf score < 90 Then
Result = "Very Good"
Else
Result = "Excellent"
End If

Let’s assume that score is 49. The code would compare the score variable to the value 75.
Because 49 is less than 75, it would assign the value Pass to the variable ResuTt, and then it
would skip the remaining clauses. Thus, a student who scored 49 would have passed the test!
So be extremely careful and test your code thoroughly if it uses multiple ETseIf clauses. You
must either make sure they’re listed in the proper order or use upper and lower limits, as in
the sidebar ““Multiple If..Then Structures versus E1seIf.” It goes without saying that such a
code segment should be tested for all possible intervals of the score variable.

THE IIf () FUNCTION

Not to be confused with the If..Then statement, the IIf() function is also part of the lan-
guage. This built-in function accepts as an argument an expression and two values, evaluates
the expression, and returns the first value if the expression is True or the second value if the
expression is False. The IIf() function has the following syntax:

IIf(expression, TruePart, FalsePart)

The TruePart and FalsePart arguments are objects. (They can be integers, strings, or any
built-in or custom object.) The IIf() function is a more compact notation for simple If
statements, and you can use it to shorten If..Then..Else expressions. Let’s say you want
to display one of the strings "Close" or "Far", depending on the value of the distance
variable. Instead of a multiline If statement, you can call the IIf() function as follows:

Dim result As String
Result = IIf(distance > 1000, "Far", "Close")
MsgBox(result)

Another typical example of the IIf() function is in formatting negative values. It’s fairly
common in business applications to display negative amounts in parentheses. Use the IIf()
statement to write a short expression that formats negative and positive amounts differently,
like the following one:

ITIf(amount < 0, " (" & Math.Abs(Camount).ToString("#.00") & ")",
amount.ToString("#.00"))
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The Abs method of the Math class returns the absolute value of a numeric value, and the “#.00”’
argument of the ToString method specifies that the amount should be formatted as a currency
amount with two decimal digits. You can insert the preceding statement anywhere you would
display the amount variable. Assign a positive or negative value to the amount variable and then
pass the entire expression to the MsgBox() function to display the formatted value:

MsgBox(
IIf(amount < 0, "(" & Math.Abs(amount).ToString("#.00") & ")",
amount.ToString("#.00")))

SELECT CASE STATEMENTS

An alternative to the efficient but difficult-to-read code of the multiple ETseIf structure is the
Select Case structure, which compares the same expression to different values. The advantage
of the Select Case statement over multiple If..Then..ETseIf statements is that it makes the
code easier to read and maintain.

The Select Case structure evaluates a single expression at the top of the structure. The
result of the expression is then compared with several values; if it matches one of them, the
corresponding block of statements is executed. Here’s the syntax of the Select Case statement:

Select Case expression
Case valuel

' statementblockl
Case value2

' statementblock2

Case Else
statementbTockN
End Select

A practical example based on the Select Case statement is shown in Listing 3.2.

LISTING 3.2: Using the SeTect Case statement

Dim Message As String
Select Case Now.DayOfWeek
Case DayOfWeek.Monday

message = "Have a nice week"
Case DayOfWeek.Friday
message = "Have a nice weekend"
Case Else
message = "Welcome back! "
End Select

MsgBox(message)
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In the listing, the expression that’s evaluated at the beginning of the statement is the
Now.DayOfWeek method. This method returns a member of the DayOfWeek enumeration, and
you can use the names of these members in your code to make it easier to read. The value of
this expression is compared with the values that follow each Case keyword. If they match,
the block of statements up to the next Case keyword is executed, and the program skips
to the statement following the End SeTect statement. The block of the Case Else statement is
optional and is executed if none of the previous cases matches the expression. The first two
Case statements take care of Fridays and Mondays, and the Case Else statement takes care of
the other days.

Some Case statements can be followed by multiple values, which are separated by commas.
Listing 3.3 is a revised version of the previous example. The code of Listing 3.3 handles Satur-
days and Sundays.

LISTING 3.3: ASelect Case statement with multiple cases per clause

Select Case Now.DayOfWeek
Case DayOfWeek.Monday

message = "Have a nice week"
Case DayOfWeek.Tuesday, DayOfWeek.Wednesday, DayOfWeek.Thursday
message = "Welcome back!"
Case DayOfWeek.Friday, DayOfWeek.Saturday, DayOfWeek.Sunday
message = "Have a nice weekend!"
End Select
MsgBox(message)

Monday, weekends, and weekdays are handled separately by three Case statements. The
second Case statement handles multiple values (all workdays except for Monday and Friday).
Monday is handled by a separate Case statement. This structure doesn’t contain a Case Else
statement because all possible values are examined in the Case statements; the DayOfWeek
method can’t return another value.

The Case statements can get a little more complex. For example, you may want to distin-
guish a case where the variable is larger (or smaller) than a value. To implement this logic, use
the Is keyword, as in the following code segment that distinguishes between the first and sec-
ond half of the month:

Select Now.Day
Case Is < 15
MsgBox("It's the first half of the month")
Case Is >= 15
MsgBox("It's the second half of the month")
End Select

SHORT-CIRCUITING EXPRESSION EVALUATION

A common pitfall of evaluating expressions with VB is to attempt to compare a Nothing value
to something. An object variable that hasn’t been set to a value can’t be used in calculations or
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comparisons. Consider the following statements:

Dim B As SolidBrush
B = New SolidBrush(Color.Cyan)
If B.Color = Color.White Then
MsgBox("Please select another brush color")
End If

These statements create a SolidBrush object variable, the B variable, and then examine the
brush color and prohibit the user from drawing with a white brush. The second statement ini-
tializes the brush to the cyan color. (Every shape drawn with this brush will appear in cyan.)
If you instead attempted to use the B variable without initializing it (that is, if you had not
included the line that creates a new SolidBrush object), a runtime exception would be thrown:
the infamous Nul1ReferenceException would be thrown when the program gets to the If
statement because the B variable has no value (it's Nothing), and the code attempts to com-
pare it to something. Nothing values can’t be compared to anything. Comment out the second
statement by inserting a single quote in front of it and then execute the code to see what will
happen. Then restore the statement by removing the comment mark.

Actually, as soon as you comment out the statement that initializes the B variable, the editor
will underline the B variable and it will generate the warning Variable B is used before it has been
assigned a value. A null reference exception could result at runtime.

Let’s fix it by making sure that B is not Nothing:

If B IsNot Nothing And B.Color = Color.White Then
MsgBox("Please select another brush color")
End If

The If statement should compare the Color property of the B object, only if the B object is
not Nothing. But this isn’t the case. The AND operator evaluates all terms in the expression and
then combines their results (True or False values) to determine the value of the expression. If
they’re all True, the result is also True. However, it won't skip the evaluation of some terms as
soon as it hits a False value. To avoid unnecessary comparisons, use the AndA1so operator. The
AndAT1so operator does what the And operator should have done in the first place: it evaluates
the expressions from left to right, and when it encounters a False value, it stops evaluating the
remaining terms because they won’t affect the result. If one of its operands is False, the entire
expression will evaluate to False. In other words, if B is Nothing, there’s no reason to examine
its color; the entire expression will evaluate to False, regardless of the brush color. Here’s how
to use the AndATso operator:

If B IsNot Nothing AndAlso B.Color = Color.White Then
MsgBox("Please select another brush color")
End If

The AndATso operator is said to short-circuit the evaluation of the entire expression as
soon as it runs into a False value. As soon as one of the parts in an AndATso operation turns
out to be False, the entire expression is False and there’s no need to evaluate the remaining
terms.
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There’s an equivalent operator for short-circuiting OR expressions: the OrE1se operator. The
OrETse operator can speed the evaluation of logical expressions a little by returning True when
the first operand evaluates to True (the result of the OR operation will be True, regardless of the
value of the second operand). Another good reason for short-circuiting expression evaluation is
to help performance. If the second term of an And expression takes longer to execute (it has to
access a remote database, for example), you can use the AndATso operator to make sure that it’s
not executed when it’s not needed.

Loop Statements

Loop statements allow you to execute one or more lines of code repetitively. Many tasks consist
of operations that must be repeated over and over again, and loop statements are an important
part of any programming language. Visual Basic supports the following loop statements:

& For.Next
& Do..Loop
¢ While..EndWhile

FOR...NEXT LOOPS

Unlike the other two loops, the For..Next loop requires that you know the number of times that
the statements in the loop will be executed. The For..Next loop has the following syntax:

For counter = start To end [Step increment]
' statements
Next [counter]

The keywords in the square brackets are optional. The arguments counter, start, end, and
increment are all numeric. The loop is executed as many times as required for the counter
variable’s value to reach (or exceed) the end value. The variable that appears next to the For
keyword is the loop’s counter, or control variable.

In executing a For..Next loop, Visual Basic does the following:

1. Sets the counter variable equal to the start variable (this is the control variable’s initial
value).

2. Tests to see whether counter is greater than end. If so, it exits the loop without executing
the statements in the loop’s body, not even once. If increment is negative, Visual Basic tests
to see whether the counter value is less than the end value. If it is, it exits the loop.

3. Executes the statements in the block.

4. Increases the counter variable by the amount specified with the increment argument fol-
lowing the Step keyword. If the increment argument isn’t specified, counter is increased
by 1.If Step is a negative value, counter is decreased accordingly.

5. Continues with step 2.

The For..Next loop in Listing 3.4 scans all the elements of the numeric array data and calcu-
lates their average.
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LISTING 3.4: Iterating an array with a For..Next loop

Dim i As Integer, total As Double
For i = 0 To data.Length
total = total + data(i)
Next i
Debug.WriteLine (total / Data.Length)

The single most important thing to keep in mind when working with For..Next loops is that
the loop’s ending value is set at the beginning of the loop. Changing the value of the end vari-
able in the loop’s body won’t have any effect. For example, the following loop will be executed
10 times, not 100 times:

Dim endValue As Integer = 10
Dim i as Integer
For i = 0 To endValue
endvalue = 100
' more statements
Next i

You can, however, adjust the value of the counter variable from within the loop. The fol-
lowing is an example of an endless (or infinite) loop:

For i = 0 To 10
Debug.WriteLine(i)
i=1 -1

Next i

This loop never ends because the loop’s control variable, in effect, is never increased. (If you try
this, press Ctrl4+Break to interrupt the endless loop.)

DO NOT MANIPULATE THE LOOP COUNTER

Manipulating the control variable of a For..Next loop is strongly discouraged. This practice
will most likely lead to bugs, such as infinite loops, overflows, and so on. If the number of
repetitions of a loop isn’t known in advance, use a Do..Loop or a WhiTe..End While structure
(discussed shortly). To jump out of a For..Next loop prematurely, use the Next For state-
ment. You can also use the Continue For statement to continue with the next iteration of
the loop (in other words, jump to the beginning of the loop and start a new iteration).

The increment argument can be either positive or negative. If start is greater than end, the
value of increment must be negative. If not, the loop’s body won’t be executed, not even once.

VB 2010 allows you to declare the counter in the For statement. The control variable ceases to

exist when the program bails out of the loop:

For i As Integer = 1 to 10
Debug.WriteLine(i.ToString)
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Next
Debug.WriteLine(i.ToString)

The 7 variable is used as the loop counter and it’s not visible outside the loop. The last state-
ment won’t even compile; the editor will underline it with a wiggly line and will generate the
error message Name i’ is not declared.

FOR EACH...NEXT LOOPS

This is a variation of the classic For loop and it’s used to iterate through the items of a collec-
tion or array. Let’s say you have declared an array of strings like the following:

Dim months() As String = _
{"January", "February", "March"', "April", "May", "June"}

You can iterate through the month names with a For Each loop like the one that follows:

For Each month As String In months
Debug.WriteLine(month)
Next

The month control variable need not be declared if the Infer option is on. The compiler will
figure out the type of the control variable based on the types of the values you're iterating over,
which in our example are strings. You can easily write the equivalent For..Next loop for the
same task, but the For Each loop is more elegant. It also provides a variable that represents the
current item at each iteration.

Let’s look at a more interesting example of the For Each loop to get an idea of the type
of operations it’s best suited for. The Process class of the Framework provides methods for
inspecting the process running on the target computer at any time. These are the processes you
see in the Processes tab of the Task Manager. Each process is represented by a Process object,
which in turn exposes several useful properties (such as the name of the process, the physical
memory it’s using, and so on) as well as methods to manipulate the processes, including the
Ki11 method that terminates a process.

The GetProcesses method returns an array of Process objects, one for each running process.
To iterate through the current processes, you can use a For Each loop like the following:

Dim processes() = Process.GetProcesses
For Each Proc As Process In processes
Debug.WriteLine(Proc.ProcessName & " " &
Proc.PrivateMemorySize64.ToString)
Next

This loop will display a list like the following in the Output window:

taskeng 10588160
svchost 11476992
YahooMessenger 20496384

sqlservr 104538112
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svchost 4255744
svchost 6549504
SearchIndexer 53612544
sqlwriter 3715072
searchFilterHost 3514368
cmd 2080768
iexplore 250073088

As you can see, the For Each loop is much more elegant than a For..Next loop when it comes
to iterating through the items of a collection. The loop’s counter is not an index, but an object
that represents the current entity — provided that all elements are of the same type, of course.
Many developers use a For Each..Next loop whenever possible, even in situations where a triv-
ial For..Next loop would suffice. Compare the loops in Listing 3.5 and Listing 3.6 for iterating
through the elements of an array of integers.

LISTING 3.5: Using a For..Next loop

Dim numbers() = {10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20}
For i As Integer = 1 to numbers.Length - 1

Process value numbers(i)
Next

LISTING 3.6: Usinga For Each..Next loop

Dim numbers() = {10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20}
For Each number As Integer In numbers

Process value number
Next

Although I declare the control variable in both of the preceding loops, this isn’t mandatory
as long as you have turned on type inference. The compiler will figure out the proper type
from the type of the objects that make up the collection you're iterating.

Do LooPs

The Do..Loop statement executes a block of statements for as long as a condition is True or
until a condition becomes True. Visual Basic evaluates an expression (the loop’s condition), and
if it’s True, the statements in the loop body are executed. The expression is evaluated either

at the beginning of the loop (before any statements are executed) or at the end of the loop (after
the block statements are executed at least once). If the expression is False, the program’s execu-
tion continues with the statement following the loop. These two variations use the keywords
WhiTe and UntiT to specify how long the statements will be executed. To execute a block of
statements while a condition is True, use the following syntax:

Do While condition
' statement-block
Loop
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To execute a block of statements until the condition becomes True, use the following syntax:

Do Until condition
' statement-block
Loop

When Visual Basic executes these loops, it first evaluates condition. If condition is False,
a Do..WhiTe loop is skipped (the statements aren’t even executed once) but a Do..Unti1 loop
is executed. When the Loop statement is reached, Visual Basic evaluates the expression again;
it repeats the statement block of the Do..While loop if the expression is True or repeats the
statements of the Do..Unti1 loop if the expression is False. In short, the Do..While loop is
executed when the condition is True (while the condition is True), and the Do..Unti1 loop
is executed when the condition is False (until the condition becomes True).

A last variation of the Do statement, the Do..Loop statement, allows you to always evaluate
the condition at the end of the loop, even in a While loop. Here’s the syntax of both types of
loop, with the evaluation of the condition at the end of the loop:

Do

statement-block
Loop While condition

Do

statement-block
Loop Until condition

As you can guess, the statements in the loop’s body are executed at least once, even in the
case of the WhiTe loop, because no testing takes place as the loop is entered.

Here’s a typical example of using a Do..Loop: Suppose that the variable MyText holds some
text (like the Text property of a TextBox control) and you want to count the words in the text.
(We’ll assume that there are no multiple spaces in the text and that the space character sepa-
rates successive words.) To locate an instance of a character in a string, use the IndexOf method
of the String class. This method accepts two arguments: the starting location of the search and
the character being searched. The following loop repeats for as long as there are spaces in the
text. Each time the IndexOf method finds another space in the text, it returns the location of
the space. When there are no more spaces in the text, the IndexOf method returns the value -1,
which signals the end of the loop, as shown:

Dim MyText As String =
"The quick brown fox jumped over the lazy dogs"

Dim position, words As Integer
position = 0
words = 0
Do While position >= 0

position = MyText.IndexOf(" ", position + 1)

words += 1
Loop
MsgBox("There are " & words & " words in the text")

The Do..Loop is executed while the IndexOf method function returns a positive number,
which means that there are more spaces (and therefore words) in the text. The variable
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position holds the location of each successive space character in the text. The search for the
next space starts at the location of the current space plus 1 (so the program won’t keep finding
the same space). For each space found, the program increases the value of the words variable,
which holds the total number of words when the loop ends. By the way, there are simpler
methods of breaking a string into its constituent words, such as the Sp1it method of the String
class. This is just an example of the Do..While loop.

You might notice a problem with the previous code segment: It assumes that the text con-
tains at least one word. You should insert an If statement that detects zero-length strings and
doesn’t attempt to count words in them. You can also use the IsNu110rEmpty method of the
String class, which returns True if a String variable is empty or Nothing.

You can code the same routine with the Unti1 keyword. In this case, you must continue
searching for spaces until position becomes —1. Here’s the same code with a different loop:

Dim position As Integer = 0
Dim words As Integer = 0
Do Until position = -1

position = MyText.IndexOf(" ", position + 1)
words = words + 1
Loop

MsgBox("There are " & words & " words in the text")

WHILE LOOPS

The While..End While loop executes a block of statements as long as a condition is True. The
loop has the following syntax:

While condition
' statement-block
End While

If condition is True, the statements in the block are executed. When the End While state-
ment is reached, control is returned to the While statement, which evaluates condition again.
If condition is still True, the process is repeated. If condition is False, the program resumes
with the statement following End WhiTe.

The loop in Listing 3.7 prompts the user for numeric data. The user can type a negative
value to indicate he’s done entering values and terminate the loop. As long as the user enters
positive numeric values, the program keeps adding them to the total variable.

LISTING 3.7: Reading an unknown number of values

Dim number, total As Double
number = 0
While number => 0
total = total + number
number = InputBox("Please enter another value")
End While
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I've assigned the value 0 to the number variable before the loop starts because this value isn’t
negative and doesn’t affect the total.

Sometimes, the condition that determines when the loop will terminate can’t be evaluated at
the top of the loop. In these cases, we declare a Boolean value and set it to True or False from
within the loop’s body. Here’s the outline of such a loop:

Dim repeatLoop As Boolean
repeatLoop = True
While repeatlLoop
' statements
If condition Then
repeatLoop = True
Else
repeatLoop = False
End If
End While

You may also see an odd loop statement like the following one:

While True
' statements
End While

It’s also common to express the True condition in one of the following two forms:
While 1 =1

or

While True

Now, there’s no good reason to use statements like these; I guess they’re leftovers from old pro-
grams. The seemingly endless loops must be terminated from within the body using an Exit
WhiTe statement, which is called when a condition becomes True or False. The following loop
terminates when a condition is met in the loop’s body:

While True
' statements
If condition Then Exit While
' more statements

End While

Of course, this code isn’t elegant and you should avoid it, except when you're implementing
some complicated logic that can’t be easily coded differently.

Nested Control Structures

You can place, or nest, control structures inside other control structures (such as an If..Then
block within a For..Next loop) or nest multiple If..Then blocks within one another. Control
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structures in Visual Basic can be nested in as many levels as you want. The editor automatically
indents the bodies of nested decision and loop structures to make the program easier to read.

When you nest control structures, you must make sure that they open and close within the
same structure. In other words, you can’t start a For..Next loop in an If statement and close
the loop after the corresponding End If. The following code segment demonstrates how to nest
several flow-control statements:

For a = 1 To 100
' statements
If a = 99 Then
' statements
End If
While b < a
' statements
If total <= 0 Then
' statements
End If
End While
For c = 1 to a
' statements
Next c
Next a

I show the names of the control variables after the Next statements to make the code more
readable to humans. To find the matching closing statement (Next, End If, or End While), move
down from the opening statement until you hit a line that starts at the same column. This is the
matching closing statement. Notice that you don’t have to align the nested structures yourself;
the editor reformats the code automatically as you type. It also inserts the matching closing
statement — the End If statement is inserted automatically as soon as you enter an If state-
ment and press Enter, for example. Not only that, but as soon as you click in a control or loop
statement, the editor highlights the corresponding ending statement.

Listing 3.8 shows a typical situation with nested loops. The two nested loops scan all the
elements of a two-dimensional array.

LISTING 3.8: Iterating through a two-dimensional array

Dim Array2D(6, 4) As Integer
Dim iRow, iCol As Integer
For iRow = 0 To Array2D.GetUpperBound(0)

For iCol = 0 To Array2D.GetUpperBound(1)
Array2D(iRow, iCol) = iRow * 100 + iCol
Debug.Write(iRow & ", " & iCol & " =" &

Array2D(iRow, iCol) & " ")

Next iCol

Debug.WriteLine()

Next iRow
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The outer loop (with the 7Row counter) scans each row of the array. At each iteration, the
inner loop scans all the elements in the row specified by the counter of the outer loop (7Row).
After the inner loop completes, the counter of the outer loop is increased by one, and the inner
loop is executed again — this time to scan the elements of the next row. The loop’s body con-
sists of two statements that assign a value to the current array element and then print it in the
Output window. The current element at each iteration is Array2D(iRow, iCol).

Another typical example of nested loops is the code that iterates through the cells of a
ListView control. (This control is discussed in Chapter 7, “More Windows Controls,” and
also in the tutorial “The ListView and TreeView controls.””) The ListView control is basically
a grid — not an editable one, I'm afraid, but an excellent tool for displaying tabular data. To
iterate through the control’s cells, you must set up a loop that iterates through its rows and a
nested loop that iterates through the current row’s cells. Each row of the ListView control is a
ListViewltem object, which provides information about the rows’ cells through the SubItems
property. The SubItems property is an array of values, one for each cell of the grid’s row. The
expression ListViewl.Items(2).SubItems(1).Text returns the contents of the second cell in
the control’s third row. The following code segment iterates through the cells of any ListView
control, regardless of the number of rows and columns it contains:

For iRow As Integer = 0 To ListViewl.Items.Count - 1
Dim LI As ListViewItem = ListViewl.Items(iRow)
For iCol As Integer = 0 To LI.SubItems.Count - 1

" process cell LI.SubItems(iCol)
Next
Next

The two nested For..Next loops are quite old-fashioned. In modern VB, you’d write the same
code as follows:

Dim str As String = ""
For Each LI As ListViewItem In ListViewl.Items
For Each cell In LI.SubItems
str = str & cell.Text.ToString & vbTab

Next

str = str & vbCrLf
Next
MsgBox(str)

The preceding code segment gradually builds a string with the contents of the ListView con-
trol, separating cells in the same row with a tab (vbTab constant) and consecutive rows with a
line feed (vbCrLf constant). You can also nest multiple If statements. The code in Listing 3.9
tests a user-supplied value to determine whether it’s positive; if so, it determines whether the
value exceeds a certain limit.

LISTING 3.9: Simple nested If statements

Dim Income As Decimal
Income = Convert.ToDecimal(InputBox("Enter your income"))
If Income > 0 Then
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If Income > 12000 Then
MsgBox "You will pay taxes this year"

Else
MsgBox "You won't pay any taxes this year'
End If
Else
MsgBox "Bummer"
End If

The Income variable is first compared with zero. If it'’s negative, the ETse clause of the
If..Then statement is executed. If it’s positive, it’s compared with the value 12,000, and
depending on the outcome, a different message is displayed. The code segment shown here
doesn’t perform any extensive validations and assumes that the user won’t enter a string when
prompted for income.

The Exit and Continue Statements

The Exit statement allows you to prematurely exit from a block of statements in a control
structure, from a loop, or even from a procedure. Suppose that you have a For..Next loop that
calculates the square root of a series of numbers. Because the square root of negative numbers
can’t be calculated (the Math.Sqrt method will generate a runtime error), you might want to
halt the operation if the array contains an invalid value. To exit the loop prematurely, use the
Exit For statement as follows:

For i = 0 To UBound(nArray)
If nArray(i) < 0 Then
MsgBox("Can't complete calculations" & vbCrLf &
"Ttem " & i.ToString & " is negative! "
Exit For
End If
nArray(i) = Math.Sqrt(nArray(i))
Next

If a negative element is found in this loop, the program exits the loop and continues with the
statement following the Next statement.

There are similar Exit statements for the Do loop (Exit Do), the WhiTe loop (Exit WhiTe),
the Select statement (Exit Select), and functions and subroutines (Exit Function and Exit
Sub). If the previous loop was part of a function, you might want to display an error and exit
not only the loop, but also the function itself by using the Exit Function statement.

Sometimes you may need to continue with the following iteration instead of exiting the loop
(in other words, skip the body of the loop and continue with the following value). In these
cases, you can use the Continue statement (Continue For for For.. Next loops, Continue While
for While loops, and so on).

Writing and Using Procedures

Now that you have seen the decision and looping structures of Visual Basic, let’s move on to
procedures. In traditional programming languages, procedures are the basic building blocks
of every application. And what exactly is a traditional language? Well, a procedural language, of
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course. A procedural language is one that requires you to specify how to carry out specific tasks
by writing procedures. A procedure is a series of statements that tell the computer how to carry
out a specific task. The task could be the calculation of a loan’s monthly payment (a task that
can be coded literally with a single statement) or the retrieval of weather data from a remote
server. In any case, the body of statements form a unit of code that can be invoked by name,
not unlike scripts or macro commands but much more flexible and certainly more complex.

The idea of breaking a large application into smaller, more manageable sections is not new
to computing. Few tasks, programming or otherwise, can be managed as a whole. Using event
handlers is just one example of breaking a large application into smaller tasks.

For example, when you write code for a control’s Click event, you concentrate on the event
at hand — namely, how the program should react to the Click event. What happens when the
control is double-clicked or when another control is clicked is something you will worry about
later — in another control’s event handler. This divide-and-conquer approach isn’t unique to
programming events. It permeates the Visual Basic language, and developers write even the
longest applications by breaking them into small, well-defined, easily managed tasks. Each
task is performed by a procedure that is written and tested separately from the others. As
mentioned earlier, the two types of procedures supported by Visual Basic are subroutines and
functions.

Subroutines perform actions and they don’t return any result. Functions, on the other hand,
perform some calculations and return a value. This is the only difference between subroutines
and functions. Both subroutines and functions can accept arguments (values you pass to the
procedure when you call it). Usually, the arguments are the values on which the procedure’s
code acts. Arguments and the related keywords are discussed in detail later in this chapter.

Subroutines

A subroutine is a block of statements that carries out a well-defined task. The block of state-
ments is placed within a set of Sub..End Sub statements and can be invoked by name. The fol-
lowing subroutine displays the current date in a message box:

Sub ShowDate()
MsgBox("Today's date is " & Now().ToShortDateString)
End Sub

To use it in your code, you can just enter the name of the function in a line of its own:

ShowDate()

To experiment with the procedures presented in this chapter, start a new Windows project,
place a button on the main form, and then enter the definition of the ShowDate() subrou-
tine outside any event handler. In the button’s Click event handler, enter the statement
ShowDate(). If you run the application and click the button, the current date will appear on a
message box. The single statement in the event handler calls the ShowDate() subroutine, which
displays the current date. Your main program calls the subroutine by name and it doesn’t care
how complex the subroutine is.

Normally, the task performed by a subroutine is more sophisticated than this, but even this
simple subroutine is a block of code isolated from the rest of the application. The statements in
a subroutine are executed, and when the End Sub statement is reached, control returns to the
calling code. It’s possible to exit a subroutine prematurely by using the Exit Sub statement. In
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effect, a subroutine is a set of statements that perform a very specific task, and you can invoke
them by name. Use subroutines to break your code into smaller, more manageable units and
certainly if you're coding tasks that may be used in multiple parts of the application. Note that
the ShowDate() subroutine can be called from any event handler in the current form.

All variables declared within a subroutine are local to that subroutine. When the subroutine
exits, all variables declared in it cease to exist.

Most procedures also accept and act upon arguments. The ShowDate() subroutine displays
the current date in a message box. If you want to display any other date, you have to imple-
ment it differently and add an argument to the subroutine:

Sub ShowDate(ByVal aDate As Date)
MsgBox(aDate.ToShortDateString)
End Sub

aDate is a variable that holds the date to be displayed; its type is Date. The ByVal keyword
means that the subroutine sees a copy of the variable, not the variable itself. What this means
practically is that the subroutine can’t change the value of the variable passed by the calling code.

To display a specific date with the second implementation of the subroutine, use a statement
like the following:

Dim myBirthDate = #2/9/1960#
ShowDate(myBirthDate)

Or, you can pass the value to be displayed directly without the use of an intermediate
variable:

ShowDate(#2/9/1960#)

If you later decide to change the format of the date, there’s only one place in your code you
must edit — the statement that displays the date from within the ShowDate() subroutine.

Functions

A function is similar to a subroutine, but a function returns a result. Because they return values,
functions — like variables — have types. The value you pass back to the calling program from
a function is called the return value, and its type determines the type of the function. Functions
accept arguments, just like subroutines. The statements that make up a function are placed in a
set of Function..End Function statements, as shown here:

Function NextDay() As Date
Dim theNextDay As Date
theNextDay = Now.AddDays(1)
Return theNextDay

End Function

Functions are called like subroutines — by name — but their return value is usually
assigned to a variable. To call the NextDay() function, use a statement like this:

Dim tomorrow As Date = NextDay()
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Because functions have types like variables, they can be used anywhere you’d use a variable
name. You will find several examples of practical functions later in this chapter, both built-in
functions that are part of the language and custom functions. Subroutines are being gradually
replaced by functions, and in some languages there are no subroutines, just functions. Even
if you need a procedure to perform some task without returning a value, you can implement
it as a function that returns a True/False value to indicate whether the operations completed
successfully or not.

The Function keyword is followed by the function name and the As keyword that specifies
its type, similar to a variable declaration. Inside the preceding sample function, AddDays is a
method of the Date type, and it adds a number of days to a date value. The NextDay() func-
tion returns tomorrow’s date by adding one day to the current date. NextDay() is a custom
function, which calls the built-in AddDays method to complete its calculations.

The result of a function is returned to the calling program with the Return statement, which
is followed by the value you want to return from your function. This value, which is usually
a variable, must be of the same type as the function. In our example, the Return statement
happens to be the last statement in the function, but it could appear anywhere; it could even
appear several times in the function’s code. The first time a Return statement is executed, the
function terminates and control is returned to the calling code.

You can also return a value to the calling routine by assigning the result to the name of the
function. The following is an alternate method of coding the NextDay() function:

Function NextDay() As Date
NextDay = Now.AddDays(1)
End Function

Notice that this time I've assigned the result of the calculation to the function’s name
directly and haven’t use a Return statement. This assignment, however, doesn’t terminate the
function as the Return statement does. It sets up the function’s return value, but the function
will terminate when the End Function statement is reached or when an Exit Function state-
ment is encountered.

Similar to the naming of variables, a custom function has a name that must be unique in its
scope (which is also true for subroutines, of course). If you declare a function in a form, the
function name must be unique in the form. If you declare a function as Public or Friend, its
name must be unique in the project. Functions have the same scope rules as variables and can
be prefixed by many of the same keywords. In effect, you can modify the default scope of a
function with the keywords Public, Private, Protected, Friend, and Protected Friend. In
addition, functions have types, just like variables, and they’re declared with the As keyword.

Suppose that the function CountWords() counts the number of words and the function
CountChars() counts the number of characters in a string. The average length of a word in the
string TongString could be calculated as follows:

Dim longString As String, avgLen As Double
TongString = TextBox1l.Text
avgLen = CountChars(longString) / CountWords(longString)

The first executable statement gets the text of a TextBox control and assigns it to a variable,
which is then used as an argument to the two functions. When the third statement executes,
Visual Basic first calls the functions CountChars() and CountWords() with the specified argu-
ments and then divides the results they return.
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The CountWords() function uses the Sp1it method, which isolates the words in a string
and returns them as an array of strings. Then the code reads the length of the array, which
equals the number of words in the string. The SpT1it method accepts as an argument a charac-
ter, which is the delimiter it will use to break the string into words. The space character being
passed as an argument is enclosed in double quotes, but this is a string, not a character. It's
a string that contains a single character, but a string nevertheless. To convert the space string
("") into a character value, you just append the c character to the string. The number of words
in the string is the length of the array that holds the individual words, the words array.

Function CountWords(ByVal TongString As String) As Integer
Dim words = longString.Split(" "c)
Return words.Length

End Function

Function CountChars(ByVal TongString As String) As Integer
TongString = TongString.Replace(" ", "")
Return TongString.Length

End Function

You can call functions in the same way that you call subroutines, but the result won’t be
stored anywhere. For example, the function Convert() might convert the text in a text box to
uppercase and return the number of characters it converted. Normally, you'd call this function
as follows:

nChars = Convert()

If you don’t care about the return value — you only want to update the text on a TextBox
control — you would call the Convert() function with the following statement:

Convert()

Most of the procedures in an application are functions, not subroutines. The reason is that
a function can return (at the very least) a True/False value that indicates whether it completed
successfully or not. In the remainder of this chapter, I will focus on functions, but the same
principles apply to subroutines as well, except for the return value.

Arguments

Subroutines and functions aren’t entirely isolated from the rest of the application. Most pro-
cedures accept arguments from the calling program. Recall that an argument is a value you
pass to the procedure and on which the procedure usually acts. This is how subroutines and
functions communicate with the rest of the application.

Subroutines and functions may accept any number of arguments, and you must supply a value
for each argument of the procedure when you call it. Some of the arguments may be optional,
which means you can omit them; you will see shortly how to handle optional arguments.

Let’s implement a simple custom function to demonstrate the use of arguments. The Min()
function, shown next, is a custom function that accepts two arguments and returns the smaller
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one. Once you write the function, you can call it from within your code just like any built-in
function. The difference is that while the built-in functions are always available, the custom
functions are available only to the project in which they are declared. Here’s the implementa-
tion of the Min() function:

Function Min(ByVal a As Single, ByVal b As Single) As Single
Min = IIf(a < b, a, b)
End Function

Interestingly, the Min() function calls the IIf() built-in function. IIf() is a built-in function
that evaluates the first argument, which is a logical expression. If the expression is True, the
IIf() function returns the second argument. If the expression is False, the function returns the
third argument.

To call the Min() custom function, use a few statements like the following:

Dim vall As Single = 33.001

Dim val2 As Single = 33.0011

Dim smallerVal as Single

smallerVal = Min(vall, val2)

MsgBox("The smaller value is " & smallerVal)

If you execute these statements (place them in a button’s Click event handler), you will see
the following in a message box:

The smaller value is 33.001

Or you can insert these statements in the Main subroutine of a Console application and replace
the call to the MsgBox function with a call to the ConsoTle.WriteLine method to see the output
on a console window. Here’s what the entire Console application’s code should look like:

Module Modulel

Sub Main()
Dim vall As Single = 33.001
Dim val2 As Single = 33.0011

Dim smallerVal As Single
smallervVal = Min(vall, val2)
Console.WriteLine("The smaller value is " & smallerVal)
Console.ReadKey()
End Sub

Function Min(ByVal a As Single, ByVal b As Single) As Single
Min = IIf(a < b, a, b)

End Function

End Module
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If you attempt to call the same function with two Double values with a statement like the
following, you will see the value 3.33 in the Immediate window:

Debug.WriteLine(Min(3.33000000111, 3.33000000222))

The compiler converted the two values from Double to Single data type and returned one
of them. Which one is it? It doesn’t make a difference because when converted to Single, both
values are the same.

Interesting things will happen if you attempt to use the Min() function with the Strict
option turned on. Insert the statement Option Strict On at the very beginning of the file, or
set Option Strict to On in the Compile tab of the project’s properties pages. The editor will
underline the statement that implements the Min() function: the IIf() function. The IIf()
function accepts two Object variables as arguments and returns one of them as its result. The
Strict option prevents the compiler from converting an Object to a numeric variable. To use the
IIf() function with the Strict option, you must change the Min implementation as follows:

Function Min(ByVal a As Object, ByVal b As Object) As Object
Min = IIf(Val(a) < val(b), a, b)
End Function

It’s possible to implement a Min() function that can compare arguments of all types (inte-
gers, strings, dates, and so on).

Argument-Passing Mechanisms

One of the most important topics in implementing your own procedures is the mechanism used
to pass arguments. The examples so far have used the default mechanism: passing arguments
by value. The other mechanism is passing them by reference. Although most programmers use
the default mechanism, it’s important to know the difference between the two mechanisms and
when to use each.

BY VALUE VERSUS BY REFERENCE

When you pass an argument by value, the procedure sees only a copy of the argument. Even
if the procedure changes this copy, the changes aren’t reflected in the original variable passed
to the procedure. The benefit of passing arguments by value is that the argument values are
isolated from the procedure and only the code segment in which they are declared can change
their values.

In VB 6, the default argument-passing mechanism was by reference, and this is something
you should be aware of, especially if you're migrating VB 6 code to VB 2010.

To specify the arguments that will be passed by value, use the ByVal keyword in front of
the argument’s name. If you omit the ByVal keyword, the editor will insert it automatically
because it’s the default option. Suppose you're creating a function called Degrees() to convert
temperatures from degrees Celsius to degrees Fahrenheit. To declare that the Degrees() function’s
argument is passed by value, use the ByVal keyword in the argument’s declaration as follows:

Function Degrees(ByVal Celsius as Single) As Single
Return((9 / 5) * Celsius + 32)
End Function
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To see what the ByVal keyword does, add a line that changes the value of the argument in
the function:

Function Degrees(ByVal Celsius as Single) As Single
Dim Fahrenheit = (9 / 5) * Celsius + 32
Celsius = 0
Return Fahrenheit

End Function

Now call the function as follows:

Dim CTemp As Single = InputBox("Enter temperature in degrees Celsius")
Dim FTemp As Single = Degrees(CTemp)
MsgBox(CTemp.ToString & " degrees Celsius are " &

FTemp & " degrees Fahrenheit")

If you enter the value 32, the following message is displayed:

32 degrees Celsius are 89.6 degrees Fahrenheit

The value you specify in the InputBox is stored in the CTemp variable, which is then passed
to the Degrees() function. The function’s return value is then stored in the FTemp variable,
which is then used to display the result to the user. Replace the ByVal keyword with the ByRef
keyword in the function’s definition and call the function with the same statements; the pro-
gram will display the following message:

0 degrees Celsius are 89.6 degrees Fahrenheit

When the CTemp argument was passed to the Degrees() function, its value was 32. But the
function changed its value, and upon return it was 0. Because the argument was passed by ref-
erence, any changes made by the procedure affected the calling code’s variable that was passed
into the function.

RETURNING MULTIPLE VALUES

If you want to write a function that returns more than a single result, you will most likely
pass additional arguments by reference and set their values from within the function’s code.
The CalculateStatistics() function, shown a little later in this section, calculates the basic
statistics of a data set. The values of the data set are stored in an array, which is passed

to the function by reference. The CalculateStatistics() function must return two
values: the average and standard deviation of the data set. Here’s the declaration of the
CalculateStatistics() function:

Function CalculateStatistics(ByRef Data() As Double,
ByRef Avg As Double, ByRef StDev As Double) As Integer

The declaration of a procedure is basically its signature; it includes all the information you
need in order to use the procedure in your call. Of course, you have to know what the various
arguments represent, but this is where the documentation comes in. It’s also possible to add
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a short description for each argument, which will appear in the IntelliSense box, as with the
built-in procedures. You'll learn how to automate the documentation of your procedures in the
last section of this chapter. The function returns an integer, which is the number of values in
the data set. The two important values calculated by the function are returned in the Avg and
StDev arguments:

Function CalculateStatistics(ByRef Data() As Double,
ByRef Avg As Double, ByRef StDev As Double) As Integer
Dim i As Integer, sum As Double, sumSqr As Double, points As Integer
points = Data.Length
For i = 0 To points - 1
sum = sum + Data(i)
sumSqr = sumSqr + Data(i) ~ 2
Next
Avg = sum / points
StDev = System.Math.Sqrt(sumSqr / points — Avg ~ 2)
Return(points)
End Function

To call the CalculateStatistics() function from within your code, set up an array of Dou-
bles and declare two variables that will hold the average and standard deviation of the data set:

Dim Values() = {102.301, 391.200, 19.29, 179.42, 88.031, 208.01}
Dim average, deviation As Double

Dim points As Integer

points = CalculateStatistics(Values, average, deviation)
Debug.WriteLine(points & " values processed.")
Debug.WriteLine("The average is " & average.ToString & " and ")
Debug.WritelLine("the standard deviation is " & deviation.ToString)

The simplest method for a function to effectively return multiple values is to pass to it argu-
ments by reference using the ByRef keyword. However, the definition of your functions might
become cluttered, especially if you want to return more than a few values. Another problem
with this technique is that it’s not clear whether an argument must be set before calling the
function. As you will see shortly, it is possible for a function to return an array or a custom
structure with fields for any number of values.

A NOTE ON REFACTORING CODE

A relatively new term in computer programming, refactoring, refers to rewriting a piece of
code using procedures. As developers, we tend to insert a lot of code in applications. We start
coding a simple operation, and once we get it to work, we realize that we can improve it or
add more features to it. The result is a procedure that keeps growing. It doesn’t take a rocket
scientist to realize that large segments of code are hard to understand and even harder to
maintain. That’s why there are tools that allow us to break large procedures into smaller ones.
The process isn’t automatic, of course. As soon as you realize that a procedure has gotten too
long, you can select segments of it and implement them as procedures: You move the code
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into a procedure and insert a call to the procedure in the code’s place. The process isn’t trivial
because you need to pass arguments to the procedure. Refactoring tools do just that: They
remove a code segment from a routine and use it to create a new routine. I won’t discuss
refactoring tools in this book, but you should know that help is available when you decide to
reorganize your code.

Built-in Functions

VB provides many functions that implement common or complicated tasks, and you can
look them up in the documentation. (You'll find them in the Visual Studio » Visual Basic »>
Reference » Functions branch of the contents tree in the Visual Studio documentation.) There
are functions for the common math operations, functions to perform calculations with dates
(these are truly complicated operations), financial functions, and many more. When you use
the built-in functions, you don’t have to know how they work internally — just how to call
them and how to retrieve the return value.

The Pmt() function, for example, calculates the monthly payments on a loan. All you have to
know is the arguments you must pass to the function and how to retrieve the result. The syntax
of the Pmt() function is as follows, where MPay is the monthly payment, Rate is the monthly
interest rate, and NPer is the number of payments (the duration of the loan in months). PV is
the loan’s present value (the amount you took from the bank):

MPay = Pmt(Rate, NPer, PV, FV, Due)

Due is an optional argument that specifies when the payments are due (the beginning or the
end of the month), and FV is another optional argument that specifies the future value of an
amount. This isn’t needed in the case of a loan, but it can help you calculate how much money
you should deposit each month to accumulate a target amount over a given time. (The amount
returned by the Pmt() function is negative because it’s a negative cash flow — it’'s money you
owe — so pay attention to the sign of your values.)

To calculate the monthly payment for a $20,000 loan paid off over a period of six years at a
fixed interest rate of 7.25%, you call the Pmt() function, as shown in Listing 3.10.

LISTING 3.10: Using the Pmt () built-in function

Dim mPay, totalPay As Double

Dim Duration As Integer = 6 * 12

Dim Rate As Single = (7.25 / 100) / 12

Dim Amount As Single = 20000

mPay = -Pmt(Rate, Duration, Amount)

totalPay = mPay * Duration

MsgBox("Your monthly payment will be " & mPay.ToString("C") &
vbCrLf & "You will pay back a total of " &
totalPay.ToString("'C"))
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Notice that the interest (7.25%) is divided by 12 because the function requires the monthly
interest. The value returned by the function is the monthly payment for the loan specified with
the Duration, Amount, and Rate variables. If you place the preceding lines in the Click event
handler of a button, run the project, and then click the button, the following message will
appear in a message box:

Your monthly payment will be $343.39
You will pay back a total of $24,723.80

Let’s say you want to accumulate $40,000 over the next 15 years by making monthly
deposits of equal amounts. To calculate the monthly deposit amount, you must call the Pmt()
function, passing 0 as the present value and the target amount as the future value. Replace the
statements in the button’s C1ick event handler with the following and run the project:

Dim mPay As Double

Dim Duration As Integer = 15 * 12

Dim Rate As Single = (4.0 / 100.0) / 12

Dim Amount As Single = -40000.0

mPay = Pmt(Rate, Duration, 0, Amount)

MsgBox("A monthly deposit of " & mPay.ToString("C") & vbCrLf &
"every month will yield $40,000 in 15 years")

It turns out that if you want to accumulate $40,000 over the next 15 years to send your kid to
college, assuming a constant interest rate of 4%, you must deposit $162.54 every month. You'll
put out almost $30,000, and the rest will be the interest you earn.

Pmt() is one of the simpler financial functions provided by the Framework, but most of us
would find it really difficult to write the code for this function. Because financial calculations
are quite common in business programming, many of the functions you might need already
exist, and all you need to know is how to call them. If you're developing financial applications,
you should look up the financial functions in the documentation. You can experiment with the
Pmt() function (and learn the basics of banking) by finding out the monthly payments for a
loan and an investment of the same amount and same duration, using the current interest rates.

Let’s look at another useful built-in function, the MonthName() function, which accepts as an
argument a month number and returns the name of the month. This function is not as trivial
as you might think because it returns the month name or its abbreviation in the language of
the current culture. The MonthName() function accepts as arguments the month number and a
True/False value that determines whether it will return the abbreviation or the full name of the
month. The following statements display the name of the current month (both the abbreviation
and the full name). Every time you execute these statements, you will see the current month’s
name in the current language:

Dim mName As String
mName = MonthName(Now.Month, True)

MsgBox(mName) ' prints "Jan"
mName = MonthName(Now.Month, False)
MsgBox(mName) " prints "January"

A similar function, the WeekDayName() function, returns the name of the week for a specific
weekday. This function accepts an additional argument that determines the first day of the



ARGUMENTS | 113

week. (See the documentation for more information on the syntax of the WeekDayName()
function.)

The primary role of functions is to extend the functionality of the language. Many functions
that perform rather common practical operations have been included in the language, but they
aren’t nearly enough for the needs of all developers or all types of applications. Besides the
built-in functions, you can write custom functions to simplify the development of your custom
applications, as explained in the following section.

Custom Functions

Most of the code we write is in the form of custom functions or subroutines that are called
from several places in the application. Subroutines are just like functions except that they don’t
return a value, so we'll focus on the implementation of custom functions. With the exception of
a function’s return value, everything else presented in this and the following section applies to
subroutines as well.

Let’s look at an example of a fairly simple (but not trivial) function that does something
useful. Books are identified by a unique international standard book number (ISBN), and every
application that manages books needs a function to verify the ISBN, which is made up of 12
digits followed by a check digit. To calculate the check digit, you multiply each of the 12 digits
by a constant; the first digit is multiplied by 1, the second digit is multiplied by 3, the third
digit by 1 again, the fourth digit by 3, and so on. The sum of these multiplications is then
divided by 10, and we take the remainder. The check digit is this remainder subtracted from
10. To calculate the check digit for the ISBN 978078212283, compute the sum of the following
products:

9 % 1 4 8% 1 +0%3+4+7%1+8%3

2% 1 4 2%14+2%3+8%1+3%*3

o+

7 % 3 +
1*3 4+ 99

The sum is 99; when you divide it by 10, the remainder is 9. The check digit is 10 - 9, or 1, and
the book’s complete ISBN is 9780782122831. The ISBNCheckDigit() function, shown in Listing
3.11, accepts the 12 digits of the ISBN as an argument and returns the appropriate check digit.

LISTING 3.11: The ISBNCheckDigit() custom function

Function ISBNCheckDigit(ByVal ISBN As String) As String
Dim i As Integer, chksum As Integer = 0
Dim chkDigit As Integer
Dim factor As Integer = 3
For i = 0 To 11
factor = 4 - factor
chksum += factor * Convert.ToIntl6(ISBN.SubString(i, 1))
Next
Return (10 - (chksum Mod 10)).ToString
End Function

The ISBNCheckDigit() function returns a string value because ISBNs are handled as strings,
not numbers. (Leading zeros are important in an ISBN but are totally meaningless, and omitted,
in a numeric value.) The SubString method of a String object extracts a number of characters
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from the string to which it’s applied. The first argument is the starting location in the string,
and the second is the number of characters to be extracted. The expression ISBN.SubString(i,
1) extracts one character at a time from the ISBN string variable. During the first iteration of the
loop, it extracts the first character; during the second iteration, it extracts the second character;
and so on.

The extracted character is a numeric digit stored as a character, which is converted to its
numeric value and then multiplied by the factor variable value. The result is added to the
chkSum variable. This variable is the checksum of the ISBN. After it has been calculated, we
divide it by 10 and take its remainder (the Mod operator returns the remainder of this division),
which we subtract from 10. This is the ISBN’s check digit and the function’s return value.

You can use this function in an application that maintains a book database to make sure all
books are entered with a valid ISBN. You can also use it with a web application that allows
viewers to request books by their ISBN. The same code will work with two different applica-
tions, and you can even pass it to other developers. Developers using your function don’t have
to know how the check digit is calculated, just how to call the function and retrieve its result.
In Chapter 8, “Working with Objects,” you'll learn how to package this function as a method
so that other developers can use it without having access to your code. They will be able to call
it to calculate an ISBN’s check digit, but they won’t be able to modify the function’s code.

To test the ISBNCheckDigit() function, start a new project, place a button on the form, and
enter the following statements in its CT1ick event handler (or open the ISBN project in the folder
with this chapter’s sample projects at www.sybex.com/go/masteringvb2010):

Private Sub Buttonl_Click(ByVal sender As System.Object,
ByvVal e As System.EventArgs) Handles Buttonl.Click
Console.WriteLine("'The check Digit is " &
ISBNCheckDigit("978078212283"))
End Sub

After inserting the code of the ISBNCheckDigit() function and the code that calls the func-
tion, your code editor should look like Figure 3.1. You can place a TextBox control on the form
and pass the Text property of the control to the ISBNCheckDigit() function to calculate the
check digit.

FIGURE 3.1 e
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A similar algorithm is used for calculating the check digit of credit cards: the Luhns algo-
rithm. You can look it up on the Internet and write a custom function for validating credit card
numbers.

Passing Arguments and Returning Values

So far, you've learned how to write and call procedures with a few simple arguments and
how to retrieve the function’s return value and use it in your code. This section covers a few
advanced topics on argument-passing techniques and how to write functions that return multi-
ple values, arrays of values, and custom data types.

PASSING AN UNKNOWN NUMBER OF ARGUMENTS

Generally, all the arguments that a procedure expects are listed in the procedure’s definition,
and the program that calls the procedure must supply values for all arguments. On occasion,
however, you might not know how many arguments will be passed to the procedure. Proce-
dures that calculate averages or, in general, process multiple values can accept from a few
to several arguments whose count is not known at design time. Visual Basic supports the
ParamArray keyword, which allows you to pass a variable number of arguments to a proce-
dure. There are situations where you might not know in advance whether a procedure will
be called with two or two dozen arguments, and this is where the ParamArray comes in very
handy because it allows you to pass an array with any number of arguments.

Let’s look at an example. Suppose that you want to populate a ListBox control with ele-
ments. To add a single item to the ListBox control, you call the Add method of its Items col-
lection as follows:

ListBox1l.Items.Add("new item")

This statement adds the string new item to the ListBox1 control. If you frequently add
multiple items to a ListBox control from within your code, you can write a subroutine that
performs this task. The following subroutine adds a variable number of arguments to the
ListBox1 control:

Sub AddNamesTolList(ByVal ParamArray NamesArray() As Object)
Dim x As Object
For Each x In NamesArray
ListBoxl.Items.Add(x)
Next x
End Sub

This subroutine’s argument is an array prefixed with the keyword ParamArray. This array
holds all the parameters passed to the subroutine. If the parameter array holds items of the
same type, you can declare the array to be of the specific type (string, integer, and so on). To
add items to the list, call the AddNamesToList() subroutine as follows:

AddNamesToList("Robert", "Manny", "Renee", "Charles", "Madonna")

If you want to know the number of arguments actually passed to the procedure, use the Length
property of the parameter array. The number of arguments passed to the AddNamesToList()
subroutine is given by the following expression:

NamesArray.Length
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The following loop goes through all the elements of the NamesArray array and adds them to
the list (this is an alternate implementation of the AddNamesToList subroutine):

Dim i As Integer

For i = 0 to NamesArray.Length
ListBox1l.Items.Add(NamesArray(i))

Next i

A procedure that accepts multiple arguments relies on the order of the arguments. To omit
some of the arguments, you must use the corresponding comma. Let’s say you want to call
such a procedure and specify the first, third, and fourth arguments. The procedure must be
called as follows:

ProcName(argl, , arg3, arg4)

The arguments to similar procedures are frequently of equal stature, and their order doesn’t
make any difference. A function that calculates the mean or other basic statistics of a set of
numbers, or a subroutine that populates a ListBox or ComboBox control, is prime candidates
for this type of implementation. If the procedure accepts a variable number of arguments that
aren’t equal in stature, you should consider the technique described in the following section. If
the function accepts a parameter array, the parameter array must be the last argument in the
list, and none of the other parameters can be optional.

NAMED ARGUMENTS

You learned how to write procedures with optional arguments and how to pass a variable
number of arguments to the procedure. The main limitation of the argument-passing mecha-
nism, though, is the order of the arguments. By default, Visual Basic matches the values passed
to a procedure to the declared arguments by their order (which is why the arguments you've
seen so far are called positional arguments).

This limitation is lifted by Visual Basic’s capability to understand named arguments. With
named arguments, you can supply arguments in any order because they are recognized by
name and not by their order in the list of the procedure’s arguments. Suppose you've written a
function that expects three arguments: a name, an address, and an email address:

Sub CreateContact(Name As String, Address As String, EMail As String)

Presumably, this subroutine creates a new contact with the specified data, but right now
we’re not interested in the implementation of the function, just how to call it. When calling this
subroutine, you must supply three strings that correspond to the arguments Name, Address,
and EMail, in that order. You can call this subroutine as follows:

CreateContact("Peter Evans", "2020 Palm Ave., Santa Barbara, CA 90000",
"PeterEvans@example.com")

However, there’s a safer way. You can call it by supplying the arguments in any order by their
names:

CreateContact(Address:= "2020 Palm Ave., Santa Barbara, CA 90000",
EMail:= "PeterEvans@example.com", Name:= "Peter Evans")
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The := operator assigns values to the named arguments. Because the arguments are passed by
name, you can supply them in any order.
To test this technique, enter the following subroutine declaration in a form’s code:

Sub CreateContact(ByVal Name As String, ByVal Address As String,
Byval EMail As String)
Debug.WriteLine(Name)
Debug.WriteLine(Address)
Debug.WriteLine(EMail)
End Function

Then call the CreateContact() subroutine from within a button’s Cl1ick event with the fol-
lowing statement:

Debug.WriteLine(
CreateContact(Address:= "2020 Palm Ave., Santa Barbara, CA 90000",
Name:= "Peter Evans", EMail:= "PeterEvans@example.com"))

You'll see the following in the Immediate window:

Peter Evans
2020 Palm Ave., Santa Barbara, CA 90000
PeterEvans@example.com

The subroutine knows which value corresponds to which argument and can process them
the same way that it processes positional arguments. Notice that the subroutine’s definition
is the same, whether you call it with positional or named arguments. The difference is in how
you call the subroutine and not how you declare it.

Named arguments make code safer and easier to read, but because they require a lot of
typing, most programmers don’t use them. Besides, when IntelliSense is on, you can see the
definition of the function as you enter the arguments, and this minimizes the chances of swap-
ping two values by mistake.

FUNCTIONS RETURNING ARRAYS

In addition to returning custom data types, VB 2010 functions can return arrays. This is an
interesting possibility that allows you to write functions that return not only multiple values,
but also any number of values.

In this section, we’ll write the Statistics() function, similar to the CalculateStatistics()
function you saw a little earlier in this chapter. The Statistics() function returns the statistics
in an array. Moreover, it returns not only the average and the standard deviation, but the
minimum and maximum values in the data set as well. One way to declare a function that
calculates all the statistics is as follows:

Function Statistics(ByRef DataArray() As Double) As Double()
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This function accepts an array with the data values and returns an array of Doubles. To
implement a function that returns an array, you must do the following:

1. Specify a type for the function’s return value and add a pair of parentheses after the type’s
name. Don’t specify the dimensions of the array to be returned here; the array will be
declared formally in the function.

2. In the function’s code, declare an array of the same type and specify its dimensions. If the
function should return four values, use a declaration like this one:

Dim Results(3) As Double

The Results array, which will be used to store the results, must be of the same type as the
function — its name can be anything.

3. To return the Results array, simply use it as an argument to the Return statement:

Return(Results)

4. In the calling procedure, you must declare an array of the same type without dimensions:

Dim Statistics() As Double

5. Finally, you must call the function and assign its return value to this array:

Stats() = Statistics(DataSet())

Here, DataSet is an array with the values whose basic statistics will be calculated by the
Statistics() function. Your code can then retrieve each element of the array with an index
value as usual.

Overloading Functions

There are situations in which the same function must operate on different data types or a dif-
ferent number of arguments. In the past, you had to write different functions, with different
names and different arguments, to accommodate similar requirements. The Framework intro-
duced the concept of function overloading, which means that you can have multiple implemen-
tations of the same function, each with a different set of arguments and possibly a different
return value. Yet all overloaded functions share the same name. Let me introduce this concept
by examining one of the many overloaded functions that comes with the .NET Framework.

The Next method of the System.Random class returns a random integer value from
-2,147,483,648 to 2,147,483,647. (This is the range of values that can be represented by the
Integer data type.) We should also be able to generate random numbers in a limited range of
integer values. To emulate the throw of a die, we want a random value in the range from 1 to
6, whereas for a roulette game we want an integer random value in the range from 0 to 36.
You can specify an upper limit for the random number with an optional integer argument. The
following statement will return a random integer in the range from 0 to 99:

randomInt = rnd.Next(100)
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You can also specify both the lower and upper limits of the random number’s range. The
following statement will return a random integer in the range from 1,000 to 1,999:

randomInt = rnd.Next(1000, 2000)

To use the Random class in your code, you must create a variable of this type and then call
its methods:

Dim rnd As New Math.Random
MsgBox(rnd.Next(1, 6))

The same method behaves differently based on the arguments we supply. The behavior of
the method depends on the type of the arguments, the number of the arguments, or both. As
you will see, there’s no single function that alters its behavior based on its arguments. There are
as many different implementations of the same function as there are argument combinations.
All the functions share the same name, so they appear to the user as a single multifaceted func-
tion. These functions are overloaded, and you’ll see how they’re implemented in the following
section.

If you haven’t turned off the IntelliSense feature of the editor, as soon as you type the open-
ing parenthesis after a function or method name, you'll see a yellow box with the syntax of the
function or method. You’ll know that a function, or a method, is overloaded when this box con-
tains a number and two arrows. Each number corresponds to a different overloaded form, and
you can move to the next or previous overloaded form by clicking the two little arrows or by
pressing the arrow keys.

Let’s return to the Min() function we implemented earlier in this chapter. The initial imple-
mentation of the Min() function is shown next:

Function Min(ByVal a As Double, ByVal b As Double) As Double
Min = IIf(a < b, a, b)
End Function

By accepting Double values as arguments, this function can handle all numeric types. VB
2010 performs automatic widening conversions (it can convert Integers and Decimals to Dou-
bles), so this trick makes the function work with all numeric data types. However, what about
strings? If you attempt to call the Min() function with two strings as arguments, you'll get a
compiler error. The Min() function just can’t handle strings.

To write a Min() function that can handle both numeric and string values, you must write
two Min() functions. All Min() functions must be prefixed with the Overloads keyword. The
following statements show two different implementations of the same function, one for num-
bers and another one for strings:

Overloads Function Min(ByVal a As Double, ByVal b As Double) As Double
Min = Convert.ToDouble(IIf(a < b, a, b))
End Function

Overloads Function Min(ByVal a As String, ByVal b As String) As String
Min = Convert.ToString(IIf(a < b, a, b))
End Function
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You need a third overloaded form of the same function to compare dates. If you call the
Min() function, passing as an argument two dates as in the following statement, the Min()
function will compare them as strings and return (incorrectly) the first date:

Debug.WriteLine(Min(#1/1/2011#, #3/4/2010#))

This statement is not even valid when the Strict option is on, so you clearly need another over-
loaded form of the function that accepts two dates as arguments, as shown here:

Overloads Function Min(ByVal a As Date, ByVal b As Date) As Date
Min = Convert.ToDateTime(IIf(a < b, a, b))
End Function

If you now call the Min() function with the dates #1/1/2011# and #3/4/20104, the func-
tion will return the second date, which is chronologically smaller than the first. Assuming that
you have inserted the three forms of the Min() function in your code as shown in Figure 3.2,
as soon you enter the name of the function, the IntelliSense box will display the first form of
the function. Click the buttons with the arrows to see the other ones and select the appropri-
ate form.

FIGURE 3.2 overloads function Min{byval a Az Date, DyVal b As Date) As Date
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If you're wondering about the Convert.ToDateTime method, it's used because the IIf()
function returns a value of the Object type. Each of the overloaded forms of the Min() function,
however, has a specific type. If the Strict option is on (the recommended setting), you should
make sure the function returns the appropriate type by converting the result of the IIf() func-
tion to the corresponding type, as shown in the preceding Min() examples.

VB2010 AT WORK: THE OVERLOADEDFUNCTIONS PROJECT

Let’s look into a more complicated overloaded function, which makes use of some topics dis-
cussed later in this book. The CountFiles() function that follows counts the number of files
in a folder that meet certain criteria. The criteria could be the size of the files, their type, or the
date they were created. You can come up with any combination of these criteria, but the follow-
ing are the most useful combinations. (These are the functions I would use, but you can create
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even more combinations or introduce new criteria of your own.) The names of the arguments
are self-descriptive, so I won’t explain what each form of the CountFiles() function does.

CountFiles(ByVal minSize As Integer, ByVal maxSize As Integer) As Integer
CountFiles(ByVvVal fromDate As Date, ByVal toDate As Date) As Integer
CountFiles(ByVal type As String) As Integer
CountFiles(ByVal minSize As Integer, ByVal maxSize As Integer,

Byval type As String) As Integer
CountFiles(ByVal fromDate As Date, ByVal toDate As Date,

ByvVal type As String) As Integer

Listing 3.12 shows an implementation of these overloaded forms of the CountFiles() func-
tion. (I'm not showing all overloaded forms of the function; you can open the Overloaded-
Functions project in the IDE and examine the code.) Because we haven’t discussed file oper-
ations yet, most of the code in the function’s body will be new to you — but it’s not hard to
follow. For the benefit of readers who are totally unfamiliar with file operations, I included a
statement that prints in the Immediate window the type of files counted by each function. The
Debug.WriteLine statement prints the values of the arguments passed to the function along
with a description of the type of search it will perform. The overloaded form that accepts two
integer values as arguments prints something like this:

You've requested the files between 1000 and 100000 bytes

The overloaded form that accepts a string as an argument prints the following:

You've requested the .EXE files

LISTING 3.12: The overloaded implementations of the CountFiles() function

Overloads Function CountFiles(
ByVal minSize As Integer, ByVal maxSize As Integer) As Integer
Debug.WriteLine("You've requested the files between " &
minSize & " and " & maxSize & " bytes")
Dim files() As String
files = System.IO.Directory.GetFiles("c:\windows")
Dim i, fileCount As Integer
For i = 0 To files.GetUpperBound(0)
Dim FI As New System.IO.FileInfo(files(i))
If FI.Length >= minSize And FI.Length <= maxSize Then
fileCount = fileCount + 1
End If
Next
Return(fileCount)
End Function

Overloads Function CountFiTles(
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Byval fromDate As Date, ByVal toDate As Date) As Integer
Debug.WriteLine("You've requested the count of files created from " &
fromDate & " to " & toDate)
Dim files() As String
files = System.IO.Directory.GetFiles("c:\windows")
Dim i, fileCount As Integer
For i = 0 To files.GetUpperBound(0)
Dim FI As New System.IO.FileInfo(files(i))
If FI.CreationTime.Date >= fromDate And
FI.CreationTime.Date <= toDate Then
fileCount = fileCount + 1
End If
Next
Return(fileCount)
End Function

Overloads Function CountFiles(ByVal type As String) As Integer
Debug.WriteLine("You've requested the " & type & " files")
" Function Implementation

End Function

Overloads Function CountFiTes(
ByVal minSize As Integer, ByVal maxSize As Integer,
ByVal type As String) As Integer
Debug.WriteLine("You've requested the " & type &
" files between " & minSize & " and " &
maxSize & " bytes")
' Function implementation
End Function

Overloads Function CountFiTles(
ByVal fromDate As Date,
ByVal toDate As Date, ByVal type As String) As Integer
Debug.WriteLine("You've requested the " & type &
" files created from " & fromDate & " to " & toDate)
Function implementation
End Function

If you're unfamiliar with the Directory and File objects, focus on the statement that prints
to the Immediate window and ignore the statements that actually count the files that meet
the specified criteria. After reading the tutorial “Accessing Folders and Files,” published at
www . sybex.com/go/masteringvb2010, you can revisit this example and understand the state-
ments that select the qualifying files and count them.

Start a new project and enter the definitions of the overloaded forms of the function on the
form’s level. Listing 3.12 is lengthy, but all the overloaded functions have the same structure
and differ only in how they select the files to count. Then place a TextBox and a button on the
form, as shown in Figure 3.3, and enter a few statements that exercise the various overloaded
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forms of the function (such as the ones shown in Listing 3.13) in the button’s Click event

handler.

LISTING 3.13:

Testing the overloaded forms of the CountFiTles() function

Private Sub Buttonl_Click(..) Handles Buttonl.Click
TextBox1.AppendText(CountFiles(1000, 100000) &

" files with size between 1KB and 100KB" & vbCrLf)

TextBox1.AppendText(CountFiles(#1/1/2006#, #12/31/2006#) &

" files created in 2006" & vbCrLf)

TextBox1.AppendText(CountFiles(".BMP") & " BMP files" & vbCrLf)
TextBox1.AppendText(CountFiles(1000, 100000, ".EXE") &

" EXE files between 1 and 100 KB" & vbCrLf)

TextBox1.AppendText(CountFiles(#1/1/2006#, #12/31/2007#, ".EXE") &

End Sub

" EXE files created in 2006 and 2007")

FIGURE 3.3
The OverloadedFunc-
tions project

s Function Cveriaading [

1329 filzs with size between 1KB and 100KB
1433 files covatied in 2003

9 BMP Eles

2 EXE M= betavsizn 1 and 10K KB

| EXE fles created from 2007 to 2009

The button calls the various overloaded forms of the CountFiles() function one after the
other and prints the results on the TextBox control. From now on, I'll be omitting the list of
arguments in the most common event handlers, such as the Click event handler, because
they’re always the same and they don’t add to the readability of the code. In place of the two
arguments, I'll insert an ellipsis to indicate the lack of the arguments.

Function overloading is used heavily throughout the language. There are relatively few
functions (or methods, for that matter) that aren’t overloaded. Every time you enter the
name of a function followed by an opening parenthesis, a list of its arguments appears in the
drop-down list with the arguments of the function. If the function is overloaded, you'll see a
number in front of the list of arguments, as shown in Figure 3.4. This number is the order of
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the overloaded form of the function, and it’s followed by the arguments of the specific form
of the function. The figure shows all the forms of the CountFiles() function.

FIGURE 3.4

The overloaded forms A Lolh W Courthiertype At Strng) 42 :-:e.:e-'i

of the CountFiles() Tha typa of the Max to serch for
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The earfiest creation date for the the et 1o be included in the searrh

A& 3ol S W CoorthiesiminSine AS Inbeger, mushe A% [nheger] A% Riege
Thie minimum file sire of the files 10 be included in Ehe search

:L 4of5 W CourtfieiomDale As Dale foDale Ad Dale type Mg Slring] Ad Inieget

The earett créathon date Tor the the Tles 10 be included in Bhe search

The minimaim sire of the file ta be included in the search

I W Courtiiesimintize As Integer, masSoe As [nbeper, Bype A% Sinng) As Z"bh;e.'l

DOCUMENTING FUNCTIONS

When working with overloaded functions and methods, you need as much help from the editor
as possible because there are many arguments taken in total. You can document each argument
of each overloaded form with a short description that will be displayed in the IntelliSense box
as the user enters the argument values for the selected form, as shown in Figure 3.4. The same
techniques apply to all functions, of course, not just to overloaded functions. While you can get
by without documenting functions that are not overloaded, it’s almost a necessity when work-
ing with overloaded functions. To document a function, enter three single quotes in an empty
line of the editor, just before the function’s definition. As soon as you type the third quote, the
editor will insert a boilerplate for the function as follows:

<summary>

"< /summary>

<param name="fromDate"></param>
""" <param name="toDate"></param>
"' <param name="type"></param>

"' <returns></returns>

"' <remarks></remarks>

Enter any comments about the function in the summary section, even notes to yourself about
future improvements, desired but not implemented features, and so on. There’s a param section
for each of the arguments where you must insert a short description regarding each argument.
This is the description that will appear in the IntelliSense drop-down list as the user enters each
argument. Finally, in the returns section you must enter the function’s description, which will
be also displayed in the IntelliSense list. Here’s the documentation of one of the overloaded
forms of the CountFiles method:

" <summary>

" </summary>
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"' <param name="minSize">The minimum size of the file to be included
in the search</param>
<param name="maxSize">The maximum size of the file to be included
in the search</param>
"' <param name="type">The number of files of the specified type</param>
""" <returns>The number of files with a size in a given range
and of a specific type</returns>
"' <remarks></remarks>

The Bottom Line

Use Visual Basic’s flow-control statements Visual Basic provides several statements for con-
trolling the flow of control in a program: decision statements, which change the course of exe-
cution based on the outcome of a comparison, and loop statements, which repeat a number of
statements while a condition is true or false.

Master It Explain briefly the decision statements of Visual Basic.

Write subroutines and functions To manage large applications, break your code into small,
manageable units. These units of code are the subroutines and functions. Subroutines perform
actions and don’t return any values. Functions, on the other hand, perform calculations and
return values. Most of the language’s built-in functionality is in the form of functions.

Master It How will you create multiple overloaded forms of the same function?

Pass arguments to subroutines and functions Procedures and functions communicate with
one another via arguments, which are listed in a pair of parentheses following the procedure’s
name. Each argument has a name and a type. When you call a procedure, you must supply
values for each argument, and the types of the values should match the types listed in the pro-
cedure’s definition.

Master It Explain the difference between passing arguments by value and passing argu-
ments by reference.
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Chapter 4

GUI Design and Event-Driven
Programming

The first three chapters of this book introduced you to the basics of designing applications with
Visual Studio 2010 and the components of the Visual Basic language. You know how to design
graphical user interfaces (GUIs) and how to use Visual Basic statements to program events for
the various controls. You also know how to write functions and subroutines and how to call
the functions and subroutines that are built into Visual Basic.

In this chapter, you'll design a few more Windows applications — this time, a few practical
applications with more functional interfaces and a bit of code that does something more prac-
tical. You'll put together the information presented so far in the book by building Windows
applications with the visual tools of Visual Studio, and you’ll see how the applications interact
with users by coding the events of interest. If you are new to Visual Studio, you should design
the examples on your own using the instructions in the text rather than open the projects for
this chapter (available for download at www.sybex.com/go/masteringvb2010) and look at
the code.

In this chapter, you will learn how to do the following:

¢ Design graphical user interfaces
¢ Program events

¢ Write robust applications with error handling

On Designing Windows Applications

As you recall from Chapter 1, “Getting Started with Visual Basic 2010,” the design of a Win-
dows application consists of two distinct phases: the design of the application’s interface and
the coding of the application. The design of the interface is performed with visual tools and
consists of creating a form with the relevant elements. These elements are the building blocks
of Windows applications and are called controls.

The available controls are shown in the Toolbox and are the same elements used by all Win-
dows applications. You can purchase additional controls from third-party vendors or create
your own custom controls. After you install third-party or custom controls, they will appear
in the Toolbox alongside the built-in controls. In addition to being visually rich, the controls
embed a lot of functionality. The TextBox control, for example, can handle text on its own,
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without any programming effort on your part. The ComboBox control expands the list with its
items when users click the arrow button and displays the selected item in its edit box. In gen-
eral, the basic functionality of the controls is built in by design so that all applications maintain
a consistent look.

The interface dictates how users will interact with your application. To prompt users for
text or numeric data, use TextBox controls. When it comes to specifying one or more of several
options, you have many choices: You can use a ComboBox control from which users can select
an option, or you can put a few CheckBox controls on a form that users can select or clear. If
you want to display a small number of mutually exclusive options, place a few RadioButton
controls on the form. Every time the user selects an option, the previously selected one is
cleared. To initiate actions, place one or more Button controls on the form. You will learn
more about basic Windows controls and their properties in Chapter 5, “The Basic Windows
Controls.”

Controls expose a large number of properties, which are displayed in the Properties window
at design time. You use these properties to adjust not only the appearance of the controls on
the form but their functionality as well. The process of designing the interface consists mostly
of setting the properties of the various controls. By the way, you can also set the properties of
controls through code. The code will take effect in runtime. You will see some examples of such
code in the next chapter.

An important aspect of the design of your application’s user interface is the alignment of the
controls on the form. Controls that are next to one another should be aligned horizontally. Con-
trols that are stacked should have either their left or right edges aligned vertically. You should
also make sure the controls are spaced equally. The integrated development environment (IDE)
provides all the tools for sizing, aligning, and spacing controls on the form, and you'll see these
tools in action through examples in this chapter.

By designing the interface you have practically outlined how the application will interact
with the user. The next step is to actually implement the interaction by writing some code. The
programming model of Visual Basic is event driven: As the user interacts with the controls on
your form, some code is executed in response to user actions. The user’s actions cause events,
and each control recognizes its own set of events and handles them through subroutines, which
are called event handlers. When users click a button, the control’s Click event is fired, and you
must insert the relevant code in the control’s C1ick event handler. The event-driven program-
ming model has proven very successful because it allows developers to focus on handling spe-
cific actions. It allows you to break a large application into smaller, manageable units of code
and implement each unit of code independently of any other.

Developing Windows applications is a conceptually simple process, but there’s a methodol-
ogy to it and it’s not trivial. Fortunately, the IDE provides many tools to simplify the process;
it will even catch most of the errors in your code as you type. You have seen how to use some
of the tools of the IDE in the first three chapters. In this chapter, I'll present these tools through
examples.

Building a Loan Calculator

One easy-to-implement, practical application is a program that calculates loan parameters.
Visual Basic provides built-in functions for performing many types of financial calculations,
and you need only a single line of code to calculate the monthly payment given the loan
amount, its duration, and the interest rate. Designing the user interface, however, takes much
more effort.
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Regardless of the language you use, you must go through the following process to develop
an application:

1. Decide what the application will do and how it will interact with the user.
2. Design the application’s user interface according to the requirements of step 1.

3. Write the actual code behind the events you want to handle.

@ Real World Scenario

USING PROTOTYPES TO CAPTURE APPLICATION REQUIREMENTS

A prototype is an incomplete version of an application that simulates some aspects of applica-
tion functionality. The prototype is created by using constant or hard-coded values to supplant
values the program should calculate in runtime. For example, a prototype for the Loan Calcu-
lator application (see Figure 4.1) might display the form with all of the controls necessary for
loan calculation. However, when the user presses the Monthly Payment button, the value that
appears in the Monthly Payment text box would always be the same hard-coded value and
would not vary with input from the other controls.

Most commonly, prototypes are used to simulate the user interface. The purpose of the proto-
type is to get the customer’s approval on the appearance and functionality of an application.
Instead of reading documentation or analyzing drawings of the interface, users can actually
try out the application. This often facilitates user feedback in early application development
stages. Some prototypes are throw-away applications while others can be evolved further into
fully functional applications. Visual Basic is well known for its rapid prototyping features.

Understanding How the Loan Calculator Application Works

Following the first step of the process outlined previously, you decide that the user should be
able to specify the amount of the loan, the interest rate, and the duration of the loan in months.
You must, therefore, provide three text boxes in which the user can enter these values.

Another parameter affecting the monthly payment is whether payments are made at the
beginning or at the end of each month, so you must also provide a way for the user to spec-
ify whether the payments will be early (first day of the month) or late (last day of the month).
The most appropriate type of control for entering Yes/No or True/False type of information
is the CheckBox control. This control is a toggle: If it’s selected, you can clear it by clicking it;
if it’s cleared, you can select it by clicking again. The user doesn’t enter any data in this con-
trol (which means you need not anticipate user errors with this control), and it’s the simplest
method for specifying values with two possible states.

Figure 4.1 shows a user interface that matches our design specifications. This is the main
form of the LoanCalculator project, which you will find in this chapter’s folder on the book’s
project download site.

The user enters all the information on the form and then clicks the Monthly Payment button
to calculate the monthly payment. The program will calculate the monthly payment and dis-
play it in the lower TextBox control. All the action takes place in the Monthly Payment button’s
Click event handler.
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To calculate the monthly payments on a loan, we call the built-in Pmt () function, whose
syntax is as follows:

MonthlyPayment = Pmt(InterestRate, Periods, Amount, FutureValue, Due)

THE Pmt () FUNCTION

Here’s how the Pmt () function works. The interest rate, argument InterestRate, is spec-
ified as a monthly rate. If the annual interest rate is 14.5 percent, the value entered by the
user in the Interest Rate box should be 14.5. The user will express the rate as a percentage,
but the function accepts the decimal value. To convert percentage to a decimal value, you
need to multiply the annual percentage rate by 0.01. Finally, since this is the annual rate and
you need a monthly value, you need to divide the value by 12. The mathematical expression
for converting the annual interest rate specified by the user to a monthly interest rate accepted
by the Pmt() function is: 0.01 * annualInterestRate / 12. In this example, with a 14.5
annual rate, the monthly rate will be 0.145/12. The duration of the loan, the Periods argu-
ment, is specified in number of months, and the Amount argument is the total loan amount.
The FutureValue argument is the value of the loan at the end of the period, which should
be zero (it would be a positive value for an investment), and the last argument, Due, specifies
when payments are due. The value of Due can be one of the constants DueDate.BegOfPeriod
and DueDate.EndOfPeriod. These two constants are built into the language, and you can use
them without knowing their exact value.

The present value of the loan is the amount of the loan with a negative sign. It’s negative
because you don’t have the money now. You’re borrowing it — it is money you owe to the
bank. Future value represents the value of something at a stated time — in this case, what
the loan will be worth when it’s paid off. This is what one side owes the other at the end
of the specified period. So the future value of a loan is zero.

You don’t need to know how the Pmt () function calculates the monthly payment, just how to
call it and how to retrieve the results. To calculate the monthly payment on a loan of $25,000
with an interest rate of 14.5 percent, payable over 48 months and payments due the last day of
the payment period (which in this case is a month), you’d call the Pmt() function as follows:

Pmt(0.145 / 12, 48, -25000, O, DueDate.EndOfPeriod)
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The Pmt() function will return the value 689.448821287218. Because it’s a dollar amount,
you must round it to two decimal digits on the interface. Notice the negative sign in front of
the Amount argument in the statement. If you specify a positive amount, the result will be
a negative payment. The payment and the loan’s amount have different signs because they
represent different cash flows. The loan’s amount is money you owe to the bank, whereas the
payment is money you pay to the bank.

The last two arguments of the Pmt() function are optional. The Parameter Info feature of
the IntelliSense autocompletion system built into Visual Studio will indicate optional param-
eters by placing them inside the square brackets in the Parameter Info pop-up window, as
shown here.

If you omit optional parameters, Visual Basic uses their default values, which are o for the
FutureValue argument and DueDate.BegOfPeriod for the Due argument. You can entirely
omit these arguments and call the Pmt() function like this:

Pmt(0.145 / 12, 48, -25000)

Calculating the amount of the monthly payment given the loan parameters is quite simple.
For this exercise, what you need to understand are the parameters of a loan and how to pass
them to the Pmt() function. You must also know how the interest rate is specified to avoid
invalid values. Although the calculation of the payment is trivial, designing the interface will
take a bit of effort. You need to make sure the interface is easily understood and intuitive.
When the user is confronted with the application, they should be able to guess easily what
the application is doing and how they can interact with it. The application should also behave
according to the principle of least surprise. For example, if the user presses the Tab button,
they expect that focus of the controls will move from right to left or from top to bottom. Also,
the user will expect the application to perform basic data validation. If the application detects
invalid data, the user will expect that the focus will be set on the control containing the invalid
value so that they can immediately correct the entered value. These are just a few example
characteristics of well-behaved applications.

If you wish to learn more about GUI guidelines that Microsoft recommends for applications
running on Windows 7 and Windows Vista, you can download the “Windows User Experience
Interaction Guidelines”” PDF file from MSDN. You will find the download link at the following
URL: http://msdn.microsoft.com/en-us/library/aa511258.aspx.

Designing the User Interface

Now that you know how to calculate the monthly payment and understand the basics of good
interface design, you can design your own user interface. To do so, start a new Windows Forms
project, name it LoanCalculator, and rename its form to frmLoan. Your first task is to decide
the font and size of the text you'll use for the controls on the form. The form is the container
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for the controls, and they receive some of the form’s properties, such as the font. You can
change the font later during the design, but it’s a good idea to start with the right font. At any
rate, don’t try to align the controls if you're planning to change their fonts. The change will,
most likely, throw off your alignment efforts.

The book’s sample project uses the 10-point Verdana font. To change it, select the form with
the mouse, double-click the name of the Font property in the Properties window to open the
Font dialog box, and select the desired font and attributes. I use the Verdana and Seago fonts
a lot because they’re clean and they were designed for viewing on monitors. Of course, this is
a personal choice. Avoid elaborate fonts and don’t mix different fonts on the same form (or in
different forms of the same application).

To design the form shown in Figure 4.1, follow these steps:

1. Place four labels on the form and assign the captions (the Text property of each control)
listed in Table 4.1 to them.
You don’t need to change the default names of the four Label controls on the form because
their captions are all you need. You aren’t going to add any code to them.

2. Place a TextBox control next to each label. Use the information in Table 4.2 to set the Name
and Text property values. I used meaningful names for the TextBox controls because we'll
use them in our code shortly to retrieve the values entered by the user on these controls.
These initial values correspond to a loan of $25,000 with an interest rate of 14.5 percent and
a payoff period of 48 months.

TABLE 4.1: LoanCalulator label captions
NAME TEXT
Labell Amount
Label2 Duration (months)
Label3 Interest Rate (annual)
Label4 Monthly Payment
TABLE 4.2: LoanCalulator TextBox control names and default value text
NAME TEXT
txtAmount 25000
txtDuration 48
txtRate 14.5

txtPayment




9.

BUILDING A LOAN CALCULATOR

The fourth TextBox control is where the monthly payment will appear. The user isn’t sup-
posed to enter any data in this box, so set the ReadOnTy property to True to lock the con-
trol and prevent users from entering data. You'll be able to change its value from within
your code, but users won't be able to type anything in it. (We could have used a Label
control instead, but the uniform look of TextBoxes on a form is usually preferred.) You
will also notice that the TextBox controls have a 3D frame. Experiment with the control’s
BorderStyle property to discover the available styles for the control’s frame (I've used the
Fixed3D setting for the TextBox controls).

Next, place a CheckBox control on the form. By default, the control’s caption is CheckBox1,
and it appears to the right of the check box. Because we want the titles to be to the left of the
corresponding controls, we'll change this default appearance.

Select the check box with the mouse, and in the Properties window locate the CheckATign
property. Its value is MiddTeLeft. If you expand the drop-down list by clicking the arrow
button, you'll see that this property has many different settings, and each setting is shown
as a square. Select the button that will center the text vertically and right-align it horizon-
tally. The string MiddTeRight will appear in the Properties window when you click the
appropriate button.

With the check box selected, locate the Name property in the Properties window, and set it
to chkPayEarly.

Change the CheckBox’s caption by entering the string Early Payment in its Text property
field.

Place a Button control in the bottom-left corner of the form. Name it bttnShowPayment, and
set its Text property to Month1y Payment.

Finally, place another Button control on the form, name it bttnExit, and set its Text prop-
erty to Exit.

ALIGNING THE CONTROLS

Your next step is to align the controls on the form. The IDE provides commands to align the
controls on the form, all of which can be accessed through the Format menu. To align the con-
trols that are already on the form, follow these steps:

1.

Select the four labels on the form. The handles of all selected controls will be black except
for one control whose handles will be white. To specify the control that will be used as a
reference for aligning the other controls, click it after making the selection. (You can select
multiple controls either by using the mouse to draw a rectangle that encloses them or by
clicking each control while holding down the Ctrl button.)

With the four text boxes selected, choose Format > Align > Lefts to left-align them. Don’t
include the check box in this selection.

Resize the CheckBox control. Its left edge should align with the left edges of the Label con-
trols, and its right edge should align with the right edges of the Label controls. In case
the resizing markers do not appear on the CheckBox control, set the value of its AutoSize
property to False.

Select all the Label and the CheckBox controls and choose Format > Vertical Spacing
» Make Equal. This action will space the controls vertically. Then align the baseline of
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each TextBox control with the baseline of the matching Label control. To do so, move each
TextBox control with the mouse until you see a magenta line that connects the baseline of
the TextBox control you're moving and that of the matching Label control.

Your form should now look like the one shown in Figure 4.1. Take a good look at it and
make sure no controls are misaligned. In the interface design process, you tend to overlook
small problems such as a slightly misaligned control. The user of the application, however,
instantly spots such mistakes.

Programming the Loan Application

Now you've created the interface, run the application, and seen how it behaves. Next you'll
enter a few values in the text boxes, change the state of the check box, and test the function-
ality already built into the application. Clicking the Monthly Payment button won’t have any
effect because we have not yet added any code. If this were a prototype you were building for
a customer, you would add a statement in the Monthly Payment button to display a random
value in the Monthly Payment box.

When you double-click the control for the first time, Visual Studio will generate an empty
default event handler declaration for you. Next time you double-click the control, Visual Studio
will bring you to the event handler. If you're happy with the user interface, stop the applica-
tion, open the form, and double-click the Monthly Payment Button control. Visual Basic opens
the code window and displays the definition of the ShowPayment_Cl1ick event:

Private Sub bttnShowPayment_Click(...) Handles
bttnPayment.Click

Because all CTick event handlers have the same signature (they provide the same two argu-
ments), I'll be omitting the list of arguments from now on. Actually, all event handlers have
two arguments, and the first of them is always the control that fired the event. The type of the
second argument differs depending on the type of the event. Place the pointer between the lines
Private Sub and End Sub, and enter the rest of the lines of Listing 4.1. (You don’t have to reen-
ter the first and last lines that declare the event handler.)

LISTING 4.1: The Code behind the Monthly Payment button

Private Sub bttnShowPayment_Click(Byval (..)
Handles bttnShowPayment.Click
Dim Payment As Double
Dim LoanIRate As Double
Dim LoanDuration As Integer
Dim LoanAmount As Integer

LoanAmount = Convert.ToInt32(txtAmount.Text)
LoanIRate = 0.01 * Convert.ToDecimal(txtRate.Text) / 12
LoanDuration = Convert.ToInt32(txtDuration.Text)
Dim payEarly As DueDate
If chkPayEarly.Checked Then
payEarly = DueDate.BegOfPeriod



BUILDING A LOAN CALCULATOR

Else
payEarly = DueDate.EndOfPeriod
End If
Payment = Pmt(LoanIRate, LoanDuration, -LoanAmount, 0, payEarly)
txtPayment.Text = Payment.ToString("#.00")
End Sub

The code window should now look like the one shown in Figure 4.2. In previous versions
of Visual Basic, you would use the underscore character at the end of the first part of the long
line. For the most part, this is no longer necessary; Visual Basic in Visual Studio 2010 supports
implicit line continuations. I'm using implicit line continuations in this book a lot to fit long
lines on the printed page. The same statement you see as multiple lines in the book may appear
in a single, long line in the project.

FIGURE 4.2 _I‘m“'-“ o
The Show Payment T o] ehek .
button’s Click event Peblie Clxis Fra '
handler = Privare Lob betnihowPepmest Cllck(Byval sender Ly Systes.

Byval & As System thrgs) Mandles BronShowFayment.Click

P

Losndscunt = Telnt)3{ tutimcunt . Teut)
Loanliste = 080 * t, Tobecimal [ tanate. Tent) / 12
Loanburation = t, Talnt sy eetburation, Tent)

1y Chegked Then
BegPerled

payEarly = EndofPeried
Fayment = Fut(LossIRste, LoanCurstlion, -Loandsocunt, @, payEsrly)

txtPuyment. Test = Payment.Toktring[~r.207)
[FER S

You don’t have to break long lines manually as you enter code in the editor’s window. Open
the Edit menu and choose Advanced » Word Wrap. The editor will wrap long lines automati-
cally. While the word wrap feature is on, a check mark appears in front of the Edit > Advanced
» Word Wrap command. To turn off word wrapping, select the same command again.

@ Real World Scenario

ENUMERATION TYPES

Enumerations are a special kind of type in Visual Basic language used to define a set of log-
ically related unchanging literal values. A typical example for an enumeration is DayOfWeek
that contains members for each day of the week (DayOfWeek .Monday, DayOfileek . Tuesday,
and so on). Enumerations are declared with the Enum keyword, in following fashion:
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PubTlic Enum DayOfWeek
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Sunday

End Enum

By using Enum instead of simple constant literal values, you add type safety to your applica-
tion. For example, if you define the function that has a day as the DayOfWeek parameter, as
in TicketPrice(movie as Movie, day as DayOfWeek) as Decimal, the code that is calling
the function will have to pass a value defined in the DayOfWeek enum as a parameter, as in
following statement:

Dim price = TicketPrice(avatarMovie, DayOfWeek.Saturday)

Had you defined the days of the week names as constants, as in following code, you would not
be able to perform type checking:

Const Monday As String = "Monday"
Const Tuesday As String = "Tuesday"
Const Wednesday As String = "Wednesday"

Had you no Enum construct in Visual Basic, you would have to resort to constants. When you
use constants, the TicketPrice function would have to declare the day parameter as String,
meaning that when invoking the function, you could pass just any String value. Using the
Enum type, however, you know that value belongs to predefined enumeration.

In Listing 4.1, the first line of code within the subroutine declares a variable. It lets the appli-
cation know that Payment is a variable for storing a floating-point number (a number with a
decimal part) — the Double data type. The line before the If statement declares a variable of
the DueDate type. This is the type of argument that determines whether the payment takes
place at the beginning or the end of the month. The last argument of the Pmt() function must
be a variable of this type, so we declare a variable of the DueDate type. As mentioned earlier in
this chapter, DueDate is an enumeration with two members: Beg0fPeriod and EndOfPeriod.

The first really interesting statement in the subroutine is the If statement that examines
the value of the chkPayEarly CheckBox control. If the control is selected, the code sets the
payEarly variable to DueDate.BegOfPeriod. If not, the code sets the same variable to
DueDate.EndOfPeriod. The ComboBox control’s Checked property returns True if the control
is selected at the time and False otherwise. After setting the value of the payEarTly variable, the
code calls the Pmt() function, passing the values of the controls as arguments:

¢ The first argument is the interest rate. The value entered by the user in the txtRate
TextBox is multiplied by 0.01 so that the value 14.5 (which corresponds to 14.5 percent)
is passed to the Pmt() function as 0.145. Although we humans prefer to specify interest
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rates as integers (8 percent) or floating-point numbers larger than 1 (8.24 percent), the
Pmt() function expects to read a number that’s less than 1. The value 1 corresponds to 100
percent. Therefore, the value 0.1 corresponds to 10 percent. This value is also divided by 12
to yield the monthly interest rate.

¢ The second argument is the duration of the loan in months (the value entered in the
txtDuration TextBox).

The third argument is the loan’s amount (the value entered in the txtAmount TextBox).
The fourth argument (the loan’s future value) is 0 by definition.

The last argument is the payEarly variable, which is set according to the status of the chk-
PayEarly control.

The last statement in Listing 4.1 converts the numeric value returned by the Pmt() function
to a string and displays this string in the fourth TextBox control. The result is formatted appro-
priately with the following expression:

Payment.ToString("#.00")

The Payment variable is numeric, and all numeric variables provide the method ToString,
which formats the numeric value and converts it to a string. The character # stands for the
integer part of the variable. The period separates the integer from the fractional part, which
is rounded to two decimal digits. The Pmt() function returns a precise number, such as
372.2235687646345, and you should round it to two decimal digits and format it nicely before
displaying it. For more information on formatting numeric (and other) values, see the section
“Formatting Numbers” in Chapter 2, VB Programming Essentials.” Finally, the formatted
string is assigned to the Text property of the TextBox control on the form.

@ Real World Scenario

A CODE SNIPPET FOR CALCULATING MONTHLY LOAN PAYMENTS

If you didn’t know about the Pmt() built-in function, how would you go about calculating
loan payments? Code snippets to the rescue!

1. Right-click somewhere in the code window, and from the context menu, choose the Insert
Snippet command.

2. Double-click the Fundamentals folder to see another list of items.

3. This time, double-click the Math folder and then select the snippet Calculate a Monthly Payment
on a Loan.

The following code will be inserted at the location of the pointer:
Dim futureValue As Double = 0

Dim payment As Double
paymentl = Pmt(0.05 / 12, 36, -1000, futureValue, DueDate.EndOfPeriod)
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The snippet demonstrates the use of the Pmt() function. All you have to do is replace the val-
ues of the various parameters with the data from the appropriate controls on the form.

If you don’t know how to use the arguments of the Pmt() function, start editing the func-
tion’s arguments and you will see their description in the usual tooltip box, as with all
built-in functions.

The code of the LoanCalculator sample project is a bit different and considerably longer
than what I have presented here. The statements discussed in the preceding text are the bare
minimum for calculating a loan payment. The user can enter all kinds of unreasonable values
on the form and cause the program to crash. In the next section, you'll see how you can
validate the data entered by the user, catch errors, and handle them gracefully (that is, give the
user a chance to correct the data and proceed) as opposed to terminating the application with
a runtime error.

Validating the Data

If you enter a non-numeric value in one of the fields, the program will crash and display an
error message. For example, if you enter twenty in the Duration text box, the program will dis-
play the error message shown in Figure 4.3. A simple typing error can crash the program. This
isn’t the way Windows applications should work. Your applications must be able to handle all
kinds of user errors, provide helpful messages, and in general, guide the user in running the
application efficiently. If a user error goes unnoticed, your application will either end abruptly
or will produce incorrect results without an indication.
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Visual Basic will take you back to the application’s code window in which the statements
that caused the error will be highlighted in green. Obviously, we must do something about user
errors. One way to take care of typing errors is to examine each control’s contents; if the con-
trols don’t contain valid numeric values, display your own descriptive message and give the
user another chance. Listing 4.2 is the revised C1ick event handler that examines the value of
each text box before attempting to use it in any calculations.

LISTING 4.2: Revised Show Payment button

Private Sub bttnShowPayment_Click(...) Handles bttnPayment.Click
Dim Payment As Double
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Dim LoanIRate As Double
Dim LoanDuration As Integer
Dim LoanAmount As Integer

' Validate amount
If IsNumeric(txtAmount.Text) Then
LoanAmount = Convert.ToInt32(txtAmount.Text)
Else
MsgBox("Invalid amount, please re-enter")
txtAmount.Focus()
txtAmount.SelectA11()
Exit Sub
End If
' Validate interest rate
If IsNumeric(txtRate.Text) Then
LoanIRate = 0.01 * Convert.ToDouble(txtRate.Text) / 12
Else
MsgBox("Invalid interest rate, please re-enter")
txtRate.Focus()
txtRate.SelectA11()
Exit Sub
End If
' Validate loan's duration
If IsNumeric(txtDuration.Text) Then
LoanDuration = Convert.ToInt32(txtDuration.Text)
Else
MsgBox("Please specify the Toan's duration as a number of months")
txtDuration.Focus()
txtDuration.SelectAl11()
Exit Sub
End If
" If all data were validated, proceed with calculations
Dim payEarly As DueDate
If chkPayEarly.Checked Then
payEarly = DueDate.BegOfPeriod
Else
payEarly = DueDate.EndOfPeriod
End If
Payment = Pmt(LoanIRate, LoanDuration, -LoanAmount, 0, payEarly)
txtPayment.Text = Payment.ToString("#.00")
End Sub

First, we declare three variables in which the loan’s parameters will be stored: LoanAmount,
LoanIRate, and LoanDuration. These values will be passed to the Pmt() function as argu-
ments. Each text box’s value is examined with an If structure. If the corresponding text box
holds a valid number, its value is assigned to the numeric variable. If not, the program dis-
plays a warning and exits the subroutine without attempting to calculate the monthly pay-
ment. Before exiting the subroutine, however, the code moves the focus to the text box with
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the invalid value and selects the text in the textbox because this is the control that the user will
most likely edit. After fixing the incorrect value, the user can click the Show Payment button
again. IsNumeric() is another built-in function that accepts a variable and returns True if the
variable is a number and False otherwise.

You can run the revised application and check it out by entering invalid values in the fields.
Notice that you can’t specify an invalid value for the last argument; the CheckBox control won’t
let you enter a value. You can only select or clear it, and both options are valid. The actual cal-
culation of the monthly payment takes a single line of Visual Basic code. Displaying it requires
another line of code. Adding the code to validate the data entered by the user, however, is an
entire program. And that’s the way things are.

@ Real World Scenario

WRITING WELL-BEHAVED APPLICATIONS

Well-behaved applications must contain data-validation code. If an application such as Loan-
Calculator crashes because of a typing mistake, nothing really bad will happen. The user will
try again or else give up on your application and look for a more professional one. However, if
the user has been entering data for hours, the situation is far more serious. It’s your responsi-
bility as a programmer to make sure that only valid data are used by the application and that
the application keeps working, no matter how the user misuses or abuses it.

Our sample application is not typical because it calculates the result with a single function
call, but in developing typical business applications, you must write a substantial amount
of code to validate user input. The reason for validating user input is to control inputs to your
code so that you can ensure that it behaves correctly and that you can provide specific error
messages to help the user identify the error and correct it.

You will notice that the sample applications included in this book don’t contain much
data-validation code, because it would obscure the ‘“‘useful’’ code that applies to the topic at
hand. Instead, they demonstrate specific techniques. You can use parts of the examples in your
applications, but you should provide your own data-validation code (and error-handling code,
as you’ll see in a moment).

Now run the application one last time and enter an enormous loan amount. Try to find
out what it would take to pay off the national debt with a reasonable interest rate in, say, 72
months. The program will crash again (as if you didn’t know). This time the program will go
down with a different error message, as shown in Figure 4.4. Visual Basic will complain about
an overflow. The exact message is Value was either too large or too small for an Int32, and the pro-
gram will stop at the line that assigns the contents of the txtAmount TextBox to the LoanAmount
variable. Press the Break button and the offending statement in the code will be highlighted.

An overflow is a numeric value too large for the program to handle. This error is usually
produced when you divide a number by a very small value. When you attempt to assign a very
large value to an Integer variable, you'll also get an overflow exception.

Actually, in the LoanCalculator application, any amount greater than 2,147,483,647 will
cause an overflow condition. This is the largest value you can assign to an Integer variable;
it’s plenty for our banking needs but not nearly adequate for handling government deficits.
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As you learned in Chapter 2, Visual Basic provides other types of variables, which can store
enormous values (making the national debt look really small). In the meantime, if you want
the loan calculator to be truly useful, change the declaration of the LoanAmount variable to the
following:

Dim LoanAmount As Double
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The Double data type can hold much larger values. Besides, the Double data type can also
hold non-integer values. Not that anyone will ever apply for a loan of $25,000 and some cents,
but if you want to calculate the precise monthly payment for a debt you have accumulated,
you should be able to specify a non-integer amount. In short, I should have declared the
LoanAmount variable with the Double data type in the first place. By the way, there’s another
integer type, the Long data type, which can hold much larger integer values.

An overflow error can’t be caught with data-validation code. There’s always a chance that
your calculations will produce overflows or other types of math errors. Data validation won’t
help here; you just don’t know the result before you carry out the calculations. You need some-
thing called error handling, or exception handling. This is additional code that can handle errors
after they occur. In effect, you're telling VB that it shouldn’t stop with an error message, which
would be embarrassing for you and wouldn’t help the user one bit. Instead, VB should detect
the error and execute the proper statements to handle the error. Obviously, you must supply
these statements. (You'll see examples of handling errors at runtime shortly.)

The sample application works as advertised, and it’s fail-safe. Yet there’s one last touch
you can add to the application. The various values on the form are not always in synch. Let’s
say you've calculated the monthly payment for a specific loan and then you want to change
the duration of the loan to see how it affects the monthly payment. As soon as you change the
duration of the loan, and before you click the Monthly Payment button, the value in the
Monthly Payment box doesn’t correspond to the parameters of the loan. Ideally, the monthly
payment should be cleared as soon as the user starts editing one of the loan’s parameters. To
do so, you must insert a statement that clears the txtPayment control. But what’s the proper
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event handler for this statement? The TextBox control fires the TextChanged event every time
its text is changed, and this is the proper place to execute the statement that clears the monthly
payment on the form. Because there are three TextBox controls on the form, you must program
the TextChanged event of all three controls or write an event handler inside the frmLoan class
that handles all three events:

Private Sub txtAmount_TextChanged(ByVal (..) Handles
txtAmount.TextChanged, txtDuration.TextChanged,
txtRate.TextChanged

txtPayment.Clear()
End Sub

Yes, you can write a common handler for multiple events, as long as the events are of the
same type and they’re all listed after the HandTes keyword. You'll see another example of
the same technique in the following sample project.

One of the sample projects for this chapter is a revised version of the LoanCalculator project,
the LoanCalculator-Dates project, which uses a different interface. Instead of specifying the
duration of the loan in months, this application provides two instances of the DateTimePicker
control, which is used to specify dates. Delete the TextBox control and the corresponding Labels
and insert two new Label controls and two DateTimePicker controls on the form. Name the
DateTimePicker controls dtFrom and dtTo. Users can set the loan’s starting and ending dates
on these two controls and the program calculates the duration of the loan in months with the
following statement:

LoanDuration = DateDiff(DateInterval.Month,
dtFrom.Value, dtTo.Value) + 1

The DateDiff() function returns the difference between two dates in the interval supplier
as the first argument to the function. The rest of the code doesn’t change; as long as the
LoanDuration variable has the correct value, the same statements will produce the correct
result. If you open the project, you'll find a few more interesting statements that set the dtFrom
control to the first date of the selected month and the dtTo control to the last date of the
selected month.

Building a Calculator

This next application is more advanced, but it’s not as advanced as it looks. It’s a calculator
with a typical visual interface that demonstrates how Visual Basic can simplify the program-
ming of fairly advanced operations. If you haven't tried it, you may think that writing an appli-
cation such as this one is way too complicated for a beginner, but it isn’t. The MathCalculator
application is shown in Figure 4.5.

The application emulates the operation of a handheld calculator and implements basic arith-
metic operations. It has the look of a math calculator, and you can easily expand it by adding
more features. In fact, adding features such as cosines and logarithms is actually simpler than
performing the basic arithmetic operations. This interface will also give you a chance to exercise
most of the tools of the IDE for aligning and spacing the controls on a form.
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Designing the User Interface

The application’s interface is straightforward, but it takes a bit of effort. You must align the but-
tons on the form and make the calculator look as much like a handheld calculator as possible.
Start a new Windows Forms project, the MathCalculator project, and rename the main form
from Forml.vb to frmCalculator.vb.

Designing the interface of the application isn’t trivial because it’s made up of many buttons,
all perfectly aligned on the form. To simplify the design, follow these steps:

1.

Select a font that you like for the form. All the command buttons you'll place on the form
will inherit this font. The MathCalculator sample application uses 10-point Verdana font.
I've used a size of 12 points for the Period button because the 10-point period was too small
and very near the bottom of the control.

Add the Label control, which will become the calculator’s display. Set its BorderStyle
property to Fixed3D so that it will have a 3D look, as shown in Figure 4.5. Change its
ForeColor and BackColor properties too, if you want it to look different from the rest of
the form. The sample project uses colors that emulate the — now extinct — green CRT
monitors. Name the Label control Tb1Display.

Draw a Button control on the form, change its Text property to 1, and name it bttnl. Size
the button carefully so that its caption is centered on the control. The other buttons on the
form will be copies of this one, so make sure you've designed the first button as best as you
can before you start making copies of it. You can also change the button’s style with the
FlatStyTe property. (You can experiment with the Popup, Standard, and System settings
for this property.)

Place the button in its final position on the form. At this point, you're ready to create the

other buttons for the calculator’s digits. Right-click the button and choose Copy from the

context menu. The Button control is copied to the Clipboard, and now you can paste it on
the form (which is much faster than designing an identical button).

Right-click somewhere on the form, choose Paste, and the button copied to the Clipboard
will be pasted on the form. The copy will have the same caption as the button it was copied
from, and its name will be Buttonl.

Now set the button’s Name property to bttn2 and its Text property to 2. This button is the
digit 2. Place the new button to the right of the previous button. You don’t have to align the
two buttons perfectly now; later we’ll use the commands of the Format menu to align

the buttons on the form. As you move the control around on the form, one or more lines
may appear on the design surface at times. These lines are called snap lines, and they appear
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10.

11.

as soon as a control is aligned (vertically or horizontally) with one or more of the existing
controls on the form. The snap lines allow you to align controls with the mouse. Blue snap
lines appear when the control’s edge is aligned with the edge of another control. Red
snap lines appear when the control’s baseline is aligned with the baseline of another
control. The baseline is the invisible line on which the characters of the control’s caption
are based.

Repeat steps 5 and 6 eight more times, once for each numeric digit. Each time a new Button
control is pasted on the form, Visual Basic names it Buttonl and sets its caption to 1; you
must change the Name and Text properties. You can name the buttons anything you like,
but a name that indicates their role in the application is preferred.

When the buttons of the numeric digits are all on the form, place two more buttons, one
for the C (Clear) operation and one for the Period button. Name them bttnClear and
bttnDecimalPoint, and set their captions accordingly. Use a larger font size for the Period
button to make its caption easier to read.

When all the digit buttons of the first group are on the form and in their approximate posi-
tions, align them by using the commands of the Format menu. You can use the snap lines to
align horizontally and vertically the various buttons on the form, but you must still space
the controls manually, which isn’t a trivial task. Here’s how you can align the buttons per-
fectly via the Format menu:

a. First, align the buttons of the top row. Start by aligning the 1 button with the left side of
the Tb1DispTlay Label. Then select all the buttons of the top row and make their hori-
zontal spacing equal (choose Format > Horizontal Spacing > Make Equal). Then do the
same with the buttons in the first column; this time, make sure their vertical distances
are equal (Format > Vertical Spacing > Make Equal).

b. Now you can align the buttons in each row and each column separately. Use one of the

buttons you aligned in the last step as the guide for the rest of them. The buttons can be
aligned in many ways, so don’t worry if somewhere in the process you ruin the align-
ment. You can always use the Undo command in the Edit menu. Select the three buttons
on the second row and align their tops by using the first button as a reference. To set the
anchor control for the alignment, click it with the mouse while holding down the Ctrl
key. Do the same for the third and fourth rows of buttons. Then do the same for the
four columns of buttons, using the top button as a reference.

Now, place the buttons for the arithmetic operations on the form — addition (+), subtrac-
tion (-), multiplication (*), and division (/). Name the addition button bttnP1us, the sub-
traction button bttnMinus, the multiplication button bttnMultiply, and the division but-
ton bttnDivide.

Finally, place the Equals button on the form, name it bttnEquals, and make it wide enough
to span the space of two operation buttons. Use the commands on the Format menu to align
these buttons, as shown in Figure 4.5. The form shown in Figure 4.5 has a few more buttons,
which you can align by using the same techniques you used to align the numeric buttons.

If you don’t feel quite comfortable with the alignment tools of the IDE, you can still position
the controls on the form through the x and y components of each control’s Location property.
(They’re the x- and y-coordinates of the control’s upper-left corner on the form.) The various
alignment tools are among the first tools of the IDE you’ll master, and you'll be creating forms
with perfectly aligned controls in no time at all.
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Programming the MathCalculator

Now you're ready to add some code to the application. Double-click one of the digit buttons on
the form and you’ll see the following in the code window:

Private Sub bttnl_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles
bttnl.Click

End Sub

This is the CTick event’s handler for a single digit button. Your first inclination might be
to program the Click event handler of each digit button, but repeating the same code 10 times
isn’t very productive. (Not to mention that if you decide to edit the code later, the process must
be repeated 10 times.) We're going to use the same event handler for all buttons that represent
digits. All you have to do is append the names of the events to be handled by the same sub-
routine after the Handles keyword. You should also change the name of the event handler to
something that indicates its role. Because this subroutine handles the Click event for all the
digit buttons, let’s call it DigitCTlick(). Here’s the revised declaration of a subroutine that can
handle all the digit buttons:

Private Sub DigitClick(ByVal sender As System.Object,
ByVal e As System.EventArgs)
Handles bttn0.Click, bttnl.Click, bttn2.Click,
bttn3.Click, bttn4.Click, bttn5.Click, bttn6.Click,
bttn7.Click, bttn8.Click, bttn9.Click

End Sub

You don’t have to type all the event names; as soon as you insert the first comma after
bttn0.Click, a drop-down list with the names of the controls will open and you can select the
name of the next button with the down arrow. Press the spacebar to select the desired control
(bttnl, bttn2, and so on), and then type the period. This time, you'll see another list with the
names of the events for the selected control. Locate the Click event and select it by pressing
the spacebar. Type the next comma and repeat the process for all the buttons. This extremely
convenient feature of the language is IntelliSense: The IDE presents the available and valid
keywords as you type.

When you press a digit button on a handheld calculator, the corresponding digit is
appended to the display. To emulate this behavior, insert the following line in the C1ick event
handler:

Tb1Display.Text = 1b1Display.Text + sender.Text

This line appends the digit clicked to the calculator’s display. The sender argument of the
Click event represents the control that was clicked (the control that fired the event). The Text
property of this control is the caption of the button that was clicked. For example, if you have
already entered the value 345, clicking the digit 0 displays the value 3450 on the Label control
that acts as the calculator’s display.

The expression sender.Text is not the best method of accessing the Text property of the
button that was clicked, but it will work as long as the Strict option is off. As discussed in
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Chapter 2, we must cast the sender object to a specific type (the Button type) and then call its
Text method:

CType(sender, Button).Text

The code behind the digit buttons needs a few more lines. After certain actions, the display
should be cleared. After one of the buttons that correspond to math operations is pressed, the
display should be cleared in anticipation of the second operand. Actually, the display must be
cleared as soon as the first digit of the second operand is pressed and not as soon as the math
operator button is pressed. Likewise, the display should also be cleared after the user clicks the
Equals button. Revise the DigitClick event handler, as shown in Listing 4.3.

LISTING 4.3: The DigitClick event

Private Sub DigitClick(ByVal sender As System.Object,
ByVal e As System.EventArgs)
Handles bttnl.Click, bttn2.Click, bttn3.Click,
bttn4.Click, bttn5.Click, bttn6.Click,
bttn7.Click, bttn8.Click, bttn9.Click
If clearDisplay Then
Tb1Display.Text = ""
clearDisplay = False
End If
Tb1Display.Text = 1b1Display.Text + sender.text
End Sub

The clearDisplay variable is declared as Boolean, which means it can take a True or False
value. Suppose the user has performed an operation and the result is on the calculator’s dis-
play. The user now starts typing another number. Without the If clause, the program would
continue to append digits to the number already on the display. This is not how calculators
work. When the user starts entering a new number, the display must be cleared. Our program
uses the cTearDisplay variable to know when to clear the display.

The Equals button sets the clearDisplay variable to True to indicate that the display con-
tains the result of an operation. The DigitClick() subroutine examines the value of this vari-
able each time a new digit button is pressed. If the value is True, DigitClick() clears the
display and then prints the new digit on it. The subroutine also sets cTlearDispTay to False
so that when the next digit is pressed, the program won’t clear the display again.

What if the user makes a mistake and wants to undo an entry? The typical handheld calcula-
tor has no Backspace key. The Clear key erases the current number on the display. Let’s imple-
ment this feature. Double-click the C button and enter the code of Listing 4.4 in its C1ick event.

LISTING 4.4: Programming the Clear button

Private Sub bttnClear_Click (ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles bttnClear.Click
Tb1Display.Text = ""
End Sub
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Now we can look at the Period button. A calculator, no matter how simple, should be able
to handle fractional numbers. The Period button works just like the digit buttons, with one
exception. A digit can appear any number of times in a numeric value, but the decimal point
can appear only once. A number such as 99.991 is valid, but you must make sure the user can’t
enter numbers such as 23.456.55. After a decimal point is entered, this button must not insert
another one. The code in Listing 4.5 accounts for this.

LISTING 4.5: Programming the Period button

Private Sub bttnDecimalPointClick(..) Handles bttnDecimalPoint.Click
If 1b1Display.Text.IndexOf(".") >= 0 Then
Exit Sub
Else
Tb1Display.Text = 1b1Display.Text & "."
End If
End Sub

IndexOf is a method that can be applied to any string. The expression 1b1Display.Text
is a string (the text on the Label control), so we can call its IndexOf method. The expression
Tb1Display.Text.IndexOf(".") returns the location of the first instance of the period in the
caption of the Label control. If this number is zero or positive, the number entered contains a
period already and another can’t be entered. In this case, the program exits the subroutine. If
the method returns -1, the period is appended to the number entered so far, just like a regular
digit.

Check out the operation of the application. We have already created a functional user inter-
face that emulates a handheld calculator with data-entry capabilities. It doesn’t perform any
operations yet, but we have already created a functional user interface with only a small num-
ber of statements.

CODING THE MATH OPERATIONS

Now we can move to the interesting part of the application: the coding of the math operations.
Let’s start by defining the three variables listed in Table 4.3.

TABLE 4.3: Math operation variable definitions
VARIABLE DEFINITION
Operandl The first number in the operation
MathOperator The desired operation
Operand2 The second number in the operation

When the user clicks one of the math symbols, the application will store the value of the
operand in the variable Operandl. If the user then clicks the Plus button, the program must
make a note to itself that the current operation is an addition and set the clearDisplay
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variable to True so that the user can enter another value (the second value to be added). The
symbol of the operation is stored in the MathOperator variable. The user enters another value
and then clicks the Equals button to see the result. At this point, your program must do the
following:

1. Read the value on the display into the Operand?2 variable.
2. Perform the operation indicated by the MathOperator variable with the two operands.
3. Display the result and set the cTearDisplay variable to True.

The Equals button must perform the following operation:

Operandl MathOperator Operand?2

Suppose the number on the display when the user clicks the Plus button is 3342. The user
then enters the value 23 and clicks the Equals button. The program must carry out the addition:
3342 + 23.

If the user clicks the Division button, the operation is as follows: 3342 + 23.

Variables are local in the subroutines in which they are declared. Other subroutines have
no access to them and can’t read or set their values. Sometimes, however, variables must be
accessed from many places in a program. The variables Operandl, Operand2, and Operator,
as well as the clearDisplay variable, must be accessed from within more than one subrou-
tine, so they must be declared outside any subroutine; their declarations usually appear at the
beginning of the class code with the following statements:

Dim clearDisplay As Boolean
Dim Operandl As Double
Dim Operand2 As Double
Dim MathOperator As String

These variables are called form-wide variables, or simply form variables, because they are visi-
ble from within any subroutine on the form. Let’s see how the program uses the MathOperator
variable. When the user clicks the Plus button, the program must store the value + in the
MathOperator variable. This takes place from within the Plus button’s CTick event.

All variables that store numeric values are declared as variables of the Double type, which
can store values with the greatest possible precision. The Boolean type takes two values: True
and False. You have already seen how the clearDisplay variable is used.

With the variable declarations out of the way, we can now implement the operator but-
tons. Double-click the Plus button, and in the Click event’s handler, enter the lines shown in
Listing 4.6.

LISTING 4.6: The Plus button

Private Sub bttnPlus_Click(ByVal (..) Handles bttnPlus.Click
Operandl = Convert.ToDouble(1b1Display.Text)
MathOperator = "4"
clearDisplay = True

End Sub
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The variable Operandl is assigned the value currently on the display. The Convert.
ToDouble() method converts its argument to a double value. The Text property of the
Label control is a string. The actual value stored in the Text property is not a number. It’s
a string such as 428, which is different from the numeric value 428. That's why we use the
Convert.ToDouble method to convert the value of the Label’s caption to a numeric value.
The remaining buttons do the same, and I won’t show their listings here.

After the second operand is entered, the user can click the Equals button to calculate the
result. When this happens, the code of Listing 4.7 is executed.

LISTING 4.7: The Equals button

Private Sub bttnEquals_Click(ByVal (..) Handles bttnEquals.Click
Dim result As Double
Operand2 = Convert.ToDouble(1b1Display.Text)
Select Case MathOperator

Case "+

result = Operandl + Operand2
Case "-"

result = Operandl - Operand2
Case "*"

result = Operandl * Operand2
Case "/"

If Operand2 <> "0" Then
result = Operandl / Operand2
End If
End Select
Tb1Display.Text = result.ToString
clearDisplay = True
End Sub

The result variable is declared as Double so that the result of the operation will be stored
with maximum precision. The code extracts the value displayed in the Label control and stores
it in the variable Operand?2. It then performs the operation with a Select Case statement. This
statement compares the value of the MathOperator variable to the values listed after each Case
statement. If the value of the MathOperator variable matches one of the Case values, the fol-
lowing statement is executed.

Division takes into consideration the value of the second operand because if it's zero, the
division can’t be carried out. The last statement carries out the division only if the divisor is
not zero. If Operand2 happens to be zero, nothing happens.

Now run the application and check it out. It works just like a handheld calculator, and you
can’t crash it by specifying invalid data. We didn’t have to use any data-validation code in this
example because the user doesn’t get a chance to type invalid data. The data-entry mechanism
is foolproof. The user can enter only numeric values because there are only numeric digits on
the calculator. The only possible error is to divide by zero, and that’s handled in the Equals
button.

Of course, users should be able to just type the numeric values; you shouldn’t force them
to click the digit buttons on the interface. To intercept keystrokes from within your code, you
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must first set the form’s KeyPreview property to True. By default, each keystroke is reported
to the control that has the focus at the time and fires the keystroke-related events: the KeyDown,
KeyPress, and KeyUp events. Sometimes we need to handle certain keystrokes from a central
place, and we set the form’s KeyPreview property to True so that keystrokes are reported first
to the form and then to the control that has the focus. We can intercept the keystrokes in the
form’s KeyPress event and handle them in this event handler. Insert the statements shown in
Listing 4.8 in the form’s KeyPress event handler.

LISTING 4.8: Handling keystrokes at the form’s level

Private Sub CalculatorForm_KeyPress(ByVal sender As Object,
ByvVal e As System.Windows.Forms.KeyPressEventArgs) Handles
Me.KeyPress

Select Case e.KeyChar
Case "1" : bttnl.PerformClick()
Case "2" : bttn2.PerformClick()
Case "3" : bttn3.PerformClick()
Case "4" : bttn4.PerformClick()
Case "5" : bttn5.PerformClick()
Case "6" : bttn6.PerformClick()
Case "7" : bttn7.PerformClick()
Case "8" : bttn8.PerformClick()
Case "9" : bttn9.PerformClick()
Case "0" : bttn0.PerformClick()
Case "." : bttnDecimalPoint.PerformClick()
Case "C", "c" : bttnClear.PerformClick()
Case "+" : bttnPlus.PerformClick()
Case "-" : bttnMinus.PerformClick()
Case "*" : bttnMultiply.PerformClick()
Case "/" : bttnDivide.PerformClick()
Case "=" : bttnEquals.PerformClick()

End Select

End Sub

This event handler examines the key pressed by the user and invokes the Click event han-
dler of the appropriate button by calling its PerformClick method. This method allows you to
“click”” a button from within your code. When the user presses the digit 3, the form’s KeyPress
event handler intercepts the keystrokes and emulates the click of the bttn3 button. Because the
large Select Case statement doesn’t handle characters and punctuation symbols, there’s no way
for the user to enter invalid digits when a number is expected.

Using the Basic Debugging Tools

Our sample applications work nicely and are quite easy to test and fix if you discover some-
thing wrong with them (but only because they’re very simple applications). As you write code,
you'll soon discover that something doesn’t work as expected, and you should be able to find
out why and then fix it. The process of eliminating errors in logic — as opposed to errors in
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syntax, which are caught by the compiler — is called debugging. Visual Studio provides the
tools to simplify the process of debugging. There are a few simple debugging techniques you
should know, even as you work with simple projects.

Open the MathCalculator project in the code editor and place the pointer in the line that
calculates the difference between the two operands. Let’s pretend there’s a problem with this
line and we want to follow the execution of the program closely to find out what’s going wrong
with the application. Press F9 and the line will be highlighted in brown. This line has become a
breakpoint: As soon as it is reached, the program will stop.

Another way to add a breakpoint is to use the Breakpoint option in the context menu. You
can display the context menu in the editor by right-clicking the line of code where you wish
the execution to stop. Finally, there is a special window in Visual Studio that displays break-
points. You can display the Breakpoints window by navigating to the Debug > Windows >
Breakpoints menu options in Visual Studio. In this window, you can see all the breakpoints in
the solution, deactivate and activate breakpoints, attach conditions and labels to breakpoints,
and even view some breakpoint-related statistics.

VISUAL STUDIO FUNCTION KEYS AND KEYBOARD SHORTCUTS

F9 is not the only useful function key or shortcut key combination available in Visual Studio.
The following list includes some of the function key commands and shortcut key combinations
you will find useful.

FUNCTION KEY COMMAND

F1 Context-Sensitive Help

F5 Run Application In Debug Mode
Shift + F5 Run Application Without Debugging
F7 Toggle Design View - Code View

F9 Toggle Breakpoint

F10 Step Over (while Debugging)

F11 Step Into (while Debugging)

F12 Go To Definition

Ctrl +, “Navigate To”” Window

Ctrl 4 . Generate Code Stubs

Ctrl + Mouse Wheel Zoom In / Zoom Out In Code Window
Ctrl + Shift Highlight All Keyword References

Press F5 to run the application and perform a subtraction. Enter a number; click the minus
button and then another number, and finally, click the Equals button. The application will stop,
and the code editor will open. The breakpoint will be highlighted in yellow. You're still in
runtime mode, but the execution of the application is suspended. You can even edit the code in
break mode and then press F5 to continue the execution of the application. Hover the pointer
over the Operandl and Operand2 variables in the code editor’s window. The value of the
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corresponding variable will appear in a small ToolTip box. Move the pointer over any variable
in the current event handler to see its value. These are the values of the variables just prior to
the execution of the highlighted statement.

The result variable is zero because the statement hasn’t been executed yet. If the variables
involved in this statement have their proper values (if they don’t, you know that the problem
is prior to this statement and perhaps in another event handler), you can execute this statement
by pressing F10, which executes only the highlighted statement. The program will stop at the
next line. The next statement to be executed is the End Select statement.

Find an instance of the result variable in the current event handler, rest the pointer over it,
and you will see the value of the variable after it has been assigned a value. Now you can press
F10 to execute another statement or press F5 to return to normal execution mode.

You can also evaluate expressions involving any of the variables in the current event han-
dler by entering the appropriate statement in the Immediate window. The Immediate window
appears at the bottom of the IDE. If it’s not visible, open the Debug menu and choose Windows
» Immediate. The current line in the command window is prefixed with the greater-than
symbol (reminiscent of the DOS days). Place the cursor next to it and enter the following
statement:

? Operandl / Operand?2

The quotient of the two values will appear in the following line. The question mark is just a
shorthand notation for the Print command.

If you want to know the current value on the calculator’s display, enter the following
statement:

? 1b1Display.Text

This statement requests the value of a control’s property on the form. The current value of the
Label control’s Text property will appear in the following line.
You can also evaluate math expressions with statements such as the following;:

? Math.Log(3/4)

Log() is the logarithm function and a method of the Math class. With time, you'll discover
that the Immediate window is a handy tool for debugging applications. If you have a state-
ment with a complicated expression, you can request the values of the expression’s individual
components and make sure they can be evaluated.

Now move the pointer over the breakpoint and press F9 again. This will toggle the
breakpoint status, and the execution of the program won’t halt the next time this statement is
executed.

If the execution of the program doesn’t stop at a breakpoint, it means that the statement is
never reached. In this case, you must search for the bug in statements that are executed before
the breakpoint is reached. Chances are that the statement that was not reached was in an If
statement that wasn’t executed, or in a subroutine that has never been called. For example,
if you didn’t assign the proper value to the MathOperator variable, the Case clause for the sub-
traction operation will never be reached. You should place the breakpoint at the first executable
statement of the Click event handler for the Equals button to examine the values of all vari-
ables the moment this subroutine starts its execution. If all variables have the expected values,
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you will continue testing the code forward. If not, you’d have to test the statements that lead to
this statement — the statements in the event handlers of the various buttons.

Another simple technique for debugging applications is to print the values of certain
variables in the Immediate window. Although this isn’t a debugging tool, it's common
practice among VB programmers. Many programmers print the values of selected variables
before and after the execution of some complicated statements. To do so, use the statement
Debug.WriteLine followed by the name of the variable you want to print, or an expression:

Debug.WriteLine(Operandl)

This statement sends its output to the Immediate window. This is a simple technique, but it
works. You can also use it to test a function or method call. If you're not sure about the syntax
of a function, pass an expression that contains the specific function to the Debug.WritelLine
statement as an argument. If the expected value appears in the Immediate window, you can go
ahead and use it in your code.

In the project’s folder, you will find the MoreFeatures.txt document, which describes how
to add more features to the math calculator. Such features include the inversion of a number
(the 1/x button), the negation of a number (the +/- button), and the usual math functions (log-
arithms, square roots, trigonometric functions, and so on).

Exception Handling

Crashing this application won’t be as easy as crashing the LoanCalculator application. If you
start multiplying very large numbers, you won't get an overflow exception. Enter a very large
number by repeatedly typing the digit 9; then multiply this value with another equally large
value. When the result appears, click the multiplication symbol and enter another very

large value. Keep multiplying the result with very large numbers until you exhaust the value
range of the Double data type (that is, until the result is so large that it can’t be stored to a
variable of the Double type). When this happens, the string infinity will appear in the display.
This is Visual Basic’s way of telling you that it can’t handle very large numbers. This isn’t a
limitation of VB; it’s the way computers store numeric values: They provide a limited number
of bytes for each variable. (We discussed oddities such as infinity in Chapter 2.)

You can’t create an overflow exception by dividing a number by zero, either, because the
code will not even attempt to carry out this calculation. In short, the MathCalculator application
is pretty robust. However, we can’t be sure that users won’t cause the application to generate
an exception, so we must provide some code to handle all types of errors.

EXCEPTIONS VERSUS ERRORS

Errors that occur during application execution are now called exceptions. They used to be
called errors in pre-.NET versions of Visual Basic. You can think of them as exceptions to the
normal (or intended) flow of execution. If an exception occurs, the program must execute
special statements to handle it — statements that wouldn’t be executed normally. 1 think
they’re called exceptions because error is a word nobody likes and most people can’t admit
they wrote code that contains errors. The term exception can be vague. What would you rather
tell your customers: that the application you wrote has errors or that your code has raised an
exception? You may not have noticed it, but the term bug is not used as frequently anymore;
bugs are now called known issues. The term debugging, however, hasn’t changed yet.
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How do you prevent an exception raised by a calculation? Data validation won’t help. You
just can’t predict the result of an operation without actually performing the operation. And if
the operation causes an overflow, you can’t prevent it. The answer is to add a structured excep-
tion handler. Most of the sample application’s code is straightforward, and you can’t easily gen-
erate an exception for demonstration purposes. The only place where an exception may occur
is the handler of the Equals button, where the calculations take place. This is where you must
add an exception handler. The outline of the structured exception handler is the following:

Try
' statements block

Catch Exception
" handler block

Finally
" cleanup statements block

End Try

The program will attempt to perform the calculations, which are coded in the statements
block. If the program succeeds, it continues with the cleanup statements in the Finally section
of the handler. These statements are mostly cleanup code used to release reserved resources,
and the Finally section of the statement is optional. If it’s missing, the program execution con-
tinues with the statement following the End Try statement. If an error occurs in the first block
of statements, the Catch Exception section is activated and the statements in the handler block
are executed. If present, the Finally block is executed next. As you can see, the Finally block
is executed no matter the outcome of statements block execution; error or no error, you can be
certain that cleanup code is executed and important resources like database connections and file
handlers are released.

The Catch Exception block is where you handle the error. There’s not much you can do
about errors that result from calculations. All you can do is display a warning and give the user
a chance to change the values. There are other types of errors, however, that can be handled
much more gracefully. If your program can’t read a file from a CD drive, you can give the user
a chance to insert the CD and retry. In other situations, you can prompt the user for a missing
value and continue. If the application attempts to write to a read-only file, for example, chances
are that the user specified a file on a CD drive or a file with its read-only attribute set. You can
display a warning, exit the subroutine that saves the data, and give the user a chance to either
select another filename or change the read-only attribute of the selected file.

@ Real World Scenario

EXCEPTION HANDLING

A common programming mistake is to place the cleanup code inside the statements block
and to omit the Finally block altogether. Such code can result in a dreaded memory leak
problem. This way some precious computing resources end up without being recovered. When
unmanaged resources (like file handles and database connections) are accessed, they have to
be released explicitly or they will stay in memory and the program might eventually stall.
Unfortunately, since the cleanup code is placed inside the statements block, the program
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executions will jump to the Catch block immediately after the error is raised, thus omitting
the cleanup statements.

What makes such memory leak problems even more sinister is the fact that they are produced
only under exceptional conditions. If everything goes well, all resources are recovered. If an
error is produced, however, resources are leaked. Under such circumstances a program can go
on without crashing for quite some time. Usual debugging techniques are often helpless under
such circumstances. You will typically have to employ some special tools like memory profilers
to pinpoint the exact block of code responsible for producing the memory leak.

The following snippet is a simplified illustration of such a scenario. The code assumes that
the SomeFile.txt file has an integer written on the first line. If this is true, the application
will correctly close the writer. However, if you encounter something else — for example, the
characters abc on the first line in the file — the error handler will prevent the application
from crashing but will not close the writer.

To test the snippet, create a new Console Application project. Change the name of Module1
to ResourceLeakingModule and make sure it is marked as a startup object. Copy the following
code to ResourceLeakingModule:

Imports System.IO
Module ResourcelLeakingModule

Sub Main()
Dim fileReader As StreamReader
Dim firstNumber As Integer
Try
fileReader = File.OpenText("C:\SomeFile.txt")
firstNumber = fileReader.ReadLine
Console.WriteLine("At this point execution already " &
"jumped over to catch block")
fileReader.Close() 'should go to Finally block
Catch ex As Exception
Console.WriteLine("fileReader has not been closed")
' Wait so that output can be read
Console.ReadLine()
End Try
End Sub

End Module

Now create a SomeFile.txt file in the root of your C drive and write abc on the first line of
the file. You can place the file in some other location as long as you modify the snippet so it
points to the correct location of the file.

The way you can resolve the memory leak problem in this case is to place a fileReader.
Close() statement inside the Finally block. Another way to release unmanaged resources
correctly is to employ Visual Basic’s Using statement. This statement is convenient as long
as you can release the resource inside the same block of code that you used to create the
resource.
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In general, there’s no unique method to handle all exceptions. You must consider all types
of exceptions that your application may cause and handle them on an individual basis. What's
important about error handlers is that your application doesn’t crash; it simply doesn’t perform
the operation that caused the exception (this is also known as the offending operation, or offending
statement) and continues.

The error handler for the MathCalculator application must inform the user that an error
occurred and abort the calculations — it does not even attempt to display a result. If you open
the Equals button’s C1ick event handler, you will find the statements detailed in Listing 4.9.

LISTING 4.9: Revised Equals button

Private Sub bttnEquals_Click(..) Handles bttnEquals.Click
Dim result As Double
Operand2 = Convert.ToDouble(1b1Display.Text)

Try
Select Case MathOperator

Case "+'

result = Operandl + Operand?2
Case "-"

result = Operandl - Operand?2
Case "*"

result = Operandl * Operand?2
Case "/"

If Operand2 <> "0" Then result = Operandl / Operand2
End Select

Tb1Display.Text = result
Catch exc As Exception
MsgBox(exc.Message)
result = "ERROR"
Finally
clearDisplay = True
End Try
End Sub

Most of the time, the error handler remains inactive and doesn’t interfere with the
operation of the program. If an error occurs, which most likely will be an overflow error,
the error-handling section of the Try..Catch..End Try statement will be executed. This code
displays a message box with the description of the error, and it also displays the string ERROR
on the calculator’s display. The Finally section is executed regardless of whether an exception
occurred. In this example, the Finally section sets the clearDisplay variable to True so that
when another digit button is clicked, a new number will appear on the display.

The Bottom Line

Design graphical user interfaces. A Windows application consists of a graphical user inter-
face and code. The interface of the application is designed with visual tools and consists of
controls that are common to all Windows applications. You drop controls from the Toolbox
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window onto the form, size and align the controls on the form, and finally set their properties
through the Properties window. The controls include quite a bit of functionality right out of the
box, and this functionality is readily available to your application without a single line of code.

Master It Describe the process of aligning controls on a form.

Program events. Windows applications follow an event-driven model: We code the events to
which we want our application to respond. For example, an application reacts to C11ick events
of the various buttons. You select the actions to which you want your application to react and
program these events accordingly.

When an event is fired, the appropriate event handler is automatically invoked. Event handlers
are subroutines that pass two arguments to the application: the sender argument (which is

an object that represents the control that fired the event) and the e argument (which carries
additional information about the event).

Master It How will you handle certain keystrokes regardless of the control that receives
them?

Write robust applications with error handling. Numerous conditions can cause an applica-
tion to crash, but a well-written application should be able to detect abnormal conditions and
handle them gracefully. To begin with, you should always validate your data before you attempt
to use them in your code. A well-known computer term is “‘garbage in, garbage out,”” which
means you shouldn’t perform any calculations on invalid data.

Master It How will you execute one or more statements in the context of a structured
exception handler?






Chapter 5

Basic Windows Controls

In previous chapters, we explored the environment of Visual Basic and the principles of
event-driven programming, which is the core of VB’s programming model. In the process, we
briefly explored a few basic controls through the examples. The .NET Framework provides
many more controls, and all of them have a multitude of trivial properties (such as Font,
BackgroundColor, and so on), which you can set either in the Properties window or from
within your code.

This chapter explores in depth the basic Windows controls: the controls you’ll use most
often in your applications because they are the basic building blocks of typical rich client-user
interfaces. Rather than look at the background and foreground color, font, and other trivial
properties of all controls, we’ll look at the properties unique to each control and see how
these properties are used in building functional, rich user interfaces.

In this chapter, you'll learn how to do the following:

¢ Use the TextBox control as a data-entry and text-editing tool
¢ Use the ListBox, CheckedListBox, and ComboBox controls to present lists of items

¢ Use the ScrollBar and TrackBar controls to enable users to specify sizes and positions with
the mouse

The TextBox Control

The TextBox control is the primary mechanism for displaying and entering text. It is a small
text editor that provides all the basic text-editing facilities: inserting and selecting text, scrolling
if the text doesn’t fit in the control’s area, and even exchanging text with other applications
through the Clipboard.

The TextBox control is an extremely versatile data-entry tool that can be used for entering
and editing single lines of text, such as a number or a password or an entire text file. Figure 5.1
shows a few typical examples. All the boxes in Figure 5.1 contain text—some a single line,
some several lines. The scroll bars you see in some text boxes are part of the control. You can
specify which scroll bars (vertical and/or horizontal) will be attached to the control, and they
appear automatically whenever the control’s contents exceed the visible area of the control.
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Basic Properties

Let’s start with the properties that specify the appearance and, to some degree, the functionality
of the TextBox control; these properties are usually set at design time through the Properties
window. Then, we'll look at the properties that allow you to manipulate the control’s contents
and interact with users from within your code.

TEXTALIGN

This property sets (or returns) the alignment of the text on the control, and its value is a mem-
ber of the HorizontalAlignment enumeration: Left, Right, or Center. The TextBox control
doesn’t allow you to format text (mix different fonts, attributes, or colors), but you can set the
font in which the text will be displayed with the Font property as well as the control’s back-
ground color with the BackColor property.

MULTILINE

This property determines whether the TextBox control will hold a single line or multiple lines
of text. Every time you place a TextBox control on your form, it’s sized for a single line of text
and you can change its width only. To change this behavior, set the MultiLine property to
True. When creating multiline TextBoxes, you will most likely have to set one or more of the
MaxLength, Scrol1Bars, and WordWrap properties in the Properties window.

MAXLENGTH

This property determines the number of characters that the TextBox control will accept. Its
default value is 32,767, which was the maximum number of characters the VB 6 version of the
control could hold. Set this property to zero so that the text can have any length up to the con-
trol’s capacity limit—2,147,483,647 characters, to be exact. To restrict the number of characters
that the user can type, set the value of this property accordingly.

The MaxLength property of the TextBox control is often set to a specific value in data-entry
applications to prevent users from entering more characters than can be stored in a database
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field. A TextBox control for entering international standard book numbers (ISBNs), for instance,
shouldn’t accept more than 13 characters.

SCROLLBARS

This property lets you specify the scroll bars you want to attach to the TextBox if the text
exceeds the control’s dimensions. Single-line text boxes can’t have a scroll bar attached, even
if the text exceeds the width of the control. Multiline text boxes can have a horizontal or a
vertical scroll bar or both.

If you attach a horizontal scroll bar to the TextBox control, the text won’t wrap automatically
as the user types. To start a new line, the user must press Enter. This arrangement is useful
for implementing code editors in which lines must break explicitly. If the horizontal scroll bar
is missing, the control inserts soft line breaks when the text reaches the end of a line, and the
text is wrapped automatically. You can change the default behavior by setting the WordWrap

property.

WORDWRAP

This property determines whether the text is wrapped automatically when it reaches the right
edge of the control. The default value of this property is True. If the control has a horizontal
scroll bar, however, you can enter very long lines of text. The contents of the control will scroll
to the left, so the insertion point is always visible as you type. You can turn off the horizontal
scroll bar and still enter long lines of text; just use the left/right arrow keys to bring any part
of the text into view. You can experiment with the WordWrap and Scrol1Bars properties in the
TextPad sample application, which is described later in this chapter.

Notice that the WordWrap property has no effect on the actual line breaks. The lines are
wrapped automatically, and there are no hard breaks (returns) at the end of each line. Open
the TextPad project, enter a long paragraph, and resize the window —the text is automatically
adjusted to the new width of the control.

@ Real World Scenario

A FUNCTIONAL TEXT EDITOR BY DESIGN

A TextBox control with its MaxLength property set to o, its MultiLine and WordWrap prop-
erties set to True, and its Scrol1Bars property set to Vertical is, on its own, a functional text
editor. Place a TextBox control with these settings on a form, run the application, and check
out the following:

& Enter text and manipulate it with the usual editing keys: Delete, Insert, Home, and End.
4 Select multiple characters with the mouse or the arrow keys while holding down the Shift key.

& Move segments of text around with Copy (Ctrl+C), Cut (Ctrl+X), and Paste (Ctrl+V or
Shift+Insert) operations.

® Right-click the control to see its context menu; it contains all the usual text-editing commands
(and a few Unicode-related commands you’ll never use).

€ Exchange data with other applications through the Clipboard.
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You can do all this without a single line of code! If you use the My object, you can save and
load files by using two lines of code. Shortly, you’ll see what you can do with the TextBox
control if you add some code to your application, but first let’s continue our exploration of the
properties that allow us to manipulate the control’s functionality.

ACCEPTSRETURN, ACCEPTSTAB

These two properties specify how the TextBox control reacts to the Enter and Tab keys. The
Enter key activates the default button on the form, if there is one. The default button is usually
an OK button that can be activated with the Enter key, even if it doesn’t have the focus. In a
multiline TextBox control, however, we want to be able to use the Enter key to change lines.
The default value of the AcceptsReturn property is False, so pressing Enter does not create a
new line on the control. If you leave this property’s value set to False, users can still create new
lines in the TextBox control, but they’ll have to press Ctrl+Enter. If the form contains no default
button, the Enter key creates a new line regardless of the AcceptsReturn setting.

Likewise, the AcceptsTab property determines how the control reacts to the Tab key. Nor-
mally, the Tab key takes you to the next control in the Tab order, and we generally avoid
changing the default setting of the AcceptsTab property. In a multiline TextBox control, how-
ever, you may want the Tab key to insert a Tab character in the text of the control instead;
to do this, set the control’s AcceptsTab property to True (the default value is False). If you
change the default value, users can still move to the next control in the Tab order by pressing
Ctrl+Tab. Notice that the AcceptsTab property affects only the TextBox controls.

CHARACTERCASING

This property tells the control to change the casing of the characters as they’re entered by the
user. Its default value is Normal, and characters are displayed as typed. You can set it to Upper
or Lower to convert the characters to upper- or lowercase automatically.

PASSWORDCHAR

This property turns the characters typed into any character you specify. If you don’t want to
display the actual characters typed by the user (when entering a password, for instance), use
this property to define the character to appear in place of each character the user types.

The default value of this property is an empty string, which tells the control to display the
characters as entered. If you set this value to an asterisk (*), for example, the user sees an aster-
isk in the place of every character typed. This property doesn’t affect the control’s Text prop-
erty, which contains the actual characters. If the PasswordChar property is set to any character,
the user can’t copy or cut the text on the control.

READONLY, LOCKED

If you want to display text on a TextBox control but prevent users from editing it (such as for
an agreement or a contract they must read, software installation instructions, and so on), you
can set the ReadOnTy property to True. When ReadOnly is set to True, you can put text on the
control from within your code and users can view it yet they can’t edit it.

To prevent editing of the TextBox control with VB 6, you had to set the Locked property to
True. Oddly, the Locked property is also supported, but now it has a very different function.
The Locked property of VB 2010 locks the control at design time (so that you won’t move it or
change its properties by mistake as you design the form).
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Text-Manipulation Properties

Most of the properties for manipulating text in a TextBox control are available at runtime only.
The following sections present a breakdown of each property.

TEXT

The most important property of the TextBox control is the Text property, which holds the con-
trol’s text. You can set this property at design time to display some text on the control initially
and read it from within your code to obtain the user’s input and process it.

Notice that there are two methods of setting the Text property at design time. For single-line
TextBox controls, set the Text property to a short string, as usual. For multiline TextBox con-
trols, open the Lines property and enter the text in the String Collection Editor window, which
will appear. In this window, each paragraph is entered as a single line of text. When you're
finished, click OK to close the window; the text you entered in the String Collection Editor win-
dow will be placed on the control. Depending on the width of the control and the setting of the
WordWrap property, paragraphs may be broken into multiple lines.

At runtime, use the Text property to extract the text entered by the user or to replace the
existing text. You can also manipulate it with the members of the String class. The following
expression returns the number of characters in the TextBox1 control:

Dim strLen As Integer = TextBoxl.Text.Length

The IndexOf method of the String class will locate a specific string in the control’s text. The
following statement returns the location of the first occurrence of the string Visual in the text:

Dim Tocation As Integer
Tocation = TextBoxl.Text.IndexOf("Visual")

For more information on locating strings in a TextBox control, see the section ““VB 2010
at Work: The TextPad Project” later in this chapter, where we’ll build a text editor with
search-and-replace capabilities.

To store the control’s contents in a file, use a statement such as the following:

My .Computer.FileSystem.WriteAl1Text(
"MyText.txt", TextBoxl.Text, False, System.Text.Encoding.UTF8)

The first argument is the name of the file where the text will be saved and the second
argument is the text to be saved. The following argument is a True/False value that indicates
whether the text will be appended to the file (if True) or whether it will replace the file’s
contents. That holds true if the file exists, of course. If the file doesn’t exist, a new one will be
created.

Similarly, you can read the contents of a text file into a TextBox control by using a statement
such as the following:

TextBox1l.Text = My.Computer.FileSystem.ReadAl1Text("MyText.txt")

To locate all instances of a string in the text, use a loop like the one in Listing 5.1. This loop
locates successive instances of the string Basic and then continues searching from the character
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following the previous instance of the word in the text. To locate the last instance of a string
in the text, use the LastIndexOf method. You can write a loop similar to the one in Listing 5.1
that scans the text backward.

LISTING 5.1: Locating all instances of a string in a TextBox

Dim startIndex = -1
startIndex = TextBoxl.Text.IndexOf("Basic", startIndex + 1)
While startIndex > 0
Console.WriteLine "String found at " & startIndex
startIndex = TextBoxl.Text.IndexOf("Basic", startIndex + 1)
End While

To test this code segment, place a multiline TextBox and a Button control on a form; then
enter the statements of the listing in the button’s Click event handler. Run the application
and enter some text on the TextBox control. Make sure the text contains the word Basic or
change the code to locate another word, and click the button. Notice that the IndexOf method
performs a case-sensitive search.

Use the Replace method to replace a string with another within the line, the Sp1it method
to split the line into smaller components (such as words), and any other method exposed by
the String class to manipulate the control’s text.

The AppendText method appends the string specified by its argument to the control as is,
without any line breaks between successive calls. If you want to append individual paragraphs
to the control’s text, you must insert the line breaks explicitly, with a statement such as the fol-
lowing (vbCrLf is a constant for the carriage return/newline characters):

Dim newString = "enter some text here"
TextBox1.AppendText(newString & vbCrLf)

LINES

In addition to using the Text property, you can access the text on the control by using the
Lines property. The Lines property is a string array, and each element holds a paragraph of
text. You can iterate through the text lines with a loop such as the following:

Dim ilLine As Integer

For iLine = 0 To TextBoxl.Lines.Length - 1
' process string TextBoxl.Lines(iLine)
Debug.WriteLine TextBoxl.Lines(iLine)Next

Because the Lines property is an array, it supports the Length property, which returns the
number of items in the array. Each element of the Lines array is a string, and you can call any
of the String class’s methods to manipulate it. Just keep in mind that you can’t alter the text on
the control by editing the Lines array. However, you can set the control’s text by assigning an
array of strings to the Lines property at design time.
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Text-Selection Properties

The TextBox control provides three properties for manipulating the text selected by the user:
SelectedText, SelectionStart, and SelectionLength. Users can select a range of text with a
click-and-drag operation and the selected text will appear in reverse color. You can access the
selected text from within your code through the SeTectedText property and its location in the
control’s text through the SelectionStart and SelectionlLength properties.

SELECTEDTEXT

This property returns the selected text, enabling you to manipulate the current selection from
within your code. For example, you can replace the selection by assigning a new value to the
SelectedText property. To convert the selected text to uppercase, use the ToUpper method of
the String class:

TextBox1l.SelectedText = TextBoxl.SelectedText.ToUpper

SELECTIONSTART, SELECTIONLENGTH

Use these two properties to read the text selected by the user on the control or to select text
from within your code. The SelectionStart property returns or sets the position of the first
character of the selected text, somewhat like placing the cursor at a specific location in the text
and selecting text by dragging the mouse. The SelectionLength property returns or sets the
length of the selected text.

Suppose the user is seeking the word Visual in the control’s text. The IndexOf method
locates the string but doesn’t select it. The following statements select the word in the text,
highlight it, and bring it into view so that users can spot it instantly:

Dim seekString As String = "Visual"
Dim strLocation As Long
strLocation = TextBoxl.Text.IndexOf(seekString)
If strLocation > 0 Then
TextBoxl.SelectionStart = strLocation
TextBox1.SelectionLength = seekString.Length
End If
TextBox1.ScrollToCaret()

These lines locate the string Visual (or any user-supplied string stored in the seekString
variable) in the text and select it by setting the SelectionStart and SelectionLength prop-
erties of the TextBox control. If the located string lies outside the visible area of the control,
the user must scroll the text to bring the selection into view. The TextBox control provides the
Scrol1ToCaret method, which brings the section of the text with the cursor (the caret position)
into view.

The few lines of code shown previously form the core of a text editor’s Find command.
Replacing the current selection with another string is as simple as assigning a new value to
the SelectedText property, and this technique provides you with an easy implementation of
a Find and Replace operation.
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LOCATING THE CURSOR POSITION IN THE CONTROL

The SelectionStart and SelectionLength properties always have a value even if no text
is selected on the control. In this case, SelectionLength is o, and SelectionStart is the
current position of the pointer in the text. If you want to insert some text at the pointer’s loca-
tion, simply assign it to the SelectedText property, even if no text is selected on the control.

In addition to using the SelectionStart and SelectionLength properties, you can select
text on the control with the SeTlect method, which accepts as arguments the starting position
and the length of the selection:

TextBox1l.Select(start, length)

A variation of the Select method is the SelectAl1 method, which selects all the text on the
control. Finally, the DeselectAl1 method deselects any text on the control.

HIDESELECTION

The selected text in the TextBox does not remain highlighted when the user moves to another
control or form; to change this default behavior, set the HideSelection property to False. Use
this property to keep the selected text highlighted, even if another control, form, or a dialog
box, such as a Find & Replace dialog box, has the focus. Its default value is True, which means
that the text doesn’t remain highlighted when the TextBox loses the focus.

Undoing Edits

An interesting feature of the TextBox control is that it can automatically undo the most recent
edit operation. To undo an operation from within your code, you must first examine the value
of the CanUndo property. If it’s True, the control can undo the operation; then you can call the
Undo method to undo the most recent edit.

An edit operation is the insertion or deletion of characters. Entering text without deleting
any is considered a single operation and will be undone in a single step. Even if the user has
spent an hour entering text (without making any corrections), you can make all the text dis-
appear with a single call to the Undo method. Fortunately, the deletion of the text becomes the
most recent operation, which can be undone with another call to the Undo method. In effect, the
Undo method is a toggle. When you call it for the first time, it undoes the last edit operation. If
you call it again, it redoes the operation it previously undid. You can disable the redo operation
by calling the CTearUndo method, which clears the undo buffer of the control. You should call
it from within an Undo command’s event handler to prevent an operation from being redone. In
most cases, you should give users the option to redo an operation, especially because the Undo
method can delete an enormous amount of text from the control.

VB 2010 at Work: The TextPad Project

The TextPad application, shown in Figure 5.2, demonstrates most of the TextBox control’s

properties and methods described so far. TextPad is a basic text editor that you can incorporate
into your programs and customize for special applications. The TextPad project’s main form is
covered by a TextBox control, whose size is adjusted every time the user resizes the form. This
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feature doesn’t require any programming —just set the Dock property of the TextBox control to
Fill.

FIGURE 5.2
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The name of the application’s main form is frmTextPad, and the name of the Find & Replace
dialog box is frmFind. You can design the two forms as shown in the figures of this chapter,
or you can open the TextPad project. To design the application’s interface from scratch, place
a MenuStrip control on the form. The control will be docked to the top of the form automat-
ically. Then place a TextBox control on the main form, name it txtEditor, and set the fol-
lowing properties: MultiTine to True, MaxLength to O (to edit text documents of any length),
HideSelection to False (so that the selected text remains highlighted even when the main form
doesn’t have the focus), and Dock to Fill, so that it will fill the form.

The menu bar of the form contains all the commands you’d expect to find in any text editing
application; they’re listed in Table 5.1.

The File menu commands are implemented with the Open and Save As dialog boxes,
the Font command with the Font dialog box, and the Color command with the Color dialog
box. These dialog boxes are discussed in the following chapters, and as you'll see, you don’t
have to design them yourself. All you have to do is place a control on the form and set a few
properties; the Framework takes it from there. The application will display the standard Open
File/Save File/Font/Color dialog boxes, in which the user can select or specify a filename, or
select a font or color. Of course, we’ll provide a few lines of code to actually move the text
into a file (or read it from a file and display it on the control), change the control’s background
color, and so on. I'll discuss the commands of the File menu in Chapter 7, “More Windows
Controls.”

THE EDITING COMMANDS

The options on the Edit menu move the selected text to and from the Clipboard. For the
TextPad application, all you need to know about the Clipboard is that the SetText method
places the currently selected text on the Clipboard and the GetText method retrieves
information from the Clipboard (see Figure 5.3).

169
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TABLE 5.1: The TextPad form’s menu
MENU COMMAND DESCRIPTION
File New Clears the text
Open Loads a new text file from disk
Save Saves the text to its file on disk
Save As Saves the text with a new filename on disk
Print Prints the text
Exit Terminates the application
Edit Undo/Redo Undoes/redoes the last edit operation
Copy Copies selected text to the Clipboard
Cut Cuts the selected text
Paste Pastes the Clipboard’s contents to the editor
Select All Selects all text in the control
Find & Replace Displays a dialog box with Find and Replace options
Process Convert To Upper Converts selected text to uppercase
Convert To Lower Converts selected text to lowercase
Number Lines Numbers the text lines
Format Font Sets the text’s font, size, and attributes
Page Color Sets the control’s background color
Text Color Sets the color of the text
WordWrap Toggle menu item that turns text wrapping on and off

The Copy command, for example, is implemented with a single line of code (txtEditor
is the name of the TextBox control). The Cut command does the same, and it also clears the
selected text. The code for these and for the Paste command, which assigns the contents of the
Clipboard to the current selection, is presented in Listing 5.2.

If no text is currently selected, the Clipboard’s text is pasted at the pointer’s current loca-
tion. If the Clipboard contains a bitmap (placed there by another application) or any other
type of data that the TextBox control can’t handle, the paste operation will fail; that’s why we
handle the Paste operation with an If statement. You could provide some hint to the user by
including an ETse clause that informs them that the data on the Clipboard can’t be used with a
text-editing application.
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LISTING 5.2: The Cut, Copy, and Paste commands

Private Sub EditCopyItem_Click(..)
Handles EditCopyItem.Click
If txtEditor.SelectionLength > 0 Then
Clipboard.SetText(txtEditor.SelectedText)
End If
End Sub

Private Sub EditCutItem_ Click(..)

Handles EditCutItem.Click
Clipboard.SetText(txtEditor.SelectedText)
txtEditor.SelectedText = ""

End Sub

Private Sub EditPasteItem_Click(..)
Handles EditPasteltem.Click
If Clipboard.ContainsText Then
txtEditor.SelectedText = Clipboard.GetText
End If
End Sub

THE PROCESS AND FORMAT MENUS

The commands of the Process and Format menus are straightforward. The Format menu
commands open the Font or Color dialog box and change the control’s Font, ForeColor, and
BackColor properties. You will learn how to use these controls in the following chapter. The
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Upper Case and Lower Case commands of the Process menu are also trivial: They select all
the text, convert it to uppercase or lowercase, respectively, and assign the converted text to the
control’s SelectedText property with the following statements:

txtEditor.SelectedText = txtEditor.SelectedText.TolLower
txtEditor.SelectedText = txtEditor.SelectedText.ToUpper

Notice that the code uses the SelectedText property to convert only the selected text, not
the entire document. The Number Lines command inserts a number in front of each text line
and demonstrates how to process the individual lines of text on the control. However, it doesn’t
remove the line numbers, and there’s no mechanism to prevent the user from editing the line
numbers or inserting/deleting lines after they have been numbered. Use this feature to create a
numbered listing or to number the lines of a file just before saving it or sharing it with another
user. Listing 5.3 shows the Number Lines command’s code and demonstrates how to iterate
through the TextBox control’s Lines array.

LISTING 5.3: The Number Lines command

Private Sub ProcessNumberlLinesItem Click(..)
Handles ProcessNumberLines.Click
Dim ilLine As Integer
Dim newText As New System.Text.StringBuilder()
For iLine = 0 To txtEditor.Lines.Length - 1
newText.Append((iLine + 1).ToString & vbTab &
txtEditor.Lines(iLine) & vbCrLf)

Next
txtEditor.SelectA11()
Clipboard.SetText(newText.ToString)
txtEditor.Paste()

End Sub

This event handler uses a StringBuilder variable. The StringBuilder class, discussed in
Chapter 11, “The Framework at Large,” is equivalent to the String class; it exposes similar
methods and properties, but it’s much faster at manipulating dynamic strings than the
String class.

SEARCH AND REPLACE OPERATIONS

The last option in the Edit menu—and the most interesting—displays a Find & Replace dialog
box (shown earlier in Figure 5.2). This dialog box works like the similarly named dialog box
of Microsoft Word and many other Windows applications. The buttons in the Find & Replace
dialog box are relatively self-explanatory:

Find The Find command locates the first instance of the specified string in the text after
the cursor location. If a match is found, the Find Next, Replace, and Replace All buttons
are enabled.
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Find Next This command locates the next instance of the string in the text. Initially, this but-
ton is disabled; it’s enabled only after a successful Find operation.

Replace This command replaces the current selection with the replacement string and then
locates the next instance of the same string in the text. Like the Find Next button, it’s disabled
until a successful Find operation occurs.

Replace All This command replaces all instances of the string specified in the Search For box
with the string in the Replace With box.

To design the Find & Replace form, add a new form to the project (select Add New Item
from the project’s context menu) and place the following controls on it:

¢ A TextBox control and the Search for Label control.
¢ A TextBox control and the Replace with Label control.
¢ A CheckBox control with the caption Case Sensitive.
¢ The Find, Find Next, Replace, and Replace All buttons.

Set the new form’s TopMost property to True; you want this form to remain on top of the
main form, even when it doesn’t have the focus. Whether the search is case sensitive or not
depends on the status of the Case Sensitive CheckBox control. If the string is found in the
control’s text, the program will highlight it by selecting it. In addition, the code will call the
TextBox control’s Scrol1ToCaret method to bring the selection into view. The Find Next
button takes into consideration the location of the pointer and searches for a match after the
current location. If the user moves the pointer somewhere else and then clicks the Find Next
button, the program will locate the first instance of the string after the current location of the
pointer —and not necessarily after the last match. Of course, you can always keep track of the
location of each match and continue the search from this location. The Find button executes the
code shown in Listing 5.4.

LISTING 5.4: The Find button

Private Sub bttnFind_Click(..) Handles bttnFind.Click
Dim selStart As Integer
If chkCase.Checked = True Then
selStart =
frmTextPad. txtEditor.Text.Index0f(
searchWord.Text, StringComparison.Ordinal)

Else
selStart =
frmTextPad. txtEditor.Text.Index0f(
searchWord.Text,
StringComparison.OrdinalIgnoreCase)
End If

If selStart = -1 Then
MsgBox("Text not found")
Exit Sub

End If
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frmTextPad. txtEditor.Select(
selStart, searchWord.Text.Length)
bttnFindNext.Enabled = True
bttnReplace.Enabled = True
bttnReplaceAll.Enabled = True
frmTextPad. txtEditor.Scrol1ToCaret()
End Sub

The Find button examines the value of the chkCase CheckBox control, which specifies
whether the search will be case sensitive and calls the appropriate form of the Index0f
method. The first argument of this method is the string we’re searching for; the second argu-
ment is the search mode, and its value is a member of the StringComparison enumeration:
Ordinal for case-sensitive searches and OrdinalIgnoreCase for case-insensitive searches. If
the IndexOf method locates the string, the program selects it by calling the control’s Select
method with the appropriate arguments. If not, it displays a message. Notice that after a
successful Find operation, the Find Next, Replace, and Replace All buttons on the form
are enabled.

The code of the Find Next button is the same, but it starts searching at the character follow-
ing the current selection:

selStart = frmTextPad.txtEditor.Text.Index0f(
searchWord.Text,
frmTextPad.txtEditor.SelectionStart + 1,
StringComparison.Ordinal)

The Replace button replaces the current selection with the replacement string and then
locates the next instance of the find string. The Replace All button replaces all instances of the
search word in the document. Listing 5.5 presents the code behind the Replace and Replace All
buttons.

LISTING 5.5: The Replace and Replace All operations

Private Sub bttnReplace_Click(..) Handles bttnReplace.Click
If frmTextPad.txtEditor.SelectedText <> "" Then
frmTextPad.txtEditor.SelectedText = replaceWord.Text
End If
bttnFindNext_Click(sender, e)
End Sub

Private Sub bttnReplaceAl1_Click(..) Handles bttnReplaceAll.Click
Dim curPos, curSel As Integer
curPos = frmTextPad.txtEditor.SelectionStart
curSel = frmTextPad.txtEditor.SelectionLength
frmTextPad. txtEditor.Text =
frmTextPad.txtEditor.Text.Replace(
searchWord.Text.Trim, replaceWord.Text.Trim)
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frmTextPad. txtEditor.SelectionStart = curPos
frmTextPad. txtEditor.SelectionLength = curSel
End Sub

The Replace method is case sensitive, which means that it replaces instances of the search
argument in the text that have the exact same spelling as its first argument. For a case-
insensitive replace operation, you must write the code to perform consecutive case-insensitive
search-and-replace operations. Alternatively, you can use the Replace built-in function to
perform case-insensitive searches. Here’s how you’d call the Replace function to perform a
case-insensitive replace operation:

Replace(frmTextPad.txtEditor.Text, searchWord.Text.Trim,
replaceWord.Text.Trim, , , CompareMethod.Text)

The last, optional, argument determines whether the search will be case-sensitive (Compare-
Method.Binary) or case-insensitive (CompareMethod. Text).

When you're searching for a string in the text, the active form is the frmFind form and any
selection you make from within your code in the main form’s TextBox control isn’t highlighted
by default. You must set the HideSeTection property of the TextBox control to False to high-
light the selected text on a control that doesn’t currently have the focus. This is a common
property for many controls, and you should remember to change it to False if you want the
selection to remain visible even when the control loses the focus. (You will use this property
most often with the TextBox, ListBox, ListView, and TreeView controls.)

THE UNDO/REDO COMMANDS

The Undo command (shown in Listing 5.6) is implemented with a call to the Undo method.
However, because the Undo method works like a toggle, we must also toggle its caption from
Undo to Redo (and vice versa) each time the command is activated.

LISTING 5.6: The Undo/Redo command of the Edit menu

Private Sub EditUndoItem_Click(..)
Handles EditUndoItem.Click
If EditUndoItem.Text = "Undo" Then
If txtEditor.CanUndo Then
txtEditor.Undo()
EditUndoItem.Text = "Redo"
End If
Else
If txtEditor.CanUndo Then
txtEditor.Undo()
EditUndoItem.Text = "Undo"
End If
End If
End Sub




176

CHAPTER 5 BASIC WINDOWS CONTROLS

The TextBox control doesn’t provide more granular undo operations —unlike Word, which
keeps track of user actions (insertions, deletions, replacements, and so on) and then undoes
them in steps. If you edit the text after an undo operation, you can no longer redo the last undo
operation. This means that as soon as the contents of the TextBox control change, the caption of
the first command in the Edit menu must become Undo, even if it’s Redo at the time. To detect
the action of editing the control’s contents and reset the Undo command’s caption, insert the
following statement in the TextChanged event of the TextBox control:

EditUndoItem.Text = "Undo"

If you need a more-granular undo feature, you should use the RichTextBox control, which is
discussed in detail in Chapter 7. The RichTextBox control can display formatted text, but it can
also be used as an enhanced TextBox control.

Capturing Keystrokes

Another event that is quite commonly used in programming the TextBox control is the
KeyPress event, which occurs every time a key is pressed and reports the character that was
pressed. You can use this event to capture certain keys and modify the program’s behavior
depending on the character typed.

By capturing keystrokes, you can process the data as they are entered, in real time. For
example, you can make sure that a TextBox accepts only numeric or hexadecimal characters
and rejects all others. To implement a binary editor, use the KeyPress event handler shown in
Listing 5.7.

LISTING 5.7: Handling keystrokes

Private Sub TextBox1l_KeyPress(..) Handles TextBoxl.KeyPress
If Char.IslLetterOrDigit(e.KeyChar) Then
Select Case UCase(e.KeyChar)
Case "1", "2", "3", "4" "5"' ‘'g", "7', "8", "9" 'Q"
TextBox1l.SelectedText = e.KeyChar
Case "A", "B", "C", "D", "E", "F"
TextBox1.SelectedText = UCase(e.KeyChar)
End Select
e.Handled = True
End If
End Sub

The very first executable statement in the event handler examines the key that was pressed
and exits if it is a special editing key (Delete, Backspace, Ctrl+V, and so on). If so, the handler
exits without taking any action. The KeyChar property of the e argument of the KeyPress event
reports the key that was pressed. The code converts it to a string and then uses a Case state-
ment to handle individual keystrokes. If the user pressed the a or the 1 key, for example, the
code displays the corresponding uppercase character ("1" or "A"). If the character pressed is
not among the characters that may appear in hexadecimal values, the code skips it by setting
the HandTed property to True.
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You can process the characters pressed from within the KeyDown event handler, only this
time you must set the SuppressKeyPress property to True:

Private Sub TextBox1l_KeyDown(..) Handles TextBoxl.KeyDown
Dim ch As Windows.Forms.Keys
ch = e.KeyCode
If Char.IsLetterOrDigit(Chr(ch)) Then
Select Case ch
Case Keys.D1, Keys.D2, Keys.D3, Keys.D4, Keys.D5,
Keys.D6, Keys.D7, Keys.D8, Keys.D9, Keys.DO
TextBox1l.SelectedText = Chr(ch)
Case Keys.A, Keys.B, Keys.C, Keys.D, Keys.E, Keys.F

o0l

TextBox1l.SelectedText = UCase(Chr(ch))
Case Else
End Select
e.SuppressKeyPress = True
End If
End Sub

CANCELING KEYSTROKES

Before you exit the event handler, you must “kill”’ the original key that was pressed so it
won’t appear on the control. You do this by setting the Handled property to True, which
tells VB that it shouldn’t process the keystroke any further. If you omit this statement, the
special characters will be printed twice: once in their transformed format and once as regular
characters (Aa, Bb, and so on).

CAPTURING FUNCTION KEYS

Another common feature used in all types of applications is the assignment of special opera-
tions to the function keys. The Notepad application, for example, uses the F5 function key to
insert the current date and time at the cursor’s location. You can do the same with the TextPad
application, but you can’t use the KeyPress event—the KeyChar argument doesn’t report
function keys. The events that can capture the function keys are the KeyDown and KeyUp events.
Also, unlike the KeyPress event, these two events don’t report the character pressed but
instead report the key’s code (a special number that distinguishes each key on the keyboard,
also known as the scancode) through the e.KeyCode property.

The keycode is unique for each key, not each character. Lower- and uppercase characters
have different ASCII values but the same keycode because they are on the same key. For
example, the number 4 and the $ symbol have the same keycode because the same key on the
keyboard generates both characters. Along with the key’s code, the KeyDown and KeyUp events
also report the state of the Shift, Ctrl, and Alt keys through the e.Shift, e.Alt, and e.Control
properties.

The KeyUp event handler shown in Listing 5.8 uses the F5 and F6 function keys to insert the
current date and time in the document. It also uses the F7 and F8 keys to insert two predefined
strings in the document.
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LISTING 5.8: KeyUp event examples

Private Sub txtEditor_KeyUp(ByVal sender As Object,
ByVal e As System.Windows.Forms.KeyEventArgs)
Handles txtEditor.KeyUp

Select Case e.KeyCode
Case Keys.F5 :
txtEditor.SelectedText =
Now().TolLongDateString
Case Keys.F6 :
txtEditor.SelectedText =
Now().ToLongTimeString
Case Keys.F7 :
txtEditor.SelectedText =
"MicroWeb Designs, Inc.
Case Keys.F8 :
txtEditor.SelectedText =
"Another user-supplied string"
End Select
End Sub

Windows already uses some of the function keys (for example, the F1 key for help), and you
shouldn’t modify their original functions. With a little additional effort, you can provide users
with a dialog box that lets them assign their own strings to function keys. You'll probably have
to take into consideration the status of the Shift, Control, and A1t properties of the event’s e
argument. To find out whether two of the modifier keys are pressed along with a key, use the
AND operator with the appropriate properties of the e argument. The following If clause detects
the Ctrl and Alt keys:

If e.Control AND e.Alt Then
{ Both Alt and Control keys were down}
End If

If you need to control the keystrokes from within your code (a rather common scenario in
an advanced, functional user interface design), you should be aware of the order of the events
fired every time a key is pressed. First, the KeyDown event is fired; this event is fired before the
keystroke is passed to the control. This is the event in which you should “’kill"” any keystrokes
that you don’t want to be processed normally by the control, or replace them with a different
key. Then the KeyPress event is fired, if the keystroke corresponds to a character, number, or
symbol but not a control key. Finally, the KeyUp event is fired. By that time, the keystroke has
already been processed by the control and it’s too late to kill or replace the original keystroke.
Can you guess what will happen if you insert the following statements in a TextBox control’s
(or Form’s) KeyDown event handler?

If e.KeyCode = Keys.A Then
e.SuppressKeyPress = True
End If

The A key will never be processed, as if the keyboard isn’t working with this application.
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Autocomplete Properties

One set of interesting properties of the TextBox control are the autocomplete properties. Have
you noticed how Internet Explorer prompts you with possible matches as soon as you start typ-
ing an address or your username in a text box (or in the address bar of the browser)? You can
easily implement such boxes with a single-line TextBox control and the autocomplete proper-
ties. Please note that these properties apply to single-line TextBoxes only.

Let me review the properties that relate to automatic completion. You may wish to open the
AutoCompleteTextBoxes project (available for download from www.sybex.com/go/mastering-
vb2010) to experiment with the settings of these properties while reading the text. The Auto-
CompleteMode property determines whether, and how, the TextBox control will prompt
users, and its setting is a member of the AutoCompTeteMode enumeration: Suggest, Append,
SuggestAppend, and None. In Append mode, the TextBox control selects the first matching item
in the list of suggestions and completes the text. In SuggestAppend mode, the control suggests
the first matching item in the list, as before, but it also expands the list. In Suggest mode, the
control simply opens a list with the matching items but doesn’t select any of them. Regular
TextBox controls have their AutoCompTeteMode property set to None.

The AutoCompleteSource property determines where the list of suggestions comes
from; its value is a member of the AutoCompleteSource enumeration, which is shown in
Table 5.2.

TABLE 5.2: The members of the AutoCompTleteSource enumeration
MEMBER DESCRIPTION
A11SystemSources The suggested items are the names of system resources.
A11Ur1 The suggested items are the URLs visited by the target computer. Does

not work if you’re deleting the recently viewed pages.

CustomSource The suggested items come from a custom collection.
FileSystem The suggested items are filenames.

HistorylList The suggested items come from the computer’s history list.
RecentlyUsedList The suggested items come from the Recently Used folder.
None The control doesn’t suggest any items.

To demonstrate the basics of the autocomplete properties, I've included the AutoComplete-
TextBoxes project, which you can download from www.sybex.com/go/masteringvb2010. The
main form of the project is shown in Figure 5.4. This project allows you to set the autocomplete
mode and source for a single-line TextBox control. The top TextBox control uses a custom list
of words, while the lower one uses one of the built-in autocomplete sources (file system, URLs,
and so on).

Once you set the AutoCompleteSource to CustomSource, you must also populate an
AutoCompTleteStringColTlection object with the desired suggestions and assign it to the
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AutoCompTleteCustomSource property. The AutoCompleteStringCollection is just a collection
of strings. Listing 5.9 shows statements in a form’s Load event that prepare such a list and use
it with the TextBox1 control.

FIGURE 5.4
Suggesting W AutcComplete TetBones =i
words with the Entier @ languisge name
AutoCompleteSource wide]
property Vil Base MET
Yriural Basic 2008
Visual Basic 3 —
Wisua! Basic & oy AutcCamglats Teatiomes =
| Enled @ language name
Append Sl
! Viswal Basic 2010
The AulsComelete me | | SEHctaURL o fle
AufoComplels ssuwes s || | Itveeend
huinComplete soure | || | i
R A ATEZON. Cam -
— hbtpe e £ diirrabank £ omd 13
et o £ iyt makes g/
| hitp e gaogle Camd |
i hitp.fwwsguisnbergproject comy’
| The Aublempietn rmode srtbrsg agirles kot Pt medob, while #e
| BuisCampleie soorns seag Bpien b the bobiom Texilax coevirol. The inp contol's
| Busoliomplele source is iwarys & cusiom list
LISTING 5.9: Populating a custom AutoCompleteSource property

Private Sub Forml_Load(..) Handles MyBase.Load
Dim knownWords As New AutoCompleteStringCollection
knownWords.Add("Visual Basic 2008")
knownWords.Add("Visual Basic .NET")
knownWords.Add("Visual Basic 6")
knownWords.Add("Visual Basic")
knownWords.Add("Framework")
TextBox1l.AutoCompleteCustomSource = knownWords
TextBox1.AutoCompleteSource = AutoCompleteSource.CustomSource
TextBox1.AutoCompleteMode = AutoCompleteMode.Suggest
TextBox2.AutoCompleteSource = AutoCompleteSource.RecentlyUsedList
TextBox2.AutoCompleteMode = AutoCompleteMode.Suggest

End Sub

The TextBox1 control on the form will open a drop-down list with all possible matches in
the knownWords collection as soon as the user starts typing in the control, as shown in the top
part of Figure 5.4.
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@ Real World Scenario

DATA-ENTRY APPLICATIONS

Typical business applications contain numerous forms for data entry, and the most common
element on data-entry forms is the TextBox control. Data-entry operators are very efficient
with the keyboard, and they should be able to use your application without reaching for the
mouse.

Seasoned data-entry operators can’t live without the Enter key; they reach for this key at the
end of each operation. In my experience, a functional interface should add intelligence to this
keystroke: the Enter key should perform the obvious or most likely operation at any time.
When data is being entered, for example, it should take the user to the next control in the Tab
order. Consider a data-entry screen like the one shown in the following image, which contains
several TextBox controls, a DataTimePicker control for entering dates, and two CheckBox
controls. This is the main form of the Simple Data Entry Form sample project, which you will
find at www.sybex.com/go/masteringvb2010 along with the other projects available for use
with this book.

=7 Dhala Entry Foim | | ]
] 899
Nama Frasty Pizza
Price 8.99
Category Frazien Food -
¥ lin stack! On Order
Ok | Eancel

The application demonstrates how to use the Enter key intelligently: Every time the Enter key
is pressed, the focus is moved to the next control in the Tab order. Even if the current control
is a CheckBox, this keystroke doesn’t change the status of the CheckBox controls; it simply
moves the focus forward.

You could program the KeyUp event of each control to react to the Enter key, but this app-
roach can lead to maintenance problems if you add new controls to an existing form. The best
approach is to intercept the Enter keystroke at the form level, before it reaches a control. To
do so, you must set the KeyPreview property of the form to True. This setting causes the key
events to be fired first at the form level and then at the control that has the focus. In essence,
it allows you to handle certain keystrokes for multiple controls at once. The KeyUp event
handler of the sample project’s main form intercepts the Enter keystroke and reacts to it by
moving the focus to the next control in the Tab order via the ProcessTabKey method. This
method simulates the pressing of the Tab key, and it’s called with a single argument, which is
a Boolean value: True moves the focus forward, and False moves it backward. Here’s the code
in the KeyDown event handler of the application’s form that makes the interface much more
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functional and intuitive (you can open the DataEntry project, examine all of the code, and see
how it functions):

Private Sub frmDataEntry_KeyDown(
ByVal sender As Object,
ByVal e As System.Windows.Forms.KeyEventArgs)
Handles Me.KeyUp
If e.KeyCode = Keys.Enter And Not (e.Alt Or e.Control) Then
If Me.ActiveControl.GetType Is GetType(TextBox) Or
Me.ActiveControl.GetType Is GetType(CheckBox) Or
Me.ActiveControl.GetType Is
GetType(DateTimePicker) Then
If e.Shift Then
Me.ProcessTabKey(False)

Else
Me.ProcessTabKey(True)
End If
End If
End If
End Sub

It’s important to program the KeyDown event if you want to be able to process keystrokes
before the control captures them, or even if you want to cancel keystrokes. If you insert the
same code in the KeyUp event, the keystrokes will be processed by the control first and then
by your code. There are a couple of things you should notice about this handler. First, it
doesn’t react to the Enter key if it was pressed along with the Alt or Ctrl key. The Shift key,
on the other hand, is used to control the direction in the Tab order. The focus moves forward
with the Enter keystroke and moves backward with the Shift + Enter keystroke. Also, the
focus is handled automatically only for the TextBox, CheckBox, and DataTimePicker controls.
When the user presses the Enter key when a button has the focus, the program reacts as
expected by invoking the button’s C11ick event handler.

The ListBox, CheckedListBox, and ComboBox Controls

The ListBox, CheckedListBox, and ComboBox controls present lists of choices from which the
user can select one or more of the items. The first two are illustrated in Figure 5.5.
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The ListBox control occupies a user-specified amount of space on the form and is populated
with a list of items. If the list of items is longer than can fit on the control, a vertical scroll bar
appears automatically.

The CheckedListBox control is a variation of the ListBox control. It’s identical to the List-
Box control, but a check box appears in front of each item. The user can select any number of
items by checking or clearing the boxes. As you know, you can also select multiple items from
a ListBox control by pressing the Shift or Ctrl key.

The ComboBox control also contains multiple items but typically occupies less space on
the screen. The ComboBox control is an expandable ListBox control: The user can expand it to
make a selection and collapse it after the selection is made. The real advantage of the Combo-
Box control, however, is that the user can enter new information in the ComboBox rather than
being forced to select from the items listed.

To add items to any of the three controls at design time, locate the Items property in the
Properties window for the control and click the ellipsis button. When the String Collection
Editor window pops up, you can add the items you want to display in the list. Each item must
appear on a separate text line, and blank text lines will result in blank lines in the list. These
items will appear in the list when the form is loaded, but you can add more items (or remove
existing ones) from within your code at any time. They appear in the same order as entered on
the String Collection Editor window unless the control has its Sorted property set to True, in
which case the items are automatically sorted regardless of the order in which you've specified
them.

The next sections explore the ListBox control’s properties and methods. Later in the chapter,
you'll see how the same properties and methods can be used with the ComboBox control.

Basic Properties

In the following sections, you'll find the properties that determine the functionality of the List-
Box, CheckedListBox, and ComboBox controls. These properties are usually set at design time,
but you can change the settings from within your application’s code.

INTEGRALHEIGHT

This property can be set to a True/False value that indicates whether the control’s height will
be adjusted to avoid the partial display of the last item. When IntegralHeight is set to True,
the control’s actual height changes in multiples of the height of a single line, so only an integer
number of rows are displayed at all times.

ITEMS

The Items property is a collection that holds the list items for the control. At design time, you
can populate this list through the String Collection Editor window. At runtime, you can access
and manipulate the items through the methods and properties of the Items collection, which
are described in the section “Manipulating the Items Collection” later in this chapter.

MULTICOLUMN

A ListBox control can display its items in multiple columns if you set its MultiColumn prop-
erty to True. The problem with multicolumn ListBoxes is that you can’t specify the column

in which each item will appear. ListBoxes (and CheckedListBoxes) with many items and the
MultiColumn property set to True expand horizontally, not vertically. A horizontal scroll bar
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will be attached to a multicolumn ListBox so that users can bring any column into view. This
property does not apply to the ComboBox control.

SELECTIONMODE

This property, which applies to the ListBox and CheckedListBox controls only, determines
how the user can select the list’s items. The possible values of this property —members of the
SelectionMode enumeration—are shown in Table 5.3.

TABLE 5.3: The SelectionMode enumeration
VALUE DESCRIPTION
None No selection at all is allowed.
One (Default) Only a single item can be selected.
MultiSimple Simple multiple selection: A mouse click (or pressing the spacebar) selects or

deselects an item in the list. You must click all the items you want to select.

MultiExtended  Extended multiple selection: Press Shift and click the mouse (or press one of the
arrow keys) to select multiple contiguous items. This process highlights all the items
between the previously selected item and the current selection. Press Ctrl and click
the mouse to select or deselect multiple single items in the list.

SORTED

When this property is True, the items remain sorted at all times. The default is False because
it takes longer to insert new items in their proper location. This property’s value can be set at
design time as well as runtime. The items in a sorted ListBox control are sorted in ascending
and case-sensitive order, also known as phone book order. Because of this, the ListBox con-
trol won’t sort numeric data. The number 10 will appear in front of the number 5 because the
numeric value of the string 10 is smaller than the numeric value of the string 5. If the numbers
are formatted as 010 and 005, they will be sorted correctly.

TEXT

The Text property returns the selected text on the control. Although you can set the Text prop-
erty for the ComboBox control at design time, this property is available only at runtime for the
other two controls. Notice that the items need not be strings. By default, each item is an object.
For each object, however, the control displays a string, which is the same string returned by the
object’s ToString method.

Manipulating the Items Collection

To manipulate a ListBox control from within your application, you should be able to do the
following:

¢ Add items to the list
¢ Remove items from the list

& Access individual items in the list
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The items in the list are represented by the Items collection. You use the members of the
Items collection to access the control’s items and to add or remove items. The Items property
exposes the standard members of a collection, which are described later in this section.

Each member of the Items collection is an object. In most cases, we use ListBox controls to
store strings, but it’s also common to store objects to this control. When you add an object to a
ListBox control, a string is displayed on the corresponding line of the control. This is the string
returned by the object’s ToString method. You can display any other property of the object by
setting the control’s ValueMember property to the name of the property.

If you add a Font object and a Rectangle object to the Items collection with the statements

ListBox1l.Items.Add(New Font("Verdana", 12, FontStyle.Bold))
ListBox1l.Items.Add(New Rectangle(0, 0, 100, 100))

then the following strings appear on the first two lines of the control:

[Font: Name=Verdana, Size=12, Units=3, GdiCharSet=1, gdiVerticalFont=False]
{X=0, Y=0, Width=100, Height=100}

However, you can access the members of the two objects because the ListBox stores objects,
not their descriptions. The following statement prints the width of the Rectangle object (the out-
put produced by the statement is highlighted):

Debug.WriteLine(ListBox1l.Items.Item(1).Width)
100

The expression in the preceding statement is late-bound, which means that the compiler
doesn’t know whether the first object in the Items collection is a Rectangle object and it can’t
verify the member Width. If you attempt to call the Width property of the first item in the
collection, you’'ll get an exception at runtime indicating that the code has attempted to access a
missing member. The missing member is the Width property of the Font object.

The proper way to read the objects stored in a ListBox control is to examine the type of the
object first and then attempt to retrieve a property (or call a method) of the object, but only
if it’s of the appropriate type. Here’s how you would read the Width property of a Rectangle
object:

If ListBox1l.Items.Item(0).GetType Is

GetType(Rectangle) Then
Debug.WriteLine(CType(ListBox1l.Items.Item(0), Rectangle).Width)

End If

THE ADD METHOD

To add items to the list, use the Items.Add or Items.Insert method. The Add method accepts
as an argument the object to be added to the list. New items are appended to the end of the
list, unless the Sorted property has been set to True. The following loop adds the elements of
the array words to a ListBox control, one at a time:

Dim words(100) As String
{ statements to populate array }
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Dim i As Integer

For i = 0 To 99
ListBox1l.Items.Add(words(i))

Next

Then, to iterate through all the items on the control, use a loop such as the following;:

Dim i As Integer
For i = 0 To ListBoxl.Items.Count - 1

{ statements to process item ListBoxl.Items(i) }
Next

You can also use the For Each..Next statement to iterate through the Items collection, as
shown here:

Dim itm As Object
For Each itm In ListBoxl.Items

{ process the current item, represented by the itm variable }
Next

When you populate a ListBox control with a large number of items, call the BeginUpdate
method before starting the loop and call the EndUpdate method when you're done. These
two methods turn off the visual update of the control while you're populating it, and they
speed up the process considerably. When the EndUpdate method is called, the control is
redrawn with all the items.

THE INSERT METHOD
To insert an item at a specific location, use the Insert method, whose syntax is as follows:

ListBoxl.Items.Insert(index, 1item)

Remember that you must declare the item prior to using it. If you don’t initialize it, you will
get a null ref.

The item parameter is the object to be added, and index is the location of the new item.
(The first item’s index in the list is zero).

THE CLEAR METHOD

The Clear method removes all the items from the control. Its syntax is quite simple:

ListBox1l.Items.Clear

THE COUNT PROPERTY

This is the number of items in the list. If you want to access all the items with a For..Next
loop, the loop’s counter must go from 0 to ListBox.Items.Count — 1, as shown in the example
of the Add method.
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THE COPYTO METHOD

The CopyTo method of the Items collection retrieves all the items from a ListBox control and
stores them in the array passed to the method as an argument. The syntax of the CopyTo
method is as follows, where destination is the name of the array that will accept the items,
and index is the index of an element in the array where the first item will be stored:

ListBox1l.CopyTo(destination, index)

The array that will hold the items of the control must be declared explicitly and must be large
enough to hold all the items.

THE REMOVE AND REMOVEAT METHODS

To remove an item from the list, you can simply call the Items collection’s Remove method,
passing the object to be removed as an argument. If the control contains strings, pass the string
to be removed. If the same string appears multiple times on the control, only the first instance
will be removed.

You can also remove an item by specifying its position in the list via the RemoveAt method,
which accepts as argument the position of the item to be removed:

ListBox1l.Items.RemoveAt(index)

The index parameter is the order of the item to be removed, and the first item’s order is 0.

THE CONTAINS METHOD

The Contains method of the Items collection —not to be confused with the control’s Contains
method —accepts an object as an argument and returns a True/False value that indicates
whether the collection contains this object. Use the Contains method to avoid the insertion of
identical objects into the ListBox control. The following statements add a string to the Items
collection only if the string isn’t already part of the collection:

Dim itm As String = "Remote Computing"

If Not ListBoxl.Items.Contains(itm) Then
ListBox1l.Items.Add(itm)

End If

Selecting Items

The ListBox control allows the user to select either one or multiple items, depending on the set-
ting of the SelectionMode property. In a single-selection ListBox control, you can retrieve the
selected item by using the SelectedItem property and its index by using the SelectedIndex
property. SelectedItem returns the selected item, which is an object. The text of the selected
item is reported by the Text property.

If the control allows the selection of multiple items, they’re reported with the Selected-
Items property. This property is a collection of objects and exposes the same members as the
Items collection. Because the ComboBox does not allow the selection of multiple items, it pro-
vides only the SelectedIndex and SelectedItem properties.
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To iterate through all the selected items in a multiselection ListBox control, use a loop such
as the following:

For Each itm As Object In ListBoxl.SelectedItems
Debug.WriteLine(itm)
Next

The 1tm variable should be declared as Object because the items in the ListBox control are
objects. If they're all of the same type, you can convert them to the specific type and then call
their methods. If all the items are of the Rectangle type, you can use a loop like the following
to print the area of each rectangle:

For Each itm As Rectangle In ListBoxl.SelectedItems
Debug.WriteLine(itm.Width * itm.Height)
Next

VB 2010 at Work: The ListBox Demo Project

The ListBox Demo application (shown in Figure 5.6) demonstrates the basic operations of the
ListBox control. The two ListBox controls on the form operate slightly differently. The first has
the default configuration: Only one item can be selected at a time, and new items are appended
after the existing item. The second ListBox control has its Sorted property set to True and its
MultiSelect property set according to the values of the two RadioButton controls at the bot-
tom of the form.

FIGURE 5.6
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The code for the ListBox Demo application contains much of the logic you'll need in your
ListBox manipulation routines. It shows you how to do the following:

Add and remove items at runtime

Transfer items between lists at runtime

* o

Handle multiple selected items

Maintain sorted lists

.

THE ADD ITEM BUTTONS
The Add Item buttons use the InputBox() function to prompt the user for input, and then they

add the user-supplied string to the ListBox control. The code is identical for both buttons (see
Listing 5.10).

LISTING 5.10: The Add Item buttons

Private Sub bttnSourceAdd_CTlick(..)
Handles bttnSourceAdd.Click
Dim ListItem As String
ListItem = InputBox("Enter new item's name")
If ListItem.Trim <> "" Then
sourcelList.Items.Add(ListItem)
End If
End Sub

Notice that the subroutine examines the data entered by the user to avoid adding blank
strings to the list. The code for the Clear buttons is also straightforward; it simply calls the
Clear method of the Items collection to remove all entries from the corresponding list.

REMOVING ITEMS FROM THE TWO LISTS

The code for the Remove Selected Item button is different from that for the Remove Selected
Items button (both are presented in Listing 5.11). The code for the Remove Selected Item button
removes the selected item, while the Remove Selected Items buttons must scan all the items of
the left list and remove the selected one(s).

LISTING 5.11: The Remove buttons

Private Sub bttnDestinationRemove_Cl1ick(..)
Handles bttnDestinationRemove.Click
destinationList.Items.Remove( destinationList.SelectedItem)
End Sub
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Private Sub bttnSourceRemove_Click(..)
HandTles bttnSourceRemove.Click
Dim i As Integer
For i = 0 To sourcelList.SelectedIndices.Count - 1
sourcelList.Items.RemoveAt( sourcelList.SelectedIndices(0))
Next
End Sub

Notice that the code of the second event handler (the one that removes multiple selected
items) always removes the first item in the SelectedIndices collection. If you attempt to remove
the item SelectedIndices(i), you will remove the first selected item during the first itera-
tion. After an item is removed from the selection, the remaining items are no longer at the same
locations. (In effect, you have to refresh the SelectedIndices collection.) The second selected
item will take the place of the first selected item, which was just deleted, and so on. By remov-
ing the first item in the SelectedIndices collection, we make sure that all selected items, and
only those items, will be eventually removed.

MOVING ITEMS BETWEEN LISTS

The two single-arrow buttons (located between the ListBox controls shown in Figure 5.6) trans-
fer selected items from one list to another. The button with the single arrow pointing to the
right transfers the items selected in the left list after it ensures that the list contains at least one
selected item. Its code is presented in Listing 5.12. First, it adds the item to the second list, and
then it removes the item from the original list. Notice that the code removes an item by passing
it as an argument to the Remove method because it doesn’t make any difference which one of
two identical objects will be removed.

LISTING 5.12: Moving the selected items

Private Sub bttnSourceMove_CTick(..)
Handles bttnSourceMove.Click
While sourcelList.SelectedIndices.Count > 0
destinationList.Items.Add(sourcelList.Items(
sourcelList.SelectedIndices(0)))
sourcelList.Items.Remove(sourcelList.Items(
sourcelList.SelectedIndices(0)))
End While
End Sub

The second single-arrow button transfers items in the opposite direction. The destination
control (the one on the right) doesn’t allow the selection of multiple items, so you can use the
SelectedIndex and SelectedItem properties. The event handler that moves a single item from
the right to the left ListBox is shown next:

sourceList.Items.Add(destinationList.SelectedItem)
destinationList.Items.RemoveAt(destinationList.SelectedIndex)
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Searching the ListBox

Two of the most useful methods of the ListBox control are the FindString and FindString-
Exact methods, which allow you to quickly locate any item in the list. The FindString method
locates a string that partially matches the one you're searching for; FindStringExact finds an
exact match. If you're searching for Man and the control contains a name such as Mansfield,
FindString matches the item but FindStringExact does not.

Both the FindString and FindStringExact methods perform case-insensitive searches. If
you're searching for visual and the list contains the item Visual, both methods will locate it. The
syntax for both methods is the same, where searchStr is the string you're searching for:

itemIndex = ListBox1l.FindString(searchStr)

An alternative form of both methods allows you to specify the index where the search begins:

itemIndex = ListBoxl.FindString(searchStr,
startIndex)

The FindString and FindStringExact methods work even if the ListBox control is not
sorted. You need not set the Sorted property to True before you call one of the searching meth-
ods on the control. Sorting the list will help the search operation, but it takes the control less
than 100 milliseconds to find an item in a list of 100,000 items, so the time spent to sort the list
isn’t worth it. Before you load thousands of items in a ListBox control, however, you should
probably consider a more-functional interface.

VB 2010 AT WORK: THE LISTBOXFIND APPLICATION

The application you'll build in this section (seen in Figure 5.7) populates a list with a large
number of items and then locates any string you specify. Click the button Populate List to pop-
ulate the ListBox control with 10,000 random strings. This process will take a few seconds and
will populate the control with different random strings every time. Then, you can enter a string
in the TextBox control at the bottom of the form. As you type characters (or even delete charac-
ters in the TextBox), the program will locate the closest match in the list and select (highlight)
this item.
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The sample application reacts to each keystroke in the TextBox control and locates the string
you're searching for as you enter characters. The Find Item button does the same, but I thought
I should demonstrate the efficiency of the ListBox control and the type of functionality you’'d
expect in a rich client application.

The code (shown in Listing 5.13) attempts to locate an exact match via the FindStringExact
method. If it succeeds, it reports the index of the matching element. If not, it attempts to locate
a near match with the FindString method. If it succeeds, it reports the index of the near
match (which is the first item on the control that partially matches the search argument) and
terminates. If it fails to find either an exact or a near match, it reports that the string wasn’t
found in the list.

LISTING 5.13: Searching the list

Private Sub TextBoxl_TextChanged(..) Handles TextBox1l.TextChanged
Dim srchWord As String = TextBoxl.Text.Trim
If srchWord.Length = 0 Then Exit Sub
Dim wordIndex As Integer
wordIndex = ListBoxl.FindStringExact(srchWord)
If wordIndex >= 0 Then
ListBox1l.TopIndex = wordIndex
ListBox1l.SelectedIndex = wordIndex
Else
wordIndex = ListBox1l.FindString(srchWord)
If wordIndex >= 0 Then
ListBox1.TopIndex = wordIndex
ListBox1l.SelectedIndex = wordIndex
Else
Debug.WriteLine("Item " & srchWord &
" is not in the Tist")
End If
End If
End Sub

If you search for SAC, for example, and the control contains a string such as SAC or sac or
sAc, the program will return the index of the item in the list and will report an exact match. If
no exact match can be found, the program will return something like SACDEF, if such a string
exists on the control, as a near match. If none of the strings on the control starts with the char-
acters SAC, the search will fail.

The application is quite responsive even if you increase the size of the ListBox control to
100,000 items, except that the process of generating the random strings and populating the con-
trol takes considerably longer. In a practical application, however, you should never have to
display that many items to the user. (Consider an overhaul of your application interface before
you present the user with an enormous list.)

The Populate List button creates 10,000 random items with the help of the Random class.
First, it generates a random value in the range 1 through 20, which is the length of the string
(not all strings have the same length). Then the program generates as many random charac-
ters as the length of the string and builds the string by appending each character to it. These
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random numbers are in the range of 65 to 91 and they’re the ANSI values of the uppercase
characters.

By the way, this technique for generating random strings is not a contrived sample of VB
code. I've used similar techniques on several occasions to populate large database tables with
data and optimize my queries and data-driven applications for performance.

The ComboBox Control

The ComboBox control is similar to the ListBox control in the sense that it contains multiple
items and the user may select one, but it typically occupies less space onscreen. The ComboBox
is practically an expandable ListBox control, which can grow when the user wants to make a
selection and retract after the selection is made. Normally, the ComboBox control displays one
line with the selected item because this control doesn’t allow multiple-item selection. The essen-
tial difference, however, between ComboBox and ListBox controls is that the ComboBox allows
the user to specify items that don’t exist in the list.

There are three types of ComboBox controls. The value of the control’s DropDownStyle prop-
erty determines which box is used; these values are shown in Table 5.4.

TABLE 5.4: DropDownStyTe options for the ComboBox control
VALUE EFFECT
DropDown (Default) The control is made up of a drop-down list, which is visible at all

times, and a text box. The user can select an item from the list or type a new
one in the text box.

DropDownlList This style is a drop-down list from which the user can select one of its items but
can’t enter a new one. The control displays a single item, and the list is expan-
ded as needed.

Simple The control includes a text box and a list that doesn’t drop down. The user can
select from the list or type in the text box.

The ComboBox Styles project, shown in Figure 5.8, demonstrates the three styles of the
ComboBox control. This is another common element of the Windows interface, and its pro-
perties and methods are identical to those of the ListBox control. Load the ComboBox Styles
project in the Visual Basic IDE and experiment with the three styles of the ComboBox control.

The DropDown and Simple ComboBox styles allow the user to select an item from the list or
enter a new one in the edit box of the control. Moreover, they’re collapsed by default and they
display a single item unless the user expands the list of items to make a selection. The Drop-
DownlList style is similar to a ListBox control in the sense that it restricts the user to selecting
an item (the user cannot enter a new one). However, it takes much less space on the form than
a ListBox does because normally it displays a single item. When the user wants to make a selec-
tion, the DropDownlList expands to display more items. After the user has made a selection,
the list contracts to a single line again. Finally, the DropDownlList style of the control doesn’t
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allow the user to enter a new string in the edit area; users are restricted to selecting one of the
existing items.

FIGURE 5.8
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Most of the properties and methods of the ListBox control also apply to the ComboBox con-
trol, shown in Figure 5.9. The Items collection gives you access to the control’s items, and the
SelectedIndex and SelectedItem properties give you access to the current selection. You can
also use the FindString and FindStringExact methods to locate any item in the control from
within your code. Both methods return the index of the item you're searching for on the con-
trol, or the value -1 if no such item exists.

FIGURE 5.9
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There’s one aspect worth mentioning regarding the operation of the control. Although the
edit box at the top allows you to enter a new string, the new string doesn’t become a new item
in the list. It remains there until you select another item or you clear the edit box. You can pro-
vide some code to add any string entered by the user in the control’s edit box to the list of
existing items.

The most common use of the ComboBox control is as a lookup table. The ComboBox control
takes up very little space on the form, but it can be expanded at will. You can save even more
space when the ComboBox is contracted by setting it to a width that’s too small for the longest
item. Use the DropDownWidth property, which is the width of the segment of the drop-down
list. By default, this property is equal to the control’s Width property. The second ComboBox
control in Figure 5.9 contains an unusually long item. The control is wide enough to display the
default selection. When the user clicks the arrow to expand the control, the drop-down section
of the control is wider than the default width so that the long items can be read.

ADDING ITEMS TO A COMBOBOX AT RUNTIME

Although the ComboBox control allows users to enter text in the control’s edit box, it doesn’t
provide a simple mechanism for adding new items at runtime. Let’s say you provide a Combo-
Box with city names. Users can type the first few characters and quickly locate the desired item.
But what if they want to specify a new city name? You can provide this capability with two
simple techniques. The simpler one is to place a button with an ellipsis (three periods) right
next to the control. When users want to add a new item to the control, they can click the button
and be prompted for the new item.

A more-elegant and user-friendly approach is to examine the control’s Text property as soon
as the control loses focus or the user presses the Enter key. If the string entered by the user
doesn’t match an item on the control, you must add a new item to the control’s Items collec-
tion and select the new item from within your code. The FlexComboBox project demonstrates
how to use both techniques in your code. The main form of the project, which is shown in
Figure 5.10, is a simple data-entry screen. It's not the best data-entry form, but it's meant for
demonstration purposes.

FIGURE 5.10
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name. The application will let you enter any city/country combination. You should provide
code to limit the cities within the selected country, but this is a nontrivial task. You also need
to store the new city names entered on the first ComboBox control to a file (or a database
table) so users will find them there the next time they run the application. I haven’t made the
application elaborate; I've added the code only to demonstrate how to add new items to a
ComboBox control at runtime.

VB 2010 AT WORK: THE FLEXCOMBO PROJECT

The ellipsis button next to the City ComboBox control prompts the user for the new item
via the InputBox() function. Then it searches the Items collection of the control via the
FindString method, and if the new item isn’t found, it's added to the control. Then the code
selects the new item in the list. To do so, it sets the control’s SelectedIndex property to the
value returned by the Items.Add method or the value returned by the FindString method,
depending on whether the item was located or added to the list. Listing 5.14 shows the code
behind the ellipsis button.

LISTING 5.14: Adding a new item to the ComboBox control at runtime

Private Sub Buttonl_Click(..) Buttonl.Click
Dim itm As String

itm = InputBox("Enter new item", "New Item")
If itm.Trim <> "" Then AddETement(ComboBox1, 1itm)
End Sub

The AddETement() subroutine, which accepts the control you are adding to and a string as
arguments and adds the string to the control, is shown in Listing 5.15. If the item doesn’t exist
in the control, it’s added to the Items collection. If the item is already a member of the Items
collection, it’s selected. As you will see, the same subroutine will be used by the second method
for adding items to the control at runtime.

LISTING 5.15: The AddETement () subroutine

Sub AddETement(ByRef control As ComboBox, ByVal newItem As String)
Dim idx As Integer
If ComboBoxl.FindString(newItem) > O Then
idx = control.FindString(newItem)
Else
idx = control.Items.Add(newItem)
End If
control.SelectedIndex = idx
End Sub
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You can also add new items at runtime by adding the same code in the control’s LostFocus
event handler:

Private Sub ComboBox1l_ LostFocus(..) Handles ComboBox1.LostFocus
Dim newItem As String = ComboBoxl.Text
AddETement(ComboBox1l, newItem)

For an even more functional interface, capture the Enter keystroke in the control’s KeyUp
event, add the new item to the list (if needed), and then move the focus to the next control on
the form, as discussed earlier in this chapter.

The ScrollBar and TrackBar Controls

The ScrollBar and TrackBar controls let the user specify a magnitude by moving a selector
between its minimum and maximum values. In some situations, the user doesn’t know in
advance the exact value of the quantity to specify (and in this case, a text box would suffice),
so your application must provide a more-flexible mechanism for specifying a value along with
some type of visual feedback.

The vertical scroll bar that lets a user move up and down a long document is a typical
example of the use of the ScrollBar control. The scroll bar and visual feedback are the prime
mechanisms for repositioning the view in a long document or in a large picture that won't fit
entirely in a window.

The TrackBar control is similar to the ScrollBar control, but it doesn’t cover a continuous
range of values. The TrackBar control has a fixed number of tick marks and users can place the
slider’s indicator to the desired value.

In short, the ScrollBar control should be used when the exact value isn’t as important as the
value’s effect on another object or data element. The TrackBar control should be used when the
user can type a numeric value and the value your application expects is a number in a specific
range —for example, integers between 0 and 100 or a value between 0 and 5 inches in steps
of 0.1 inches (0.0, 0.1, 0.2...5.0). The TrackBar control is preferred to the TextBox control in
similar situations because there’s no need for data validation on your part. The user can specify
only valid numeric values with the mouse.

The ScrollBar Control

There’s no ScrollBar control per se in the Toolbox; instead, there are two versions of it: the
HScrollBar and VScrollBar controls. They differ only in their orientation, but because they share
the same members, I will refer to both controls collectively as ScrollBar controls. Actually, both
controls inherit from the ScrollBar control, which is an abstract control: It is used to imple-
ment vertical and horizontal scroll bars, but it can’t be used directly on a form. Moreover, the
HScrollBar and VScrollBar controls are not displayed in the Common Controls tab of the Tool-
box. You have to open the All Windows Forms tab to locate these two controls.

The ScrollBar control is a long stripe, which allows users to select a value between the two
ends of the control. The left (or bottom) end of the control corresponds to its minimum value;
the other end is the control’s maximum value. The current value of the control is determined
by the position of the indicator, which can be scrolled between the minimum and maximum
values. The basic properties of the ScrollBar control, therefore, are properly named Minimum,
Maximum, and Value.
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Minimum The control’s minimum value. The default value is 0, but because this is an Integer
value, you can set it to negative values as well.

Maximum The control’s maximum value. The default value is 100, but you can set it to any
value that you can represent with the Integer data type.

Value The control’s current value, specified by the indicator’s position.

To cover a range of non-integers, you must supply the code to map the actual values to Inte-
ger values. For example, to cover a range from 2.5 to 8.5, set the Minimum property to 25, set
the Maximum property to 85, and divide the control’s value by 10. If the range you need is from
-2.5 to 8.5, set the Minimum property to —25 and the Maximum value to 85, and divide the Value
property by 10.

There are two more properties that allow you to control the movement of the indicator:
the Smal1Change and LargeChange properties. The first property is the amount by which the
indicator changes when the user clicks one of the arrows at the two ends of the control. The
LargeChange property is the displacement of the indicator when the user clicks somewhere in
the scroll bar itself. You can manipulate a scroll bar by using the keyboard as well. Press the
arrow keys to move the indicator in the corresponding direction by SmallChange and the Page
Up/Page Down keys to move the indicator by LargeChange.

VB 2010 AT WORK: THE COLORS PROJECT

Figure 5.11 shows the main form of the Colors sample project, which lets the user specify a
color by manipulating the value of its basic colors (red, green, and blue) through scroll bars.
Each basic color is controlled by a scroll bar and has a minimum value of 0 and a maximum
value of 255. By adjusting the value of each of the basic colors, you can create (almost) any
color imaginable. This is what the Colors application does.

FIGURE 5.11
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As the scroll bar is moved, the corresponding color is displayed, and the user can easily
specify a color without knowing the exact values of its primary components. All the user needs
to know is whether the desired color contains, for example, too much red or too little green.
With the help of the scroll bars and the immediate feedback from the application, the user can

easily pinpoint the desired color.
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THE SCROLLBAR CONTROL’S EVENTS

You can monitor the changes of the ScrollBar’s value from within your code by using two
events: ValueChanged and Scroll. Both events are fired every time the indicator’s position
is changed. If you change the control’s value from within your code, only the ValueChanged
event will be fired.

The Scrol1 event can be fired in response to many different actions, such as the scrolling of
the indicator with the mouse, a click on one of the two buttons at the ends of the scroll bars,
and so on. If you want to know the action that caused this event, you can examine the Type
property of the second argument of the event handler. The value of the e.Type property is a
member of the Scrol1EventType enumeration (LargeDecrement, SmallIncrement, Track, and
SO on).

HANDLING THE EVENTS IN THE COLORS APPLICATION

The two PictureBox controls display the color designed with the three scroll bars. The left
PictureBox is colored from within the Scrol11 event, whereas the other one is colored from
within the ValueChanged event. Both events are fired as the user scrolls the scroll bar’s indi-
cator, but in the Scrol11 event handler of the three scroll bars, the code examines the value of
the e.Type property and reacts to it only if the event was fired because the scrolling of the
indicator has ended. For all other actions, the event handler doesn’t update the color of the left
PictureBox.

If the user attempts to change the Color value by clicking the two arrows of the scroll bars
or by clicking in the area to the left or to the right of the indicator, both PictureBox controls are
updated. While the user slides the indicator or keeps pressing one of the end arrows, only the
PictureBox to the right is updated.

The conclusion from this experiment is that you can program either event to provide contin-
uous feedback to the user. If this feedback requires too many calculations, which would slow
down the reaction of the corresponding event handler, you can postpone the reaction until the
user has stopped scrolling the indicator. You can detect this condition by examining the value
of the e.Type property. When it’s Scrol1EventType.EndScrol1, you can execute the appropri-
ate statements. Listing 5.16 shows the code behind the Scrol11 and ValueChanged events of the
scroll bar that controls the red component of the color. The code of the corresponding events of
the other two controls is identical.

LISTING 5.16: Programming the ScrollBar control’s scroll event

Private Sub redBar_Scroll1(..) Handles redBar.Scroll
If e.Type = ScrollEventType.EndScroll Then
ColorBox1()
Tb1Red.Text = "RED " & redBar.Value.ToString("###")
End If
End Sub

Private Sub redBar_ValueChanged(..) Handles redBar.ValueChanged
CoTlorBox2()
End Sub
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The CoTorBox1() and ColorBox2() subroutines update the color of the two PictureBox con-
trols by setting their background colors. You can open the Colors project in Visual Studio and
examine the code of these two routines.

The TrackBar Control

The TrackBar control is similar to the ScrollBar control, but it lacks the granularity of ScrollBar.
Suppose that you want the user of an application to supply a value in a specific range, such as
the speed of a moving object. Moreover, you don’t want to allow extreme precision; you need

only a few distinct settings. The user can set the control’s value by sliding the indicator or by
clicking on either side of an indicator like the one shown in Figure 5.12.

FIGURE 5.12
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Granularity determines how specific you want to be in measuring. In measuring distances
between towns, a granularity of a mile is quite adequate. In measuring (or specifying) the
dimensions of a building, the granularity could be on the order of a foot or an inch. The
TrackBar control lets you set the type of granularity that’s necessary for your application.

Similar to the ScrollBar control, Smal1Change and LargeChange properties are available.
SmallChange is the smallest increment by which the Slider value can change. The user can
change the slider by the Small1Change value only by sliding the indicator. (Unlike with the
ScrollBar control, there are no arrows at the two ends of the Slider control.) To change the
Slider’s value by LargeChange, the user can click on either side of the indicator.

VB 2010 AT WORK: THE INCHES PROJECT

Figure 5.12 demonstrates a typical use of the TrackBar control. The form in the figure is an
element of a program’s user interface that lets the user specify a distance between 0 and 10
inches in increments of 0.2 inches. As the user slides the indicator, the current value is dis-
played on a Label control below the TrackBar. If you open the Inches application, you'll notice
that there are more stops than there are tick marks on the control. This is made possible with
the TickFrequency property, which determines the frequency of the visible tick marks.

You might specify that the control has 50 stops (divisions) but that only 10 of them will be
visible. The user can, however, position the indicator on any of the 40 invisible tick marks. You
can think of the visible marks as the major tick marks and the invisible ones as the minor tick
marks. If the TickFrequency property is 5, only every fifth mark will be visible. The slider’s
indicator, however, will stop at all tick marks.

When using the TrackBar control on your interfaces, you should set the TickFrequency
property to a value that helps the user select the desired setting. Too many tick marks are con-
fusing and difficult to read. Without tick marks, the control isn’t of much help. You might also
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consider placing a few labels to indicate the value of selected tick marks, as I have done in
this example.
The properties of the TrackBar control in the Inches application are as follows:

Minimum = 0

Maximum = 50

SmallChange = 1
5

LargeChange =
TickFrequency = 5

The TrackBar needs to cover a range of 10 inches in increments of 0.2 inches. If you set the
Small1Change property to 1, you have to set LargeChange to 5. Moreover, the TickFrequency
is set to 5, so there will be a total of five divisions in every inch. The numbers below the tick
marks were placed there with properly aligned Label controls.

The label at the bottom needs to be updated as the TrackBar’s value changes. This is sig-
naled to the application with the Change event, which occurs every time the value of the control
changes, either through scrolling or from within your code. The ValueChanged event handler of
the TrackBar control is shown next:

Private Sub TrackBarl ValueChanged(..) Handles TrackBarl.ValueChanged
Tb1Inches.Text = "Length in inches = " &
Format(TrackBarl.vValue / 5, "#.00")
End Sub

The Label controls below the tick marks can also be used to set the value of the control.
Every time you click one of the labels, the following statement sets the TrackBar control’s value.
Notice that all the Label controls” Click events are handled by a common handler. (There are
more event handlers following the Handles keyword in the listing.)

Private Sub Label_CTlick(..) Handles Labell.Click, Label2.Click, ..
TrackBarl.Value = CInt(CType(sender, Label).text) * 5
End Sub

The code is a bit complicated, but it will compile with the Strict option on. The CType()
function converts its argument, which is an Object variable and may represent any of the
Labels on the form, to a Label object. Then it converts the Label’s caption to an integer value
(the string "1" to the numeric value 1, and so on) by calling the CInt() function. CInt() is
a VB function; the equivalent method of the Framework is System.Convert.ToInt32. The
captions of all Labels are numbers by design, so the conversion will never fail. This value is
then assigned to the Value property of the TrackBar control.

The Bottom Line

Use the TextBox control as a data-entry and text-editing tool. The TextBox control is the
most common element of the Windows interface, short of the Button control, and it’s used to
display and edit text. You can use a TextBox control to prompt users for a single line of text
(such as a product name) or a small document (a product’s detailed description). You can
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actually implement a functional text editor by placing a TextBox control on a form and setting
a few of its properties.

Master It What are the most important properties of the TextBox control? Which ones
would you set in the Properties windows at design time?

Master It How would you implement a control that suggests lists of words matching the
characters entered by the user?

Use the ListBox, CheckedListBox, and ComboBox controls to present lists of items. The
ListBox control contains a list of items from which the user can select one or more, depending
on the setting of the SelectionMode property.

Master It How would you locate an item in a ListBox control?

Use the ScrollBar and TrackBar controls to enable users to specify sizes and positions with

the mouse. The ScrollBar and TrackBar controls let the user specify a magnitude by scrolling
a selector between its minimum and maximum values. The ScrollBar control uses some visual
feedback to display the effects of scrolling on another entity, such as the current view in a long
document.

Master It Which event of the ScrollBar control would you code to provide visual feedback
to the user?



Chapter 6

Working with Forms

In Visual Basic, the form is the container for all the controls that make up the user interface.
When a Visual Basic application is executing, each window it displays on the Desktop is a
form. The terms form and window describe the same entity. A window is what the user sees
on the Desktop when the application is running. A form is the same entity at design time. The
proper term is Windows form, as opposed to web form, but I will refer to them as forms. This
term includes both typical Windows forms and dialog boxes, which are simple forms you use
for very specific actions, such as to prompt the user for a particular piece of data or to display
critical information. A dialog box is a form with a small number of controls, no menus, and
usually an OK and a Cancel button to close it.

Forms have a built-in functionality that is always available without any programming effort
on your part. You can move a form around, resize it, and even cover it with other forms. You
do so with the mouse or with the keyboard through the Control menu.

In previous chapters, you concentrated on placing the elements of the user interface on
forms, setting their properties, and adding code behind selected events. Now you’ll look
at forms themselves and at a few related topics. In this chapter, you'll learn how to do the
following:

¢ Use form properties

¢ Design applications with multiple forms

¢ Design dynamic forms

¢ Design menus

Forms have many trivial properties that won’t be discussed here. Instead, let’s jump directly

to the properties that are unique to forms and then look at how to manipulate forms from
within an application’s code.

The Appearance of Forms

Applications are made up of one or more forms — usually more than one. You should craft
your forms carefully, make them functional, and keep them simple and intuitive. You already
know how to place controls on the form, but there’s more to designing forms than populat-
ing them with controls. The main characteristic of a form is the title bar on which the form’s
caption is displayed (see Figure 6.1).
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FIGURE 6.1
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Clicking the Control menu icon opens the Control menu, which contains the commands
listed in Table 6.1. On the right end of the title bar are three buttons: Minimize, Maximize, and
Close. Clicking these buttons performs the associated function. When a form is maximized, the
Maximize button is replaced by the Restore button. When clicked, the Restore button resets the
form to its size and position before it was maximized, and it’s replaced by the Maximize but-
ton. To access the Control menu from the keyboard, press Alt and then the down arrow key.

TABLE 6.1: Commands of the Control menu
COMMAND EFFECT
Restore Restores a maximized form to the size it was before it was maximized;

available only if the form has been maximized.

Move Lets the user move the form around with the arrow keys.
Size Lets the user resize the form with the arrow keys.

Minimize Minimizes the form.

Maximize Maximizes the form.

Close Closes the current form. (Closing the application’s main form

terminates the application.)

Properties of the Form Object

You're familiar with the appearance of forms, even if you haven’t programmed in the Windows
environment in the past; you have seen nearly all types of windows in the applications you're
using every day. The floating toolbars used by many graphics applications, for example, are
actually forms with a narrow title bar. The dialog boxes that prompt for critical information or
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prompt you to select the file to be opened are also forms. You can duplicate the look of any
window or dialog box through the following properties of the Form object.

ACCEPTBUTTON, CANCELBUTTON

These two properties let you specify the default Accept and Cancel buttons. The Accept but-
ton is the one that’s automatically activated when you press Enter, no matter which control
has the focus at the time; it is usually the button with the OK caption. Likewise, the Cancel
button is the one that’s automatically activated when you hit the Esc key; it is usually the but-
ton with the Cancel caption. To specify the Accept and Cancel buttons on a form, locate the
AcceptButton and CancelButton properties of the form and select the corresponding con-
trols from a drop-down list, which contains the names of all the buttons on the form. For more
information on these two properties, see the section “Forms versus Dialog Boxes,” later in this
chapter.

AUTOSCALEMODE

This property determines how the control is scaled, and its value is a member of the
AutoScaleMode enumeration: None (automatic scaling is disabled); Font (the controls on the
form are scaled relative to the size of the font); Dpi, which stands for dots per inch (the controls
on the form are scaled relative to the display resolution); and Inherit (the controls are scaled
according to the AutoScaleMode property of their parent class). The default value is Font; if
you change the form’s font size, the controls on it are scaled to the new font size. As a result,
the entire form is resized.

AUTOSCROLL

The AutoScrol1 property is a True/False value that indicates whether scroll bars (as shown
in Figure 6.2) will be automatically attached to the form if the form is resized to a point that
not all its controls are visible. Use this property to design large forms without having to worry
about the resolution of the monitor on which they’ll be displayed. Scrolling forms are not
very common, but they’re easy to implement. The AutoScrol11 property is used in conjunction
with two other properties (described a little later in this section): AutoScrolIMargin and
AutoScrolIMinSize. Note that the AutoScroll property applies to a few controls as well,
including the Panel and SplitContainer controls. For example, you can create a form with a
fixed and a scrolling pane by placing two Panel controls on it and setting the AutoScrol1
property of one of them (the Panel control you want to scroll) to True.

FIGURE 6.2
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The AutoScroll property is rarely used with data-entry forms, but it’s used routinely to
display large images. You'll see how to create a scrolling form for displaying large images later
in this chapter in the section on anchoring and docking controls.

AUTOSCROLLPOSITION

This property is available from within your code only (you can’t set this property at design
time but it can be set at runtime from within your code), and it indicates the number of pixels
that the form was scrolled up or down. Its initial value is zero, and it takes on a value when
the user scrolls the form (provided that the AutoScrol1 property is True). Use this property
to find out the visible controls from within your code or to scroll the form from within your
application’s code to bring a specific control into view.

AUTOSCROLLMARGIN

This is a margin, expressed in pixels, that’s added around all the controls on the form. If the
form is smaller than the rectangle that encloses all the controls adjusted by the margin, the
appropriate scroll bar(s) will be displayed automatically.

AUTOSCROLLMINSIZE

This property lets you specify the minimum size of the form before the scroll bars are attached.
If your form contains graphics that you want to be visible at all times, set the Width and
Height members of the AutoScrolIMinSize property to the dimensions of the graphics. (Of
course, the graphics won't be visible at all times, but the scroll bars indicate that there’s more
to the form than can fit in the current window.) Notice that this isn’t the form’s minimum
size; users can make the form even smaller. To specify a minimum size for the form, use the
MinimumSize property, described later in this section.

Let’s say the AutoScrol1Margin property of the form is 180x150. If the form is resized
to fewer than 180 pixels horizontally or 150 pixels vertically, the appropriate scroll bars will
appear automatically as long as the AutoScroll property is True. If you want to enable the
AutoScrol1 feature when the form’s width is reduced to anything fewer than 250 pixels, set the
AutoScrol1MinSize property to (250, 0). In this example, setting AutoScrolIMinSize.Width to
anything less than 180, or AutoScrolIMinSize.Height to anything less than 150, will have no
effect on the appearance of the form and its scroll bars.

BRINGING SELECTED CONTROLS INTO VIEW

In addition to the Autoscroll properties, the Form object provides a Scroll method,
which allows you to scroll a form programmatically, and ScrollControlIntoView, which
scrolls the form until the specified control comes into view. The Scroll method accepts
as arguments the horizontal and vertical displacements for the scrolling operation, whereas
Scrol1ControlIntoView accepts as an argument the control you want to bring into view.
Notice that activating a control with the Tab key automatically brings the next control into
view if it’s not already visible on the form. Finally, the Scroll event is fired every time a
form is scrolled.
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FORMBORDERSTYLE

The FormBorderStyTe property determines the style of the form’s border; its value is one of
the FormBorderStyle enumeration members, which are shown in Table 6.2. You can make
the form’s title bar disappear altogether by setting the form’s FormBorderStyle property to
FixedToolWindow, the Contro1Box property to False, and the Text property (the form’s cap-
tion) to an empty string. However, a form like this can’t be moved around with the mouse and
will probably frustrate users.

TABLE 6.2: The FormBorderStyle enumeration
VALUE EFFECT
Fixed3D A window with a fixed visible border ‘‘raised” relative to the main

area. Unlike the None setting, this setting allows users to minimize and
close the window.

FixedDialog A fixed window used to implement dialog boxes.
FixedSingle A fixed window with a single-line border.
FixedToolWindow A fixed window with a Close button only. It looks like a toolbar

displayed by drawing and imaging applications.

None A borderless window that can’t be resized. This setting is rarely used.
Sizable (default) A resizable window that’s used for displaying regular forms.
SizableToolWindow Same as the FixedToolWindow, but it’s resizable. In addition, its

caption font is smaller than the usual.

Create a simple form and try out the various settings of the FormBorderStyle property to
find out how this property affects the appearance of the form.

CONTROLBOX

This property is also True by default. Set it to False to hide the control box icon and disable the
Control menu. Although the Control menu is rarely used, Windows applications don’t disable
it. When the ControlBox property is False, the three buttons on the title bar are also disabled.
If you set the Text property to an empty string, the title bar disappears altogether.

MINIMIZEBOX, MAXIMIZEBOX

These two properties, which specify whether the Minimize and Maximize buttons will appear
on the form’s title bar, are True by default. Set them to False to hide the corresponding buttons
on a form’s title bar.

MINIMUMSIZE, MAXIMUMSIZE

These two properties read or set the minimum and maximum size of a form. When users resize
the form at runtime, the form won’t become any smaller than the dimensions specified by the
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MinimumSize property or any larger than the dimensions specified by the MaximumSize prop-
erty. The MinimumSize property is a Size object, and you can set it with a statement like the
following:

Me.MinimumSize = New Size(400, 300)

Or you can set the width and height separately:

Me.MinimumSize.Width = 400
Me.MinimumSize.Height = 300

The MinimumSize.Height property includes the height of the form’s title bar; you should

take that into consideration. If the minimum usable size of the form is 400x300, use the follow-
ing statement to set the MinimumSize property:

Me.MinimumSize = New Size(400, 300 + SystemInformation.CaptionHeight)

The default value of both properties is (0, 0), which means that no minimum or maximum
size is imposed on the form and the user can resize it as desired.

USE THE SYSTEMINFORMATION CLASS TO READ SYSTEM INFORMATION

The height of the caption is not a property of the Form object, even though it’s used to
determine the useful area of the form (the total height minus the caption bar). Keep in mind
that the height of the caption bar is given by the CaptionHeight property of the System-
Information object. You should look up the SystemInformation object; it exposes a lot of useful
properties, such as BorderSize (the size of the form’s borders), Border3DSize (the size of
three-dimensional borders), CursorSize (the cursor’s size), and many more.

KEYPREVIEW

This property enables the form to capture all keystrokes before they’re passed to the control
that has the focus. Normally, when you press a key, the KeyPress event of the control with the
focus is triggered (as well as the KeyUp and KeyDown events), and you can handle the keystroke
from within the control’s appropriate handler. In most cases, you let the control handle the
keystroke and don’t write any form code for that.

Some forms perform certain actions when you hit a specific key (the F5 key for refresh-
ing the form being a very common example), no matter which control on the form has the
focus. If you want to use these keystrokes in your application, you must set the KeyPreview
property to True. Doing so enables the form to intercept all keystrokes, so you can process
them from within the form’s keystroke event handlers. To handle a specific keystroke at the
form’s level, set the form’s KeyPreview property to True and insert the appropriate code in
the form’s KeyDown or KeyUp event handler (the KeyPress event isn’t fired for the function and
other non-character keys).

The same keystrokes are then passed to the control with the focus, unless you kill the
keystroke by setting its SuppressKeystroke property to True when you process it on the
form’s level. For more information on processing keystrokes at the form level and using special
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keystrokes throughout your application, see the Contacts project later in this chapter as well as
the TextPad project discussed in Chapter 5, “The Basic Window Controls.”

SI1ZEGRIPSTYLE

This property gets or sets the style of the sizing handle to display in the lower-right corner of
the form. You can set it to a member of the SizeGripStyle enumeration: Auto (the size grip is
displayed as needed), Show (the size grip is displayed at all times), or Hide (the size grip is not
displayed, but users can still resize the form with the mouse).

STARTPOSITION, LOCATION

The StartPosition property, which determines the initial position of the form when it’s
first displayed, can be set to one of the members of the FormStartPosition enumeration:
CenterParent (the form is centered in the area of its parent form), CenterScreen (the form
is centered on the monitor), Manual (the position of the form is determined by the Location
property), WindowsDefaultLocation (the form is positioned at the Windows default location),
and WindowsDefaultBounds (the form’s location and bounds are determined by Windows
defaults). The Location property allows you to set the form’s initial position at design time or
to change the form’s location at runtime.

ToPMOST

This property is a True/False setting that lets you specify whether the form will remain on
top of all other forms in your application. Its default value is False, and you should change
it only on rare occasions. Some dialog boxes, such as the Find & Replace dialog box of any
text-processing application, are always visible, even when they don’t have the focus. For
more information on using the TopMost property, see the discussion of the TextPad project
in Chapter 5. You can also add a professional touch to your application by providing a
CheckBox control that determines whether a form should remain on top of all other forms of
the application.

SIZE

Use the Size property to set the form size at design time or at runtime. Normally, the form
width and height are controlled by the user at runtime. This property is usually set from within
the form Resize event handler to maintain a reasonable aspect ratio when the user resizes the
form. The Form object also exposes the Width and Height properties for controlling its size.

Placing Controls on Forms

The first step in designing your application interface is, of course, the analysis and careful plan-
ning of the basic operations you want to provide through your interface. The second step is
to design the forms. Designing a form means placing Windows controls on it and setting the
control properties (and finally, of course, writing code to handle the events of interest). Visual
Studio is a rapid application development (RAD) environment. This doesn’t mean that you're
expected to develop applications rapidly. It has come to mean that you can rapidly prototype
an application and show something to the customer. And this is made possible through the
visual tools that come with Visual Studio, especially the new Form Designer.

To place controls on your form, you select them in the Toolbox and then draw, on the form,
the rectangle in which the control will be enclosed. Or you can double-click the control’s icon
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to place an instance of the control on the form. Or you can just drag the desired control from
the Toolbox and drop it on the form. All controls have a default size, and you can resize the
control on the form by using the mouse.

Each control’s dimensions can also be set in the Properties window through the Size prop-
erty. The Size property is a composite property that exposes the Width and Height fields,
which are expressed in pixels. Likewise, the Location property returns (or sets) the coordi-
nates of the top-left corner of the control. In “Building Dynamic Forms at Runtime” later in this
chapter, you'll see how to create new controls at runtime and place them in a specific location
on a form from within your code.

As you place controls on the form, you can align them in groups with the relevant com-
mands from the Format menu. Select multiple controls on the form by using the mouse and
the Shift (or Ctrl) key, and then align their edges or center them vertically and horizontally
with the appropriate command from the Format menu. To align the left edges of a column of
TextBoxes, choose the Format > Align » Left command. You can also use the commands from
the Format » Make Same Size command to adjust the dimensions of the selected controls. (To
make them equal in size, make the widths or heights equal.)

As you move controls around with the mouse, a blue snap line appears when the controls
become aligned with another control. Release the mouse while the snap line is visible to leave
the control aligned with the one indicated by the snap lines. The blue snap lines indicate edge
alignment. Most of the time, you need to align not the edges of two controls but their baselines
(the baseline of the text on the control). The snap lines that indicate baseline alignment are red.
Figure 6.3 shows both types of snap lines. When you're aligning a Label control with its match-
ing TextBox control on a form, you want to align their baselines, not their frames (especially
if you consider that the Label controls are always displayed without borders). If the control is
aligned with other controls in both directions, two snap lines will appear — a horizontal one
and a vertical one.

FIGURE 6.3
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One of the most important (and most overlooked) aspects of designing forms is the align-
ment of the controls on the form. Whether the form contains a lot of controls or just a few, the
application is more professional looking and easier for the end user to interact with when the
programmer spends the time to align the controls one to another and group them function-
ally. Try to group controls together based on their functionality. Try to present an uncluttered
interface to the end user. Once you have aligned the controls on the form as discussed in this
section, you can select them all and lock them in place by setting their Locked property to
True. When the Locked property is True, the designer won’t allow you to move them around
by mistake.



THE APPEARANCE OF FORMS | 211

Setting the TabIndex Property

Another important issue in form design is the tab order of the controls on the form. As you
know, by default, pressing the Tab key at runtime takes you to the next control on a form. The
tab order of the controls is the order in which they were placed on the form, but this is hardly
ever what we want. When you design the application, you can specify the order in which the
controls receive the focus (the tab order, as it is known) with the help of the TabIndex prop-
erty. Each control has its own TabIndex setting, which is an integer value. When the Tab key is
pressed, the focus is moved to the control whose tab order immediately follows the tab order
of the current control (the one with the next larger TabIndex property value).

To specify the tab order of the various controls, you can set their TabIndex property in the
Properties window or you can choose the Tab Order command from the View menu. The tab
order of each control will be displayed on the corresponding control, as shown in Figure 6.4.
(The form shown in the figure is the Contacts application, which is discussed shortly.)
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To set the tab order of the controls, click each control in the order in which you want them
to receive the focus. You must click all of them in the desired order, starting with the first
control in the tab order. Each control’s index in the tab order appears in the upper-left corner
of the control. When you're finished, choose the Tab Order command from the View menu
again to hide the numbers. Note that Label controls never receive the focus, but they have their
own TabIndex value. When the next control to receive the focus is a Label control, the focus

is moved automatically to the next control in the tab order until a control that can actually
receive the focus is reached.

@ Real World Scenario

DESIGN WITH THE USER IN MIND

Designing functional forms is a crucial step in the process of developing Windows applications.
Most data-entry operators don’t work with the mouse, and you must make sure that all the
actions (such as switching to another control, opening a menu, clicking a button, and so on)
can be performed with the keyboard. This requirement doesn’t apply to graphics applications,
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of course, but most applications developed with VB are business applications, and users should
be able to perform most of the tasks with the keyboard, not with the mouse.

In my experience, the most important aspect of the user interface of a business application is
the handling of the Enter keystroke. When a TextBox control has the focus, the Enter keystroke
should advance the focus to the next control in the tab order; when a list control (such as the
ListBox or ListView control) has the focus, the Enter keystroke should invoke the same action
as double-clicking the current item. The idea is to package as much intelligence into the Enter
keystroke as possible. The sample project in the following section demonstrates many of the
features you’d expect from a data-entry application.

If you’re developing a data-entry form, you must take into consideration the needs of the
users. Make a prototype and ask the people who will use the application to test-drive it. Listen
to their objections carefully, collect all the information, and then use it to refine your applica-
tion’s user interface. Don’t defend your design — just learn from the users. They will uncover
all the flaws of the application and they’ll help you design the most functional interface. In
addition, they will accept the finished application with fewer objections and complaints if they
know what to expect.

VB 2010 at Work: The Contacts Project

I want to conclude with a simple data-entry application that demonstrates many of the topics
discussed here as well as a few techniques for designing easy-to-use forms. Figure 6.5 shows a
data-entry form for maintaining contact information, and I'm sure you will add your own fields
to make this application more useful.
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You can navigate through the contacts by clicking the arrow keys on the keyboard as well
as add new contacts or delete existing ones by clicking the appropriate buttons. When you're
entering a new contact, the buttons shown in Figure 6.5 are replaced by the usual OK and
Cancel buttons. The action of adding a new contact, or editing an existing one, must end by
clicking one of these two buttons. After a new contact is committed or the action is canceled,
the usual navigation buttons appear again.
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Now, it’s your turn to design the Contacts project. Create a new VB project and place the
controls you see in Figure 6.5 on the application’s form, align them appropriately, and lock
them in position. Or, if you prefer, open the Contacts sample project available for download
from www.sybex.com/go/masteringvb2010. After the controls are on the form, the next step
is to set their tab order. You must specify a value for the TabIndex property even for controls
that never receive focus, such as the Label controls. In addition to setting the tab order of the
controls, use shortcut keys to give the user quick access to the most common fields. The short-
cut keys are displayed as underlined characters on the corresponding labels. Notice that the
Label controls have shortcut keys, even though they don’t receive the focus. When you press
the shortcut key of a Label control, the focus is moved to the following control in the tab order,
which (on this form) is the TextBox control next to it.

If you open the application and run it now, you'll see that the focus moves from one
TextBox to the next with the Tab key and that the labels are skipped. After the last TextBox
control, the focus is moved to the buttons and then back to the first TextBox control. To add a
shortcut key for the most common fields, determine which fields will have shortcut keys and
then which keys will be used for that purpose. Being the Internet buffs that we all are, let’s
assign shortcut keys to the Company, EMail, and URL fields. Locate each label’s Text property
in the Properties window and insert the & symbol in front of the character you want to act as
a shortcut for each Label. The Text property of the three controls should be & ompany, &Mail,
and &URL.

Shortcut keys are activated at runtime by pressing the shortcut character while holding
down the Alt key. The shortcut key will move the focus to the corresponding Label control,
but because labels can’t receive the focus, the focus is moved immediately to the next control
in the tab order, which is the adjacent TextBox control.

The contacts are stored in an ArrayList object, which is similar to an array but a little more
convenient. We’ll discuss ArrayLists in Chapter 12, ““Storing Data in Collections.” For now, you
can ignore the parts of the application that manipulate the contacts and focus on the design
issues.

Start by loading the sample data included with the application that you downloaded from
www . sybex.com/go/masteringvb2010. Open the File menu and choose Load. You won’t be
prompted for a filename; the application always opens the same file in its root folder (it’s the
CONTACTS.BIN file). After reading about the OpenFileDialog and SaveFileDialog controls, you
can modify the code so that it prompts the user to choose the file to read from or write to. Then
enter a new contact by clicking the Add button or edit an existing contact by clicking the Edit
button. Both actions must end with the OK or Cancel button. In other words, users must explic-
itly end the operation and cannot switch to another contact while adding or editing a contact
without committing or discarding the changes.

The code behind the various buttons is straightforward. The Add button hides all the nav-
igational buttons at the bottom of the form and clears the TextBoxes in anticipation of a new
contact record. The OK button saves the new contact to an ArrayList structure and redisplays
the navigational buttons. The Cancel button ignores the data entered by the user and likewise
displays the navigational buttons. In all cases, when the user switches back to the view mode,
the code locks all the TextBoxes by setting their ReadOnly property to True.

HANDLING KEYSTROKES

Although the Tab key is the Windows method of moving to the next control on the form, most
users will find it more convenient to use the Enter key for that purpose. The Enter key is the
most important one on the keyboard, and applications should handle it intelligently. When
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the user presses Enter in a single-line TextBox, for example, the obvious action is to move the
focus to the following control. I included a few statements in the KeyDown event handlers of the
TextBox controls to move the focus to the following one:

Private Sub txtAddressl_KeyDown(..) Handles txtAddressl.KeyDown
If e.KeyData = Keys.Enter Then
e.SuppressKeyPress = True
txtAddress2.Focus()
End If
End Sub

If you use the KeyUp event handler instead, the result won’t be any different, but an annoy-
ing beeping sound will be emitted with each keystroke. The beep occurs when the button is
depressed, so you must intercept the Enter key as soon as it happens and not after the control
receives the notification for the KeyDown event. The control will still catch the KeyUp event and
it will beep because it’s a single-line TextBox control (the beep is an audible warning that the
specific key shouldn’t be used in a single-line TextBox control). To avoid the beep sound, the
code “’kills” the keystroke by setting the SuppressKeystroke property to True.

@ Real World Scenario

PROCESSING KEYS FROM WITHIN YOUR CODE

The code shown in the preceding KeyDown event handler will work, but you must repeat it
for every TextBox control on the form. A more convenient approach is to capture the Enter
keystroke in the form’s KeyDown event handler and process it for all TextBox controls. First,
you must figure out whether the control with the focus is a TextBox control. The property
Me.ActiveControl returns a reference to the control with the focus. To find out the type
of the active control and compare it to the TextBox control’s type, use the following If
statement:

If Me.ActiveControl.GetType Is GetType(TextBox) Then
process the Enter key
End If

Once you can figure out the active control’s type, you need a method of simulating the Tab
keystroke from within your code so you don’t have to code every TextBox control’s KeyDown
event. An interesting method of the Form object is the ProcessTabKey method, which
imitates the Tab keystroke. Calling the ProcessTabKey method is equivalent to pressing the
Tab key from within your code. The method accepts a True/False value as an argument, which
indicates whether it will move the focus to the next control in the tab order (if True) or to the
previous control in the tab order.

Start by setting the form’s KeyPreview property to True and then insert the following
statements in the form’s KeyDown event handler:

If e.KeyCode = Keys.Enter Then
If Me.ActiveControl.GetType Is GetType(TextBox) Then
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e.SuppressKeyPress = True
If e.Shift Then
Me.ProcessTabKey(False)
Else
Me.ProcessTabKey(True)
End If
End If
End If

The last topic demonstrated in this example is how to capture certain keystrokes regardless
of the control that has the focus. We'll use the F10 keystroke to display the total number of
contacts entered so far. Assuming that you have already set the form’s KeyPreview property
to True, enter the following code in the form’s KeyDown event:

If e.Keycode = keys.F10 Then
MsgBox("There are " & MyContacts.Count.ToString & " contacts in the database")
e.Handled = True

End If

Listing 6.1 shows the complete handler for the form’s KeyDown event, which also allows you
to move to the next or previous contact by using the Alt+Plus or Alt+Minus keys, respectively.

LISTING 6.1: Handling keystrokes in the form’s KeyDown event handler

PubTic Sub Forml_KeyDown(ByVal sender As Object,
ByVal e As System.WinForms.KeyEventArgs)
Handles Forml.KeyUp
If e.Keycode = Keys.F10 Then
MsgBox("There are " & MyContacts.Count.ToString &
" contacts in the database")
e.Handled = True
End If
If e.KeyCode = Keys.Subtract And e.Modifiers = Keys.Alt Then
bttnPrevious.PerformClick
End If
If e.KeyCode = Keys.Add And e.Modifiers = Keys.Alt Then
bttnNext.PerformClick
End If
If e.KeyCode = Keys.Enter Then
If Me.ActiveControl.GetType Is GetType(TextBox) Then
e.SuppressKeyPress = True
If e.Shift Then
Me.ProcessTabKey(False)
Else
Me.ProcessTabKey(True)
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End If
End If
End If
End Sub

Anchoring and Docking

A common issue in form design is the design of forms that can be properly resized. For
instance, you might design a nice form for a given size, but when it’s resized at runtime, the
controls are all clustered in the upper-left corner. Or a TextBox control that covers the entire
width of the form at design time suddenly “cringes’ on the left when the user drags out the
window. If the user makes the form smaller than the default size, part of the TextBox could be
invisible because it’s outside the form. You can attach scroll bars to the form, but that doesn’t
really help — who wants to type text and have to scroll the form horizontally? It makes sense
to scroll vertically because you get to see many lines at once, but if the TextBox control is
wider than the form, you can’t read entire lines.

Visual Studio provides several techniques for designing forms that scale nicely. The two
most important of them are the Anchor and Dock properties.

ANCHORING CONTROLS

The Anchor property lets you attach one or more edges of the control to corresponding edges of
the form. The anchored edges of the control maintain the same distance from the corresponding
edges of the form.

Place a TextBox control on a new form, set its MultiLine property to True, and then open
the control’s Anchor property in the Properties window. You will see a rectangle within a
larger rectangle and four pegs that connect the small control to the sides of the larger box (see
Figure 6.6). The large box is the form, and the small one is the control. The four pegs are the
anchors, which can be either white or gray. The gray anchors denote a fixed distance between
the control and the edge of the form. By default, the control is placed at a fixed distance
from the upper-left corner of the form. When the form is resized, the control retains its size
and its distance from the upper-left corner of the form.
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Let’s say you're designing a simple form with a TextBox control that must fill the width of
the form, be anchored to the top of the form, and leave some space for a few buttons at the
bottom. You also want your form to maintain this arrangement regardless of its size. Make
the TextBox control as wide as the form (allowing, perhaps, a margin of a few pixels on either
side). Then place a couple of buttons at the bottom of the form and make the TextBox control
tall enough that it stops above the buttons. This is the form of the Anchor sample project.

Now open the TextBox control’s Anchor property and make all four anchors gray by clicking
them. This action tells the Form Designer to resize the control accordingly, so that the distances
between the sides of the control and the corresponding sides of the form remain the same as
those you set at design time. Select each button on the form and set their Anchor properties in
the Properties window: Anchor the left button to the left and bottom of the form and the right
button to the right and bottom of the form.

Resize the form at design time without running the project and you’ll see that all the con-
trols are resized and rearranged on the form at all times. Figure 6.7 shows the Anchor project’s
main form in two different sizes.
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Yet, there’s a small problem: If you make the form very narrow, there will be no room for
both buttons across the form’s width. The simplest way to fix this problem is to impose a min-
imum size for the form. To do so, you must first decide the form’s minimum width and height
and then set the MinimumSize property to these values. You can also use the AutoScrol1 prop-
erties, but it’s not recommended that you add scroll bars to a small form like ours. Use the
AutoScrol1 properties for large forms with many controls that can’t be resized with the form.

DOCKING CONTROLS

In addition to the Anchor property, most controls provide a Dock property, which determines
how a control will dock on the form. The default value of this property is None.
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Create a new form, place a multiline TextBox control on it, and then open the Dock property
for the control. The various rectangular shapes are the settings of the property. If you click the
middle rectangle, the control will be docked over the entire form: It will expand and shrink
both horizontally and vertically to cover the entire form. This setting is appropriate for simple
forms that contain a single control, usually a TextBox, and sometimes a menu. Try it out.

Let’s create a more complicated form with two controls (see the Docking sample project at
www . sybex.com/go/masteringvb2010). The form shown in Figure 6.8 contains a TreeView con-
trol on the left and a ListView control on the right. The two controls display folder and file data
on an interface that’s very similar to that of Windows Explorer. The TreeView control displays
the directory structure, and the ListView control displays the selected folder’s files.

Place a TreeView control on the left side of the form and a ListView control on the right side
of the form. Then dock the TreeView to the left and the ListView to the right. If you run the
application now, as you resize the form, the two controls remain docked to the two sides of the
form — but their sizes don’t change. If you make the form wider, there will be a gap between
the two controls. If you make the form narrower, one of the controls will overlap the other.

End the application, return to the Form Designer, select the ListView control, and set its
Dock property to Fill. This time, the ListView will change size to take up all the space to the
right of the TreeView. The ListView control will attempt to fill the form, but it won’t take up
the space of another control that has been docked already. The TreeView and ListView controls
are discussed in the tutorial ““The TreeView and ListView Controls,” which you can download
from www.sybex.com/go/masteringvb2010. That’s why I've populated them with some fake
data at design time. In the tutorial, you'll learn how to populate these two controls at runtime
with folder names and filenames, respectively, and build a custom Windows Explorer.

@ Real World Scenario

SCROLLING PICTUREBOX

An interesting technique 1 should mention here is how to create a scrolling form for displaying
large images. The basic requirement is that the image can’t take up the entire form; you need
some space for a menu, a few buttons, or other controls to interact with the form. The image
must be displayed on a PictureBox control with its SizeMode property set to AutoSize. This
setting causes the PictureBox to adjust to the size of the image it contains. Place the various
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controls you need for your interface on the form, as shown here, and then place a Panel on
the form. Anchor the Panel to all four edges of the form so that it’s resized along with the
form. Then set its AutoScrol1 property to True. Finally, place a PictureBox control on the
Panel and align its upper-left corner with the upper-left corner of the Panel control. Do not
anchor or dock this control, because its size will be determined by the size of the image it
contains, not by its container’s size. Now assign a large image to the PictureBox control (you
can use any of the images in the Sample Pictures folder).

i Sorclieg Fctusion [ESE——=|

i — ] = ———

If you run the application now, you will see as much of the upper-left corner of the image
as can fit on the Panel control. You can resize the form to see more of the image or scroll it
around with the two scroll bars to bring any segment of the image into view. This technique
allows you to display an image of any size on a form of any (usually smaller) size.

Splitting Forms into Multiple Panes

So far, the form for the Docking sample project you've designed behaves better than the initial
design, but it’s not what you really expect from a Windows application. The problem with the
form in Figure 6.8 is that users can’t change the relative widths of the controls. In other words,
they can’t make one of the controls narrower to make room for the other, which is a fairly com-
mon concept in the Windows interface.

The narrow bar that allows users to control the relative sizes of two controls is a splitter.
When the cursor hovers over a splitter, it changes to a double arrow to indicate that the
bar can be moved. By moving the splitter, you can enlarge one of the two controls while
shrinking the other. The Form Designer provides a special control for creating resizable panes
on a form: the SplitContainer control. We’ll design a new form with two TextBoxes and a
splitter between them so that users can change the relative size of the two controls.

Start by placing a SplitContainer control on the form. The SplitContainer consists of two
Panel controls, the Panell and Panel2 controls, and a vertical splitter between them. This is
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the default configuration; you can change the orientation of the splitter by using the control’s
Orientation property. Also by default, the two panels of the Splitter control are resized pro-
portionally as you resize the form. If you want to keep one of the panels fixed and have the
other one take up the remaining space of the form, set the control’s FixedPanel property to the
name of the panel you want to retain its size.

Next, place a TextBox control in the left panel of the SplitContainer control and set its
Multiline property to True. You don’t need to do anything about its size because we’ll dock
it in the panel to which it belongs. With the TextBox control selected, locate its Dock property
and set it to Fi71. The TextBox control will fill the left panel of the SplitContainer control. Do
the same with another TextBox control, which will fill the right panel of the SplitContainer
control. Set this control’s Multiline property to True and its Dock property to FiT7.

Now run the project and check out the functionality of the SplitContainer. Paste
some text on the two controls and then change their relative sizes by sliding the split-
ter between them, as shown in Figure 6.9. You will find this project, called Splitter1, at
www . sybex.com/go/masteringvb2010 among the sample projects for this chapter.
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Splitter

Let’s design a more elaborate form with two SplitContainer controls, such as the one shown
in Figure 6.10. (It’s the form in the Splitter2 sample project.) This form, which resembles the
interface of Microsoft Office Outlook, consists of a TreeView control on the left (where the fold-
ers are displayed), a ListView control (where the selected folder’s items are displayed), and a
TextBox control (where the selected item’s details are displayed). Because we haven’t discussed
the ListView and TreeView controls yet, I'm using three TextBox controls with different back-
ground colors; the process of designing the form is identical regardless of the controls you put
on it.

Start by placing a SplitContainer control on the form. Then place a multiline TextBox con-
trol on the left panel of the SplitContainer control and set the TextBox control’s Dock property
to F111. The TextBox control will fill the left panel of the SplitContainer control. Place another
SplitContainer in the right panel of the first SplitContainer control. This control will be auto-
matically docked in its panel and will fill it. Its orientation, however, is vertical, and the splitter



will separate the panel into two smaller vertical panes. Select the second SplitContainer control,
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locate its Orientation property in the Properties window, and set it to Horizontal.

FIGURE 6.10
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Now you can fill each of the panels with a TextBox control. Set each TextBox control’s
BackgroundColor to a different color, its MultiLine property to True, and its Dock property
to F111. The TextBox controls will fill their containers, which are the panels of the two
SplitContainer controls, not the form. If you look up the properties of a SplitContainer control,
you'll see that it's made up of two Panel controls, which are exposed as properties of the
SplitContainer control, the Panell and Panel2 controls. You can set many of the properties
of these two constituent controls, such as their font and color, their minimum size, and so on.
They even expose an AutoScroll property so that users can scroll the contents of each one
independently of the other. You can also set other properties of the SplitContainer control, such
as the SplitterWidth property, which is the width of the splitter bar between the two panels
in pixels, and the SpTitterIncrement property, which is the smallest number of pixels that the
splitter bar can be moved in either direction.

So far, you've seen what the Form Designer and the Form object can do for your application.
Let’s switch our focus to programming forms and explore the events triggered by the Form
object.

Form Events

The Form object triggers several events. The most important are Activated, Deactivate,
FormClosing, Resize, and Paint.

THE ACTIVATED AND DEACTIVATE EVENTS

When more than one form is displayed, the user can switch from one to the other by using the
mouse or by pressing Alt+Tab. Each time a form is activated, the Activated event takes place.
Likewise, when a form is activated, the previously active form receives the Deactivate event.

Insert the code you want to execute when a form is activated (set certain control properties, for
example) and when a form loses the focus or is deactivated in these two event handlers. These
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two events are the equivalents of the Enter and Leave events of the various controls. Notice
that there’s an inconsistency in the names of the two events: the Activated event takes place
after the form has been activated, whereas the Deactivate event takes place right before the
form is deactivated.

THE FORMCLOSING AND FORMCLOSED EVENTS

The FormClosing event is fired when the user closes the form by clicking its Close button.
If the application must terminate because Windows is shutting down, the same event will be
fired. Users don’t always quit applications in an orderly manner, and a professional application
should behave gracefully under all circumstances. The same code you execute in the application
Exit command must also be executed from within the FormClosing event. For example, you
might display a warning if the user has unsaved data, you might have to update a database,
and so on. Place the code that performs these tasks in a subroutine and call it from within your
menu’s Exit command as well as from within the FormClosing event’s handler.

You can cancel the closing of a form by setting the e.Cancel property to True. The event
handler in Listing 6.2 displays a message box informing the user that the data hasn’t been
saved and gives them a chance to cancel the action and return to the application.

LISTING 6.2: Canceling the closing of a form

PubTic Sub Forml_FormClosing (..) Handles Me.FormClosing
Dim reply As MsgBoxResult
reply = MsgBox('Document has been edited. " &
"OK to terminate application, Cancel to " &
"return to your document.", MsgBoxStyle.OKCancel)
If reply = MsgBoxResult.Cancel Then
e.Cancel = True
End If
End Sub

The e argument of the FormClosing event provides the CloseReason property,
which reports how the form is closing. Its value is one of the following members of the
CloseReason enumeration: FormOwnerClosing, MdiFormClosing, None, TaskManagerClosing,
WindowsShutDown, ApplicationExitCall, and UserClosing. The names of the members are
self-descriptive, and you can query the CloseReason property to determine how the window is
closing.

THE RESIZE, RESIZEBEGIN, AND RESIZEEND EVENTS

The Resize event is fired every time the user resizes the form by using the mouse. In the past,
programmers had to insert quite a bit of code in the Resize event’s handler to resize the con-
trols and possibly rearrange them on the form. With the Anchor and Dock properties, much of
this overhead can be passed to the form itself. If you want the two sides of the form to main-
tain a fixed ratio, however, you have to resize one of the dimensions from within the Resize
event handler. Let’s say the form’s width-to-height ratio must be 3:4. Assuming that you're
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using the form’s height as a guide, insert the following statement in the Resize event handler
to make the width equal to three-fourths of the height:

Private Forml_Resize (..) Handles Me.Resize
Me.Width = (0.75 * Me.Height)
End Sub

The Resize event is fired continuously while the form is being resized. If you want to keep
track of the initial form’s size and perform all the calculations after the user has finished resiz-
ing the form, you can use the ResizeBegin and ResizeEnd events, which are fired at the begin-
ning and after the end of a resize operation, respectively. Store the form’s width and height to
two global variables in the ResizeBegin event and use these two variables in the ResizeEnd
event handler to adjust the positions of the various controls on the form.

THE SCROLL EVENT

The Scrol1 event is fired by forms that have the AutoScrol1 property set to True when the
user scrolls the form. The second argument of the Scrol1 event handler exposes the 01dvalue
and NewValue properties, which are the displacements of the form before and after the scroll
operation. This event can be used to keep a specific control in view when the form’s contents
are scrolled.

The AutoScroll property is handy for large forms, but it has a serious drawback: It scrolls
the entire form. In most cases, you want to keep certain controls in view at all times. Instead
of a scrollable form, you can create forms with scrollable sections by exploiting the AutoScrol1
properties of the Panel and/or the SplitContainer controls. You can also reposition certain con-
trols from within the form’s Scro11 event handler. Let’s say you have placed a few controls on
a Panel container and you want to keep this panel at the top of a scrolling form. The following
statements in the form’s Scrol11 event handler reposition the panel at the top of the form every
time the user scrolls the form:

Private Sub Forml_Scrol1(..) Handles Me.Scroll
Panell.Top = Panell.Top + (e.NewValue - e.OldValue)
End Sub

THE PAINT EVENT

This event takes place every time the form must be refreshed, and we use its handler to exe-
cute code for any custom drawing on the form. When you switch to another form that partially
or totally overlaps the current one and then switch back to the first form, the Paint event will
be fired to notify your application that it must redraw the form. The form will refresh its con-
trols automatically, but any custom drawing on the form won’t be refreshed automatically. This
event is discussed in more detail in the tutorial “Drawing and Painting with Visual Basic 2008,”
where the Framework’s drawing methods are presented. You can download the tutorial from
www . sybex . com/go/masteringvb2010.

Loading and Showing Forms

Most practical applications are made up of multiple forms and dialog boxes. One of the opera-
tions you'll have to perform with multiform applications is to load and manipulate forms from
within other forms’ code. For example, you might want to display a second form to prompt the
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user for data specific to an application. You must explicitly load the second form and read the
information entered by the user when the auxiliary form is closed. Or you might want to main-
tain two forms open at once and let the user switch between them. A text editor and its Find &
Replace dialog box is a typical example.

You can access a form from within another form using its name. Let’s say that your appli-
cation has two forms, named Forml and Form2, and that Forml is the project’s startup form. To
show Form2 when an action takes place on Forml, call the Show method of the auxiliary form:

Form2.Show

This statement brings up Form2 and usually appears in a button’s or menu item’s Click
event handler. To exchange information between two forms, use the techniques described in
the section “Sharing Variables between Forms’ later in this chapter.

The Show method opens a form in a modeless manner: The two forms are equal in stature
on the desktop, and the user can switch between them. You can also display the second form
in a modal manner, which means that users can’t return to the form from which they invoked it
without closing the second form. While a modal form is open, it remains on top of the desktop,
and you can’t move the focus to any other form of the same application (but you can switch to
another application). To open a modal form, use the ShowDialog method:

Form2.ShowDialog

A dialog box is simply a modal form. When you display forms as dialog boxes, change the
border of the forms to the setting FixedDialog and invoke them with the ShowDialog method.
Modeless forms are more difficult to program because the user may switch among them at any
time. Moreover, the two forms that are open at once must interact with one another. When the
user acts on one of the forms, it might necessitate changes in the other, and you’ll see shortly
how this is done. If the two active forms don’t need to interact, display one of them as a
dialog box.

When you're finished with the second form, you can either close it by calling its Close
method or hide it by calling its Hide method. The Close method closes the form, and its
resources are returned to the system. The Hide method sets the form’s Visible property to
False; you can still access a hidden form’s controls from within your code, but the user can’t
interact with it.

The Startup Form

A typical application has more than a single form. When an application starts, the main form
is loaded. You can control which form is initially loaded by setting the startup object in the
project Properties window. To open this dialog box, right-click the project’s name in the Solu-
tion Explorer and select Properties. In the project’s Properties pages, switch to the Application
tab and select the appropriate item in the Startup Form combo box. By default, the IDE sug-
gests the name of the first form it created, which is Forml. If you change the name of the form,
Visual Basic will continue using the same form as the startup form with its new name.

You can also start an application by using a subroutine without loading a form. This sub-
routine is the MyApplication_Startup event handler, which is fired automatically when the
application starts. To display the AuxiTiaryForm object from within the Startup event handler,
use the following statement:
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Private Sub MyApplication_Startup (..) Handles Me.Startup
System.Windows.Forms.Application.Run(New AuxiliaryForm())
End Sub

To view the MyAppT1ication_Startup event handler, click the View Application Events but-
ton at the bottom of the Application pane in the project’s Properties window. This action will
take you to the MyApplication code window, where you can select the MyApplication Events
item in the object list and the Startup item in the events list.

Controlling One Form from within Another

Loading and displaying a form from within another form’s code is fairly trivial. In some sit-
uations, this is all the interaction you need between forms. Each form is designed to operate
independently of the others, but they can communicate via public variables (see the following
section). In most situations, however, you need to control one form from within another’s code.
Controlling the form means accessing its controls and setting or reading values from within
another form’s code.

SHARING VARIABLES BETWEEN FORMS

The preferred method for two forms to communicate with each other is through public
variables. These variables are declared in the form’s declarations section, outside any proce-
dure, with the keyword PubTlic. If the following declarations appear in Forml, the variable
NumPoints and the array DataValues can be accessed by any procedure in Forml as well as
from within the code of any form belonging to the same project:

Public NumPoints As Integer
Public DataValues(100) As Double

To access a public variable declared in Forml from within another form’s code, you must
prefix the variable’s name by the name of the form, as in the following;:

Forml.NumPoints = 99
Forml.DataValues(0) = 0.3395022

In effect, the two public variables have become properties of the form in which they were
declared. You can use the same notation to access the controls on another form. If Forml con-
tains the TextBox1 control, you can use the following statement to read its text:

Forml.TextBox1l.Text

The controls on a form can be accessed by the code in another form because the default
value of the Modifiers property of the controls on a form is Friend, which means that all
components in a solution can access them. Other settings of the Modifiers property are Public
(any application can access the control) and Private (the control is private to the form to which
it belongs and cannot be accessed from code outside its own form). There are two more values,
Protected and Protected Friend, which apply to inherited forms, a topic that’s not covered
in this book.
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If a button on Forml opens the auxiliary form Form2, you can set selected controls to specific
values before showing the auxiliary form. The following statements should appear in a button’s
or menu item’s C1ick event handler:

Form2.TextBox1l.Text = "some text"
Form2.DateTimePickerl.Value = Today
Form2.Show()

You can also create a variable to represent another form and access the auxiliary form
through this variable. Let’s say you want to access the resources of Form2 from within the code
of Forml. Declare the variable auxForm to represent Form2 and then access the resources of
Form2 with the following statements:

Dim auxForm As Form2
auxForm.TextBox1l.Text = "some text'
auxForm.DateTimePickerl.Value = Today
auxForm.Show

MULTIPLE INSTANCES OF A SINGLE FORM

Note that the variable that represents an auxiliary form is declared without the New keyword.
The auxForm variable represents an existing form. If we used the New keyword, we’d create
a new instance of the corresponding form. This technique is used when we want to display
multiple instances of the same form, as in an application that allows users to open multiple
documents of the same type.

Let’s say you’re designing an image-processing application or a simple text editor. Each
new document should be opened in a separate window. Obviously, you can’t design many
identical forms and use them as needed. The solution is to design a single form and create
new instances of it every time the user opens an existing document or creates a new one.
These instances are independent of one another and they may interact with the main form.

The approach described here is reminiscent of Multiple Document Interface (MDI) applica-
tions. The MDI interface requires that all windows be contained within a parent window, and
although once very popular, it’s going slowly out of style. The new interfaces open multiple
independent windows on the Desktop. Each window is an instance of a single form and
it’s declared with the New keyword. I’ve used this style of interface to redesign the TextPad
application of Chapter 5, and I’ve included the revised application in this chapter’s projects for
your reference. Open the project in Visual Studio and examine its code, which contains a lot
of comments.

Forms versus Dialog Boxes

Dialog boxes are special types of forms with very specific functionality that prompt the user
for data. The Open and Save dialog boxes are two of the most familiar dialog boxes in Win-
dows. They’re so common that they’re actually known as common dialog boxes. Technically,
a dialog box is a good old form with its FormBorderStyle property set to FixedDialog. Like
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forms, dialog boxes might contain a few simple controls, such as Labels, TextBoxes, and But-
tons. Don’t overload a dialog box with controls and functionality; you'll end up with a regular
form. Dialog boxes are supposed to present a few options and perform very simple tasks. There
are exceptions, of course, like the Printer Setup dialog box, but dialog boxes are usually simple
forms with a pair of OK/Cancel buttons.

Figure 6.11 shows a couple of dialog boxes you have certainly seen while working with Win-
dows applications. The Caption dialog box of Word is a modal dialog box: You must close it
before switching to your document. The Find and Replace dialog box is modeless: It allows you
to switch to your document, yet it remains visible while open even if it doesn’t have the focus.
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Notice that some dialog boxes, such as Open, Color, and even the humble MessageBox,
come with the Framework, and you can incorporate them in your applications without having
to design them.

A characteristic of dialog boxes is that they provide an OK and a Cancel button. The OK
button tells the application that you're finished using the dialog box and the application can
process the information in it. The Cancel button tells the application that it should ignore the
information in the dialog box and cancel the current operation. As you will see, dialog boxes
allow you to quickly find out which buttons were clicked to close them so that your application
can take a different action in each case.

In short, the difference between forms and dialog boxes is artificial. If it were really impor-
tant to distinguish between the two, they’d be implemented as two different objects — but
they’re the same object. So, without any further introduction, let’s look at how to create and
use dialog boxes.

To create a dialog box, start with a Windows form, set its FormBorderStyle property to
FixedDialog, and set the ControlBox, MinimizeBox, and MaximizeBox properties to False.
Then add the necessary controls on the form and code the appropriate events, as you would
do with a regular Windows form.

Figure 6.12 shows a simple dialog box that prompts the user for an ID and a password (see
the Password sample project available for download from www.sybex.com/go/masteringvb2010).
The dialog box contains two TextBox controls (next to the appropriate labels) and the usual OK
and Cancel buttons.

Now, to design your own Password main form, start a new project, rename the form
MainForm, and place a button on it. This is the application main form, and we’ll invoke the
dialog box from within the button’s C1ick event handler. Then add a new form to the project,
name it PasswordForm, and place on it the controls shown in Figure 6.12.
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To display a modal form, you call the ShowDialog method instead of the Show method. You
already know how to read the values entered on the controls of the dialog box. You also need
to know which button was clicked to close the dialog box. To convey this information from the
dialog box back to the calling application, the Form object provides the DialogResult property.
This property can be set to one of the values shown in Table 6.3 to indicate which button was
clicked. The DialogResult.OK value indicates that the user has clicked the OK button on the
form. There’s no need to place an OK button on the form; just set the form’s DialogResult
property to DialogResult.OK.

TABLE 6.3: The DialogResult enumeration
VALUE DESCRIPTION
Abort The dialog box was closed with the Abort button.
Cancel The dialog box was closed with the Cancel button.
Ignore The dialog box was closed with the Ignore button.
No The dialog box was closed with the No button.
None The dialog box hasn’t been closed yet. Use this option to find out

whether a modeless dialog box is still open.

OK The dialog box was closed with the OK button.
Retry The dialog box was closed with the Retry button.
Yes The dialog box was closed with the Yes button.

The dialog box need not contain any of the buttons mentioned here. It's your responsibil-
ity to set the value of the DialogResult property from within your code to one of the settings
shown in the table. This value can be retrieved by the calling application. The code behind the
two buttons in the dialog box is quite short:

Private Sub bttnOK_Click(..) Handles bttnOK.Click
Me.DialogResult = DialogResult.OK
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Me.Close
End Sub

Private Sub bttnCancel_Click(..) Handles bttnCancel.Click
Me.DialogResult = DialogResult.Cancel
Me.Close

End Sub

The event handler of the button that displays this dialog box should contain an If statement
that examines the value returned by the ShowDialog method:

If PasswordForm.ShowDialog = DialogResult.0K Then
" { process the user selection }
End If

Depending on your application, you might allow the user to close the dialog box by
clicking more than two buttons. Some of them must set the DialogResult property to
DialogResult.OK, others to DialogResult.Cancel.

If the form contains an Accept and a Cancel button, you don’t have to enter a single
line of code in the modal form. The user can enter values on the various controls and then
close the dialog box by pressing the Enter or Cancel key. The dialog box will close and will
return the DialogResult.OK or DialogResult.Cancel value. The Accept button sets the
form’s DialogResult property to DialogResult.OK automatically, and the Cancel button sets
the same property to DialogResult.Cancel. Any other button must set the DialogResult
property explicitly. Listing 6.3 shows the code behind the Log In button on the sample project’s
main form.

LISTING 6.3: Prompting the user for an ID and a password

Private Sub Buttonl_Click(..) Handles Buttonl.Click
If PasswordForm.ShowDialog() = DialogResult.OK Then

If PasswordForm.txtUserID.Text = "" Or
PasswordForm.txtPassword.Text = "" Then
MsgBox("Please specify a user ID and a password to connect')
Exit Sub
End If
MsgBox("You were connected as " & PasswordForm.txtUserID.Text)
Else
MsgBox("Connection failed for user " & PasswordForm.txtPassword.Text)
End If
End Sub

VB 2010 AT WORK: THE MULTIPLEFORMS PROJECT

It’s time to write an application that puts together the topics discussed in this section. The
MultipleForms project, available for download from www.sybex.com/go/masteringvb2010,
consists of a main form, an auxiliary form, and a dialog box. All three components of the
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FIGURE 6.13
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application interface are shown in Figure 6.13. The buttons on the main form display both the
auxiliary form and the dialog box.
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Let’s review the various operations you want to perform — they’re typical for many situa-
tions, not for only this application. At first, you must be able to invoke both the auxiliary form
and the dialog box from within the main form; the Show Auxiliary Form and Show Dialog Box
buttons do this. The main form contains a variable declaration: strProperty. This variable is,
in effect, a property of the main form and is declared as public with the following statement:

Public strProperty As String = "Mastering VB 2010"

The main form calls the auxiliary form’s Show method to display it in a modeless manner.
The auxiliary form button with the caption Read Shared Variable In Main Form reads the
strProperty variable of the main form with the following statement:

Private Sub bttnReadShared_Click(..) Handles bttnReadShared.Click
MsgBox(MainForm.strProperty, MsgBoxStyle.OKOnly,
"Public Variable Value")
End Sub

Using the same notation, you can set this variable from within the auxiliary form. The fol-
lowing event handler prompts the user for a new value and assigns it to the shared variable of
the main form:

Private Sub bttnSetShared_Click(..) Handles bttnSetShared.Click
Dim str As String
str = InputBox("Enter a new value for strProperty")
MainForm.strProperty = str

End Sub
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The two forms communicate with each other through public properties. Let’s make this com-
munication a little more elaborate by adding an event. Every time the auxiliary form sets the
value of the strProperty variable, it raises an event to notify the main form. The main form,
in turn, uses this event to display the new value of the string on the TextBox control as soon as
the code in the auxiliary form changes the value of the variable and before it’s closed.

To raise an event, you must declare the event name in the form’s declaration section. Insert
the following statement in the auxiliary form’s declarations section:

Event strPropertyChanged()

Now add a statement that fires the event. To raise an event, call the RaiseEvent statement
and pass the name of the event as an argument. This statement must appear in the Click event
handler of the Set Shared Variable In Main Form button, right after setting the value of the
shared variable. As soon as the user clicks the button, the auxiliary form notifies the main form
by raising the strPropertyChanged event. Listing 6.4 shows the revised event handler.

LISTING 6.4: Raising an event

Private Sub bttnSetShared_Click(..) Handles bttnSetShared.Click
Dim str As String
str = InputBox("Enter a new value for strProperty")
MainForm.strProperty = str
RaiseEvent strPropertyChanged

End Sub

The event will be raised, but it will go unnoticed if you don’t handle it from within the main
form’s code. To handle the event, you must create a variable that represents the auxiliary form
with the WithEvents keyword:

Dim WithEvents FRM As New AuxiliaryForm()

The WithEvents keyword tells VB that the variable is capable of raising events and that
VB should listen for events from the specific form. If you expand the drop-down list with the
objects in the code editor, you will see the name of the FRM variable, along with the other con-
trols you can program. Select FRM in the list and then expand the list of events for the selected
item. In this list, you will see the strPropertyChanged event. Select it and the definition of an
event handler will appear. Enter these statements in this event’s handler:

Private Sub FRM_strPropertyChanged() Handles FRM.strPropertyChanged
TextBox1l.Text = strProperty

Beep()
End Sub

It’s a simple handler, but it's adequate for demonstrating how to raise and handle custom
events on the form level. If you want, you can pass arguments to the event handler by
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including them in the declaration of the event. To pass the original and the new value through
the strPropertyChanged event, use the following declaration:

Event strPropertyChanged(ByVal oldValue As String,
Byval newValue As String)

If you run the application now, you'll see that the value of the TextBox control in the main
form changes as soon as you change the property’s value in the auxiliary form. You can actu-
ally change the value of the variable several times before closing the auxiliary form, and each
time the current value will be displayed on the main form.

Of course, you can update the TextBox control on the main form directly from within the
auxiliary form’s code. Use the expression MainForm.TextBox1 to access the control and then
manipulate it as usual. Events are used to perform some actions on a form when an action
takes place. The benefit of using events, as opposed to accessing members of another form from
within your code, is that the auxiliary form need not know anything about the form that called
it. The auxiliary form raises the event, and it’s the calling form’s responsibility to handle it.
Moreover, the event handler in the main form may perform other actions in addition to set-
ting a control’s value; it may submit something to a database, log the action, and perform any
other operation suited for the application at hand.

Let’s see now how the main form interacts with the dialog box. What goes on between a
form and a dialog box is not exactly interaction; it's a more timid type of behavior. The form
displays the dialog box and waits until the user closes the dialog box. Then it looks at the value
of the DialogResult property to find out whether it should even examine the values passed
back by the dialog box. If the user has closed the dialog box with the Cancel (or an equivalent)
button, the application ignores the dialog box settings. If the user closed the dialog box with
the OK button, the application reads the values and proceeds accordingly.

Before showing the dialog box, the code of the Show Dialog Box button sets the values of
certain controls on the dialog box. In the course of the application, it usually makes sense to
suggest a few values in the dialog box so that the user can accept the default values by pressing
the Enter key. The main form reads a date on the dialog box’s controls and then displays the
dialog box with the statements given in Listing 6.5.

LISTING 6.5: Displaying a dialog box and reading its values

Protected Sub Button3_Click(..) Handles Button3.Click
' Preselects the date 4/11/1980
AgeDialog.cmbMonth.Text = "4"
AgeDialog.cmbDay.Text = "11"
AgeDialog.CmbYear.Text = "1980"
AgeDialog.ShowDialog()
If AgeDialog.DialogResult = DialogResult.OK Then
MsgBox(AgeDialog.cmbMonth.Text & " " &
AgeDialog.cmbDay.Text & "," &
AgeDialog.cmbYear.Text)
Else
MsgBox("OK, we'l1l protect your vital personal data")
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End If
End Sub

To close the dialog box, you can click the OK or Cancel button. Each button sets the
DialogResult property to indicate the action that closed the dialog box. The code behind the
two buttons is shown in Listing 6.6.

LISTING 6.6: Setting a dialog box DialogResult property

Protected Sub bttnOK_CTick(..) Handles bttnOK.CTick
Me.DialogResult = DialogResult.OK
End Sub

Protected Sub bttnCancel_Click(..) Handles bttnCancel.Click
Me.DialogResult = DialogResult.Cancel
End Sub

Because the dialog box is modal, the code in the Show Dialog Box button is suspended at
the line that shows the dialog box. As soon as the dialog box is closed, the code in the main
form resumes with the statement following the one that called the ShowDialog method of the
dialog box. This is the If statement in Listing 6.5 that examines the value of the DialogResult
property and acts accordingly.

Building Dynamic Forms at Runtime

Sometimes you won’t know in advance how many instances of a given control might be
required on a form. Let’s say you're designing a form for displaying the names of all tables

in a database. It's practically impossible to design a form that will accommodate every
database users might throw at your application. Another typical example is a form for entering
family-related data, which includes the number of children in the family and their ages. As
soon as the user enters (or changes) the number of children, you should display as many
TextBox controls as there are children to collect their ages.

For these situations, it is possible to design dynamic forms, which are populated at runtime.
The simplest approach is to create more controls than you’ll ever need and set their Visible
properties to False at design time. At runtime, you can display the controls by switching their
Visible properties to True. As you know already, quick-and-dirty methods are not the most
efficient ones. You must still rearrange the controls on the form to make it look nice at all times.
The proper method to create dynamic forms at runtime is to add controls to and remove them
from your form as needed from within your code using the techniques discussed in the follow-
ing sections.

Just as you can create new instances of forms, you can also create new instances of any con-
trol and place them on a form. The Form object exposes the Controls property, which is a
collection that contains all the controls on the form. This collection is created automatically as
you place controls on the form at design time, and you can access the members of this collec-
tion from within your code. It is also possible to add new members to the collection, or remove
existing members, with the Add and Remove methods of the Form object accordingly.
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The Form’s Controls Collection

All the controls on a form are stored in the Controls collection, which is a property of the
Form object. The Controls collection exposes members for accessing and manipulating the con-
trols at runtime, and they’re the usual members of a collection:

Add Method The Add method adds a new element to the Controls collection. In effect, it adds
a new control on the current form. The Add method accepts a reference to a control as an argu-
ment and adds it to the collection. Its syntax is the following, where control0bj is an instance
of a control:

Controls.Add(control0bj)

To place a new Button control on the form, declare a variable of the Button type, set its proper-
ties, and then add it to the Controls collection:

Dim bttn As New System.Windows.Forms.Button
bttn.Text = "New Button"

bttn.Left = 100

bttn.Top = 60

bttn.Width = 80

Me.Controls.Add(bttn)

Remove Method The Remove method removes an element from the Controls collection. It
accepts as an argument either the index of the control to be removed or a reference to the con-
trol to be removed (a variable of the Control type that represents one of the controls on the
form). The syntax of these two forms of the Remove method is as follows:

Me.Controls.Remove(index)
Me.Controls.Remove(controlObj)

Count Property and A11 Method The Count property returns the number of elements in the
Controls collection. Notice that if there are container controls, such as a Panel control, the con-
trols in the containers are not included in the count. The Panel control has its own Controls
collection. The A11 method returns all controls on a form (or a container control) as an array of
the System.WinForms.Control type.

Clear Method The Clear method removes all the elements of the Controls array and effec-
tively clears the form.

The Controls collection is also a property of any control that can host other controls. As
you recall from our discussion of the Anchor and Dock properties, it's customary to place con-
trols on a panel and handle them collectively as a section of the form. They are moved along
with the panel at design time, and they’re rearranged as a group at runtime. The Panel belongs
to the form’s Controls collection, and it provides its own Controls collection, which lets you
access the controls on the panel.

VB 2010 AT WORK: THE SHOWCONTROLS PROJECT

The ShowControls project (shown in Figure 6.14) demonstrates the basic methods of
the Controls property. Download the ShowControls project from www.sybex.com/go/
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masteringvb2010, open it, and add any number of controls on the main form. You can place a
panel to act as a container for other controls as well. Just don’t remove the button at the top of
the form (the Scan Controls On This Form button); it contains the code to list all the controls.
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The code behind the Scan Controls On This Form button enumerates the elements of the
form’s Controls collection. The code doesn’t take into consideration containers within contain-
ers. This would require a recursive routine, which would scan for controls at any depth. The
code that iterates through the form’s Controls collection and prints the names of the controls
in the Output window is shown in Listing 6.7.

LISTING 6.7: Iterating the Controls collection

Private Sub Buttonl_Click(..) Handles Buttonl.Click
Dim Control As Windows.Forms.Control
For Each Control In Me.Controls
Debug.WriteLine(Control.ToString)
If Control.GetType Is GetType(System.Windows.Forms.Panel) Then
Dim nestedControl As Windows.Forms.Control
For Each nestedControl In Control.Controls
Debug.WriteLine(" " & nestedControl.ToString)
Next
End If
Next
End Sub
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The form shown in Figure 6.15 produced the following (partial) output (the controls on the
Panel are indented to stand out in the listing):

Panell: System.Windows.Forms.Panel,

BorderStyle: System.Windows.Forms.BorderStyle.FixedSingle
CheckBox4: System.Windows.Forms.CheckBox, CheckState: 0
CheckBox3:  System.Windows.Forms.CheckBox, CheckState: 0

HScrol1Barl: System.Windows.Forms.HScrol1Bar,

Minimum: O, Maximum: 100, Value: 0

CheckedListBox1l: System.Windows.Forms.CheckedListBox,

Items.Count: 3, Items[0]: Item 1

TextBox2: System.Windows.Forms.TextBox,

Text: TextBox2

To find out the type of individual controls, call the GetType method. The following state-
ment examines whether the control in the first element of the Controls collection is a TextBox:

If Me.Controls(0).GetType Is GetType( System.Windows.Forms.TextBox) Then
MsgBox("It's a TextBox control")
End If

Notice the use of the Is operator in the preceding statement. The equals operator would
cause an exception because objects can be compared only with the Is operator. (You're com-
paring instances, not values.)

To access other properties of the control represented by an element of the Controls col-
lection, you must first cast it to the appropriate type. If the first control of the collection is a
TextBox control, use the CType() function to cast it to a TextBox variable and then request its
SelectedText property:

If Me.Controls(0).GetType Is GetType( System.Windows.Forms.TextBox) Then
Debug.WriteLine(CType(Me.Controls(0), TextBox).SelectedText)
End If

The If statement is necessary, unless you can be sure that the first control is a TextBox con-
trol. If you omit the If statement and attempt to convert the control to a TextBox, a runtime
exception will be thrown if the object Me.Controls(0) isn’t a TextBox control.

VB 2010 AT WORK: THE DYNAMICFORM PROJECT

To demonstrate how to handle controls at runtime from within your code, I included the
DynamicForm project (Figure 6.15) on www.sybex.com/go/masteringvb2010. It's a simple
data-entry window for a small number of data points. The user can specify at runtime the
number of data points she wants to enter, and the number of TextBoxes on the form is adjusted
automatically.

The control you see at the top of the form is the NumericUpDown control. All you
really need to know about this control is that it displays an integer in the range specified
by its Minimum and Maximum properties and allows users to select a value. It also fires the
ValueChanged event every time the user clicks one of the two arrows or types another value
in its edit area. This event handler’s code adds or removes controls on the form so that the
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number of text boxes (as well as the number of corresponding labels) matches the value on
the control. Listing 6.8 shows the handler for the ValueChanged event of the NumericUpDownl
control.

FIGURE 6.15
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LISTING 6.8: Adding and removing controls at runtime

Private Sub NumericUpDownl_ValueChanged(..) Handles NumericUpDownl.ValueChanged
Dim TB As New TextBox()
Dim LBL As New Label()
Dim i, TBoxes As Integer
' Count all TextBox controls on the Form
For i = 0 To Me.Controls.Count - 1
If Me.Controls(i).GetType Is
GetType(System.Windows.Forms.TextBox) Then
TBoxes = TBoxes + 1
End If
Next
" Add new controls if number of controls on the Form is Tess
' than the number specified with the NumericUpDown control
If TBoxes < NumericUpDownl.Value Then
TB.Left = 100: TB.Width = 120
TB.Text = ""
For i = TBoxes To CInt(NumericUpDownl.Value) - 1
TB = New TextBox()
LBL = New Label()
If NumericUpDownl.Value = 1 Then
TB.Top = 20: TB.TabIndex = 0
Else
TB.Top = Me.Controls(Me.Controls.Count - 2).Top + 25
End If
' Set the trivial properties of the new controls
LBL.Left = 20: LBL.Width = 80
LBL.Text = "Data Point " & i
LBL.Top = TB.Top + 3
TB.Left 100: TB.Width = 120
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TB.Text = ""
' add controls to the form
Me.Controls.Add(TB)
Me.Controls.Add(LBL)
TB.TabIndex = Convert.ToInt32(NumericUpDownl.Value)
" and finally connect their GotFocus/LostFocus events
' to the appropriate handler
AddHandTler TB.Enter,
New System.EventHandler(AddressOf TBox_Enter)
AddHandler TB.Leave,
New System.EventHandler(AddressOf TBox_Leave)
Next
Else
For i = Me.Controls.Count - 1 To Me.Controls.Count -

2 * (TBoxes - CInt(NumericUpDownl.Value)) Step -2
Me.Controls.Remove(Controls(i))
Me.Controls.Remove(Controls(i - 1))

Next
End If
End Sub

The code is lengthy but straightforward; most of the statements just set the basic proper-
ties of the Label and TextBox controls on the form. Ignore the AddHandler statements for now;
they're discussed in the following section. First, the code counts the number of TextBoxes on
the form; then it figures out whether it should add or remove elements from the Controls
collection. To remove controls, the code iterates through the last n controls on the form and
removes them. The number of controls to be removed is the following, where TBoxes is the
total number of controls on the form minus the value specified in the NumericUpDown control:

2 * (TBoxes - NumericUpDownl.Value)

If the value entered in the NumericUpDown control is less than the number of TextBox con-
trols on the form, the code removes the excess controls from within a loop. At each step, it
removes two controls, one of them a TextBox and the other a Label control with the matching
caption. (That’s why the loop variable is decreased by two.) The code also assumes that the first
two controls on the form are the Button and the NumericUpDown controls. If the value entered
by the user exceeds the number of TextBox controls on the form, the code adds the necessary
pairs of TextBox and Label controls to the form.

To add controls, the code initializes a TextBox (TB) and a Label (LBL) variable. Then, it sets
their locations and the label’s caption. The left coordinate of all labels is 20, their width is 80,
and their Text property (the label’s caption) is the order of the data item. The vertical coordi-
nate is 20 pixels for the first control, and all other controls are 3 pixels below the control on the
previous row. After a new control is set up, it’s added to the Controls collection with one of
the following statements:

Me.Controls.Add(TB) ' adds a TextBox control
Me.Controls.Add(LBL) ' adds a Label control



BUILDING DYNAMIC FORMS AT RUNTIME | 239

To use the values entered by the user on the dynamic form, we must iterate the Controls
collection, extract the values in the TextBox controls, and read their values. Listing 6.9 shows
how the Process Values button scans the TextBox controls on the form and performs some basic
calculations with them (counting the number of data points and summing their values).

LISTING 6.9: Reading the controls on the form

Private Sub Buttonl_CTlick(..) Handles Buttonl.Click
Dim TBox As TextBox
Dim Sum As Double = 0, points As Integer = 0
Dim iCtr1 As Integer
For iCtrl = 0 To Me.Controls.Count - 1
If Me.Controls(iCtrl).GetType Is
GetType(System.Windows.Forms.TextBox) Then
TBox = CType(Me.Controls(iCtrl), TextBox)
If IsNumeric(TBox.Text) Then
Sum = Sum + Val(TBox.Text)
points = points + 1
End If
End If
Next
MsgBox("The sum of the " & points.ToString &
" data points is " & Sum.ToString)
End Sub

@ Real World Scenario

HANDLING REPEATED DATA ITEMS

Dynamic forms are actually quite common even in business-line applications. There are situ-
ations where users are expected to enter or review multiple items of information on a single
form. If each data item consists of several fields (such as names, ages, and the like), your best
bet is to design a form like the following one.

This form, which is part of the DynamicDataEntry project, is a more typical example of a
dynamic form, which allows users to enter an unknown number of dependant members (or
any other entity, for that matter). Although you can create an auxiliary form where the user
can enter each entry, the form shown here works better because it allows the user to focus on
a single form.

Initially the form is populated with the appropriate controls for entering a single member.
Users can click the “Add new member” link to create a new entry. On the left you see the
form in its initial state and on the right you see the same form after adding four members.
The ‘‘Remove member”’ link removes the last member from the form. Users can enter any
number of dependant members on this form by adding new entries. If the number of entries
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exceeds the height of the form, a scroll bar appears. Notice that the scroll bar scrolls the
entries for the members and not the fixed items on the form, which are the two links at the
top and the Done Entering Members button at the bottom. You can change the structure of
each entry to enable other types of data (such as room types in a hotel reservation system, a
student’s courses and grades, the statistics of various teams, and so on).
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1 will not present the full code for the application here; it is well documented and you can
examine it on your own. The individual entries are made up of a number of controls, all on
a Panel control. This allows you to use the same name for the controls. There’s no naming
conflict since the controls belong to a different Panel. All individual panels are placed on
another larger Panel control, which is anchored to all four sides of the form and resizes nicely
along with the form. The AutoScroll property on this Panel control was set to True so that
the appropriate scroll bars appear automatically should the user have a large number of
members to enter.

Adding and removing entries is quite straightforward. 1 will show you only the code that
iterates through all entries and processes them:

For Each ctrl As Control In Me.Controls("pnlAl1Members").Controls
If ctrl.GetType Is GetType(System.Windows.Forms.Panel) Then
Name = ctrl.Controls("txtName").Text
Age = CType(ctrl.Controls("cbAge"), ComboBox).SelectedItem
If CType(ctrl.Controls("rdMale"), RadioButton).Checked

Then sex = "Male"
If CType(ctrl.Controls("rdFemale"), RadioButton).Checked
Then sex = "Female"

message & '"NAME: " & Name & vbCrLf &
"AGE: " & Age & vbCrLf &
"SEX: " & sex & vbCrLf &



BUILDING DYNAMIC FORMS AT RUNTIME | 241

B e et " & vbCrLf
End If
Next

The outer loop goes through the controls on the pnlAT1Members Panel control, which is the
large panel with the entries. If the current control is a Panel, we can process it. Normally, all
child controls on the pnlA11Members Panel will be also Panel controls; you may choose to
add other control as well. Then the code accesses each individual control by name. txtName is
the name of the TextBox control for the member’s name and it’s always the same regardless
of the entry to which it belongs. The code gradually builds a string with the data of the
dependant members and displays them. A real-world application would submit the same data
to a database, convert it to XML format, and store it locally or process the data in some other
meaningful way. You can open the DynamicDataEntry project and examine its code, which is
actually quite short considering all the flexibility.

If you make the form wide, the various entries will still be lined up in a single column,
leaving most of the form empty. How about entering some code in the form’s resizing events
to display the entries in multiple columns depending on the width of the form?

Creating Event Handlers at Runtime

You saw how to add controls on your forms at runtime and how to access the properties of
these controls from within your code. In many situations, this is all you need: a way to access
the properties of the controls (the text on a TextBox control or the status of a CheckBox or
RadioButton control). What good is a Button control, however, if it can’t react to the Click
event? The only problem with the controls you add to the Controls collection at runtime is
that they don’t react to events. It’s possible, though, to create event handlers at runtime, and
this is what you'll learn in this section.

To create an event handler at runtime, create a subroutine that accepts two arguments — the
usual sender and e arguments — and enter the code you want to execute when a specific con-
trol receives a specific event. The type of the e argument must match the definition of the sec-
ond argument of the event for which you want to create a handler. Let’s say that you want to
add one or more buttons at runtime on your form and these buttons should react to the C11ick
event. Create the ButtonClick() subroutine and enter the appropriate code in it. The name of
the subroutine can be anything; you don’t have to make up a name that includes the control’s
or the event’s name.

After the subroutine is in place, you must connect it to an event of a specific control. The
ButtonClick() subroutine, for example, must be connected to the C1ick event of a Button con-
trol. The statement that connects a control’s event to a specific event handler is the AddHandTer
statement, whose syntax is as follows:

AddHandler control.event, New System.EventHandler(AddressOf ButtonClick)

Consider, for example, an application that performs certain calculations with an existing sub-
routine. To connect the ProcessNow() subroutine to the C1ick event of the Calculate button,
use the following statement:

AddHandTer Calculate.Click,
New System.EventHandler(AddressOf ProcessNow)
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You can use similar statements to connect the same subroutine to other control event
handlers. You can also associate multiple controls” Click event handler with the ProcessNow()
subroutine.

Let’s add a little more complexity to the DynamicForm application. I'll program the Enter
and Leave events of the TextBox controls added to the form at runtime. When a TextBox con-
trol receives the focus, I'll change its background color to a light yellow, and when it loses
the focus, I'll restore the background to white so the user knows which box has the focus at
any time. I'll use the same handlers for all TextBox controls. (The code for the two handlers is
shown in Listing 6.10.)

LISTING 6.10: Event handlers added at runtime

Private Sub TBox_Enter(ByVal sender As Object,
ByvVal e As System.EventArgs)
CType(sender, TextBox).BackColor = color.LightCoral
End Sub

Private Sub TBox_Leave(ByVal sender As Object,
Byval e As System.EventArgs)
CType(sender, TextBox).BackColor = color.White
End Sub

The two subroutines use the sender argument to find out which TextBox control received
or lost the focus, and they set the appropriate control’s background color. (These subroutines
are not event handlers yet because they’re not followed by the Handles keyword — at least,
not before we associate them with an actual control and a specific event.) This process is done
in the same segment of code that sets the properties of the controls we create dynamically at
runtime. After adding the control to the Me.Controls collection, call the following statements
to connect the new control’s Enter and Leave events to the appropriate handlers:

AddHandler TB.Enter, New System.EventHandler(AddressOf TBox_Enter)
AddHandler TB.Leave, New System.EventHandler(AddressOf TBox_Leave)

Note that you don’t have to raise the event from within your code; neither do you specify
the arguments to the event. Since you've associated the two routines with the Click event han-
dler, the compiler knows that they’re C1ick event handlers and passes the appropriate argu-
ments to them. All you have to do is make sure the signatures of the two routines match the
signature of the Click event handler.

Run the DynamicForm application and see how the TextBox controls handle the
focus-related events. With a few statements and a couple of subroutines, we were able to create
event handlers at runtime from within our code.

DESIGNING AN APPLICATION GENERATOR

In the preceding sections of this chapter, you learned how to create new forms from within
your code and how to instantiate them. In effect, you have the basic ingredients for designing
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applications from within your code. Designing an application from within the code is not a
trivial task, but now you have a good understanding of how an application generator works.
You can even design a wizard that prompts the user for information about the appearance of
the form and then design the form from within your code.

Designing Menus

Menus are among the most common and most characteristic elements of the Windows user
interface. Even in the old days of character-based displays, menus were used to display
methodically organized choices and guide the user through an application. Despite the visually
rich interfaces of Windows applications and the many alternatives, menus are still the most
popular means of organizing a large number of options. Many applications duplicate some or
all of their menus in the form of toolbar icons, but the menu is a standard fixture of a form.
You can turn the toolbars on and off, but not the menus.

The Menu Editor

Menus can be attached only to forms, and they’re implemented through the MenuStrip control.
The items that make up the menu are ToolStripMenultem objects, which belong to a MenuStrip
control (they’re the menu options) or to another ToolStripMenultem (they form submenus). As
you will see, the MenuStrip control and ToolStripMenultem objects give you absolute control
over the structure and appearance of the menus of your application. The MenuStrip control is a
variation of the Strip control, which is the base of menus, toolbars, and status bars.

You can design menus visually and then program their Click event handlers. In principle,
that’s all there is to a menu: You specify its items (the menu commands) and then you program
each command’s actions, as if the menu items were buttons. Depending on the needs of your
application, you might want to enable and disable certain commands, add context menus to
some of the controls on your form, and so on. Because each item in a menu is represented by
a ToolStripMenultem object, you can control the application’s menus from within your code by
manipulating the properties of the ToolStripMenultem objects. Let’s start by designing a simple
menu, and I'll show you how to manipulate the menu objects from within your code as we go
along.

Double-click the MenuStrip icon in the Toolbox. (You'll find the MenuStrip control in the
Menus & Toolbars tab of the Toolbox.) An instance of the MenuStrip control will be added to
the form, and a single menu command will appear on your form. Its caption will be Type Here.
If you don’t see the first menu item on the form right away, select the MenuStrip control in the
Components tray below the form. Do as the caption says: Click it and enter the first command
caption, File, as shown in Figure 6.16. To add items under the File menu, press Enter. To enter
another command in the main menu, press Tab. Depending on your action, another box will
be added and you can type the caption of the next command in it. Press Enter to move to the
next item vertically and Tab to move to the next item horizontally. To insert a separator enter a
hyphen (-) as the item’s caption.

When you hover the pointer over a menu item, a drop-down button appears to the right of
the item. Click this button to select the type of item you’ll place on the menu. This item can be
a Menultem object, a separator, a ComboBox, or a TextBox. In this chapter, I'll focus on menu
items, which are by far the most common elements on a menu. The last two options, however,
allow you to build elaborate menus, reminiscent of the Office menus.
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FIGURE 6.16
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Enter the items you wish to include in the File menu — New, Open, Save, SaveAs, and
Exit — and then click somewhere on the form. All the temporary items (the ones with the
Type Here caption) will disappear, and the menu will be finalized on the form.

To add the Edit menu, select the MenuStrip icon to activate the visual menu editor and then
click the File item. In the new item that appears next to the File item on the control, enter the
string Edit. Press Enter and you'll switch to the first item of the Edit menu. Fill the Edit menu
with the usual editing commands. Table 6.4 shows the captions (property Text) and names
(property Name) for each menu and each command. You can also insert a standard menu with
the Insert Standard Items command of the MenuStrip object’s context menu.

TABLE 6.4: The captions and names of the File and Edit menus

CAPTION NAME CAPTION NAME

File FileMenu Tools ToolsMenu
New FileNew Edit EditMenu
Open FileOpen Undo EditCopy
Save FileSave Redo EditRedo
Save As FileSaveAs Cut EditCut
Print FilePrint Copy EditCopy
Print Preview FilePrintPreview Paste EditPaste
Exit FileExit Select All EditSelectAll

Help HelpMenu

The bold items in Table 6.4 are the names of the first-level menus (File and Edit); the cap-
tions that are indented in the table are the commands on these two menus. The default names
of the menu items you add visually to the application’s menu are based on the item’s caption
followed by the suffix ToolStripMenultem (FiTeToolStripMenuItem, NewToolStripMenuItem,
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and so on). You'll probably want to change the default names to something less redundant.
To do so, change the Name property in the Properties window. To view the properties of a
menu item, right-click it and select Properties from the context menu. One of the properties
you should try out is the LayoutStyTe property, which determines the orientation of the menu.

The most convenient method of editing a menu is to use the Items Collection Editor win-
dow, which is shown in Figure 6.17. This isn’t a visual editor, but you can set all the properties
of each menu item in the dialog box without having to switch to the Properties window.

FIGURE 6.17
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The Add button adds to the menu an item of the type specified in the combo box next to it
(a menu item, combo box, or text box). To insert an item at a different location, add it to the
menu and then use the arrow buttons to move it up or down. As you add new items, you
can set their Text and Name properties on the right pane of the editor. You can also set their
font, set the alignment and orientation of the text, and specify an image to be displayed along
with the text. To add an image to a menu item, locate the Image property and click the ellipsis
button. A dialog box in which you can select the appropriate resource will appear. Notice that
all the images you use on your form are stored as resources of the project. You can add all the
images and icons you might need in a project to the same resource file and reuse them at will.
The TextImageRelation property allows you to specify the relative positions of the text and
the image. You can also select to display text only, images only, or text and images for each
menu item with the DisplayStyle property.

If the menu item leads to a submenu, you must also specify the submenu’s items. Locate
the DropDownItems property and click the ellipsis button. An identical window will appear, in
which you can enter the drop-down items of the current menu item. Notice that the menu on
the form is continuously updated while you edit it in the Items Collection Editor window, so
you can see the effects of your changes on the form. Personally, I'm more productive with the
editor than with the visual tools, mainly because all the properties are right there and I don’t
have to switch between the design surface and the Properties window.

Note that except for Menultems, you can add ComboBoxes and TextBoxes to a menu. The
TextBox control can be used to facilitate search operations, similar to the Search box of the
browsers. You can also display a number of options in a ComboBox control on the menu.
The advantage of the ComboBox menu item is that the selected option is visible at all times.
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ComboBoxes are used in the menus of Office applications a lot (a typical example is the
Font name and size ComboBoxes that allow you to change the current selections” font name
and size).

The ToolStripMenultem Properties

The ToolStripMenultem class represents a menu command, at any level. If a command leads to
a submenu, it’s still represented by a ToolStripMenultem object, which has its own collection
of ToolStripMenultem objects: the DropDownItems property, which is a collection and it’s
made up of ToolStripMenultem objects. The ToolStripMenultem class provides the following
properties, which you can set in the Properties window at design time or manipulate from
within your code:

Checked Some menu commands act as toggles, and they are usually selected (checked) to
indicate that they are on or deselected (unchecked) to indicate that they are off. To initially dis-
play a check mark next to a menu command, set its Checked property to True. You can also
access this property from within your code to change the checked status of a menu command
at runtime. For example, to toggle the status of a menu command called FntBold, use this
statement:

FntBold.Checked = Not FntBold.Checked

Enabled Some menu commands aren’t always available. The Paste command, for example,
has no meaning if the Clipboard is empty (or if it contains data that can’t be pasted in the cur-
rent application). To indicate that a command can’t be used at the time, you set its Enabled
property to False. The command then appears grayed out in the menu, and although it can be
highlighted, it can’t be activated.

IsOnDropDown If the menu command represented by a ToolStripMenultem object belongs to
a submenu, its IsOnDropDown property is True; otherwise, it’s False. The IsOnDropDown prop-
erty is read-only and False for the items on the first level of the menu.

Visible To remove a command temporarily from the menu, set the command’s Visible
property to False. The Visible property isn’t used frequently in menu design. In general, you
should prefer to disable a command to indicate that it can’t be used at the time (some other
action is required to enable it). Making a command invisible frustrates users, who might spend
time trying to locate the command in another menu.

PROGRAMMING MENU COMMANDS

When a menu item is selected by the user, it triggers a Click event. To program a menu item,
insert the appropriate code in the item’s Click event handler. The Exit command’s code would
be something like the following:

Sub menuExit(..) Handles menuExit.Click
End
End Sub

If you need to execute any cleanup code before the application ends, place it in the
CleanUp() subroutine and call this subroutine from within the Exit item’s C11ick event handler:
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Sub menuExit(..) Handles menuExit.Click
CleanUp()
End

End Sub

The same subroutine must also be called from within the FormClosing event handler of the
application’s main form because some users might terminate the application by clicking the
form’s Close button.

An application’s Open menu command contains the code that prompts the user to select a
file and then open it. You will see many examples of programming menu commands in the
following chapters. All you really need to know now is that each menu item is a ToolStrip-
Menultem object and each fires the CTick event every time it’s selected with the mouse or the
keyboard. In most cases, you can treat the Click event handler of a ToolStripMenultem object
just like the Click event handler of a Button.

Another interesting event of the ToolStripMenultem is the DropDownOpened event, which is
fired when the user opens a menu or submenu (in effect, when the user clicks a menu item that
leads to a submenu). In this event’s handler, you can insert code to modify the submenu. The
Edit menu of just about any application contains the ubiquitous Cut/Copy/Paste commands.
These commands are not meaningful at all times. If the Clipboard doesn’t contain text, the
Paste command should be disabled. If no text is selected, the Copy and Cut commands should
also be disabled. Here’s how you could change the status of the Paste command from within
the DropDownOpened event handler of the Edit menu:

If My.Computer.Clipboard.ContainsText Then
PasteToolStripMenultem.Enabled = True
Else
PasteToolStripMenultem.Enabled = True
End If

Likewise, to change the status of the Cut and Copy commands, use the following statements
in the DropDownOpened event of the ToolStripMenultem that represents the Edit menu:

If txtEditor.SelectedText.Trim.Length > 0 Then
CopyToolStripMenultem.Enabled = True
CutToolStripMenultem.Enabled = True

Else
CopyToolStripMenultem.Enabled = False
CutToolStripMenultem.Enabled = False

End If

USING ACCESS AND SHORTCUT KEYS

Menus provide a convenient way to display a large number of choices to the user. They
allow you to organize commands in groups, according to their functions, and are available
at all times. Opening menus and selecting commands with the mouse, however, can be an
inconvenience. When using a word processor, for example, you don’t want to have to take
your hands off the keyboard and reach for the mouse. To simplify menu access, Windows
forms support access keys and shortcut keys.
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Access Keys

Access keys allow the user to open a menu by pressing the Alt key and a letter key. To open
the Edit menu in all Windows applications, for example, you can press Alt+E. E is the Edit
menu’s access key. After the menu is open, the user can select a command with the arrow keys
or by pressing another key, which is the command’s access key, without holding down the Alt
key.

Access keys are designated by the designer of the application and are marked with an
underline character. To assign an access key to a menu item, insert the ampersand symbol (&)
in front of the character you want to use as an access key in the ToolStripMenultem’s Text

property.

DEFAULT ACCESS KEYS ARE BASED ON ITEM CAPTIONS

If you don’t designate access keys, Visual Basic will use the first character in the caption
of each top-level menu as its access key. The user won’t see the underline character under
the first character but can open the menu by pressing the first character of its caption while
holding down the Alt key. If two or more menu captions begin with the same letter, the first
(leftmost and topmost) menu will open.

Because the & symbol has a special meaning in menu design, you can’t use it in a menu
item’s caption. To actually display the & symbol in a caption, prefix it with another & symbol.
For example, the caption &rag produces a command with the caption Drag (the first char-
acter is underlined because it’s the access key). The caption Drag && Drop will create another
command whose caption will be Drag & Drop. Finally, the string &rag & Drop will create
another command with the caption Drag & Drop (note the underline character in front of the
first uppercase D in the string).

Shortcut Keys

Shortcut keys are similar to access keys, but instead of opening a menu, they run a command
when pressed. Assign shortcut keys to frequently used menu commands so that users can reach
them with a single keystroke. Shortcut keys are combinations of the Ctrl key and a function or
character key. For example, the usual access key for the Close command (after the File menu is
opened with Alt+F) is C, but the usual shortcut key for the Close command is Ctrl+W.

To assign a shortcut key to a menu command, drop down the ShortcutKeys list in the
ToolStripMenultem’s Properties window and select a keystroke. Specify a modifier (Shift,
Ctrl, or Alt) and a key. When assigning access and shortcut keys, take into consideration the
well-established Windows standards. Users expect Alt+F to open the File menu, so don’t
use Alt+F for the Format menu. Likewise, pressing Ctrl+C universally performs the Copy
command; don’t use Ctrl4+C as a shortcut for the Cut command.

Manipulating Menus at Runtime

Dynamic menus change at runtime to display more or fewer commands, depending on the cur-
rent status of the program. The following sections explore two techniques for implementing
dynamic menus:

¢ Creating short and long versions of the same menu

¢ Adding and removing menu commands at runtime
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CREATING SHORT AND LONG MENUS

A common technique in menu design is to create long and short versions of a menu. If a menu
contains many commands and most of the time only a few of them are needed, you can create
one menu with all the commands and another with the most common ones. The first menu is
the long one, and the second is the short one. The last command in the long menu should be
Short Menu, and when selected, it should display the short version. The last command in the
short menu should be Long Menu (or Full Menu), and it should display the long version.

Figure 6.18 shows a long and a short version of the same menu from the LongMenu project.
The short version omits infrequently used commands and is easier to handle.
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To implement the LongMenu command, start a new project and create a menu with the
options shown in Figure 6.18. Listing 6.11 is the code that shows/hides the long menu in the
MenuSize command’s CTick event.

LISTING 6.11: The MenuSize menu item’s C11 ck event

Private Sub mnuSize_Click(..) Handles mnuSize.Click
If mnuSize.Text = "Short Menu" Then

mnuSize.Text = "Long Menu"
Else

mnuSize.Text = "Short Menu"
End If

mnuUnderTline.Visible = Not mnuUnderline.Visible
mnuStrike.Visible = Not mnuStrike.Visible
mnuSmallCaps.Visible = Not mnuSmallCaps.Visible
mnuATT1Caps.Visible = Not mnuAllCaps.Visible

End Sub

The subroutine in Listing 6.11 doesn’t do much. It simply toggles the Visible property of
certain menu commands and changes the command’s caption to Short Menu or Long Menu,
depending on the menu’s current status.
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ADDING AND REMOVING COMMANDS AT RUNTIME

I conclude the discussion of menu design with a technique for building dynamic menus, which
grow and shrink at runtime. Many applications maintain a list of the most recently opened files
in the File menu. When you first start the application, this list is empty, and as you open and
close files, it starts to grow.

The RunTimeMenu project, available for download from www.sybex.com/go/mastering
vb2010, demonstrates how to add items to and remove items from a menu at runtime. The
main menu of the application’s form contains the Run Time Menu submenu, which is initially
empty.

The two buttons on the form add commands to and remove commands from the Run
Time Menu. Each new command is appended at the end of the menu, and the commands are
removed from the bottom of the menu first (the most recently added commands are removed
first). To change this order and display the most recent command at the beginning of the
menu, use the Insert method instead of the Add method to insert the new item. Listing 6.12
shows the code behind the two buttons that add and remove menu items.

LISTING 6.12: Adding and removing menu items at runtime

Private Sub bttnAddItem_Click(..) Handles bttnAddItem.Click
Dim Item As New ToolStripMenuItem
Item.Text = "Run Time Option" &
RunTimeMenuTool1StripMenuItem.DropDownItems.Count.ToString
RunTimeMenuToo1StripMenultem.DropDownItems.Add(Item)
AddHandler Item.Click, New System.EventHandler(AddressOf OptionClick)
End Sub

Private Sub bttnRemoveItem_Click(..) Handles bttnRemoveItem.Click
If RunTimeMenuToolStripMenuItem.DropDownItems.Count > 0 Then
Dim mItem As ToolStripItem
Dim items As Integer =
RunTimeMenuTool1StripMenultem.DropDownItems.Count
mItem = RunTimeMenuToolStripMenultem.DropDownItems(items - 1)
RunTimeMenuToo1StripMenultem.DropDownItems.Remove(mItem)
End If
End Sub

The Remove button’s code uses the Remove method to remove the last item in the menu by
its index after making sure the menu contains at least one item. The Add button adds a new
item and sets its caption to Run Time Option 1, where 7 is the item’s order in the menu. In
addition, it assigns an event handler to the new item’s Click event. This event handler is the
same for all the items added at runtime; it’s the OptionClick() subroutine. All the runtime
options invoke the same event handler — it would be quite cumbersome to come up with a
separate event handler for different items. In the single event handler, you can examine the
name of the ToolStripMenultem object that invoked the event handler and act accordingly.
The OptionClick() subroutine used in Listing 6.13 displays the name of the menu item that
invoked it. It doesn’t do anything, but it shows you how to figure out which item of the Run
Time Menu was clicked.
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LISTING 6.13: Programming dynamic menu items

Private Sub OptionClick(..)
Dim itemClicked As New ToolStripMenultem
itemClicked = CType(sender, ToolStripMenuItem)
MsgBox("You have selected the item " & itemClicked.Text)
End Sub

CREATING CONTEXT MENUS

Nearly every Windows application provides a context menu that the user can invoke by
right-clicking a form or a control. (It's sometimes called a shortcut menu or pop-up menu.)
This is a regular menu, but it’s not anchored on the form. It can be displayed anywhere on the
form or on specific controls. Different controls can have different context menus, depending on
the operations you can perform on them at the time.

To create a context menu, place a ContextMenuStrip control on your form. The new context
menu will appear on the form just like a regular menu, but it won’t be displayed there at run-
time. You can create as many context menus as you need by placing multiple instances of the
ContextMenuStrip control on your form and adding the appropriate commands to each one. To
associate a context menu with a control on your form, set the ContextMenu property for that
control to the name of the corresponding context menu.

Designing a context menu is identical to designing a regular menu. The only difference is
that the first command in the menu is always ContextMenuStrip and it’s not displayed along
with the menu.

The Bottom Line

Visual form design Forms expose a lot of trivial properties for setting their appearance. In
addition, they expose a few properties that simplify the task of designing forms that can be
resized at runtime. The Anchor property causes a control to be anchored to one or more edges
of the form to which it belongs. The Dock property allows you to place on the form controls
that are docked to one of its edges. To create forms with multiple panes that the user can resize
at runtime, use the SplitContainer control. If you just can’t fit all the controls in a reasonably
sized form, use the AutoScrol1 properties to create a scrollable form.

Master It You've been asked to design a form with three distinct sections. You should also
allow users to resize each section. How will you design this form?

Design applications with multiple forms. Typical applications are made up of multiple
forms: the main form and one or more auxiliary forms. To show an auxiliary form from within
the main form’s code, call the auxiliary form’s Show method, or the ShowDialog method if you
want to display the auxiliary form modally (as a dialog box).

Master It How will you set the values of selected controls in a dialog box, display them,
and then read the values selected by the user from the dialog box?
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Design dynamic forms. You can create dynamic forms by populating them with controls at
runtime through the form’s Controls collection. First, create instances of the appropriate con-
trols by declaring variables of the corresponding type. Then set the properties of each of these
variables that represent controls. Finally, place the control on the form by adding the corre-
sponding variable to the form’s Controls collection.

Master It How will you add a TextBox control to your form at runtime and assign a han-
dler to the control’s TextChanged event?

Design menus. Both form menus and context menus are implemented through the Menu-
Strip control. The items that make up the menu are ToolStripMenultem objects. The ToolStrip-
Menultem objects give you absolute control over the structure and appearance of the menus of
your application.

Master It What are the two basic events fired by the ToolStripMenultem object?



Chapter 7

More Windows Controls

In this chapter, I will continue the discussion of the Windows controls. I'll start with the con-
trols that implement the common dialog boxes and the RichTextBox control. Then I will deal
with two more advanced controls, TreeView and ListView.

The .NET Framework provides a set of controls for displaying common dialog boxes, such
as the Open and Color dialog boxes. Each of these controls encapsulates a large amount of
functionality that would take a lot of code to duplicate. The common dialog controls are fun-
damental components because they enable you to design user interfaces with the look and feel
of a Windows application.

You'll also explore the RichTextBox control, which is an advanced version of the TextBox
control. The RichTextBox control provides all the functionality you’ll need to build a word pro-
cessor — WordPad is actually built around the RichTextBox control. The RichTextBox control al-
lows you to format text by mixing fonts and attributes, aligning paragraphs differently, and so on.

The TreeView and ListView controls implement two of the more-advanced data structures.
TreeView can be used to present a hierarchical list — a tree in which items that belong to
other items appear under their parent with the proper indentation. For instance, a list of
city and state names should be structured so that each city appears under the corresponding
state. ListView can be used to present a “flat” structure where each item has a number of
subitems. A typical example is a file, whose most important attributes are name, size, type, and
modification date. These attributes can be presented as subitems in a list of files.

The TreeView and ListView controls were designed to hide much of the complexity of these
structures, and they do this very well. They are among the more-advanced controls, and they
are certainly more difficult to program than the ones discussed in the preceding chapters. These
two controls, however, are the basic makings of unique user interfaces, as you'll see in this
chapter’s examples.

In this chapter you'll learn how to do the following:

¢ Use the OpenFileDialog and SaveFileDialog controls to prompt users for filenames.

¢ Use ColorDialog and FontDialog controls to prompt users for colors and typefaces.

¢ Use the RichTextBox control as an advanced text editor to present richly formatted text.
*

Use the TreeView and ListView controls to present hierarchical lists and lists of structured
items.
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CHAPTER 7 MORE WINDOWS CONTROLS

The Common Dialog Controls

A rather tedious, but quite common, task in nearly every application is to prompt the user

for filenames, font names and sizes, or colors to be used by the application. Designing your
own dialog boxes for these purposes would be a hassle, not to mention that your applications
wouldn’t conform to the basic Windows interface design principles. Truth be told, users are
not fond of surprises, and all your creative effort will most likely backfire. Unexpected interface
features are guaranteed to curb GUI usability and result in a number of frustrated users. In fact,
all Windows applications use standard dialog boxes for common operations; two of them are
shown in Figure 7.1. These dialog boxes are implemented as standard controls in the Toolbox.
To use any of the common dialog controls in your interface, just place the appropriate control
from the Dialogs section of the Toolbox on your form and activate it from within your code by
calling the ShowDialog method.
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The common dialog controls are invisible at runtime, and they’re not placed on your forms
because they’re implemented as modal dialog boxes and they’re displayed as needed. You sim-
ply add them to the project by double-clicking their icons in the Toolbox; a new icon appears in
the components tray of the form, just below the Form Designer. The following common dialog
controls are in the Toolbox under the Dialogs tab:

OpenFileDialog Lets users select a file to open. It also allows the selection of multiple files
for applications that must process many files at once.
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SaveFileDialog Lets users select or specify the path of a file in which the current document
will be saved.

FolderBrowserDialog Lets users select a folder (an operation that can’t be performed with
the OpenFileDialog control).

ColorDialog Lets users select a color from a list of predefined colors or specify custom colors.

FontDialog Lets users select a typeface and style to be applied to the current text selection.
The Font dialog box has an Apply button, which you can intercept from within your code and
use to apply the currently selected font to the text without closing the dialog box.

There are three more common dialog controls: the PrintDialog, PrintPreviewDialog, and
PageSetupDialog controls. These controls are discussed in detail in the tutorial “Printing with
Visual Basic 2010,” available for download from www.sybex.com/go/masteringvb2010, in the
context of VB’s printing capabilities.

Using the Common Dialog Controls

To display any of the common dialog boxes from within your application, you must first add
an instance of the appropriate control to your project. Then you must set some basic properties
of the control through the Properties window. Most applications set the control’s properties
from within the code because common dialogs interact closely with the application. When you
call the Color common dialog, for example, you should preselect a color from within your
application and make it the default selection on the control. When prompting the user for the
color of the text, the default selection should be the current setting of the control’s ForeColor
property. Likewise, the Save dialog box must suggest a filename when it first pops up (or the
filename’s extension, at least).

To display a common dialog box from within your code, you simply call the control’s
ShowDialog method, which is common for all controls. Note that all common dialog controls
can be displayed only modally and they don’t expose a Show method. As soon as you call the
ShowDialog method, the corresponding dialog box appears onscreen, and the execution of the
program is suspended until the box is closed. Using the Open, Save, and FolderBrowser dialog
boxes, users can traverse the entire structure of their drives and locate the desired filename or
folder. When the user clicks the Open or Save button, the dialog box closes and the program’s
execution resumes. The code should read the name of the file selected by the user through
the FileName property and use it to open the file or store the current document there. The
folder selected in the FolderBrowserDialog control is returned to the application through the
SelectedPath property.

Here is the sequence of statements used to invoke the Open common dialog and retrieve the
selected filename:

If OpenFileDialogl.ShowDialog = Windows.Forms.DialogResult.OK Then
fileName = OpenFileDialogl.FileName
' Statements to open the selected file

End If

The ShowDialog method returns a value indicating how the dialog box was closed. You
should read this value from within your code and ignore the settings of the dialog box if the
operation was cancelled.
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The variable fileName in the preceding code segment is the full pathname of the file
selected by the user. You can also set the FileName property to a filename, which will be
displayed when the Open dialog box is first opened:

OpenFileDialogl.FileName =
"C:\WorkFiTes\Documents\Documentl.doc"
If OpenFileDialogl.ShowDialog =
Windows.Forms.DialogResult.OK Then
fileName = OpenFileDialogl.FileName
' Statements to open the selected file
End If

Similarly, you can invoke the Color dialog box and read the value of the selected color by
using the following statements:

ColorDialogl.Color = TextBoxl.BackColor

If ColorDialogl.ShowDialog = DialogResult.OK Then
TextBox1.BackColor = ColorDialogl.Color

End If

The ShowDialog method is common to all controls. The Title property is also common to
all controls and it’s the string displayed in the title bar of the dialog box. The default title is the
name of the dialog box (for example, Open, Color, and so on), but you can adjust it from within
your code with a statement such as the following:

ColorDialogl.Title = "Select Drawing Color"

The ColorDialog Control

The Color dialog box, shown in Figure 7.2, is one of the simplest dialog boxes. Its Color
property returns the color selected by the user or sets the initially selected color when the user
opens the dialog box.
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The following statements set the initial color of the ColorDialog control, display the dialog
box, and then use the color selected in the control to fill the form. First, place a ColorDialog
control in the form and then insert the following statements in a button’s C11ick event handler:

Private Sub Buttonl_CTlick(..) Handles Buttonl.Click
ColorDialogl.Color = Me.BackColor
If ColorDialogl.ShowDialog = Windows.Forms.DialogResult.OK Then
Me.BackColor = ColorDialogl.Color
End If
End Sub

The following sections discuss the basic properties of the ColorDialog control.

ALLOWFULLOPEN

Set this property to True if you want users to be able to open the dialog box and define their
own custom colors, as you can in the one shown in Figure 7.2. The A1lowFul10pen property
doesn’t open the custom section of the dialog box; it simply enables the Define Custom Colors
button in the dialog box. Otherwise, this button is disabled.

ANYCOLOR

This property is a Boolean value that determines whether the dialog box displays all available
colors in the set of basic colors.

COLOR

This is the color specified on the control. You can set it to a color value before showing the
dialog box to suggest a reasonable selection. On return, read the value of the same property
to find out which color was picked by the user in the control:

ColorDialogl.Color = Me.BackColor

If ColorDialogl.ShowDialog = DialogResult.OK Then
Me.BackColor = ColorDialogl.Color

End If

CUSTOMCOLORS

This property indicates the set of custom colors that will be shown in the dialog box. The Color
dialog box has a section called Custom Colors, in which you can display 16 additional custom
colors. The CustomColors property is an array of integers that represent colors. To display three
custom colors in the lower section of the Color dialog box, use a statement such as the following;:

Dim colors() As Integer = {222663, 35453, 7888}
ColorDialogl.CustomColors = colors

You'd expect that the CustomColors property would be an array of Color values, but it’s
not. You can’t create the array CustomColors with a statement such as this one:

Dim colors() As Color =
{Color.Azure, Color.Navy, Color.Teal}
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Because it’s awkward to work with numeric values, you should convert color values to inte-
ger values by using a statement such as the following:

Color.Navy.ToArgb

The preceding statement returns an integer value that represents the color navy. This value,
however, is negative because the first byte in the color value represents the transparency of
the color. To get the value of the color, you must take the absolute value of the integer value

returned by the previous expression. To create an array of integers that represent color values,
use a statement such as the following:

Dim colors() As Integer =
{Math.Abs(Color.Gray.ToArgh),
Math.Abs(Color.Navy.ToArgh),
Math.Abs(Color.Teal.ToArgb)}

Now you can assign the colors array to the CustomColors property of the control and the
colors will appear in the Custom Colors section of the Color dialog box.

SOLIDCOLORONLY

This indicates whether the dialog box will restrict users to selecting solid colors only. This setting
should be used with systems that can display only 256 colors. Although today few systems can’t
display more than 256 colors, some interfaces are limited to this number. When you run an app-
lication through Remote Desktop, for example, only the solid colors are displayed correctly on the
remote screen regardless of the remote computer’s graphics card (and that’s for efficiency reasons).

The FontDialog Control

The Font dialog box, shown in Figure 7.3, lets the user review and select a font and then set
its size and style. Optionally, by clicking the Apply button users can also select the font’s color
and even apply the current settings to the selected text on a control of the form without closing
the dialog box. This button isn’t displayed by default; to show this button, you must set the
control’s ShowApply property to True. To see how the Apply button is used, see the description
of the ShowApply property a little later in this section.
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When the dialog is closed by clicking the OK button, you can retrieve the selected font by
using the control’s Font property. In addition to the OK button, the Font dialog box may con-
tain the Apply button, which reports the current setting to your application. You can intercept
the Click event of the Apply button and adjust the appearance of the text on your form while
the common dialog is still visible.

The main property of this control is the Font property, which sets the initially selected font
in the dialog box and retrieves the font selected by the user. The following statements display
the Font dialog box after setting the initial font to the current font of the TextBox1 control.
When the user closes the dialog box, the code retrieves the selected font and assigns it to the
same TextBox control:

FontDialogl.Font = TextBoxl.Font

If FontDialogl.ShowDialog = DialogResult.OK Then
TextBox1.Font = FontDialogl.Font

End If

Use the following properties to customize the Font dialog box before displaying it.

ALLOWSCRIPTCHANGE

This property is a Boolean value that indicates whether the Script combo box will be displayed
in the Font dialog box. This combo box allows the user to change the current character set and
select a non-Western language (such as Greek, Hebrew, Cyrillic, and so on).

ALLOWVERTICALFONTS

This property is a Boolean value that indicates whether the dialog box allows the display and
selection of both vertical and horizontal fonts. Its default value is False, which displays only
horizontal fonts.

COLOR, SHOWCOLOR

The Color property sets or returns the selected font color. To enable users to select a color for
the font, you must also set the ShowColor property to True.

FIXEDPITCHONLY

This property is a Boolean value that indicates whether the dialog box allows only the
selection of fixed-pitch fonts. Its default value is False, which means that all fonts (fixed- and
variable-pitch fonts) are displayed in the Font dialog box. Fixed-pitch fonts, or monospaced
fonts, consist of characters of equal widths that are sometimes used to display columns of
numeric values so that the digits are aligned vertically.

FONT

This property is a Font object. You can set it to the preselected font before displaying the dialog
box and assign it to a Font property upon return. You've already seen how to preselect a font
and how to apply the selected font to a control from within your application.
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You can also create a new Font object and assign it to the control’s Font property. Upon
return, the TextBox control’s Font property is set to the selected font:

Dim newFont As New Font('Verdana", 12, FontStyle.Underline)

FontDialogl.Font = newFont

If FontDialogl.ShowDialog() = DialogResult.OK Then
TextBox1l.ForeColor = FontDialogl.Color

End If

FONTMUSTEXIST

This property is a Boolean value that indicates whether the dialog box forces the selection of
an existing font. If the user enters a font name that doesn’t correspond to a name in the list

of available fonts, a warning is displayed. Its default value is True, and there’s no reason to

change it.

MAXSIZE, MINSIZE

These two properties are integers that determine the minimum and maximum point size the
user can specify in the Font dialog box. Use these two properties to prevent the selection
of extremely large or extremely small font sizes because these fonts might throw off a
well-balanced interface (text will overflow in labels, for example).

SHOWAPPLY

This property is a Boolean value that indicates whether the dialog box provides an Apply but-
ton. Its default value is False, so the Apply button isn’t normally displayed. If you set this prop-
erty to True, you must also program the control’s Apply event — the changes aren’t applied
automatically to any of the controls in the current form.

The following statements display the Font dialog box with the Apply button:

Private Sub Button2_Click(..) Handles Button2.Click
FontDialogl.Font = TextBoxl.Font
FontDialogl.ShowApply = True
If FontDialogl.ShowDialog = DialogResult.OK Then

TextBox1l.Font = FontDialogl.Font
End If
End Sub

The FontDialog control raises the AppTy event every time the user clicks the Apply button.
In this event’s handler, you must read the currently selected font and use it in the form so that
users can preview the effect of their selection:

Private Sub FontDialogl_Apply(..) Handles FontDialogl.Apply
TextBox1.Font = FontDialogl.Font
End Sub

SHOWEFFECTS

This property is a Boolean value that indicates whether the dialog box allows the selection
of special text effects, such as strikethrough and underline. The effects are returned to the
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application as attributes of the selected Font object, and you don’t have to do anything special

in your application.

The OpenDialog and SaveDialog Controls

Open and Save As, the two most widely used common dialog boxes (see Figure 7.4), are imple-

mented by the OpenFileDialog and SaveFileDialog controls. Nearly every application prompts
users for filenames, and the .NET Framework provides two controls for this purpose. The two
dialog boxes are nearly identical, and most of their properties are common, so we’ll start with

the properties that are common to both controls.
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When either of the two controls is displayed, it rarely displays all the files in any given

folder. Usually the files displayed are limited to the ones that the application recognizes so that
users can easily spot the file they want. The Filter property limits the types of files that will

appear in the Open or Save As dialog box.

It’s also standard for the Windows interface not to display the extensions of filenames

(although Windows distinguishes files by their filename extensions). The file type ComboBox,

which appears at the bottom of the form next to the File Name box, contains the various file
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types recognized by the application. The various file types can be described in plain English
with long descriptive names and without their filename extensions.

The extension of the default file type for the application is described by the DefaultExten-
sion property, and the list of the file types displayed in the Save As Type box is determined by
the Filter property.

To prompt the user for a file to be opened, use the following statements. The Open dialog
box displays the files with the filename extension .bin only:

OpenFileDialogl.DefaultExt = ".bin"
OpenFileDialogl.AddExtension = True
OpenFileDialogl.Filter = "Binary Files|*.bin"
If OpenFileDialogl.ShowDialog() =
Windows.Forms.DialogResult.OK Then
Debug.WriteLine(OpenFileDialogl.FileName)
End If

The following sections describe the properties of the OpenFileDialog and SaveFileDialog
controls.

ADDEXTENSION

This property is a Boolean value that determines whether the dialog box automatically adds an
extension to a filename if the user omits it. The extension added automatically is the one spec-
ified by the DefaultExtension property, which you must set before calling the ShowDialog
method. This is the default filename extension of the files recognized by your application.

CHECKFILEEXISTS

This property is a Boolean value that indicates whether the dialog box displays a warning if the
user enters the name of a file that does not exist in the Open dialog box or if the user enters the
name of a file that exists in the Save dialog box.

CHECKPATHEXISTS

This property is a Boolean value that indicates whether the dialog box displays a warning if the
user specifies a path that does not exist as part of the user-supplied filename.

DEFAULTEXT

This property sets the default extension for the filenames specified on the control. Use this
property to specify a default filename extension, such as .txt or .doc, so that when a file with
no extension is specified by the user, the default extension is automatically appended to the
filename. You must also set the AddExtension property to True. The default extension property
starts with the period, and it’s a string — for example, .bin.

DEREFERENCELINKS

This property indicates whether the dialog box returns the location of the file referenced by
the shortcut or the location of the shortcut itself. If you attempt to select a shortcut on your
Desktop when the Dereferencelinks property is set to False, the dialog box will return to
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your application a value such as C: \WINDOWS\SYSTEM32\Tnkstub.exe, which is the name of the
shortcut, not the name of the file represented by the shortcut. If you set the DereferencelLinks
property to True, the dialog box will return the actual filename represented by the shortcut,
which you can use in your code.

FILENAME

Use this property to retrieve the full path of the file selected by the user in the control. If you
set this property to a filename before opening the dialog box, this value will be the proposed
filename. The user can click OK to select this file or select another one in the control. The two
controls provide another related property, the FileNames property, which returns an array of
filenames. To find out how to allow the user to select multiple files, see the discussion of the
MultiSelect and FileNames properties later in this chapter.

FILTER

This property is used to specify the type(s) of files displayed in the dialog box. To display
text files only, set the Filter property to Text files|*.txt. The pipe symbol separates
the description of the files (what the user sees) from the actual filename extension (how the
operating system distinguishes the various file types).

If you want to display multiple extensions, such as .bmp, .gif, and .jpg, use a semi-
colon to separate extensions with the Filter property. Set the Filter property to the string
Images|*.bmp;*.gif;%.jpg to display all the files of these three types when the user selects
Images in the Save As Type combo box under the box with the filename.

Don’t include spaces before or after the pipe symbol because these spaces will be displayed
on the dialog box. In the Open dialog box of an image-processing application, you'll probably
provide options for each image file type as well as an option for all images:

OpenFileDialogl.Filter =
"Bitmaps|*.bmp|GIF Images|*.gif|" &
"JPEG Images|*.jpg|Al1l Images|*.bmp;*.gif;*.jpg"

FILTERINDEX

When you specify more than one file type when using the Filter property of the Open dia-
log box, the first file type becomes the default. If you want to use a file type other than the first
one, use the FilterIndex property to determine which file type will be displayed as the default
when the Open dialog box is opened. The index of the first type is 1, and there’s no reason to
ever set this property to 1. If you use the Filter property value of the example in the preced-
ing section and set the FilterIndex property to 2, the Open dialog box will display GIF files
by default.

INITIALDIRECTORY

This property sets the initial folder whose files are displayed the first time that the Open and
Save dialog boxes are opened. Use this property to display the files of the application’s folder
or to specify a folder in which the application stores its files by default. If you don’t specify
an initial folder, the dialog box will default to the last folder where the most recent file was
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opened or saved. It’s also customary to set the initial folder to the application’s path by using
the following statement:

OpenFileDialogl.InitialDirectory = Application.ExecutablePath

The expression Application.ExecutablePath returns the path in which the application’s
executable file resides.

RESTOREDIRECTORY

Every time the Open and Save As dialog boxes are displayed, the current folder is the one
that was selected by the user the last time the control was displayed. The RestoreDirectory
property is a Boolean value that indicates whether the dialog box restores the current directory
before closing. Its default value is False, which means that the initial directory is not restored
automatically. The InitialDirectory property overrides the RestoreDirectory property.

FILENAMES

If the Open dialog box allows the selection of multiple files (you have set the MultiSelect
property to True), the FileNames property contains the pathnames of all selected files.
FileNames is a collection, and you can iterate through the filenames with an enumerator. This
property should be used only with the OpenFileDialog control, even though the SaveFileDialog
control exposes a FileNames property.

MULTISELECT

This property is a Boolean value that indicates whether the user can select multiple files in the
dialog box. Its default value is False, and users can select a single file. When the MuTtiSelect
property is True, the user can select multiple files, but they must all come from the same folder
(you can’t allow the selection of multiple files from different folders). This property is unique
to the OpenFileDialog control. This and the following two properties are unique to the Open-
FileDialog control.

READONLYCHECKED, SHOWREADONLY

The ReadOnTyChecked property is a Boolean value that indicates whether the Read-Only check
box is selected when the dialog box first pops up (the user can clear this box to open a file

in read/write mode). You can set this property to True only if the ShowReadOnly property is
also set to True. The ShowReadOnly property is also a Boolean value that indicates whether the
Read-Only check box is available. If this check box appears on the form, the user can select it
so the file will be opened as read-only. Files opened as read-only shouldn’t be saved with the
same filename — always prompt the user for a new filename.

THE OPENFILE AND SAVEFILE METHODS

The OpenFileDialog control exposes the OpenFile method, which allows you to quickly
open the selected file. Likewise, the SaveFileDialog control exposes the SaveFile method,
which allows you to quickly save a document to the selected file. Normally, after retriev-
ing the name of the file selected by the user, you must open this file for reading (in
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the case of the Open dialog box) or writing (in the case of the Save dialog box). The
topic of reading from or writing to files is discussed in detail in the tutorial ““Access-
ing Files and Folders with the System.IO Class,” which is available for download at
www . sybex.com/go/masteringvb2010.

When this method is applied to the Open dialog box, the file is opened with read-only per-
mission. The same method can be applied to the SaveFile dialog box, in which case the file is
opened with read-write permission. Both methods return a Stream object, and you can call this
object’s Read and Write methods to read from or write to the file.

VB 2010 AT WORK: MULTIPLE FILE SELECTION

The Open dialog box allows the selection of multiple files. This feature can come in handy
when you want to process files en masse. You can let the user select many files, usually of the
same type, and then process them one at a time. Or, you might want to prompt the user to
select multiple files to be moved or copied.

To allow the user to select multiple files in the Open dialog box, set the MultiSeTlect prop-
erty to True. The user can then select multiple files with the mouse by holding down the Shift
or Ctrl key. The names of the selected files are reported by the property FileNames, which is
an array of strings. The FileNames array contains the pathnames of all selected files, and you
can iterate through them and process each file individually.

One of this chapter’s sample projects is the MultipleFiles project, which demonstrates how
to use the FileNames property. The application’s form is shown in Figure 7.5. The button at
the top of the form, Show Files in Folder, displays the Open dialog box, where you can select
multiple files. After closing the dialog box by clicking the Open button on the Open dialog box,
the application displays the pathnames of the selected files on a ListBox control.
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The code behind the Open Files button is shown in Listing 7.1. In this example, I used
the array’s enumerator to iterate through the elements of the FileNames array. You can use
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any of the methods discussed in Chapter 2, “VB Programming Essentials” to iterate through
the array.

LISTING 7.1: Processing multiple selected files

Private Sub bttnFile_Click(..) Handles bttnFile.Click
OpenFileDialogl.Multiselect = True
OpenFileDialogl.ShowDialog()

Dim filesEnum As IEnumerator
ListBox1l.Items.Clear()
filesEnum = OpenFileDialogl.FileNames.GetEnumerator()
While filesEnum.MoveNext
ListBox1l.Items.Add(filesEnum.Current)
End While
End Sub

The FolderBrowserDialog Control

Sometimes we need to prompt users for a folder rather than a filename. An application that
processes files in batch mode shouldn’t force users to select the files to be processed. Instead, it
should allow users to select a folder and process all files of a specific type in the folder (it could
encrypt all text documents or resize all image files, for example). As elaborate as the File Open
dialog box might be, it doesn’t allow the selection of a folder. To prompt users for a folder’s
path, use the FolderBrowser dialog box, which is a very simple one; it’s shown in Figure 7.6. The
FolderBrowserDialog control exposes a small number of properties, which are discussed next.

FIGURE 7.6
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ROOTFOLDER

This property indicates the initial folder to be displayed when the dialog box is shown. It is
not necessarily a string; it can also be a member of the SpecialFolder enumeration. To see the
members of the enumeration, enter the following expression:

FolderBrowserDialogl.RootFolder =

As soon as you enter the equals sign, you will see the members of the enumeration. The
most common setting for this property is My Computer, which represents the target computer’s
file system. You can set the RootFolder property to a number of special folders (for example,
Personal, Desktop, ApplicationData, LocalApplicationData, and so on). You can also set this
property to a string with the desired folder’s pathname.

SELECTEDPATH

After the user closes the FolderBrowser dialog box by clicking the OK button, you can retrieve
the name of the selected folder with the SelectedPath property, which is a string, and you
can use it with the methods of the System.I0O namespace to access and manipulate the selected
folder’s files and subfolders.

SHOWNEWFOLDERBUTTON

This property determines whether the dialog box will contain a New button; its default value
is True. When users click the New button to create a new folder, the dialog box prompts them
for the new folder’s name and creates a new folder with the specified name under the selected
folder.

VB 2010 AT WORK: FOLDER BROWSING DEMO PROJECT

The FolderBrowser control is a trivial control, but I'm including a sample application,
available for download from www.sybex.com/go/masteringvb2010, to demonstrate
its use. The same application demonstrates how to retrieve the files and subfolders of
the selected folder and how to create a directory listing in a RichTextBox control, like
the one shown in Figure 7.6. The members of the System.I0 namespace, which allow
you to access and manipulate files and folders from within your code, are discussed in
detail in the tutorial ““Accessing Files and Folders,” which is available for download at
www . sybex.com/go/masteringvb2010.

The FolderBrowser dialog box is set to display the entire file system of the target computer
and is invoked with the following statements:

FolderBrowserDialogl.RootFolder = Environment.SpecialFolder.MyComputer
FolderBrowserDialogl.ShowNewFolderButton = False

If FolderBrowserDialogl.ShowDialog = DialogResult.OK Then

' process files in selected folder

End If

As usual, we examine the value returned by the ShowDialog method of the control
and we proceed if the user has closed the dialog box by clicking the OK button. The code
that iterates through the selected folder’s files and subfolders, shown in Listing 7.2, is
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basically a demonstration of some members of the System.IO namespace, but I'll review it
briefly here.

LISTING 7.2: Scanning a folder

Private Sub bttnSelectFiles_Click(..) Handles bttnSelectFiles.Click
FolderBrowserDialogl.RootFolder =
Environment.SpecialFolder.MyComputer
FolderBrowserDialogl.ShowNewFolderButton = False
If FolderBrowserDialogl.ShowDialog = Windows.Forms.DialogResult.OK Then
RichTextBox1l.Clear()
' Retrieve initial folder
Dim initialFolder As String =
FolderBrowserDialogl.SelectedPath
Dim InitialDir As New IO.DirectoryInfo(
FolderBrowserDialogl.SelectedPath)
" and print its name w/o any indentation
PrintFolderName(InitialDir, "")
" and then print the files in the top folder
If InitialDir.GetFiles("*.*").Length = 0 Then
SwitchToItalics()
RichTextBox1.AppendText(
"folder contains no files" & vbCrLf)
SwitchToRegular()
Else
PrintFileNames(InitialDir, "")
End If
Dim DI As I0.DirectoryInfo
' Iterate through every subfolder and print it
For Each DI In InitialDir.GetDirectories
PrintDirectory(DI)
Next
End If
End Sub

The selected folder’s name is stored in the 7nitialFolder variable and is passed as an
argument to the constructor of the DirectoryInfo class. The InitialDir variable represents the
specified folder. This object is passed to the PrintFolderName() subroutine, which prints the
folder’s name in bold. Then the code iterates through the same folder’s files and prints them
with the PrintFileNames() subroutine, which accepts as an argument the DirectoryInfo object
that represents the current folder and the indentation level. After printing the initial folder’s
name and the names of the files in the folder, the code iterates through the subfolders of the
initial folder. The GetDirectories method of the DirectoryInfo class returns a collection of
objects, one for each subfolder under the folder represented by the InitialDir variable. For
each subfolder, it calls the PrintDirectory() subroutine, which prints the folder’s name and
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the files in this folder, and then iterates through the folder’s subfolders. The code that iterates
through the selected folder’s files and subfolders is shown in Listing 7.3.

LISTING 7.3: The PrintDirectory() subroutine

Private Sub PrintDirectory(ByVal CurrentDir As I0.DirectoryInfo)
Static IndentationLevel As Integer = 0
IndentationLevel += 1
Dim indentationString As String = ""
indentationString =

New String(Convert.ToChar(vbTab), IndentationLevel)

PrintFolderName(CurrentDir, indentationString)

If CurrentDir.GetFiles("*.*").Length = 0 Then
SwitchToItalics()
RichTextBox1.AppendText(indentationString &

"folder contains no files" & vbCrLf)
SwitchToRegular()

Else
PrintFileNames(CurrentDir, indentationString)

End If

Dim folder As IO.DirectoryInfo

For Each folder In CurrentDir.GetDirectories
PrintDirectory(folder)

Next

IndentationLevel -= 1

End Sub

The code that iterates through the subfolders of a given folder is discussed in detail in
the tutorial ““Accessing Files and Folders,” available for download from www.sybex.com
/go/masteringvb2010, so you need not worry if you can’t figure out how it works yet. In the
following sections, you'll learn how to display formatted text in the RichTextBox control.

The RichTextBox Control

The RichTextBox control is the core of a full-blown word processor. It provides all the func-
tionality of a TextBox control; it can handle multiple typefaces, sizes, and attributes and offers
precise control over the margins of the text (see Figure 7.7). You can even place images in your
text on a RichTextBox control (although you won’t have the kind of control over the embedded
images that you have with Microsoft Word).

The fundamental property of the RichTextBox control is its Rtf property. Similar to the Text
property of the TextBox control, this property is the text displayed on the control. Unlike the
Text property, however, which returns (or sets) the text of the control but doesn’t contain for-
matting information, the Rtf property returns the text along with any formatting information.
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Therefore, you can use the RichTextBox control to specify the text’s formatting, including para-
graph indentation, font, and font size or style.
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RTF, which stands for Rich Text format, is a standard for storing formatting information
along with the text. The beauty of the RichTextBox control for programmers is that they don’t
need to supply the formatting codes. The control provides simple properties to change the font
of the selected text, change the alignment of the current paragraph, and so on. The RTF code is
generated internally by the control and used to save and load formatted files. It's possible to
create elaborately formatted documents without knowing the RTF specification.

The WordPad application that comes with Windows is based on the RichTextBox control.
You can easily duplicate every bit of WordPad’s functionality with the RichTextBox control, as
you will see later in this chapter.

The RTF Language

A basic knowledge of the Rich Text format, its commands, and how it works will certainly
help you understand the RichTextBox control’s inner workings. RTF is a language that uses
simple commands to specify the formatting of a document. These commands, or tags, are
ASCII strings, such as \par (the tag that marks the beginning of a new paragraph) and \b
(the tag that turns on the bold style). And this is where the value of the Rich Text format lies.
RTF documents don’t contain special characters and can be easily exchanged among different
operating systems and computers, as long as there is an RTF-capable application to read the
document.
RTF is similar to Hypertext Markup Language (HTML), and if you're familiar with HTML,

a few comparisons between the two standards will provide helpful hints and insight into the
RTF language. Like HTML, RTF was designed to create formatted documents that could be dis-
played on different systems. The following RTF segment displays a sentence with a few words
in italic:

\bRTF\bO (which stands for Rich Text Format) is a \i

document formatting language\iO that uses simple

commands to specify the formatting of the document.
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<b>RTF</b> (which stands for Rich Text Format) is a
<i>document formatting language</i> that uses simple
commands to specify the formatting of the document.

The <b> and <i> tags of HTML, for example, are equivalent to the \b and \1i tags of RTF.
The closing tags in RTF are \bO and \1i0, respectively.

Although you don’t need to understand the RTF specifications to produce formatted text
with the RichTextBox control, if you want to generate RTF documents from within your code,
visit the RTF Cookbook site at http://search.cpan.org/~sburke/RTF-Writer/1ib/RTF/
Cookbook.pod. There’s also a Microsoft resource on RTF at http://msdn2.microsoft.com/

en-us/library/aal40277(office.10).aspx

Text Manipulation and Formatting Properties

The RichTextBox control provides properties for manipulating the selected text on the con-
trol. The names of these properties start with the Selection or Selected prefix, and the most
commonly used ones are shown in Table 7.1. Some of these properties are discussed in further

detail in following sections.

TABLE 7.1:
PROPERTY
SelectedText
SelectedRtf
SelectionStart
SelectionLength
SelectionFont
SelectionColor
SelectionBackColor
SelectionAlignment

SelectionIndent, SelectionRightIndent,
SelectionHangingIndent

RightMargin

SelectionTabs

SelectionBullet

BulletIndent

RichTextBox properties for manipulating selected text

‘WHAT IT MANIPULATES

The selected text

The RTF code of the selected text

The position of the selected text’s first character
The length of the selected text

The font of the selected text

The color of the selected text

The background color of the selected text

The alignment of the selected text

The indentation of the selected text

The distance of the text’s right margin from the
left edge of the control

An array of integers that sets the tab stop
positions in the control

Whether the selected text is bulleted

The amount of bullet indent for the selected text




272

CHAPTER 7 MORE WINDOWS CONTROLS

SELECTEDTEXT

The SeTectedText property represents the selected text, whether it was selected by the user via
the mouse or from within your code. To assign the selected text to a variable, use the following
statement:

selText=RichTextbox1.SelectedText

You can also modify the selected text by assigning a new value to the SelectedText prop-
erty. The following statement converts the selected text to uppercase:

RichTextbox1l.SelectedText =
RichTextboxl.SelectedText.ToUpper

You can assign any string to the SelectedText property. If no text is selected at the time,
the statement will insert the string at the location of the pointer.

SELECTIONSTART, SELECTIONLENGTH

To simplify the manipulation and formatting of the text on the control, two additional prop-
erties, SeTectionStart and SelectionLength, report (or set) the position of the first selected
character in the text and the length of the selection, respectively, regardless of the formatting of
the selected text. One obvious use of these properties is to select (and highlight) some text on
the control:

RichTextBox1l.SelectionStart = 0
RichTextBoxl.SelectionLength = 100

You can also use the Select method, which accepts as arguments the starting location and
the length of the text to be selected.

SELECTIONALIGNMENT

Use this property to read or change the alignment of one or more paragraphs. This property’s
value is one of the members of the HorizontalAlignment enumeration: Left, Right, and Center.
Users don’t have to select an entire paragraph to align it; just placing the pointer anywhere in
the paragraph will do the trick because you can’t align part of the paragraph.

SELECTIONINDENT, SELECTIONRIGHTINDENT, SELECTIONHANGINGINDENT

These properties allow you to change the margins of individual paragraphs. The Selection-
Indent property sets (or returns) the amount of the text’s indentation from the left edge of the
control. The SelectionRightIndent property sets (or returns) the amount of the text’s inden-
tation from the right edge of the control. The SelectionHangingIndent property indicates the
indentation of each paragraph’s first line with respect to the following lines of the same para-
graph. All three properties are expressed in pixels.
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The SelectionHangingIndent property includes the current setting of the SelectionIndent
property. If all the lines of a paragraph are aligned to the left, the SelectionIndent property
can have any value (this is the distance of all lines from the left edge of the control), but the
SelectionHangingIndent property must be zero. If the first line of the paragraph is shorter
than the following lines, the SelectionHangingIndent has a negative value. Figure 7.8 shows
several differently formatted paragraphs. The settings of the SelectionIndent and Selection-
HangingIndent properties are determined by the two sliders at the top of the form.

FIGURE 7.8
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SELECTIONBULLET, BULLETINDENT

You use these properties to create a list of bulleted items. If you set the SelectionBullet prop-
erty to True, the selected paragraphs are formatted with a bullet style, similar to the <u1> tag
in HTML. To create a list of bulleted items, select them from within your code and assign the
value True to the SeTectionBullet property. To change a list of bulleted items back to normal
text, make the same property False.

The paragraphs formatted as bullets are also indented from the left by a small amount. To
set the amount of the indentation, use the BulletIndent property, which is also expressed in
pixels.

SELECTIONTABS

Use this property to set the tab stops in the RichTextBox control. The Selection tab should be set
to an array of integer values, which are the absolute tab positions in pixels. Use this property
to set up a RichTextBox control for displaying tab-delimited data.
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@ Real World Scenario

USING THE RICHTEXTBOX CONTROL TO DISPLAY DELIMITED DATA

As a developer 1 tend to favor the RichTextBox control over the TextBox control, even though
1 don’t mix font styles or use the more-advanced features of the RichTextBox control. I sug-
gest that you treat the RichTextBox control as an enhanced TextBox control and use it as a
substitute for the TextBox control. One of the features of the RichTextBox control that I find
very handy is its ability to set the tab positions and display tabular data. You can also display
tabular data on a ListView control, as you will see later in the chapter, but it’s simpler to
use a RichTextBox control with its ReadOnly property set to True and its SelectionTabs
property set to an array of values that will accommodate your data. Here’s how to set up a
RichTextBox control to display a few rows of tab-delimited data:

RichTextBox1l.ReadOnly = True
RichTextBox1l.SelectionTabs = New Integer() {100, 160, 340}
RichTextBox1.AppendText("R1C1" & vbTab &
"R1C2" & vbTab &
"R1C3" & vbCrLf)
RichTextBox1.AppendText("R2C1" & vbTab &
"R2C2" & vbTab &
"R2C3" & vbCrLf)
This technique is a lifesaver when 1 have to read the delimited data from a file. I just set up
the tab positions and then load the data with the LoadFile method, which is discussed in the
next section.

Methods

The first two methods of the RichTextBox control you need to know are SaveFile and
LoadFiTe. The SaveFile method saves the contents of the control to a disk file, and the
LoadFile method loads the control from a disk file.

SAVEFILE

The syntax of the SaveFiTle method is as follows, where path is the path of the file in which
the current document will be saved:

RichTextBox1l.SaveFile(path, filetype)

By default, the SaveFile method saves the document in RTF format and uses the .rtf exten-

sion. You can specify a different format by using the second optional argument, which can take
on the value of one of the members of the RichTextBoxStreamType enumeration, described in
Table 7.2.

LOADFILE

Similarly, the LoadFile method loads a text or RTF file to the control. Its syntax is identical to
the syntax of the SaveFile method:

RichTextBoxl.LoadFile(path, filetype)
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TABLE 7.2: The RichTextBoxStreamType enumeration
FORMAT EFFECT
PlainText Stores the text on the control without any formatting
R7chNoOLEObjs Stores the text without any formatting and ignores any embedded OLE (Object

Linking and Embedding) objects
RichText Stores the text in RTF format (text with embedded RTF commands)
TextTextOLEObjs Stores the text along with the embedded OLE objects

UnicodePlainText Stores the text in Unicode format

The filetype argument is optional and can have one of the values of the RichTextBox-
StreamType enumeration. Saving and loading files to and from disk files is as simple as pre-
senting a Save or Open common dialog to the user and then calling one of the SaveFile or
LoadFiTe methods with the filename returned by the common dialog box.

SELECT, SELECTALL

The SeTect method selects a section of the text on the control, similar to setting the SeTlection-
Start and SelectionLength properties. The Select method accepts two arguments, the loca-
tion of the first character to be selected and the length of the selection:

RichTextBoxl.Select(start, Tength)

The SelectA11 method accepts no arguments and it selects all the text on the control.

Advanced Editing Features

The RichTextBox control provides all the text-editing features you’d expect to find in a
text-editing application, similar to the TextBox control. Among its more-advanced features,
the RichTextBox control provides the AutoWordSeTlection property, which controls how the
control selects text. If it’s True, the control selects a word at a time.

In addition to formatted text, the RichTextBox control can handle object linking and embed-
ding (OLE) objects. You can insert images in the text by pasting them with the Paste method.
The Paste method doesn’t require any arguments; it simply inserts the contents of the Clip-
board at the current location (the location of the cursor) in the document.

Unlike the plain TextBox control, the RichTextBox control encapsulates undo and redo
operations at multiple levels. Each operation has a name (Typing, Deletion, and so on), and
you can retrieve the name of the next operation to be undone or redone and display it on
the menu. Instead of a simple Undo or Redo caption, you can change the captions of the Edit
menu to something like Undo Delete or Redo Typing. To program undo and redo operations
from within your code, you must use the properties and methods discussed in the following
sections.
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CANUNDO, CANREDO

These two properties are Boolean values you can read to find out whether there’s an operation
that can be undone or redone. If they’re False, you must disable the corresponding menu com-
mand from within your code. The following statements disable the Undo command if there’s
no action to be undone at the time (EditUndo is the name of the Undo command on the Edit
menu):

If RichTextBox1l.CanUndo Then
EditUndo.Enabled = True
Else
EditUndo.Enabled = False
End If

These statements should appear in the menu item’s Select event handler (not in the Click
event handler) because they must be executed before the menu is displayed. The Select event
is triggered when a menu is opened. As a reminder, the Click event is fired when you click an
item and not when you open a menu. For more information on programming the events of a
menu, see Chapter 6, “Working with Forms.”

UNDOACTIONNAME, REDOACTIONNAME

These two properties return the name of the action that can be undone or redone. The most
common value of both properties is Typing, which indicates that the Undo command will
delete a number of characters. Another common value is DeTete, and some operations are
named Unknown. If you change the indentation of a paragraph on the control, this action’s
name is Unknown. Even when an action’s name is Unknown the action can be undone with the
Undo method.

The following statement sets the caption of the Undo command to a string that indicates the
action to be undone (Editor is the name of a RichTextBox control):

If Editor.CanUndo Then
EditUndo.Text = "Undo " & Editor.UndoActionName
End If

UNDO, REDO

These two methods undo or redo an action. The Undo method cancels the effects of the last
action of the user on the control. The Redo method redoes the most recent undo action. The
Redo method does not repeat the last action; it applies to undo operations only.

Cutting, Copying, and Pasting

To cut, copy, and paste text in the RichTextBox control, you can use the same techniques you
use with the regular TextBox control. For example, you can replace the current selection by
assigning a string to the SelectedText property. The RichTextBox, however, provides a few
useful methods for performing these operations. The Copy, Cut, and Paste methods perform
the corresponding operations. The Cut and Copy methods are straightforward and require no
arguments. The Paste method accepts a single argument, which is the format of the data to be
pasted. Because the data will come from the Clipboard, you can extract the format of the data
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in the Clipboard at the time and then call the CanPaste method to find out whether the control
can handle this type of data. If so, you can then paste them in the control by using the Paste
method.

This technique requires a bit of code because the Clipboard class doesn’t return the format
of the data in the Clipboard. You must call the following method of the Clipboard class to find
out whether the data is of a specific type and then paste it on the control:

If Clipboard.GetDataObject.GetDataPresent(DataFormats.Text) Then
RichTextBox1l.Paste(DataFormats.GetFormat("Text")
End If

This is a very simple case because we know that the RichTextBox control can accept
text. For a robust application, you must call the GetDataPresent method for each type
of data your application should be able to handle. (You may not want to allow users to
paste all types of data that the control can handle.) By the way, you can simplify the code
with the help of the ContainsText/ContainsImage and GetText/GetImage methods of the
My.Application.Clipboard object.

In the RTFPad project in this chapter, we’ll use a structured exception handler to allow users
to paste anything in the control. If the control can’t handle it, the data won’t be pasted in the
control.

VB 2010 at Work: The RTFPad Project

Creating a functional — even fancy — word processor based on the RichTextBox control is
unexpectedly simple. The challenge is to provide a convenient interface that lets the user
select text, apply attributes and styles to it, and then set the control’s properties accordingly.
The RTFPad sample application of this section does just that. You can download a copy from
www . sybex.com/go/masteringvb2010.

The RTFPad application (refer to Figure 7.7) is based on the TextPad application developed
in Chapter 5, “Basic Windows Controls.” It contains the same text-editing commands and some
additional text-formatting commands that can be implemented only with the RichTextBox con-
trol; for example, it allows you to apply multiple fonts and styles to the text and, of course,
multiple Undo/Redo operations.

The two TrackBar controls above the RichTextBox control manipulate the indentation of the
text. We already explored this arrangement in the discussion of the TrackBar control in Chapter
5, but let’s review the operation of the two controls again. Each TrackBar control has a width
of 816 pixels, which is equivalent to 8.5 inches on a monitor that has a resolution of 96 dots
per inch (dpi). The height of the TrackBar controls is 42 pixels, but unfortunately they can’t be
made smaller. The Minimum property of both controls is 0, and the Maximum property is 16. The
TickFrequency is 1. With these values, you can adjust the indentation in steps of } inch. Set
the Maximum property to 32 and you'll be able to adjust the indentation in steps of 1 inch. It's
not the perfect interface, as it’s built for A4 pages in portrait orientation only. You can experi-
ment with this interface to build an even more functional word processor.

Each time the user slides the top TrackBar control, the code sets the SeTectionIndent prop-
erty to the proper percentage of the control’s width. Because the SelectionHangingIndent
includes the value of the SelectionIndent property, it also adjusts the setting of the Selec-
tionHangingIndent property. Listing 7.4 is the code that’s executed when the upper TrackBar
control is scrolled.
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LISTING 7.4: Setting the SelectionIndent property

Private Sub TrackBarl_Scroll1(..) Handles TrackBarl.Scroll
Editor.SelectionIndent = Convert.ToInt32(Editor.Width *
(TrackBarl.Value / TrackBarl.Maximum))
Editor.SelectionHangingIndent =
Convert.ToInt32(Editor.Width *
(TrackBar2.Value / TrackBar2.Maximum) -
Editor.SelectionIndent)
End Sub

Editor is the name of the RichTextBox control on the form. The code sets the control’s
indentation to the same percentage of the control’s width, as indicated by the value of the top
TrackBar control. It also does the same for the SelectionHangingIndent property, which is
controlled by the lower TrackBar control. If the user has scrolled the lower TrackBar control,
the code sets the RichTextBox control’s SelectionHangingIndent property in the event
handler, as presented in Listing 7.5.

LISTING 7.5: Setting the SelectionHangingIndent property

Private Sub TrackBar2_Scrol1(..) Handles TrackBar2.Scroll
Editor.SelectionHangingIndent =
Convert.ToInt32(Editor.Width *
(TrackBar2.Value / TrackBar2.Maximum) -
Editor.SelectionIndent)
End Sub

Enter a few lines of text in the control, select one or more paragraphs, and check out the
operation of the two sliders.

The Scrol1 events of the two TrackBar controls adjust the text’s indentation. The opposite
action must take place when the user rests the pointer on another paragraph: The sliders” posi-
tions must be adjusted to reflect the indentation of the selected paragraph. The selection of a
new paragraph is signaled to the application by the SelectionChanged event. The statements
of Listing 7.6, which are executed from within the SelectionChanged event, adjust the two
slider controls to reflect the indentation of the text.

LISTING 7.6: Setting the slider controls

Private Sub Editor_SelectionChanged(..)
Handles Editor.SelectionChanged
If Editor.SelectionIndent = Nothing Then
TrackBarl.Value = TrackBarl.Minimum
TrackBar2.Value = TrackBar2.Minimum
Else
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TrackBarl.Value = Convert.ToInt32(
Editor.SelectionIndent *
TrackBarl.Maximum / Editor.Width)

TrackBar2.Value = Convert.ToInt32( _
(Editor.SelectionHangingIndent /

Editor.Width) *
TrackBar2.Maximum + TrackBarl.Value)
End If
End Sub

If the user selects multiple paragraphs with different indentations, the SelectionIndent
property returns Nothing. The code examines the value of this property and, if it’s Nothing,
moves both controls to the left edge. This way, the user can slide the controls and set the inden-
tations for multiple paragraphs. Some applications make the handles gray to indicate that the
selected text doesn’t have uniform indentation, but unfortunately you can’t gray the sliders and
keep them enabled. Of course, you can always design a custom control. This wouldn’t be a bad
idea, especially if you consider that the TrackBar controls are too tall for this type of interface
and can’t be made very narrow (as a result, the interface of the RTFPad application isn’t very
elegant).

THE FILE MENU

The RTFPad application’s File menu contains the usual Open, Save, and Save As commands,
which are implemented with the control’s LoadFile and SaveFile methods. Listing 7.7 shows
the implementation of the Open command in the File menu.

LISTING 7.7: The Open command

Private Sub OpenToolStripMenultem_Click(..) Handles
OpenToolStripMenuItem.Click
If DiscardChanges() Then
OpenFileDialogl.Filter =
"RTF Files|*.RTF|DOC Files|*.DOC|" &
"Text Files|*.TXT|ATT Files|*.*"
If OpenFileDialogl.ShowDialog() =
DialogResult.OK Then
fName = OpenFileDialogl.FileName
Editor.LoadFiTe(fName)
Editor.Modified = False
End If
End If
End Sub

The fName variable is declared on the form’s level and holds the name of the currently open
file. This variable is set every time a new file is successfully opened, and it’s used by the Save
command to automatically save the open file without prompting the user for a filename.
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DiscardChanges() is a function that returns a Boolean value, depending on whether the
control’s contents can be discarded. The function examines the Editor control’s Modified prop-
erty. If True, it prompts users as to whether they want to discard the edits. Depending on the
value of the Modified property and the user response, the function returns a Boolean value. If
the DiscardChanges() function returns True, the program goes on and opens a new document.
If the function returns False, the program aborts the operation to give the user a chance to save
the document. Listing 7.8 shows the DiscardChanges() function.

LISTING 7.8: The DiscardChanges() function

Function DiscardChanges() As Boolean
If Editor.Modified Then
Dim reply As MsgBoxResult
reply = MsgBox(
"Text hasn't been saved. Discard changes?",
MsgBoxStyle.YesNo)
If reply = MsgBoxResult.No Then
Return False
Else
Return True
End If
Else
Return True
End If
End Function

The Modified property becomes True after the first character is typed and isn’t reset back
to False. The RichTextBox control doesn’t handle this property very intelligently and doesn’t
reset it to False even after saving the control’s contents to a file. The application’s code sets the
Editor.Modified property to False after creating a new document as well as after saving the
current document.

The Save As command (see Listing 7.9) prompts the user for a filename and then stores the
Editor control’s contents to the specified file. It also sets the fName variable to the file’s path so
that the Save command can use it.

LISTING 7.9: The Save As command

Private Sub SaveAsToolStripMenuItem Click(..)
Handles SaveAsToolStripMenuIltem.Click
SaveFileDialogl.Filter =
"RTF Files|*.RTF|DOC Files" &

SaveFileDialogl.DefaultExt = "RTF"
If SaveFileDialogl.ShowDialog() = DialogResult.OK Then
fName = SaveFileDialogl.FileName
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Editor.SaveFile(fName)
Editor.Modified = False
End If
End Sub

The Save command’s code is similar, only it doesn’t prompt the user for a filename. It calls
the SaveFile method, passing the fName variable as an argument. If the fName variable has no
value (in other words, if a user attempts to save a new document by using the Save command),
the code activates the event handler of the Save As command automatically and resets the con-
trol’s Modified property to False. Listing 7.10 shows the code behind the Save command.

LISTING 7.10: The Save command

Private Sub SaveToolStripMenuItem_Click(..)
Handles SaveToolStripMenuItem.Click
If fName <> "" Then
Editor.SaveFile(fName)
Editor.Modified = False
Else
SaveAsToolStripMenuIltem Click(sender, e)
End If
End Sub

THE EDIT MENU

The Edit menu contains the usual commands for exchanging data through the Clipboard (Copy,
Cut, Paste), Undo/Redo commands, and a Find command to invoke the Search & Replace dia-
log box. All the commands are almost trivial, thanks to the functionality built into the control.

The basic Cut, Copy, and Paste commands call the RichTextBox control’s Copy, Cut, and Paste
methods to exchange data through the Clipboard. Listing 7.11 shows the implementation of the
Paste command.

LISTING 7.11: The Paste command

Private Sub PasteToolStripMenuItem_Click(..)
Handles PasteToolStripMenuItem.Click
Try
Editor.Paste()
Catch exc As Exception
MsgBox(
"Can't paste current clipboard's contents. " &
"Try pasting the data in some other format.")
End Try
End Sub
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As you may recall from the discussion of the Paste command, using the CanPaste method
isn’t trivial, you have to handle each data type differently. By using an exception handler, you
allow the user to paste all types of data that the RichTextBox control can accept and display
a message when an error occurs. Using exceptions for programming application logic can be
quite costly, but in this case it’s acceptable because the RTFPad editor is a desktop applica-
tion serving a single user. A delay of a few milliseconds in this case should not make a huge
difference.

For a more robust solution though, you might wish to handle each data type separately
using the CanPaste method. That way, you can provide the user with much more precise feed-
back over the problem that caused the error; that is, the exact format of the data in the Clip-
board they are trying to paste but the RichTex